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ComfortVIEW ™ is the Carrier Corporation software that is the
primary man/machine interface to the Carrier Comfort Network
(CCN). The software, designed to run under the Microsoft® Win-
dows® 2000, Windows 2003 Server, or Windows XP Professional
operating system, enables you to quickly identify information and
intuitively perform all operator functions.

ComfortVIEW provides the tools you need for monitoring, config-
uring, and analyzing your facility’s daily HVAC operations. You
can achieve optimum results using the following ComfortVIEW
features and functions:

• WorkSPACE Manager Application — You can create customized
displays of data that you care about most and save them as
WorkSPACEs. Each WorkSPACE can consist of multiple graphic
displays of any type of data, including trending information.

• Dynamic Trending — You can elect to trend any available
realtime data point, and store report output in a format compat-
ible with spreadsheet industry standards.

• Simultaneous Dynamic Displays — You can simultaneously
display data from multiple controllers — either controllers
located in the same area or, using concurrent modem connec-
tions, data from controllers at remote areas.

• Fast Alarm Response — You can see and acknowledge incom-
ing alarms, regardless of the application that you have running
on your computer. With the click of the mouse, you can jump to
the WorkSPACE that is pertinent to the given alarm condition.
You can record the action you have taken in response to an
alarm by attaching a note to the alarm entry. You can suppress
the annunciation of specified alarm conditions to avoid interrup-
tion by known “nuisance-type” alarms.

• Database — Depending on how you set up your ComfortVIEW
system, your database can be shared by other ComfortVIEW
operators at other computers. Changes made by ComfortVIEW
operators are stored in a central area to create a common source
of data.

• Logical Controller Groupings — You can group controllers into
user-defined buildings, floors, areas or regions, independent of
your Carrier Comfort Network architecture.

Introduction
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The ComfortVIEW Operation Manual is designed for use by indi-
viduals who have completed CCN training and have a working
knowledge of Windows.

The manual is organized in a how-to functional format to help you
readily locate the information you need.

This manual contains the following chapters:

• Introduction
• Carrier Network Manager
• Remote Access
• WorkSPACE Manager
• Alarm Manager
• Setup
• Report Panel
• Global Function Manager
• Appendix A
• Appendix B

The Introduction chapter consists of this description of the manual,
login and logout instructions, and a description of ComfortVIEW
window format, menus, and commands. The chapter also includes
mouse and keyboard instructions, including an overview of the keys
and mouse techniques that you will typically use in operating
ComfortVIEW.

The Carrier Network Manager chapter provides instructions on
adding ComfortVIEW operators, specifying alarm printers, connect-
ing to remote CCNs and remote ComfortVIEW computers, and
adding, viewing, and modifying controller data.

The Remote Access chapter provides instructions for connecting to
and disconnecting from a remote ComfortVIEW server.

The WorkSPACE Manager chapter provides instructions on creating
customized displays of data that you care about most and saving
them as WorkSPACEs, which are multiple graphic and tabular

About this Manual

Intended Audience

Description of
Chapters
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displays of any type of data, including trending information.

The Alarm Manager chapter provides instructions on using
ComfortVIEW alarm indication and alarm handling capabilities.

The Setup chapter provides information on defining local area
network workstations and alarm printers. It also includes instructions
on specifying global system parameters such as time of day for
automatic report data retrieval, and the time period for retaining
report data in your ComfortVIEW database.

The Report Panel chapter provides instructions on generating con-
sumable, runtime, and history reports to view, print, export, or save
on ComfortVIEW hard disk. Refer to the end of the Report Panel
chapter for samples of ComfortVIEW reports.

The Global Function Manager chapter provides instructions on
configuring ComfortVIEW to automatically force and auto groups of
points, perform point data transfers onto the CCN Bus, create central
occupancy schedules, and configure global holidays.

Appendix A provides instructions on generating additional
ComfortVIEW reports. Current additional reports include the Sys-
tem Activity, Alarm Summary, Time Schedule, Tenant Billing
Summary, and Tenant Billing Activity report.

Appendix B describes the CCN time and setpoint schedule, global
occupancy schedule, and remote site connection DLL that is in-
cluded with the standard ComfortVIEW installation.

Instructions Assume:  All step-by-step instructions assume that each
ComfortVIEW application is either inactive or minimized. The
instructions begin by instructing you to double click on an icon to
launch the application. For example, in Viewing the Alarm List,
which appears in the Alarms chapter, the first step tells you to
double click on the Alarm Manager icon. If, however, the Alarm
Manager application is active, but hidden by another window, press
Alt, and with this key held down, repeatedly press the Tab key to
switch through all active applications until the Alarm Manager
displays on your window.

Standards Used
Throughout this
Manual
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Using the Mouse: The instructions in this manual assume you are
using a mouse to operate your ComfortVIEW. For keyboard instruc-
tions, refer to Using the Keyboard, which appears under Using
ComfortVIEW:  An Overview, and To Select a Command Using
Your Keyboard, which appears under ComfortVIEW Menus and
Commands Lists.

Icon Illustrations:  To help you locate and identify the various
ComfortVIEW icons, the manual includes an illustration of each
icon in the left margin next to the instructions describing the icon’s
use. Each chapter also includes a table displaying and describing
each of the icons in the toolbar.

Menu Commands:  To help you locate a description of each menu
bar command, the last section of each chapter contains a command
summary.

Dialog Boxes:  All ComfortVIEW applications use dialog boxes,
which are special windows containing options that you select to
specify how ComfortVIEW should carry out a command. The
numbered-step instructions that appear throughout this manual do
not explain all dialog box options available to you. You can, how-
ever, find full summaries of all dialog box options in the tables that
immediately follow the numbered steps. You can also access these
tables while using ComfortVIEW by clicking on Help while display-
ing a dialog box. Thus, while performing some of the instructions in
this manual, you may need to refer out of the numbered steps to
these tables.

The sample instructions below illustrate the use of numbered steps
and tables to explain dialog box options.
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1. Select the alarms to which you wish to attach a note by
following the instructions found under Selecting Alarms.

2. Click on the Functions menu item and then click on Note.

ComfortVIEW displays the Operator Note dialog box.

3. Click in the Note text box and enter your text. You can enter
up to 500 characters. Refer to Figure 1-1 and Table 1-1 for
instructions on using this box.

Note: If any of the selected alarms currently has a note
attached to it, ComfortVIEW appends this new note
to the existing note text. You can enter up to 500
characters per note.

4. After you have entered the note text, click on OK. This closes
the Operator Note dialog box and saves the new note text.

Sample — To Attach a
Note to Multiple
Alarms

Figure 1-1
Operator Note Dialog Box

Operator Note

OK Cancel Help...

Note:

Edits the operator note text

SAMPLE

SAMPLE
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Click on To

the Note text box enter, modify, or delete operator note
text. You may enter up to 500 charac-
ters. If you have selected multiple
alarms, this text appends to existing
note text (up to a maximum of 500
characters).

Help display help information.

OK close the dialog box and save the
settings.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Other ComfortVIEW documentation includes:

ComfortVIEW Product Data Sheet (808-237)
ComfortVIEW Installation and Start-up Manual (808-238)

Instructions on operating the ComfortVIEW BEST++ application
can be found in the appendix of the BEST++ Programmer's Refer-
ence Manual (808-893).

These documents are available from Carrier Literature Distribution.

To use ComfortVIEW you should be familiar with how to power up
and shut down your computer. If you need to review this informa-
tion, refer to your computer’s user’s manual.

After powering up your computer, you must enter your Windows
username and password to log in to Windows.

Note: On computers running the Windows 2000 Server operat-
ing system, you must log in using an Administrator level
user name and password.

SAMPLE

Table 1-1
Operator Note Dialog Box

Related
Documentation

Logging In to
Windows

Power Up
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Next, you must log in to ComfortVIEW. Follow the ComfortVIEW
Logging In instructions that appear on the pages which follow.

Note: If the Auto-Login feature has been enabled for this
ComfortVIEW workstation, you will be automatically
logged into ComfortVIEW as part of Windows login. The
ComfortVIEW Logout application will display in the
Windows taskbar, which is typically located at the bottom
of your screen. For more information on this Auto-Login
feature, refer to Specifying Global System Parameters in
the Setup chapter of this manual.

For Windows 2000:

1. Click on the Windows  Start button and then click on Shut
Down.

2. In the Shut Down Windows dialog box, select Log off (fol-
lowed by your username).

3. Then, click on Yes.

For Windows XP:

1. Click on the Windows Start button and then click on Log Off.

2. In the Log Off Windows dialog box, click on Log Off.

After you log out of Windows, ComfortVIEW continues to run, and
all network functions carry on.  Report data is automatically re-
trieved and alarms continue to be received from the network as they
occur. Alarms will be indicated as configured.

ComfortVIEW applications are accessible to a single Windows XP
user account at a time - the first user to log in to Windows. If, on
attempting to launch any ComfortVIEW application, you receive the
message ComfortVIEW is currently attached to another user ses-
sion, this means that ComfortVIEW is currently running in another
Windows XP user's session.

In order to run ComfortVIEW do the following:

Logging Out of
Windows

Windows XP and Fast
User Switching
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1. Log out of Windows XP.

2. Have the other ComfortVIEW user log out of both
ComfortVIEW and Windows XP.

3. You can now log back in to Windows XP and will now be
permitted to log in to ComfortVIEW and run all
ComfortVIEW applications.

ComfortVIEW software is normally left running. Each time you
begin using ComfortVIEW, you must log in using the following
procedure. This procedure can be ignored, however, if this worksta-
tion has been configured for automatic ComfortVIEW login as part
of Windows login.

Follow the steps below to log in to ComfortVIEW:

1. Log in to Windows.

Note: On computers running the Windows 2000 Server
operating system, you must log in using an Admin-
istrator level user name and password.

2. Double click on the ComfortVIEW Login icon which is
shown at left.

ComfortVIEW displays the ComfortVIEW Login dialog box
(shown and described in Figure 1-2 and Table 1-2).

3. In the Login name text box, enter your login name.

Note: Passwords are case sensitive.

4. In the Password text box, enter your password.

ComfortVIEW displays your password as asterisks.

   Logging In

Comfort WORKS
Login
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5. Click on Login.

Note: If you enter an invalid username or password,
ComfortVIEW displays an access denied message.
Click on the OK button to close the message, then
repeat Steps 3 and 4.

If you are successful in logging in, the message Logging in.
Retrieving operator profile. displays in the dialog box.

6. When you have successfully logged in, the ComfortVIEW
Login dialog box closes and the ComfortVIEW Logout
application displays in the Windows taskbar, which is typi-
cally located at the bottom of the screen. If you have selected
an application to automatically start up on login,
ComfortVIEW opens this application. Refer to the Setting Up
Operator Profiles Section of the Setup chapter of this manual
for instructions on configuring the Start-up applications.

Click on To

Login name text box enter your username. This name was
set by your ComfortVIEW system
administrator during ComfortVIEW
software installation or when you
were added as an authorized
ComfortVIEW operator. The
username box displays the name of the
last ComfortVIEW operator who
logged in.

Password text box enter your password. To protect your
password, only asterisks are displayed
when you type. You must enter your
password using the correct case.
ComfortVIEW distinguishes between
upper and lower case letters.

Login log in using the username and pass-
word entered.

Help display help information.

Cancel exit the dialog box without logging in.

Table 1-2
ComfortVIEW Login
Dialog Box
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Figure 1-2
ComfortVIEW Login
Dialog Box

Logging out enables you to end your session with ComfortVIEW.
After you log out, ComfortVIEW continues to run and all network
functions carry on. Alarms continue to be received, all network
functions continue, and report data retrieval continues.

1. Click on the Logout button, which is displayed in the Win-
dows taskbar.

2. If there are any active remote CCN connections, the Active
Remote CCN Connections dialog box will be displayed and
all remotely-connected CCNs will be selected. Click on
Disconnect to disconnect from the selected CCNs or on Close
to close the dialog box without disconnecting. Refer to Figure
and Table 1-3a for further instructions on using this dialog
box.

3. If there are any active ComfortVIEW applications (Alarm
Manager, Carrier Network Manager, etc.) you will be
prompted to confirm logout with an indication that unsaved
data will be lost. Clicking on Yes closes all open
ComfortVIEW applications, proceeds with the logout, and
replaces the dialog box with the ComfortVIEW Login dialog
box. Clicking on No cancels the logout.

If there are no active ComfortVIEW applications or remote
CCN connections, ComfortVIEW displays the Logout dialog
box (shown and described in Figure and Table 1-3).

Logging
Out
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4. Click on Logout to log out of ComfortVIEW.

ComfortVIEW displays a confirmation dialog box asking if you
really wish to log out.

5. Click on Yes to log out or click on No to prevent the log out.

The message Logging out displays in the confirmation dialog box.
When log out is complete, this dialog box closes and is replaced with
the ComfortVIEW Login dialog box. If there is an active RAS connec-
tion, the Remote Site Manager dialog box will be displayed as a
reminder that this session is active and may need to be terminated.

Figure 1-3
ComfortVIEW Logout
Dialog Box

Click on To

Logout log off.

Help display help information.

Cancel exit the dialog box without logging
off.

Table 1-3
ComfortVIEW Logout
Dialog Box
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Figure 1-3a
Active Remote CCN
Connections Dialog Box

Click on To

a CCN in the CCN
Connections: list select the CCN(s) from which you

wish to disconnect. On initial display,
all CCNs will be selected.

Disconnect disconnect from the selected remote
CCN(s).

Note:  Remote CCNs that are cur-
rently in use by operators at other
ComfortVIEW workstations will not
be disconnected.

Close exit the dialog box without discon-
necting.

Help display help information.

Table 1-3a
Active Remote CCN
Connections Dialog Box
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You can operate ComfortVIEW using your keyboard or your mouse.

The mouse is a pointing device that enables you to move around the
ComfortVIEW window faster and easier than using the keyboard.
Hold your mouse with the cable facing away from you (as shown in
Figure 1-4). The mouse cursor takes on an arrow shape to indicate
where you are pointing on the window. Table 1-4 explains the basic
mouse techniques and terminology used throughout this manual.

Term Meaning

Double click Position the mouse cursor on the
designated item and then quickly
press and release the left mouse
button twice.

Click on Position the mouse cursor on the
designated item and then quickly
press and release the left mouse
button once.

Drag or Drag and drop Position the mouse cursor on the
designated item. Press and hold down
the left mouse button as you move the
mouse and the item to the desired
position. Then release the button.

Point Position the mouse cursor on the
designated item.

Using the Mouse

Using
ComfortVIEW:  An
Overview

Figure 1-4
Mouse

Table 1-4
Basic Mouse Terminology
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Figure 1-5 and Table 1-5 provide an overview of the keys that you
will typically use when operating ComfortVIEW. For information on
using the keyboard to select menu items and commands, refer to the
To Select a Command Using Your Keyboard section of this chapter.
You should also refer to your Windows documentation.

Using the Keyboard

Figure 1-5
Typical Keyboard
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Key Function

Alt Use Alt, and the underlined menu bar
letter, to select a menu item and
display the menu item’s command list.

Use Alt in dialog boxes to clear
selected options. Use Alt in dialog
boxes, in conjunction with an under-
lined letter, to select options.

Use Alt, in conjunction with the Tab
key, to jump to another active
ComfortVIEW function. (For ex-
ample, hold this key down and press
Tab key to jump from Carrier Net-
work Manager to Alarms.)

Ctrl When a command list is not displayed,
use Ctrl, in conjunction with the
specified command list letter, as a
short cut to select a specified com-
mand. The Ctrl key combinations are
displayed after each command on the
command list.

       (continued)

Table 1-5
ComfortVIEW Keys



16

Key Function

Tab Use Tab in dialog boxes to move to
the next text box, button, or  option.

Use Tab, in conjunction with Alt key,
to jump to another active
ComfortVIEW function. (For ex-
ample, hold down the Alt key and
press Tab to jump from Carrier Net-
work Manager to WorkSPACE Man-
ager.)

Shift Use Shift in dialog boxes in conjunc-
tion with Tab key to move to the
previous text box, button, or option.

When a command list is displayed, use
Shift, in conjunction with an under-
lined command letter, to select a
command.

Esc Use Esc to close a command list,
menu, or dialog box without making a
selection or saving changes.

Up, Down arrows Use up and down arrows to move up
and down in lists.

Left, Right arrows Use left and right arrows to move
through menu items and lists.

F3 Use F3 in the Carrier Network Man-
ager application to display help infor-
mation on a selected configuration
decision. ComfortVIEW displays a
dialog box that describes the decision
along with allowable entries. Press any
key to close the dialog box.

Table 1-5
ComfortVIEW Keys
(continued)
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Key Function

F1 Use F1 to display help information
about ComfortVIEW operation.

Table 1-5
ComfortVIEW Keys
(continued)
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ComfortVIEW windows use a standard Windows format. Figure 1-6
shows an example of a typical window. Table 1-6 describes the
labelled parts.

Figure 1-6
ComfortVIEW Window

Interpreting
ComfortVIEW
Windows

T i tle Bar Minimize
Button Maximize

Button

Menu
Bar

Scroll
Bar

Window
Corner
(Drag

to
resize)

Toolbar

Administration
Carrier Network Manager - [United Mutual Farmington Office...39N...BASE UNIT: Sta

File Edit Configure Options HelpWindow

Description Value Units Status Force Name Notes

Space Temperature 74.0 degF SPT

Air Supply Temperature 57.3 degF SAT

Return Air Temperature 74.1 RAT

Outside Air Temperature 71.3 OAT

Static Pressure 1.3 SP

Relative Humidity 36.1 RH

Outside Air Rel Humidity 43.5 OARH

Freeze Status Normal FRZ

Filter Status Clean Alarm FLTS

Enthalpy Switch Low ENT

Supply Fan Status On SFS

Supply Fan Relay On SF

Heat Interlock Relay Off HIR

Inlet Guide Vanes 36.0 IGV

Mixed Air Damper 25.2 Alarm MIXD

Heating Coil Valve 100.0 HCV

Cooling Coil Valve 100.0 CCV

70.0

Control Menu
Box

degF

degF

%
%

%
%
%
%

"H2O

Located in Room A101

0=closed, 100=open

0=closed, 100=open

0=closed, 100=open

0=closed, 100=open

Close
Button
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Table 1-6
ComfortVIEW Window
Elements

Element Function

Title Bar Displays the name of the
ComfortVIEW function you haveselected.

Control Menu Box Displays a menu with commands for
sizing and moving the ComfortVIEW
window, switching to another
ComfortVIEW application or to an
other PC application, and closing this
ComfortVIEW application.

Maximize Button Clicking on this button enlarges the
ComfortVIEW window so that it fills
the entire window. Clicking on this button
performs the same result as the Maximize
command under the Control Menu. When
the window is maximized, this button
is replaced with a Restore button.

Minimize Button Shrinks this ComfortVIEW application
to a task on the taskbar. Clicking on this
button per forms the same result as the
Minimize command under the Control
Menu.

Close Button Closes this ComfortVIEW application.

Menu Bar Lists the available menus. Each menu
contains a list of commands that you can
perform with this ComfortVIEW
function.

Restore Button Returns the window to its previous size.
This button is displayed when you click
on the Maximize button.

(continued)
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Table 1-6
ComfortVIEW Window
Elements
(continued)

Element Function

Scroll Bars Clicking on the vertical or horizontal
scroll bar or dragging the box in the scroll
bar with the mouse allows you to move
parts of the window into view when the
entire contents of the window do not fit in
the window. You can use the scroll bars
to view unseen portions of lists and other
information that cannot fit in the allotted
space.

Tool Bar Gives you instant access to the most
frequently used commands.

Window Corner Allows you to change the window size.
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ComfortVIEW is mainly controlled by menus. The menus are listed
on the menu bar at the top of the ComfortVIEW window. To operate
ComfortVIEW, you select a menu item from those displayed.

Each menu contains commands in a command list that allow you to
perform ComfortVIEW functions. Commands that perform similar
actions are grouped on a menu. For example, in the Alarm Manager
application, the Functions menu contains commands you use to
acknowledge, refresh, or select all alarms. Refer to Figure 1-7
below.

ComfortVIEW
Menus and
Command Lists

Figure 1-7
Viewing Alarm Manager
Menu and Commands

Alarms in System: 1413 Alarms in viewing buffer:

United Mutual Insurance  - Physical Plant AH10,10 Alert - 4 at 8:44 23 Sept 1994: Input/Output Channel 54 Alarm

United Mutual repairs - Point 54 change number is 54C.

Alarm Manager

Sorted by: Default

United Mutual Insurance  - Physical Plant AH10,10 Alert - 4 at 8:44 23 Sept 1994: Input/Output Channel 54 Alarm

United Mutual Insurance  - Physical Plant AH10,10 Alert - 4 at 8:44 23 Sept 1994: Input/Output Channel 54 Alarm

File Edit Configure Options Help

United Mutual repairs - Point 54 change number is 54C.

United Mutual repairs - Point 54 change number is 54C.

Acknowledges selected alarms

Functions
Acknowledge
Refresh

Ctrl+K

Select all
Attach WorkSPACE...
View suppressed
Note...

Ctrl+R
Ctrl+L

Ctrl+S

✓
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You can choose menu items and commands using your mouse or the
keyboard. For instructions, refer to To Select a Command Using
Your Mouse and To Select a Command Using Your Keyboard.
ComfortVIEW uses the following Windows command menu con-
ventions:

If the Command Meaning

is dimmed (or not visible) You cannot use this command
at the current time. You may
need to select another item
before using this command.

is followed by an ellipsis (...) A dialog box will appear when
you choose the command. The
dialog box contains options
you need to select before
ComfortVIEW can perform
the command.

is followed by a check mark (✓ ) The command is in effect.
When you remove the check
mark (by reselecting the
command), the command will
no longer be in effect.

is followed by a key combination The key combination is a
shortcut for this command.
You can use this key combina-
tion as an alternative to click-
ing on this command.

is followed by a  triangle When you select this com-
mand, a cascading menu
appears, listing additional
commands.

Table 1-7
Command Menu
Conventions

Command Menu
Conventions

(   )
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1. Point to the menu item and click the left mouse button.

ComfortVIEW displays the list of commands for this menu
item.

Note: If you wish to close the menu without performing
any command, click anywhere outside the menu.

2. Point to a command name and click the left mouse button.

ComfortVIEW carries out some commands right away. If an
ellipsis follows the command, however, more information is
needed to complete the command and a dialog box displays.
You must then select options in the dialog box to control how
ComfortVIEW performs the command.

1. Press the Alt key and then release.  Then, type the underlined
letter in the menu item name.

ComfortVIEW displays the list of commands for this menu
item.

Note: If you wish to close the menu without performing
any command, press Esc.

2. Type the underlined letter in the command name.

ComfortVIEW carries out some commands right away. If an
ellipsis follows the command, however, more information is
needed to complete the command and a dialog box displays.
You select options in the dialog box to control how
ComfortVIEW performs the command.

A dialog box is a special window containing options that you select
to tell ComfortVIEW how to carry out a command. The dialog
boxes displayed in Figures 1-8, 1-9, and 1-10 illustrate some fea-
tures common to all ComfortVIEW dialog boxes.

To Select a Command
Using Your Mouse

To Select a Command
Using Your Keyboard

Dialog Boxes
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Figure 1-8
Colors  Dialog Box

Figure 1-9
Operator Profile Dialog
Box

Figure 1-10
Page Setup
Dialog Box

Acknowledgements

Custom alarm messages

Return to normal messages

Alarm messages

Alert messages

Alarm Colors

Select text...

Selects color for display of selected text

OK Cancel Help...Defaults

Color...

Move the dialog box by
dragging the title bar.

Double click on the
control menu box to

close the dialog box.

Click on a radio
button to select
a single option.

Click on a command
button to carry out

an action.

Click on a command
button with an ellipsis

to display another dialog
box.

Login name:

Operator Profile

OK Cancel Help...

Start-up application:

<none>

Alarm indication...

Password:

Operator name:

Name

Drop-down lists work
like menus.  Click on

the arrow to see
options you can

select.

Type information in
text boxes.

Press Alt and the
underlined letter to
move to and select

an option.

Click on a check box
to select an option.

Click it again to
clear the option.

Printer setup...

Page Setup

Select items to print...

OK Cancel Help...

Selects printers and additional options

Alarm message

X

Custom message

X

Acknowledgement

X

Operator note
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Help information is available throughout ComfortVIEW. Here are
the ways you can access help:

• Context-sensitive one-line help information based on your
current window position automatically displays along the bot-
tom of most ComfortVIEW windows. See Figure 1-11.

• Pressing the F1 key displays help information about
ComfortVIEW operation.

• Pressing the F3 key while the cursor is positioned on a Carrier
Network Manager configuration decision displays a dialog box
that describes the decision and displays allowable entries.
Pressing any key closes the dialog box.

• Operational help is also available on all ComfortVIEW func-
tions by pointing to the Help menu item and clicking the left
mouse button.

• Help can also be accessed while displaying a dialog box by
clicking on the Help button.

ComfortVIEW includes help wizards that assist you in performing
the following functions:

• Creating consumable, runtime, and history report definitions

• Configuring alarms, including custom messages and
Autodial Gateway capability

• Adding new ComfortVIEW operators

• Adding new trends

• Adding new ViewSPACE databoxes.

Using
ComfortVIEW
Help

Help Wizards

Figure 1-11
Context Sensitive 1-line
Help
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Carrier Network
Manager



Alarm Manager
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Carrier
Network
Manager

This chapter provides instructions on ComfortVIEW Carrier Net-
work Manager application.

For instructions on... Turn to page

launching the Carrier Network Manager
application and displaying the System
Overview and Controller List windows 32

changing the font and point size of Carrier
Network Manager text 38

adding and configuring CCNs and areas:
• adding a new or modifying an existing CCN 39
• adding a new or modifying an existing area 54
• deleting CCNs and areas 56

adding controllers:
• displaying the controller list 58
• sorting the controller list 59
• adding/modifying controllers 60

deleting controllers 69

viewing controller data:
• viewing status display and maintenance tables 70
• viewing configuration tables 78
• viewing alarm history tables 81

performing Bus Services functions:
• polling the CCN Bus and updating the

NDS Module (Update Poll)          82, 184
• obtaining a list of system elements on a

CCN (Cold Call)                                                            82
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For instructions on... Turn to page

modifying controller data:
• forcing/autoing status display and maintenance

tables 92
• modifying configuration table values and using drag

and drop 97
• modifying controller table names and descriptions 104
• copying and moving controller configuration data    107
• verifying controller configuration against your

database 114
• downloading ComfortVIEW data to controllers 115
• uploading controller data to ComfortVIEW 116
• modifying and sending time and date 118
• displaying and configuring CCN Options 120
• configuring UT203 FIDs 128
• configuring Comfort Controllers 132

exporting controller databases 163
importing controller databases 179

connecting to remote CCNs:
• reserving Autodial Gateways for specific

operations 166
• using an Autodial Gateway 169
• disconnecting from remote CCNs 170

printing Carrier Network Manager data 171

using ComfortVIEW data in other PC applications 175

a summary of all Carrier Network Manager commands 179
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The following terms are used throughout this Carrier Network
Manager chapter.

Access Level — An operator privilege level. ComfortVIEW gives
you the capability to create access levels and specify specific
ComfortVIEW operations allowed for each level. You then assign
access levels to ComfortVIEW operators on an area by area basis.

Access Parameters — How the new CCN will be accessed (physi-
cally wired to ComfortVIEW workstation or via an Autodial Gate-
way).

Active — Currently displayed on-screen or reduced to an icon.

Address — A unique two-part identification number for each
system element on the CCN. Address consists of the communication
bus number followed by the system element number.

Alarm Filters — ComfortVIEW gives you the capability to route
alarms to  specific ComfortVIEW operators. You set up alarm filters
that specify families (area, element, and level) of alarms to be
presented to each ComfortVIEW operator. You then assign alarm
filters to ComfortVIEW operators. You can assign alarm filters to
ComfortVIEW operators on an area by area basis. You can also use
alarm filters to route ComfortVIEW alarms to specific printers.

Alarm Table — Any of the Comfort Controller's standard alarming
routines. Current Comfort Controller alarm tables include the Limit,
Setpoint, Limit, Discrete State, First Out, Runtime, and Number of
Starts.

Algorithm — Any of the Comfort Controller's standard HVAC
control routines.

Area — A logical grouping of system elements within a CCN. For
example, an area could be a building, a floor, a wing, or a chiller
plant.

Autoing a point —  To remove a force and return a point to the
controller’s automatic control.

CCN — Carrier Comfort Network. A system of communicating,
microprocessor-based controls for heating, ventilating and cooling
(HVAC) equipment.

Terminology
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Client —  A computer on a local area network running
ComfortVIEW communication and user interface software, or
ComfortVIEW user interface software only.

Configure — To specify to a controller the data that it needs to
control and monitor HVAC devices in the desired manner.

Controllers — CCN system elements with addresses, status dis-
play, and configuration tables. Controllers perform the actual
HVAC monitoring and control operations. The Carrier Comfort
Network supports several types of controllers. These include PICs,
FIDs, and Comfort Controllers, System Managers, and CCN Op-
tions.

Controller — A CCN system element with an address, status
display, and configuration tables. A controller performs the actual
HVAC monitoring and control operations. The Carrier Comfort
Network supports several types of controllers. These include PICs,
FIDs, and Comfort Controllers, System Managers (examples:  TSM,
FSM, CSM), and CCN Options.

Destination — The configuration table you are copying to when
copying and moving controller configuration data.

Download — To copy configuration table data from the
ComfortVIEW database to a controller. Performing a download
overwrites the configuration at the controller.

Export — To back up an entire controller's database to a  specified
drive. The drive can be the ComfortVIEW floppy diskette drive,
another ComfortVIEW hard drive partition, or another computer on
the LAN. The information that will be copied includes the controller
name, description, address, and all configuration data.

Force — To override a controller’s automatic control and modify a
point’s value.

Function — Any of the Comfort Controller's supporting control
routines for points and algorithms. Current Comfort Controller
function tables include Analog Trace Point, Discrete Trace Point,
Internal Consumable, Adaptive Optimal Start/Stop, Network Broad-
cast, Linkage/AOSS Schedule, Night Time Free Cooling, and
Occupancy.
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Gateway  — Refers to either a CCN Autodial Gateway or  TeLINK
module. Both these modules enable the CCN to communicate over
telephone lines with other similarly equipped CCNs enabling system
elements in two networks to communicate as though they were
connected directly.

Import — To copy configuration tables to a controller in the
ComfortVIEW database from a .CWX file that was created using
ComfortVIEW Export function.

Operators — ComfortVIEW users.

Object — A Comfort Controller hardware or software point, system
table, algorithm, setpoint, alarm, or function.

Point — An input or output (hardware) channel on the controller or
an internal (software) channel.

Server — A computer running ComfortVIEW communication, user
interface, service, and database software.

Sort key — Numbers, assigned when adding controllers to the
database, that give you the capability to customize the presentation
of your controller list. In a controller list that is sorted by sort key, a
controller assigned a sort key of 1 appears before a controller as-
signed a sort key of 2, and so on. Assigning a controller a sort key
of 255 causes it to appear at the end of the controller list. The
default sort key number is 1.

Source — The point status, maintenance, or time schedule table you
are copying from when copying and moving controller configura-
tion data.

System Element — A CCN controller with an address and configu-
ration tables. A controller performs the actual HVAC monitoring
and control operations. The Carrier Comfort Network supports
several types of system elements. These include PICs, FIDs, and
Comfort Controllers, System Managers (examples:  TSM, FSM,
CSM), and CCN Options.

System Table — A Comfort Controller Consumable, Runtime,
Holiday, Network Time Schedule, Loadshed, or Language Conver-
sion table.
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Table — A logical grouping of data that a controller uses to display
and specify information used to control and monitor HVAC devices
in the desired manner. Examples of tables are status display tables,
alarm history, configuration tables, and maintenance tables.

Upload — To copy all configuration table data from a controller to
the ComfortVIEW database.

The Carrier Network Manager graphically displays, through the use
of a directory tree with a branching structure similar to the Windows
File Manager, the CCNs, areas, controllers (system elements), and
tables that make up your ComfortVIEW database.

You can use the Carrier Network Manager to add and configure
CCNs and areas, which are logical groupings of system elements
within a CCN (for example, buildings, floors, wings, chiller plants).

You can also perform other operations such as:

• adding controllers to and deleting controllers from your
ComfortVIEW database.

• viewing and modifying controller configuration,
maintenance, and status display data.

• exporting controller databases to diskette.

• connecting to remote CCNs and remote ComfortVIEW
workstations.

Follow the steps below to launch the Carrier Network Manager
application, open the System Overview window, and display a list
of the database’s CCNs and areas.

1. Double click on the Carrier Network Manager icon.

ComfortVIEW opens the Carrier Network Manager and
displays a System Overview window (similar to the one
shown in Figure 2-1) This window displays, in a directory
tree fashion, the CCNs that make up your ComfortVIEW
database.

Accessing
the Carrier

Network Manager
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The top line of the window contains the menu bar. Refer to
the Carrier Network Manager Command Summary section of
this chapter for a description of each  menu bar command.
The second line of the window contains the toolbar. Refer to
Carrier Network Manager Toolbar, which appears later in this
section, for information on using each toolbar button.

The third line of the window contains the status bar. This line
displays in all Carrier Network Manager windows and sup-
plies information on the path you have taken to arrive at the
current window. (For example, it displays the CCN, area, and
controller name that you have selected.)

Note: If desired, you can remove the status bar from the
System Overview window by clicking on the Op-
tions menu item followed by clicking on Status bar.
To return the status bar to the window, perform
these two commands again.

You may also change the window’s font and point
size. Refer to the Changing the Font section of this
chapter for instructions.

2. Double click on the System Overview icon to expand the
directory tree and display the CCNs in your database.

Note: Double clicking on an expanded System Overview
icon collapses the tree.

3. Double click on a CCN to expand the directory tree and
display the areas in that CCN.

Note: If this is the first time you are accessing the Carrier
Network Manager since installing ComfortVIEW,
there will be no CCNs. Refer to Adding/Modifying
CCNs. Double clicking on an expanded CCN
collapses the tree.

Figure 2-1 shows an expanded System Overview window.
Refer to Table 2-1 for an explanation of the System Overview
tree icons.
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Double-clicking on an area displays the list of controllers in that
area. A controller is a CCN system element with an address, and
status display and configuration tables. A controller performs the
actual HVAC monitoring and control operations. The Carrier Com-
fort Network supports several types of controllers. These include
PICs, FIDs, Autodial Gateways, Comfort Controllers, System
Managers (examples:  TSM, FSM, CSM), and CCN Options.

Step by step instructions for displaying the controller list and a
description of the Controller List window can be found further on in
the Displaying the Controller List section of this manual.

You may also launch the Carrier Network Manager and display a
list of all areas in your ComfortVIEW database by double-clicking
on the Carrier Network Manager icon, clicking on the Access menu
item, and then clicking on Open. ComfortVIEW displays a list of all
areas in the database. You can then double click on an area and
display the area’s controllers.

The Controller List

Short Cut

Figure 2-1
System Overview Window

Tool Bar

Double click on a
CCN to display its areas.

Double click again to
hide the areas.

System Overview

United Mutual Insurance CCN1

System Overview

System Overview::United Mutual Insurance CCN1Status Bar

Double click on an area
to display its controllers. 

Double click again to 
hide the controllers.

Backup Configurations

United Mutual Insurance - Annex

United Mutual Insurance - Engineering Office

United Mutual Insurance - Physical Plant

United Mutual Insurance CCN2

United Mutual, Farmington Office

United Mutual, Syracuse Office

World Headquarters
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Table 2-1
System Overview Tree
Icons

The Icon Represents

A CCN that exists only in your computer’s
database. You cannot communicate with this
CCN. This type of CCN would typically be
used for off-line database configuration to
hold your library of controller off-line con
figurations. Double click on a CCN to dis
play its areas.

A CCN that is physically wired to your PC.
Double click on a CCN to display its areas.

A CCN that you can communicate with using
a CCN Autodial Gateway. Double click on a
CCN to display the areas in this CCN.

A CCN that you can communicate with using
a CCN to Ethernet Converter. Double click
on a CCN to display its areas.

An area of a CCN. Double click on an area to
display the controllers in this area.

A controller within an area. Double click on a
controller to display its tables.

A Comfort Controller within an area. Double
click on a Comfort Controller to display its
tables.

A Comfort ID controller within an area.

A 33CS controller within an area.

A status display, maintenance, configuration,
or alarm history table category. Double click
on a category to display the tables in that
category.

A status display, maintenance, alarm history,
configuration table. Tables that are dynami-
cally updating (status display or mainte-
nance) have red icons. Tables that are not
updating (configuration tables) have black
and white icons.
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The second line of the System Overview window contains the
toolbar. If you use a mouse, the toolbar gives you instant access to
the most frequently used Carrier Network Manager commands. By
simply clicking the mouse button, you can perform operations such
as adding, modifying, or deleting controllers, connecting and dis-
connecting from remote CCNs, and uploading and downloading
controller configuration data.

Note: If desired, you can remove the toolbar from the System
Overview window by clicking on the Options menu item
and then by clicking on Toolbar. To return the toolbar the
window, perform these two commands again.

Table 2-2 describes the buttons that appear on the Carrier Network
Manager toolbars. Note that the toolbar changes depending on the
Carrier Network Manager window that is currently displayed. The
System Overview and Controller List window toolbars contains all
of the buttons in the table. The Configuration Table window toolbar
contains a subset of these buttons.

Click on To

export the selected controller to a file.

print the active window or a database
report of the selected controller or
area.

copy the selected cell's data to the
Windows clipboard.

paste data from the Windows clip
board to the selected cell.

open a window displaying the names
of all areas in the database.

connect  to a remote CCN.

add a new CCN, area, or controller.

force the selected point.

(continued)

Carrier Network
Manager Toolbar

Table 2-2
Carrier Network
Manager Toolbar Icons
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Click on To

auto the selected point.

save the configuration to the database.

hide selected columns and rows.

show hidden columns and rows.

launch the report wizard and quickly and
easily add a new consumable, history, or
runtime report definition.

launch the alarm wizard and quickly and
easily configure an alarm for the selected
point.

launch the trend wizard and quickly and
easily add a new trend.

modify the selected CCN, area,
controller, or table name.

delete the selected CCN, area, or control-
ler.

upload the selected controller or configura-
tion table display.

download the selected controller or con-
figuration table display.

transmit time, date, and holiday informa-
tion to the selected CCN.

Table 2-2
Carrier Network
Manager Toolbar Icons
(continued)
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Click on To

examine a specified CCN bus and obtain
a list of all system elements.

sort the presentation of the controller list
alphabetically by name.

sort the presentation of the controller list
by address.

sort the presentation of the controllerlist
by sort key.

update the currently selected window
with the most recent data that was
written to the database.

display help information.

You can change the font that the Carrier Network Manager uses to
display text. When you change the font, all Carrier Network Manager
text is affected.

To change the font:

1. Click on the Options menu item followed by clicking on Font.

ComfortVIEW displays the Font dialog box. Refer to Figure 2-
3.

2. In the Font box, select the font you want to use.

The text in the Sample box changes to reflect the font you
select.

3. In the Font Style box, select any style options you want to use
(for example, bold or italic).

4. In the Size box, select the point size you want to use:  the larger
the point size, the larger the characters appear on your screen.

5. Click on OK.

Table 2-2
Carrier Network
Manager Toolbar Icons
(continued)

Changing the
Font
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Note: To make the font change permanent, click on the Options
menu item and then click on Save settings on exit. A
checkmark (3) appears before the command to indicate
that it is enabled. The text will appear in this new font and
point size the next time you start the Carrier Network
Manager. This command also saves the size and position
of all Carrier Network Manager windows. Follow the
steps below to add a new CCN into the ComfortVIEW
database.

Figure 2-3
Font Dialog Box

8

8

Font:

Font

Sample

Font Style: Size:

Geneva
MS Sans Serif
MS Sans Serif
MS Sans Serif
MS Sans Serif

Regular

Regular
10
12
14
18

AaBbYyZz

Geneva
OK

Cancel

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

Note: If you are creating a new database, there are no
CCNs or areas in the database. The only visible icon
is the System Overview icon.

2. Click on System Overview.

3. Click on Configure and then click on New.

Note: You may also perform this command by clicking on
the Add New icon in the toolbar.

Adding/
Modifying CCNs

To Add a
New CCN
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ComfortVIEW displays the Add New dialog box (shown in
Figure 2-4 following these instructions). The Carrier Comfort
Network (CCN) button will be selected.

4. Click on OK.

ComfortVIEW displays the New CCN Definition dialog box.

5. Enter the name of the new CCN in the CCN name edit box. Up
to 48 characters are allowed.

6. You can modify the CCN Number if desired, or leave it set at
the displayed default value, which is the lowest available CCN
number. This number is used internally by ComfortVIEW
Report Panel and Alarm Manager applications to identify
CCNs. You must assign each CCN a unique number. Used
CCN numbers can be viewed by clicking on the down arrow in
the Used CCN number drop down list.

Note: If you are adding a remote CCN that will be accessed
by Autodial Gateway, this number must match the
Customer Number configured at the remote Autodial
Gateway.

Refer to Figure 2-5 and Table 2-5 for instructions on using the
New CCN Definition dialog box.

7. Click on Access to display the CCN Access Definition dialog
box. This dialog box gives you the capability to specify access
parameters for the new CCN.

8. Click on the Method drop down list and select the way this
CCN will be accessed. Refer to Table 2-6 following these
instructions for a definition of each CCN access method.

9. If you are adding a Local - Direct Connection CCN:

RS232/485:  Click on the Port drop down list and select the
computer serial port to which the CCN is attached.

CCN/Ethernet Gateway:  Specify the IP address of this CCN's
CCN-to-Ethernet converter.

Then click on the Extended button to display the Standard CCN
Settings dialog box and select additional CCN parameters such
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as address and baud rate. Refer to Table 2-7 following these
instructions for an explanation of the fields in this dialog box.

If you are adding a Remote - Gateway or Modem Connection
CCN:

Under Phone number select one of the following actions:

• Click on Add to add a new remote Gateway phone num-
ber and password to the phone number list, or

• Select a phone number and then click on Modify to
change the number, or

• Select a phone number and then click on Delete to delete
it.

10. Refer to Figure 2-6 and Table 2-6 for further instructions on
using the CCN Access Definition dialog box.

11. Once you have entered all CCN access parameters, click on
OK. This permanently saves the changes and closes the CCN
Access Definition dialog box.

12. Click on OK to close the New CCN Definition dialog box.

ComfortVIEW re-displays the System Overview window. The new
CCN appears in the window in alphabetical order.

Figure 2-4
Add New Dialog Box

Add New ...

Add new ...

Carrier Comfort Network [CCN]

Area [Building, Floor, Zone, etc.]

OK Cancel Help...
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Click on To

Carrier Comfort Network add a new CCN to the ComfortVIEW
database.

Area add a new area to the ComfortVIEW
database.

OK close the dialog box and save the changes
made. Either the New Area Definition or
the New CCN Definition dialog box
displays, depending on whether you are
adding a new Carrier Comfort Network or
area. Instructions for using the New Area
Definition dialog box can be found in the
Adding/Modifying Areas section of this
chapter. Refer to Figure 2-5 and
Table 2-5 below for instructions for using
the New CCN Definition dialog box.

Cancel exit the dialog box and restore the previous
settings. Any changes made are not saved.

Help display help information.

Table 2-4
Add New Dialog Box

Used CCN numbers:

New CCN Definition

CCN name:

OK Cancel Help...

100

Sets CCN access parameters

CCN number:

1

Access ...

Figure 2-5
New CCN Definition
Dialog Box
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Click on To

CCN name edit box enter the new CCN name. Up to 48
characters are allowed.

CCN number edit box modify the displayed CCN number. You
can modify the CCN Number if desired,
or leave it set at the displayed default
value, which is the lowest available CCN
number. This number is used internally
by ComfortVIEW Reports and Alarms
functions to identify CCNs. You must
assign each CCN a unique number. Used
CCN numbers can be viewed by clicking
on the down arrow in the Used CCN
numbers drop down list.

Note: If you are adding a remote CCN
that will be accessed by Autodial Gate-
way, this number must match the Cus-
tomer Number configured in the remote
Gateway.

Used CCN numbers view the highest number already in use.
Click on the down arrow to view a
complete list of all used CCN numbers.

Access set the CCN access parameters. The CCN
Access Definition Dialog Box displays.
Refer to Figure 2-6 and Table 2-6 for
instructions on using this dialog box.

OK close the dialog box and save the changes
made.

Cancel exit the dialog box and restore the previ-
ous settings. Any changes made are not
saved.

Help display help information.

Table 2-5
New CCN Definition
Dialog Box
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Click on To

Method specify how this CCN will be ac-
cessed. Clicking on the down arrow
gives you these choices:

None - Database Only. Select this
method if you are adding a CCN to
your workstation’s database only. You
cannot communicate with this CCN.
This method of CCN access would
typically be used for off-line database
configuration to hold your library of
controller off-line configurations.

                                                                                           (continued)

Figure 2-6
CCN Access Definition
Dialog Box

Table 2-6
CCN Access Definition
Dialog Box
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Table 2-6
CCN Access Definition
Dialog Box
(continued)

Click on To

Local - Direct Connection.
Select RS-485 if you are adding a
CCN that is physically wired to the
local workstation using an internal
RS-485 card or similar-type device.

Select RS-232 if the workstation's
serial port is connected to an external
RS-232/485 convertor (for example, a
CCN Repeater).

If you select either RS-485 or RS-232,
you must now click on Port to specify
the workstation name and associated
serial port.

Select CCN/Ethernet Gateway if the
workstation is connected to the CCN
over a building's Ethernet LAN using
the CCN-to-Ethernet converter. You
must now enter the IP address associ-
ated with the CCN-to-Ethernet con-
verter.
Notes:  The Ethernet to CCN connec-
tion can only be associated with the
ComfortVIEW server's network
connection. ComfortVIEW only
supports Ethernet connections through
one network card. If you have mul-
tiple CCN-to-Ethernet connections,
they all will be associated with the
same network card.

Remote - Gateway Connection. Select
this method if you are adding a CCN
that you will communicate with using
a Gateway. If you select this method,
you must click on Phone Number and
specify the Gateway/modem tele-
phone number of the remote CCN
modem. Optionally, you can also click
on Gateway to select a specific Gate-
way to use. If you do not select a
Gateway, ComfortVIEW will search
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Click on To

(continued)

for and use one that is available.

Port select the workstation and serial
communication port to which the
CCN Bus will be wired. The only time
you are required to make this selection
is if you selected Local - Direct
Connection (either RS-232 or 485)
from the Method list.

CCN/Ethernet Gateway
IP address enter the IP address of this CCN's

CCN-to-Ethernet converter. The value
that you enter into this field must
match the value that is in the
converter's Host IP Address decision.

Extended set additional CCN parameters such as
address and baud rate. The Standard
CCN Settings dialog box displays.
Refer to Figure 2-7 and Table 2-7 for
instructions on completing this dialog
box.

Phone Number display the list of remote CCN phone
numbers. Click on the down arrow.
Any existing phone numbers will be
displayed. You would typically only
enter more than one phone number in
this list if you have more than one
Autodial Gateway at the remote CCN.
To modify or delete an existing phone
number, select a phone number and
click on  Modify or Delete.

Note: If the phone number exceeds 15
characters, a TeLINK, rather than
Autodial Gateway, must be used to
make the connection.

Table 2-6
CCN Access Definition
Dialog Box
(continued)
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Table 2-6
CCN Access Definition
Dialog Box
(continued)

Click on To

Add add a new phone number to the phone
number list. The only time you are
required to specify a phone number is

       (continued)
if you selected Remote - Gateway
Connection from the Method list.
ComfortVIEW displays the Phone
Number Configuration dialog box.
Refer to Figure 2-8 and Table 2-8 for
instructions on using the Phone
Number Configuration dialog box.

Modify modify an existing phone number.
You must select the phone number
prior to clicking on Modify.
ComfortVIEW displays the Phone
Number Configuration dialog box.
Refer to Figure 2-8 and Table 2-8 for
instructions on using the Phone
Number Configuration dialog box.

Delete delete an existing phone number. You
must select the phone number prior to
clicking on Delete.

Gateway select a specific Autodial Gateway to
use when establishing a connection to
the remote CCN. ComfortVIEW
displays the Select Autodial Gateway
dialog box. Refer to Figure 2-6a and
Table 2-6a for instructions on using
the Select Autodial Gateway dialog
box.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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Click on To

the Select a CCN: drop down list select the CCN containing the
Autodial Gateway.

an Autodial Gateway in the Select
a gateway: list select the Autodial Gateway to

use to connect to the remote
CCN.

<any gateway> disable any previous Gateway
selection.

OK close the dialog box and save
the changes made.

Cancel exit the dialog box and restore
the previous settings. Any
changes made are not saved.

Help display help information.

Table 2-6a
Select Autodial Gateway
Dialog Box

Figure 2-6a
Select Autodial Gateway
Dialog Box

Select Autodial Gateway

OK Cancel Help...

Select a CCN:

Select a gateway:

United Mutual Insurance

AUTODIAL: Autodial Gateway - 0, 51
<any gateway>
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Modifying
CCNs

Follow the steps below to modify an existing CCN’s name, number,
or access parameters:

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

2. Click on the CCN you wish to change.

3. Click on Configure and then click on Modify.

Note: You may also perform this command by clicking on
the Modify icon in the toolbar.

ComfortVIEW displays the Modify CCN Definition dialog
box.

4. Modify the CCN name as desired. To modify the CCN’s
associated access parameters, click on Access. ComfortVIEW
displays the CCN Access Definition dialog box. Refer to
Figure 2-6 and Table 2-6 for further instructions on using this
dialog box.

To modify additional CCN parameters such as address and
baud rate, click on the Extended button. ComfortVIEW
displays the Standard CCN Settings dialog box. Refer to
Figure 2-7 and Table 2-7 for further instructions on using this
dialog box.

5. Once you have modified the CCN name or access parameters,
click on OK. This permanently saves the changes and closes
the CCN Access Definition dialog box.

6. Click on OK to close the CCN Access Definition dialog box.
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Figure 2-7
Standard CCN Settings
Dialog Box

Click on To

Bus specify the ComfortVIEW bus
number. You can enter a value or click
on the up or down  arrow to increment
or decrement the displayed number.

Note: If you set the Bus number to a
non-zero value, the Enable
alarm acknowledgement and
Enable NDS diagnostics
functions will not be sup-
ported.

Element specify the ComfortVIEW system
element number. You can enter a
value or click on the up or down arrow
to increment or decrement the dis-
played number.

Retries specify the number of times that
ComfortVIEW will attempt to
communicate with a system element if
it fails to respond.You can enter a
value or click on the up or down arrow
to increment or decrement the dis-
played number.

                                                                                           (continued)

Table 2-7
Standard CCN Settings
Dialog Box
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Table 2-7
Standard CCN Settings
Dialog Box
(continued)

Click on To

Enable alarm acknowledger assign ComfortVIEW to be the CCN
alarm acknowledger. You must
specify only one alarm acknowledger
on a CCN.

Enable NDS diagnostics enable NDS diagnostic routine polling
of all system elements in a local direct
connect CCN (RS-232, RS-485, or
Ethernet Gateway). The routine scans
the CCN bus and checks for commu-
nication and clock errors. The routine
generates alarms and alerts and corre-
sponding return-to-normal messages
that you can view using the Alarm
Manager application. Diagnostics are
performed on all controllers in the
CCN, including "shadow controllers",
which are those controllers for which
ComfortVIEW has no database infor-
mation.

Enable Time Broadcast specify this ComfortVIEW server to
act as time broadcaster to its locally-
connected CCN (a CCN connected to
the server or any of its clients).
ComfortVIEW will broadcast time,
date, day-of-week, and holiday indica-
tion (as indicated in the Global Func-
tion Manager's Holidays Table) at the
following times: twice daily — at 10
to 15 minutes past midnight and past
noon, within 1 minute of a change of
date or time (either automatically
initiated by daylight saving or manu-
ally), on ComfortVIEW server start-
up, or in response to broadcast re-
quests originating from a locally-
connected CCN (for which broadcast
is enabled).

       (continued)
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Click on To

the Baud rate
drop down list specify the baud rate of the

ComfortVIEW communication port.

Note : The most commonly used baud
rate is (9600). This field will not
display if the CCN Access Definition
dialog box's Method drop down list is
set to CCN/Ethernet Gateway.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-7
Standard CCN Settings
Dialog Box
(continued)

Phone Number Configuration

Phone number:

minutes

OK Cancel Help...

Password:

Quiet time:

Edits the CCN's phone number

60

Figure 2-8
Phone Number
Configuration Dialog Box
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OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-8
Phone Number
Configuration Dialog Box

Click on To

Phone Number enter the phone number of the remote
CCN’s Autodial Gateway. Up to 128
characters are allowed.

Password enter an up to 8-character password.
This password  must match the pass-
word that is configured in the remote
Autodial Gateway. Valid characters
are: upper case A-Z, 0-9, space,
hyphen (-), and comma (,).

Quiet time specify the number of minutes after
which, if no communication occurs,
the Autodial Gateway automatically
hangs up. You can enter a new value
or click on the up or down arrow to
increment or decrement the displayed
number. Allowable entries:  5-255
minutes. Default:  10 minutes.
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Follow the steps below to add a new area into the ComfortVIEW
database.

An area is a logical grouping of system elements within a CCN. For
example, an area could be a building, a floor, a wing, or a chiller
plant.

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

2. Click on the CCN in which the new area will appear.

3. Click on Configure and then click on New.

Note: You may also perform this command by clicking on
the Add New icon in the toolbar.

ComfortVIEW displays the Add New dialog box (shown in
Figure 2-4). The Area button will be selected.

4. Click on OK.

ComfortVIEW displays the New Area Definition dialog box
(shown in Figure 2-9). The CCN name will be displayed in
the Area name edit box.

Note: It is recommended that you  append the area name to
the CCN name. ComfortVIEW Alarm Manager and
Report Panel applications identify alarms and points
using the area name. Creating area names that
consist of both the CCN and area name will assist
you in identifying alarm and report points.

5. Click in the dialog box after the CCN name and enter the
name of the new area in the Area name edit box. Up to 48
characters are allowed.

6. Click on OK.

The new area name displays in alphabetical order in the
System Overview window under its associated CCN.

To Add a
New Area

Adding/
Modifying Areas
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Figure 2-9
New Area Definition
Dialog Box

United Mutual Insurance - 

New Area Definition

OK Cancel Help...

Area name:

Follow the steps below to modify an existing area name:

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

2. Click on the area whose name you wish to change.

3. Click on Configure and then click on Modify.

Note: You may also perform this command by clicking on
the Modify icon in the toolbar.

ComfortVIEW displays the Modify Area Definition dialog
box (shown in Figure 2-10).

4. Modify the Area name and click on OK to save your changes,
or,

click on Cancel to exit the dialog box without saving any
changes.

To Modify an
Existing Area
Name

United Mutual Insurance - Physical Plant

Modify Area Definition

OK Cancel Help...

Area name:

Edits the area name

Figure 2-10
Modify Area Definition
Dialog Box
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 Follow the steps below to delete a CCN or area from the
ComfortVIEW database:

Note: Deleting a CCN also deletes all areas and controllers
assigned to the CCN.

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

2. Click on the CCN to be deleted.

3. Click on the Configure menu item and then click on Delete.

Note: You may also perform this command by clicking on
the Delete icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before deleting the CCN.

4. Click on Yes to initiate the deletion or click on No to prevent
the deletion from taking place.

If you click on Yes, ComfortVIEW prompts you again before
deleting the CCN.

5. Click on Yes to complete the deletion or click on No to
prevent the deletion from taking place.

Note: If ComfortVIEW displays the message CCN Is In
Use, you have attempted to delete a CCN containing
a controller that is currently being accessed by you
or another ComfortVIEW operator. Attempt the
deletion again when the controller is available.

Deleting CCNs
and Areas

To Delete a CCN
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Follow the steps below to delete an area:

Note: Deleting an area also deletes all controllers assigned to the
area.

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

2. Click on the area to be deleted.

3. Click on the Configure menu item and then click on Delete.

Note: You may also perform this command by clicking on
the Delete icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before deleting the area.

4. Click on Yes to initiate the deletion or click on No to prevent
the deletion from taking place.

If you click on Yes, ComfortVIEW prompts you again before
deleting the area.

5. Click on Yes or No.

To Delete
an Area
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Controllers are CCN system elements with addresses, status display,
and configuration tables. Controllers perform the actual HVAC moni-
toring and control operations. The Carrier Comfort Network supports
several types of controllers. These include PICs, FIDs, and Comfort
Controllers, System Managers, and CCN Options.

Follow the steps below to display the list of controllers in a selected
area:

1. Display the System Overview window and expand it to display
the database’s CCNs and areas. If necessary, follow the instruc-
tions listed under Accessing the Carrier Network Manager.

2. Double click on an area to view the controllers in the area.

ComfortVIEW displays a split-screen Controller List window
similar to the one shown in Figure 2-11. The window has a bar
that splits it into two sections that each contain an identical list of
the controllers in this area. This split window will aid you in
getting to the controller information you want by way of a visual
stepping stone. Included for each controller is its eight character
name, 24 character description, and address.

Displaying the
Controller List

Figure 2-11
Controller List Window

Area

United Mutual Insurance CCN1::United Mutual Insurance - Physical Plant

19XL: Chiller #1 - 0, 128

United Mutual Insurance - Physical Plant

United Mutual Insurance - Physical Plant

United Mutual Insurance - Physical Plant

19XL: Chiller #2 - 0, 4

AHU: Air Handler Unit with DX - 0, 2
Controllers

Up to 8
Character
Controller
Name

Up to 24
Character
Description

Address

Direct connection

19XL: Chiller #1 - 0, 128

19XL: Chiller #2 - 0, 4

AHU: Air Handler Unit with DX - 0, 2
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While viewing the controller list you can use the Windows menu's
Jump to Table/WorkSPACE command to display a selected system
element's status display table or linked WorkSPACE. For more
information on this command, refer to the menu command summary
at the end of this Carrier Network Manager chapter.

You can sort the presentation of the controller list alphabetically by
controller name, numerically by ascending address, or by sort key
number. By default on launching the Carrier Network Manager
application, the controller list appears sorted by sort key.

1. Click on the Options menu item and then click on Sort.

Note: You may also sort the Controller List by clicking on
the Sort by Name, Sort by Address, or Sort by Sort
Key icons in the toolbar.

2. Perform one of the following actions:

• Click on Name to sort the list alphabetically by name.

• Click on Address to sort it in ascending numerical order by
address.

• Click on Sort to sort the list in ascending numerical order
by sort key.

Note: Sort keys are assigned when you add controllers to
the ComfortVIEW database. For further information
on sort keys, refer to the Adding/Modifying Con-
trollers section of this chapter.

The Controller List window re-displays sorted accordingly. When
sorted alphabetically, controller names beginning with numbers
appear at the beginning of the list.

You can move the window’s split bar so that you have more room to
display information in either section.

1. Position the mouse on the split bar.

The mouse pointer turns into a double bar with two arrows.

Displaying a
Controller's Status
Display Table or
WorkSPACE

Sorting the
Controller List

Moving the Split Bar
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2. Press and hold down the mouse button, and move the mouse left
or right to re-position the split bar.

3. Release the mouse button when the split bar is in the desired
location.

You can also resize and move the Controller List window. For more
information about ComfortVIEW windows, see Interpreting
ComfortVIEW Screens in the Introduction of this manual.

Follow the steps below to add a controller (CCN system element) to
the ComfortVIEW database.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on Configure and then click on New.

Note: You may also perform this command by clicking on
the Add New icon in the toolbar.

ComfortVIEW displays the CCN Element Definition dialog box
(shown in Figure 2-12).

3. Enter the Element name, description, address (bus and element
number), and sort key for the new controller. Specify whether
this controller should be assigned a high priority NDS diagnostic
scan rate.

Refer to Figure 2-12 and Table 2-12 for instructions on using
this dialog box.

4. Select the action that will add the controller’s configuration
tables by clicking on one of the following:

• Upload
• Copy from
• Import from

Refer to Table 2-12 for information on each of these functions.

To Add a New
Controller

Adding/
Modifying
Controllers
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5. After entering all information, click on OK.

The new controller can be accessed when the Ready for Use
message is displayed. Initially, the controller will appear
dimmed in the controller list.

6. Click on the Window menu item and then click on Refresh to
activate it.

Figure 2-12
CCN Element Definition
Dialog Box

Sort key:

Element description:

CCN Element Definition

Element name:

Bus: 0

1Element:

1

OK Cancel Help...

Copy from:

Upload

Import from:

High priority element for NDS diagnostics
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Table 2-12
CCN Element Definition
Dialog Box

Click on To

the Element name edit box enter the name of the new controller.
The name can consist of up to eight
characters.

the Element description
edit box enter the description for the controller.

The description can consist of up to
24 characters.

the Bus: edit box specify the controller’s bus number (0
to 239). You can also click on the up
or down arrow to increment or decre-
ment the displayed value.

the Element: edit box specify the element number (1 to
239). You can also click on the up or
down arrow to increment or decre-
ment the displayed value.

the Sort key: edit box specify a sort key number for this
controller (1 to 255). Sort keys give
you the capability to customize the
order of your controller list. A control-
ler with a sort key of 1 appears before a
controller with a sort key of 2, and so
on. Assigning a controller a sort key of
255 causes it to appear at the end of the
controller list. The default sort key
number is 1. For instructions on sorting
the presentation of the controller list,
refer to Sorting the Controller List,
which appears earlier in the Displaying
the Controller List section of this
chapter.

High priority element for
NDS diagnostics specify whether this element should

be assigned a high priority NDS
diagnostic routine scan rate (diagnos-
tic polling takes place every 60 mins
versus every 6 hours).

                                                                                          (continued)
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Click on To

Upload copy all configuration tables from the actual
CCN controller to the ComfortVIEW data-
base.

Copy from: duplicate the configuration tables from
another similar controller. Click on the
button to the right of the Copy from: edit
box. ComfortVIEW displays the Areas
dialog box.

Refer to Figure 2-13 and Table 2-13 for
instructions on using this dialog box. Click
on the area containing the controller whose
configuration you wish to copy and then
click on OK.

ComfortVIEW now displays the CCN
Elements dialog box (shown in Figure 2-14
and Table 2-14). Click on the controller
whose configuration tables you wish to copy
and then click on OK. ComfortVIEW copies
all configuration tables from the selected
controller to the controller you are adding.

Import from: copy the configuration tables to the
ComfortVIEW database from a .CWX file
that was created using the Export function.
This method would typically be used by a
Carrier representative during off-line prepa-
ration of a ComfortVIEW database. Either
enter the file name (with extension .CWX)

Table 2-12
CCN Element Definition
Dialog Box
(continued)
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Click on To

with the appropriate path or click on
the button to the right of the Import
from edit box and select the file from
the File Open dialog box.

the Select an area: list select the area containing the controller
whose tables you wish to copy.

OK close the dialog box and save the
changes made. ComfortVIEW displays
the CCN Elements Dialog Box. Refer
to Figure 2-14 and Table 2-14 for
instructions on using this dialog box.

        (continued)

Figure 2-13
Areas Dialog Box

Backup Configurations

Areas

OK Cancel Help...

Select an area:

United Mutual Farmington Office
United Mutual Insurance - Annex
United Mutual Insurance - Engineering Office
United Mutual Insurance - Executive Offices
United Mutual Insurance - Physical Plant
United Mutual Syracuse Office
World Headquarters

Selects an area

Table 2-13
Areas Dialog Box
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Click on To

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-13
Areas Dialog Box
(continued)

Figure 2-14
CCN Elements Dialog Box

19XL: Chiller #2 - 0, 4

CCN Elements

OK Cancel Help...

Select a CCN Element:

AHU: Air Handler Unit with DX - 0,2

19XL: Chiller #1 - 0, 128

Selects a CCN element

Click on To

the Select a
CCN Element: list select the element whose tables you

wish to copy.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-14
CCN Elements Dialog Box
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To Modify an
Existing
Controller's
Name or
Sort Key

Follow the steps below to modify an existing controller name,
description, or sort key:

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller whose name you wish to change.

3. Click on Configure and then click on Modify.

Note: You may also perform this command by clicking on
the Modify icon in the toolbar.

ComfortVIEW displays the CCN Element Definition dialog
box (shown in Figure 2-15).

4. If desired, modify the following information for the
selected controller:

• Element name
• Element description
• Sort key
• High priority NDS element

Refer to Figure 2-15 and Table 2-15 for instructions on using
this dialog box.

5. After modifying the desired information, click on OK to close
the dialog box and save your modifications, or click on
Cancel to exit the box and restore the previous settings.
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Figure 2-15
CCN Element Definition
Dialog Box

Click on To

the Element name edit box modify the controller name. The name
can consist of up to eight characters.

the Element description
edit box modify the controller description. The

description can consist of up to 24
characters.

the Sort key: edit box specify a sort key number for this
controller (1 to 255). Sort keys give
you the capability to customize the
order of your controller list. A con-
troller with a sort key of 1 appears
before a controller with a sort key of
2, and so on. Assigning a controller a

       (continued)

Table 2-15
CCN Element Definition
Dialog Box
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Table 2-15
CCN Element Definition
Dialog Box
(continued)

Click on To

sort key of 255 causes it to appear at
the end of the controller list. The
default sort key number is 1. For
instructions on sorting the presentation
of the controller list, refer to Sorting
the Controller List, which appears
earlier in the Displaying the Controller
List section of this chapter.

High priority element for
NDS diagnostics specify whether this element should be

assigned a high priority NDS diagnos-
tic routine scan rate (diagnostic poll-
ing takes place every 60 mins versus
every 6 hours).

Linked WorkSPACE display the WorkSPACEs dialog box
from which you can select a
WorkSPACE to which to link this
system element. The selected
WorkSPACE will be displayed when
you use the Window menu's Jump to
Table/WorkSPACE command, which
is available from the Bus Scan or
System Summary window, CCN
Option Table window, or Controller
List. You can also display this
WorkSPACE from the System Sum-
mary, Basic, or Detailed Bus Scan
window by double clicking on a
system element.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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Follow the steps below to delete a controller. If you remove a
controller that contains CCN Options, ComfortVIEW deletes the
options from the Options List that is displayed using the CCN
Options command in the CCN Tools menu. If any option’s configu-
ration uses points from the deleted controller, modify the configura-
tion of the affected option accordingly.

1. Display the Controller List window.

2. Click on the controller you wish to delete.

Note: ComfortVIEW allows you to delete multiple control-
lers. Use the Windows-standard mouse or keyboard
techniques to select multiple controllers. You can,
however, only select multiple controllers from the
right side of the Controller List window.

3. Click on the Configure menu item and then click on Delete.

Note: You may also perform this command by clicking on
the Delete icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before deleting the controller.

4. Click on Yes or No. If you have selected multiple controllers
and wish to delete all, click on Yes to All.

Note: If ComfortVIEW displays the message Controller Is
In Use, you have attempted to delete a controller
that is currently being accessed by you or another
ComfortVIEW operator. Attempt the delete again
when the controller is available.

Deleting
Controllers



70

Status display and maintenance tables contain real-time data for all
controller points. Follow the steps below to display a controller’s
status display or maintenance tables. For instructions on modifying
(forcing) status display or maintenance table values, refer to the
Modifying Status Display or Maintenance Table Values section of
this chapter.

1. Display the System Overview window and expand it to
display the database’s CCNs and areas. If necessary, follow
the instructions listed under Accessing the Carrier Network
Manager.

2. Display the controller list. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

3. Double click on a controller to view its table categories.

4. Double click on Status Display to view status display tables
or on Maintenance Display to view maintenance tables.

5. Double click on the table you wish to view.

Certain table categories may contain additional sub-catego-
ries. If you select a table category of this type, another list of
sub-categories will be shown, and you should click on a sub-
category from this list. Refer to Figure 2-16.

Sample status display and maintenance tables appear in the
following figures.

The Carrier Network Manager provides you with a short cut to
display and modify a selected point's associated configuration,
maintenance, time schedule, or setpoint table while you are viewing
status display or maintenance tables. To display a point's associated
tables, click on the Configure menu item followed by clicking on
Configuration, Maintenance, Time Schedule, or Setpoint.

While you are viewing Comfort Controller status display tables, the
Carrier Network Manager provides you with a means to list the
names of all Comfort Controller objects that are using a selected
status display point in their configuration. To display a point's
associated objects, click on the Configure menu item followed by
clicking on Reference tables. If desired, you can then display a
selected object's associated configuration or maintenance table.
These reference jumps are also available from magenta-highlighted
Comfort Controller maintenance table points.

Viewing Status
Display and
Maintenance
Tables

Table Jumps from
Status Display and
Maintenance Tables

Reference Jumps
from Comfort
Controller Status
Display Tables
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Figure 2-16
Sample Controller List
Window

United Mutual Insurance CCN1::United Mutual Insurance - Physical Plant

19XL: Chiller #1 - 0, 128

ComfortVIEW Lab - Quicker list

United Mutual Insurance - Physical Plant::AHU Air Handler Unit with DX - 0, 2::Maintenance

AOSSDEFM: Maintenance Display
Maintenance Display

WSMDEFME: Water Linkage Chiller Equipment

LINKDEFM: Linkage/Air Source Equipment

OCCDEFM: Occupancy Supervisory
19XL: Chiller #2 - 0, 4

AHU: AIr Handler Unit with DX - 0, 2

Direct connection

Status Display

Maintenance Display

Configuration

Service Configuration
Setpoint Configuration

Table 
Categories

MAINT: Maitenance Display

SERVHIST: Service History Display

Table 
Sub-
Categories

Alarm History
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Figure 2-17
Sample Status Display
Table

Administration
United Mutual Insurance - Physical Plant::AHU::BASE UNIT: Status Display

File Edit Configure Options HelpWindow

Description Value Units Status Force Name Notes

Space Temperature 74.5 OF SPT

Supply Air Temperature -10.0 OF Sensor failure SAT

Return Air Temperature 74.1 OF RAT

Outside Air Temperature 55.0 OF Supervisor OAT

Static Pressure 1.3 SP

Relative Humidity 36.0 RH

Outside Air Rel Humidity 44.1 Supervisor OARH

Freeze Stat Normal FRZ

Filter Status Dirty Alarm FLTS

Enthalpy Switch High ENT

Supply Fan Status Off SFS

Supply Fan Relay On SF

Heat Interlock Relay Off HIR

Inlet Guide Vanes 0.0 IGV

Mixed Air Damper 0.0 MIXD

Heating Coil Valve 0.0 HCV

Cooling Coil Valve 0.0 CCV

Direct connection

Value Units

Up to
24 Character

Description

Communication
Status

in H2O

%

%

%

%

%

%

Sensor Not Installed

Force
Status

Point
Name

Operator
Notes
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Figure 2-18
Sample Maintenance
Table

Administration
United Mutual Insurance - Physical Plant::AHU::MAINT: Maintenance Display

File Edit Configure Options HelpWindow

Description Value Units Status Force Name Notes

Heating Coil master ref. 40.0 OF HCMR

Heating Coil sub. ref. 40.0 OF HCSR

Heating Coil integ clamp 3 HCIC

Cooling master ref. 50.0 OF CCMR

Cooling sub. ref. 150.0 CCSR

Cooling integ clamp 3 CCIC

IG Vanes master ref. 0.0 IGVMR

IG Vanes submaster ref. 0.0 IGVSR

IG Vanes integ clamp 0 IGVIC

Damper setpoint 45 DPSP

Mix Air Damp master ref. 59.0 MIXDMR

Mix Air Damp sub. ref. 120.0 MIXDSR

Mix Air Damp integ clamp 0 MIXDIC

Outside Air Enthalpy 17.6 OAE

Return Air Enthalpy 24.8 RAE

Electric heat master ref. 0.0 EHMR

Electric heat sub. ref. 0.0 EHSR

in H2O

OF

in H2O

OF

OF
OF

OF
OF

Direct connection
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The table window is similar to most popular spreadsheet application
worksheets in that it consists of a rectangular grid of columns and
rows. The intersection of each column and row is a cell, the unit in
which data is stored. The worksheet includes the up to 24 character
description, value, units, eight character point name, alarm status,
communication status, and force status for each point. It also in-
cludes a notes column where you can enter an optional up to 48
character note.

The appearance of one of the following messages in a point’s status
column indicates the following:

Message Meaning

Sensor failure the point is attached to a failed sensor

Software error an internal failure has occurred

Alarm the point is in alarm or alert

Limit exceeded the point’s high or low limit has been
exceeded

Comm failure a communication failure has occurred

Port failure ComfortVIEW cannot communicate
with the computer’s communication
port

Port busy ComfortVIEW cannot communicate
with the computer’s communication
port

Status Display and
Maintenance Table
Format

Table 2-19
Message Descriptions
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If a point is currently forced, one of the following abbreviations will
appear in the force column:

Abbreviation Meaning

BEST forced by BEST or BEST++ program

Control forced by a CCN Option (PICs)

Fire forced by fire override (PICs)

Interlock forced by Permissive Interlock

Loadshed forced by the Loadshed Option

Minimum-Off forced by Loadshed minimum offtime
(PICs)

Remote Monitor forced by a remote ComfortVIEW (PICs)

NTFC forced by Night Time Free Cooling

Owners forced by the UT203 Owner’s Module

Safety forced by internal safety override (PICs)

Service forced by the Network Service Tool
(PICs)

Submaster forced by a submaster reference force

Supervisor forced by ComfortVIEW

Temp forced by temperature override

If desired, you can create customized displays of point data. You can
customize the look of your status display tables by doing such things as
grouping similar points from different controllers together, changing the
order in which points are displayed, etc. You do this by creating a
ViewSPACE in ComfortVIEW WorkSPACE Manager application.
Refer to the WorkSPACE Manager chapter of this manual for instruc-
tions.

Table 2-20
Abbreviation Descriptions
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The table below lists the keys that you can use to move around in a
worksheet. Keys that must be pressed at the same time are separated with
a plus sign. You can also use most keyboard shortcuts that are used in
most popular spreadsheet applications.

Press To

the up, down, right or left
arrow key scroll one row up or down,or one column

left or right

Page Up scroll up one window

Page Down scroll down one window

Ctrl+Page Up scroll left one window

Ctrl+Page Down scroll right one window

Home move to the cell in the upper left corner of
the  window

End move to the cell in the lower right corner of
the window

To Adjust a Column’s Width:  Drag the line to the right of the column
heading. Clicking on the Options menu item and then clicking on Best fit
gives you the ability to quickly adjust column widths to the best fit for
the longer entry in each column.

To Hide a Column or Row:

1. Click on the header of the column or on the box to the left of the
row you wish to hide.

2. Click on the Options menu item and then click on Hide.

Note: You may also perform this command by clicking on the
Hide icon in the toolbar.

To Make Row Hides Permanent:  Click on the Configure menu
item and then click on Save. The row will not appear the next time
you view this table.

Moving Around a
Worksheet

Table 2-21
ComfortVIEW Worksheet
Keys

Adjusting and Hiding
Worksheet Columns
and Rows
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To Make Column Hides Permanent:  Click on the Options menu
item and then click on Save settings on exit. A checkmark (✓ )
appears before the command to indicate that it is enabled. The
column will not appear the next time you view this table.

Note: Row hides apply to specific tables and are hidden for all
ComfortVIEW operators. Column hides apply to all
tables in all controllers and are hidden for individual
ComfortVIEW operators.

To Show Hidden Columns or Rows:

1. Click on the Options menu item and then click on Show.

Note: You may also perform this command by clicking on the
Show icon in the toolbar.

2. Select the rows or columns to add from the Show Rows/Columns
dialog box and click on OK.

If desired, you can display each point’s item reference number along
with the point name. This number is used when linking status display
table data to other PC applications, such as commercially-available
spreadsheet programs. Refer to the Sharing ComfortVIEW Dynamic
Data Applications (DDE) section of this chapter for instructions on
displaying Point IDs.

While viewing a status display or maintenance table, you can select any
point and then click on the trend wizard toolbar icon (shown at left) to
quickly and easily set up a trend of that point.

1. In the Trend Wizard dialog box, enter the new trend name, and
then either click on Finish if you are satisfied with the trend's
default 15 second scan rate, or click on Modify to display the
Modify Current Trend dialog box and add other points to the
same trend, or change the default scan rate. Refer to Table and
Figure 4-18 in this manual's WorkSPACE Manager chapter for
instructions on using this dialog box. Clicking on Finish saves the
trend for later use with the WorkSPACE Manager application.

Note: To view and run the newly-created trend, enter the
WorkSPACE Manager application. Then, use the File
menu's Open ViewSPACE/trend command. To associate
and save the trend in a WorkSPACE, enter design mode,
open a WorkSPACE, open the trend, and then save the
WorkSPACE.

Displaying Point IDs

Trend Wizard
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While viewing a status display or maintenance table, you can select
any point and then click on the Alarm Wizard toolbar icon to
quickly and easily configure an alarm for the selected point. Note
that wizard operation will differ, depending on the type of point and
CCN system element. For Comfort Controllers and UT203 FIDs, the
wizard first guides you through point alarm creation and configura-
tion, and then ComfortVIEW custom message creation. For all other
CCN system elements, the wizard provides ComfortVIEW custom
alarm creation only. Follow the steps as presented.

While viewing a status display or maintenance table, you can click
on the Report Wizard toolbar icon and quickly and easily add a new
consumable, runtime, or history report definition to the
ComfortVIEW system. Follow the steps presented:

1. Select the report type.

2. Specify the report name and description.

3. Select the points to be included in the report. Initially, the list
of points presented will include those that were selected from
the ViewSPACE or trend.

4. Select a specific Data Collection Module in which to allocate
the Data Collection Tables. By default, the wizard locates an
available module on the current CCN, but you also have the
ability to identify a specific module, if desired.

5. From the next dialog box, click on Report Options to view or
modify the default settings, if desired.

Configuration tables are used to specify operating parameters for
control applications.

Follow the steps below to display a controller’s configuration table.
For instructions on modifying configuration table values, refer to the
Modifying Configuration Table Values section of this chapter.

1. Display the System Overview window and expand it to
display the database’s CCNs and areas. If necessary, follow
the instructions listed under Accessing the Carrier Network
Manager.

Alarm Wizard

Viewing
Configuration
Tables

Report Wizard
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2. Display the controller list. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

3. Double click on a controller to view its table categories.

4. Double click on one of the following table types:

• Configuration to display a configuration table
• Service Configuration to display a service

configuration table
• Setpoint Configuration to display a setpoint

configuration table.

ComfortVIEW displays the table names or sub-categories
in the right half of the window.

5. Double click on the table or category you wish to view.

Certain table categories may contain additional sub-catego-
ries. If you select a table category of this type, another list of
sub-categories will be shown, and you should click on a sub-
category from this list.

A sample configuration table appears in Figure 2-22.
Figure 2-22
Sample Configuration
Table

United Mutual Insurance - Engineering Office::AUTODIAL::STDPSWDS:

Description Value Units Name Notes

A2F

Off-Network Location OFFNETLO

<< <<

Farmington

Password Enable PSWDENYES

Standard Password STDPSWDA2F

Value Units24-character
Description

8-character
Name

Direct connection

Allowable Entries: 1-8 alphanumeric characters

Operator
Notes
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Like status display and maintenance tables, configuration table
windows are similar to most popular spreadsheet application
worksheets in that they consist of a rectangular grid of columns and
rows. The intersection of each column and row is a cell, the unit in
which data is stored. The worksheets include the 24 character
description, value, units, eight character point name, and a notes
column where you can enter an optional up to 48 character note.

You can move around the worksheet, adjust, hide and show columns
and rows, and modify point descriptions in the same manner as
when displaying status display or maintenance tables. For instruc-
tions, refer to Moving Around a Worksheet, Adjusting and Hiding
Worksheet Columns and Rows, and Modifying Point Descriptions.

While you are viewing a setpoint or occupancy configuration table,
you can select the Window menu's Graphical command to display
the table in a graphical format. Refer to the Window menu explana-
tion that appears in this chapter's Carrier Network Manager Com-
mand Summary section for further information on this display
format.

Certain configuration tables contain multiple instances of table data.
For example, the Autodial Gateway’s Secured Password Table. If
this is the case, the << and >> buttons display below the toolbar at
the beginning of the window’s status bar. Click on  << to display
the previous block of data or click on >> to display the next block
of data. Refer to Figure 2-22.

Use of a UT203 FID service configuration table is not compatible
with use of any other FID table. Concurrent use of the service
configuration table with any other UT203 FID table (by you or any
ComfortVIEW operator) will result in the display of a Controller in
use or Controller currently locked message.

The Carrier Network Manager provides you with a short cut to
display and modify a selected configuration entry's associated
configuration, maintenance, time schedule, or setpoint table while
you are viewing a configuration table. To display a point's associ-
ated tables, click on the Configure menu item followed by clicking
on Configuration, Maintenance, Time Schedule, or Setpoint.
ComfortVIEW will display the Table Jump Selection dialog box,
which lists the controller's configuration, maintenance, time, or
setpoint schedule tables. If you select the Configuration or Mainte-

Configuration Table
Format

<< and >> Buttons

Viewing UT203 FID
Service Configuration
Tables

Table Jumps from
Configuration Tables
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nance command from a magenta-shaded cell, ComfortVIEW will
jump directly to the configuration entry's associated configuration or
maintenance table.

While you are viewing Comfort Controller configuration tables, the
Carrier Network Manager provides you with a means to list the
names of all Comfort Controller objects that are using a selected
configuration point in their configuration.This feature is only avail-
able for magenta-highlighted configuration points. To display a
point's associated objects, click on the Configure menu item fol-
lowed by clicking on Reference tables. If desired, you can then
display a selected object's associated configuration or maintenance
table.

Alarm history tables are used to display a controller's alarm history
data. These tables exist in certain CCN controllers (such as Comfort
Controllers and some PICs).

Follow the steps below to display a controller’s alarm history tables.

1. Display the System Overview window and expand it to
display the database’s CCNs and areas. If necessary, follow
the instructions listed under Accessing the Carrier Network
Manager.

2. Display the controller list. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

3. Double click on a controller to view the table categories.

4. Double click on Alarm History.

ComfortVIEW displays the table name ALRMHIST in the
right half of the window.

5. Double click on the ALRMHIST Table.

ComfortVIEW reads the controller's alarm history data and
displays the Alarm History dialog box. Clicking on the
Refresh button retrieves and displays the latest alarm data,
Clicking on Close closes the dialog box.

Note: If the selected controller does not contain alarm
history tables, the message This CCN element does
not support the Alarm History feature will be dis-
played.

Comfort Controller
Reference Jumps

Viewing Alarm
History Tables
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ComfortVIEW's Bus Services function examines a CCN Bus and
produces a list of the bus's system elements and snapshot of activ-
ity. You can use the Bus Services command to perform an update
poll or cold call, or to produce a basic or detailed bus scan. For CCS
thermostats and ComfortID boxes, you can also produce a system
summary, which searches for and produces a system summary of all
the controllers that are part of a selected system.

Follow the instructions below to poll a CCN Bus:

1. Display the Carrier Network Manager's System Overview
window and expand it to display the database's CCNs. If
necessary, follow the instructions listed previously in this
chapter under Accessing the Carrier Network Manager.

2. Click on the CCN or area that you wish to examine.

3. Click on the CCN Tools menu item and then click on Bus
Services.

Note: You may also perform this command by clicking on
the Bus Services toolbar button shown at left.

ComfortVIEW displays the Bus Services dialog box shown
in Figure 2-22a.

4. Select the activity that you wish to perform (basic or detailed
bus scan, update poll, or cold call.)

Different dialog box options will then become available,
depending on the activity you have selected. For example,
when performing an update poll or cold call, you can specify
whether to use ComfortVIEW's internal NDS function, an
external NDS Module, or an automatically selected NDS
method. When performing a bus scan, you can specify the
bus number, range of elements, and whether to include only
CCS and ComfortID devices.

5. Click on Run to close the Bus Services dialog box and per-
form the specified activity, or on Close to exit the dialog box
without performing any activity.

Refer to Figure and Table 2-22a for additional information on
the options in this dialog box and Figures 2-22b, c, and d for
sample basic, detailed, and system summary bus scan dis-
plays.

Polling a
CCN Bus
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Figure 2-22a
Bus Services Dialog Box
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Table 2-22a
Bus Services Dialog Box Click on To

Perform basic bus scan examine the specified CCN, bus, and
range of system elements and produce
a Basic Bus Scan display. Click on
Run to proceed with the scan. An
activity indicator will be displayed
during the scan. On completion, the
Basic Bus Scan window will be
displayed along with an accompany-
ing menu bar. Refer to Figure 2-22b.
Menu commands allow you to print,
display status display tables and
WorkSPACEs, add system elements
to the ComfortVIEW database,  and
copy configuration. You will also be
able to use the File menu's System
Summary command to search for and
produce a list of all CCS and
ComfortID monitor or master thermo-
stats, and associated zone and bypass
controllers. Refer to the Carrier
Network Manager Command Sum-
mary at the end of this chapter for a
description of each Bus Scan window
command.

Perform detailed bus scan examine the specified CCN, bus, and
system element range and produce a
Detailed Bus Scan display. Click on
Run to proceed with the scan. An
activity indicator will be displayed
during the scan. On completion, the
Detailed Bus Scan window will be
displayed along with an accompany-
ing menu bar. Refer to Figure 2-22c.
All basic bus scan functions can also
be performed from the Detailed bus
Scan window. A complete description
of each Bus Scan window menu
command can be found under Carrier
Network Manager Command Sum-
mary at the end of this chapter.
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Click on To

Perform update poll update the Network Directory Ser-
vices (NDS) system element directory.
Performing an update poll causes
NDS to poll the primary CCN Com-
munication Bus and identify all
system elements on it. You should
perform an Update poll to update the
NDS Module (or, if using the internal
NDS function, ComfortVIEW) before
performing a Cold Call. After select-
ing Perform update poll, you must
then select an NDS method:  external
NDS Module, internal NDS function,
or allow ComfortVIEW to automati-
cally determine the best method
(external if available, otherwise
internal). Click on Run to proceed. A
message will be displayed to indicate
successful completion of the update
poll.

Perform cold call obtain a list of all system elements on
the selected CCN. Performing a cold
call causes ComfortVIEW to read the
NDS system element directory and to
update the Controller List window
with a list of all system elements and
their addresses. You would typically
use cold call after ComfortVIEW
installation or after connecting to a
remote CCN using the Access Menu's
Connect command. Performing a cold
call determines the system elements
that are on a remote CCN (a CCN for
which ComfortVIEW has no data-
base.) From the information obtained
from a cold call you can upload,
import, or copy controllers to create

       (continued)

Table 2-22a
Bus Services Dialog Box
(continued)
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Table 2-22a
Bus Services Dialog Box
(continued)

Click on To

the database for your CCN. After
selecting Perform cold call you must
select the NDS method (see update
poll above) and then click on Run.
The CCN Areas dialog box will be
displayed (if in Step 2 an area was not
selected). Select an area in which to
place the system elements and click
on OK. ComfortVIEW will present a
confirmation dialog box asking if you
wish to perform an update poll.
Typically, before performing a cold
call, you should update the NDS
system element directory. Click on
Yes to do so. An activity indicator
displays during the update poll and
cold call processes. On completion of
the cold call, the Controller List
window will be displayed. The names
and addresses of all controllers in the
NDS system element directory will be
displayed in the Controller List.

Note:   Cold call does not update the
ComfortVIEW database. It only
includes the name and address of
controllers in the Controller List
window. Controllers for which
ComfortVIEW has no database infor-
mation will appear dimmed. You must
use the Configure menu's Upload,
Import, or Copy commands to add the
controllers to the database.

Bus enter the number of the CCN Bus for
which you wish to perform a basic or
detailed bus scan.

                                           (continued)
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Click on To

First element enter the lowest system element
address on the specified bus. The bus
scan will examine those system
elements beginning with this element
number up to and ending with the
element number specified in the Last
element.

Last element enter the highest system element
address on the specified bus.

Include only CCS and
ComfortID devices scan only CCS and ComfortID system

elements versus all CCN system
elements on the specified bus.

Use external NDS Module perform the update poll or cold call
using an NDS Module that is physi-
cally connected to the CCN Bus.

Use internal NDS function perform the update poll or cold callus-
ing ComfortVIEW's internal NDS
function.

Automatically determine
best method use an external NDS Module, if

found, to perform the update poll. If
an external NDS Module is not found,
ComfortVIEW will use its internal
NDS function.

Diagnostic priorities if desired, assign a high priority NDS
diagnostic routine scan rate to CCN
system elements that are displayed in
the recently performed cold call's
Controller List. This will cause
ComfortVIEW internal diagnostic
polling to take place every 60 minutes

       (continued)

Table 2-22a
Bus Services Dialog Box
(continued)
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Table 2-22a
Bus Services Dialog Box
(continued)

Click on To

and whenever ComfortVIEW is
started (i.e. during PC boot) versus
every 6 hours. ComfortVIEW will
display the Diagnostic Priorities
dialog box. Those elements that are
currently selected for high priority
scanning will be highlighted. Select
any other elements and click on OK.
The Diagnostic routine scans all CCN
Buses and checks for communication
and clock errors. The routine gener-
ates alarms and alerts that you can
view using the Alarm Manager appli-
cation.

Run close the dialog box and perform the
specified operation (update poll, cold
call, or bus scan.)

Close exit the dialog box without perform-
ing any activity. Any changes made
are not saved.

Help display help information.
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Figure 2-22b
Sample Basic Bus Scan

The Basic Bus Scan window shown above displays name, descrip-
tion, address (system element number), type and version data for all
system elements identified on the specified bus. For CCS and
ComfortID system elements, mode and error data will also be
included.

Master stats are identified in blue. Those system elements that have
not been added to the ComfortVIEW database will be preceded by a
"dimmed" icon. You can add such elements to the database using
the Configure menu's Add to database command. Refer to Carrier
Network Manager Command Summary at the end of this chapter for
a complete description of each Bus Scan window command.

Basic Bus Scan
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Figure 2-22c
Sample Detailed Bus Scan

In addition to all basic bus scan data (name, description, address,
type, version, error, and mode) the Detailed Bus Scan window also
includes the following data (for CCS and ComfortID system ele-
ments only):  zone temperature, cooling setpoint, heating setpoint,
demand limit, damper position, and air flow.

Master stats are identified in blue. Those system elements that have
not been added to the ComfortVIEW database will be preceded by a
"dimmed" icon. You can add such elements to the database using
the Configure menu's Add to database command. Refer to Carrier
Network Manager Command Summary at the end of this chapter for
a complete description of each Detailed Bus Scan window com-
mand.

You can produce a System Summary from either a Basic Bus Scan
or Detailed Bus Scan window. To produce a System Summary, first
produce a basic or detailed bus scan. Then, from the Bus Scan
window, select the File menu's System Summary command.

ComfortVIEW will search the Bus Scan window for the highest
addressed monitor thermostat or linkage master device. If no such
device is located, a message will be displayed indicating such, and
the system summary will terminate. On locating one or more such
devices, ComfortVIEW will begin with the monitor thermostat or
linkage master device of highest address and then scan the bus to

Detailed Bus Scan

System Summary
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Figure 2-22c
Sample System Summary

locate all devices associated with the monitor thermostat or linkage
master. On completion, the System Summary window is displayed.
The System Summary window contains the same data as a Detailed
Bus Scan window, but also includes the following zone summary
data in the lower section of the screen:  Cool Callers, Maximum
Cool Demand, Maximum Cool Demand Element, Heat Callers,
Maximum Heat Demand, and Maximum Heat Demand Element.
The list of CCS or ComfortID devices will begin with the master or
monitor stat displayed first, followed by all other CCS or ComfortID
system elements in descending order by address. As in the Bus Scan
windows, those elements that have not been added to the
ComfortVIEW database will be preceded by a dimmed icon.

Double clicking on a system element will display the element's
linked WorkSPACE (if one has been assigned) or the element's
status display table. If the selected system element has no display
table and has not been configured with a linked WorkSPACE, you
will be given an opportunity to identify a WorkSPACE to link to the
given system element.
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You can make the following modifications in status display or mainte-
nance tables:

• Force, or modify a point’s value by forcing or overriding a
controller’s automatic control of the point

• Auto, or clear a force and return a point to a controller’s automatic
control

• Modify any point’s description

• Copy cell data to the Windows clipboard. This allows table data to
be copied to other PC applications or other Carrier Network Man-
ager tables

• Paste cell data from the Windows clipboard

Follow the instructions below to force a point’s value or status.

Note: Points can also be forced and autoed by third party PC
applications that support DDE poke. For further information
on this function, refer to DDE Poke in the Sharing
ComfortVIEW Dynamic Data With Other Applications
(DDE) section of this chapter.

1. To modify a point’s value, display the maintenance or the status
display table. If necessary, follow the instructions listed under
Viewing Status Display or Maintenance Tables.

2. Double click on the cell whose value you wish to override.

Note: You may also click on the cell, click on Edit and then
click on Force. As another alternative, you may simply
click on the Force icon in the toolbar.

ComfortVIEW displays the Force dialog box shown in Figures
2-23 and Figures 2-24.

3. For analog points:

Enter the override value in the Force value edit box. You may
also use the Force up or down arrow and the Increment up or
down arrow to increase or decrease the displayed value. Refer to
Table 2-23 for more information on using the Force dialog box.

Modifying
(Forcing) Status
Display or
Maintenance
Table Values

Forcing a
Point
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For discrete points:

Click on the desired override state button (for example,
Clean, Dirty, On, Off).

4. Click on OK.

Figure 2-23
Force Dialog Box -
Analog

Figure 2-24
Force Dialog Box -
Discrete

Force value:

Force: Input/Output Channel 1

Increment:

1+-40.0

Auto time...

Note...

Force Cancel Help...

Auto

Clean Dirty

Force value:

Clean

Force Cancel Help...

Auto time...

Force: Filter Status

Note...

Auto
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The word Supervisor (for local ComfortVIEW forces) or
Remote Monitor (for remote ComfortVIEW forces) appears in
the points status column to indicate that a ComfortVIEW
force is in effect.

Follow the instructions below to clear a force and return the point to
the controller’s automatic control.

1. Display the status display or maintenance table. If necessary,
follow the instructions listed under Viewing Status Display or
Maintenance Tables.

2. Click on the cell whose force you wish to clear.

3. Click on Edit and then click on Auto.

Note: You may also perform this command by clicking on
the Auto icon in the toolbar or by double clicking on
the cell and, in the Force dialog box, clicking on
Auto.

The force clears and the point returns to the controller’s automatic
control.

Note: If more than one force exists on a point, perform Steps 2
and 3 until all force statuses are removed.

Click on To

the override state button
(Example: Clean, Dirty,
On, Off) select the desired override state

(for discrete points only).

the Force value edit box enter the desired override value
(for analog points only).

the Increment: up or
down arrow select the increase or decrease granu-

larity (For example, .1, 1, 100, 1000)

       (continued)

Autoing a Point

Table 2-23
Force Dialog Box
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Click on To

the Force value up or
down arrow increase or decrease the override value

for analog points.

Auto time indicate the time and date to remove
the force. This option is only available
for those PIC controllers that support
a force expiration. ComfortVIEW
displays the Auto Time and Date
dialog box. Click on the day of the
month and enter the time to remove
the force. To change the month, click
on the scroll bar’s down or up arrow.
Click on OK to close the dialog box
and save your settings.

Note add an operator note in the Force
dialog box. The Force Note dialog
box displays. In the Force note box,
enter a new or edit the existing note.
Click on OK to save the changes or
click on Cancel to exit without saving
changes. Force notes appear in the
System Activity report.

Auto remove any current force that may be
on the point.

Force transmit the force to the point.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-23
Force Dialog Box
(continued)
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If desired, you can modify any point’s description.

Note: These instructions do not apply to UT203 FIDs or Com-
fort Controllers. To modify point descriptions for these
two system elements, refer to Configuring UT203 FIDs or
Configuring Comfort Controllers, which appear later in
this Carrier Network Manager chapter.

1. Click on the description cell and type the new name.

The text appears in the cell and in the edit bar, which is
located below the window’s status bar.

2. Press Enter or click on the edit bar’s enter icon to enter the
change.

Note: Clicking on the edit bar’s cancel icon cancels the
change.

3. Click on the Configure menu item and then click on Save.

If desired, you can copy selected cell data to the Windows clip-
board. You can also paste clipboard data to a selected cell.

To Copy Cell Data:

1. Click on the cell or drag select multiple cells that you wish to
copy.

2. Click on the Edit menu item and then click on Copy.

Note: You may also perform this command by clicking on
the Copy icon in the toolbar.

The selected cell’s data will be copied to the Windows clip-
board. You can now paste this data into another Carrier
Network Manager table or to another third party software
application.

To Paste Cell Data from the Windows clipboard:

1. Display the table to which you wish to paste.

2. Click on the cell into which you wish to paste.

3. Click on the Edit menu item and then click on Paste.

Note: You may also perform this command by clicking on
the Paste icon in the toolbar.

To Modify Point
Descriptions

To Copy and Paste
Cell Data
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The selected cell’s data will be copied from the Windows
clipboard to the selected cell.

If you are attempting to paste data into a protected cell or are
attempting to paste incompatible data, an error message box
displays. Click on OK to close the message box.

Follow the instructions below to modify, download, and write
modified configuration table values to the ComfortVIEW database.

Note: ComfortVIEW now includes a dynamic-link library
(DLL), which can be used to provide third party access to
CCN time schedule and setpoint configuration tables. This
DLL (CWACCESS.DLL) exposes read and write func-
tionality, which can be utilized to create your own custom
software applications. For further information and instruc-
tions on using this DLL, refer to Appendix B —
CWACCESS DLL.

1. Display the configuration table. If necessary, follow the
instructions listed under Viewing Configuration Tables.

2. For analog value or text entry cells:

Click on the cell you wish to change and type the new value.

Note: To modify cells containing point names, the Caps
Lock key must be enabled.

For discrete values:

Click on the value cell you wish to change and press the
space bar to toggle the discrete state.

The value appears in the cell and in the edit bar, which is
located below the window’s status bar.

3. Press Enter or click on the edit bar’s enter icon to enter the
change.

4. Click on Configure and then click on Save if you wish to save
the new value in the ComfortVIEW database, or,

if you wish to cancel, click on Window and then click on
Refresh to refresh the window with the most recent data that
has been written to the database.

Note: You may also perform these commands by clicking
on the Save or the Refresh icon in the toolbar.

Modifying
Configuration
Table Values
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5. Click on Configuration and then click on Download if you wish to
send the new value to the controller.

Note: You may also perform this command by clicking on the
Download icon in the toolbar.

If ComfortVIEW displays the message CCN Currently
Locked or CCN Is In Use, you have attempted to download
a controller table that is currently being accessed by you or
another ComfortVIEW operator. Attempt the download
again when the controller is available.

For certain types of controllers, the drag and drop feature is available to
expedite the entry of configuration data. This feature allows you to use the
Windows drag and drop technique to copy data from a points status,
maintenance, or time schedule table to the configuration table you are
modifying. The availability of drag and drop is indicated by the presence
of green coloring on a configuration decision’s description text. This
technique can be a tremendous time saver in configuring controllers such
as the Data Collection Option.

Follow the steps below to use drag and drop:

1. Display the source and destination tables. You can use the Cascade
or Tile command in the Window menu to re-arrange windows.

2. Position the mouse pointer on the Value cell for the point that you
wish to copy.

3. Press and hold down the Ctrl key.

4. Press and hold down the mouse button and drag the mouse to re-
position it on the Value cell for the configuration table point that
you wish to copy to.

A small square icon appears next to the mouse pointer. A plus sign
appears inside the icon to indicate you are copying.

5. Release the Ctrl key and then release the mouse button when the
square is positioned on the Value cell you are copying to.

The configuration table window updates with configuration data automati-
cally completed for you.

Drag and Drop
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A Drag and Drop Example:

You wish to configure the Data Collection Option to collect runtime
data from the Supply Fan Status point in the 39N Air Handler.

To collect runtime data, you must configure the following tables:

• The Runtime Configuration Table in the 39N Air Handler
• The Runtime (RUNTM01S) Configuration Table in the Data

Collection Option

Drag and drop saves you a significant amount of configuration time
by automatically completing a large portion of the configuration
table data entry for you.

Follow the steps below to use drag and drop to automatically com-
plete the configuration required in this example.

1. Simultaneously display the 39N Baseunit Status
Display Table, the 39N Runtime Configuration Table,
and the Data Collection Option Runtime Configuration
Table.

2. Use the drag and drop technique described in Steps 2
to 4 under Drag and Drop to automatically complete
39N Runtime Configuration Table data entry. To do
this, copy the 39N Baseunit Status Display Table’s
Supply Fan Status point to the Runtime 1 Point Name
decision in the 39N Runtime Configuration Table.

ComfortVIEW automatically fills in the point name
and point type configuration for you.

3. Now you can use drag and drop to automatically
complete the Data Collection Option Runtime Con
figuration Table data entry. To do this, copy the 39N
Runtime Configuration Table’s Runtime 1 Point Name
decision to the Runtime #1 Contlr Name decision in
the Data Collection Option’s Runtime Configuration
Table, RUNTM01S.

ComfortVIEW automatically fills in all required
configuration decisions for you. Refer to Figure 2-25.
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Figure 2-25
Dragging and Dropping
Runtime Configuration
Data

Carrier Network Manager

United Mutual Insurance: Annex

United Mutual Insurance - Annex

System Overview

United Mutual Insurance

United Mutual Insurance - Annex

United Mutual, Farmington Office

United Mutual, Syracuse Office

System Overview

AdministrationFile Edit Configure Options HelpWindow

Description Value Units Name Notes

Runtime 1 point name RUN01-NM

point name Normal RUN01-TP

Runtime 2 point name RUN02-NM

point type Normal RUN02-TP

SFS

United Mutual Insurance - Annex::AHU::RUNTIME: Data Collect Ru

Allowable Entries: 1 to 8 alphanumeric characters

SFS

Description Value Units Status Force

Fitler Status Alarm

Enthalpy Switch High

Supply Fan Status

Supply Fan Relay On

On

United Mutual Insurance - Annex::AHU::BASEUNIT: Status DIsplay

Dirty

On

19XL: Chiller #1 - 0,128

United Mutual Insurance - Annex

DATCOLL:Data Collection III
AHU - 0,2

19XL: Chiller #1 - 0,128

United Mutual Insurance - Annex

DATCOLL:Data Collect ion II I  -  0,100

AHU - 0,2

Description Value Units Name Notes

Runtime #1 contlr name RUN1-CNT

point name SFS RUN1-NAM

bus # 0 RUN1-BUS

element # 2 RUN1-ELE

AHU

United Mutual Insurance - Annex::DATCOLDT::RUNTM01S: Data C

Allowable Entries: Up to 8 characters, Speedy Data Entry - F7

AHU
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Speedy Data Entry

Speedy Data Entry

Select Area:

Cancel Help...

Select Element:

Select Category:

Select Table:

Select Point:

United Mutual Insurance - Physical Plant

23XL: Chiller - 0, 128

Status Display

STATUS 01: Status Display

ECW: Entering Chilled Water

OKReset

Figure 2-25a
Speedy Data Entry
Dialog Box

For certain types of controllers, the speedy data entry feature may be
available to expedite the entry of configuration data. The availability
of speedy data entry is indicated by the presence of green coloring
on a configuration decision's description text.

To Use Speedy Data Entry:

1. Position the mouse pointer on the green-highlighted Descrip-
tion cell and press F7.

The Speedy Data Entry dialog box will be displayed.

2. In the Speedy Data Entry dialog box, select the Area, system
element, table category, table and point whose data you wish
to copy, and then click on OK. Refer to Figure and Table 2-
25a for instructions on using this dialog box.

The configuration table window updates with the configuration data
automatically completed for you.
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Table 2-25a
Speedy Data Entry
Dialog Box

Click on To

the Select Area drop down list display a list of all areas in the
currently-selected CCN. Click
to select the area containing
the point whose data you wish
to copy.

the Select Element drop down list display a list of all elements in
the selected area. Click to
select the controller (system
element) containing the point
whose data you wish to copy.

the Select Category drop down list display a list of all table
categories in the selected
system element.

the Select Table drop down list display a list of all tables in the
selected  category.

the Select Point drop down list display a list of all points in
the selected element and table.
Click on a point to select it.

OK select the specified point and
close the dialog box.

Cancel exit the dialog box without
selecting the point.

Reset clear all current selections.

Help display help information.
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Modifying
Configuration
Decision Descriptions

Copying and Pasting
Cell Data

If desired, you can modify any configuration decision description.

1. Click on the description cell and type the new name.

The text appears in the cell and in the edit bar, which is
located below the window’s status bar.

2. Press Enter or click on the edit bar’s enter icon to enter the
change.

Note: Clicking on the edit bar’s cancel icon  cancels the
change.

3. Click on Configure and then click on Save to save the new
description in the ComfortVIEW database, or,

if you wish to cancel, click on Window and then click on
Refresh to refresh the window with the most recent descrip-
tion that has been written to the database.

Note: You may also perform these commands by clicking
on the Save or the Refresh icon in the toolbar.

If ComfortVIEW displays the message CCN Currently
Locked or CCN Is In Use, you have attempted to modify a
point description in a controller that is currently being ac-
cessed by you or another ComfortVIEW operator. Attempt
the modification again when the controller is available.

If desired, you can copy selected configuration table cell data to the
Windows clipboard. You can also paste clipboard data to a selected
cell. You do this using the Edit menu’s Copy and Paste commands.

For step-by-step instructions, refer to To Copy and Paste Cell Data
in the Modifying Status Display or Maintenance Table Values
section of this chapter.
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Modifying
Table Names

and Descriptions

ComfortVIEW gives you the capability to modify all controller
table descriptions and  Loadshed and Occupancy table names. Note
that you can also modify Comfort Controller table names and
descriptions. To do this, however, you must follow the instructions
in the Configuring Comfort Controllers section of this chapter.

Table names and descriptions appear in the controller list and as
table headers throughout ComfortVIEW. You would typically
modify table descriptions if you wished to customize your control-
ler list displays. You would modify Loadshed and Occupancy table
names to maintain a one to one correspondence between the table
names in the option and the table names in the equipment that the
option affects.

Note: Exercise caution when modifying Loadshed and Occu-
pancy Option table names — modify only the numbers
that appear in the table name. Do not modify other char-
acters in the name. For example, you can change the name
of the Loadshed Option’s LDSHD01E Table to a name
such as LDSHD02E.  LODSH02E, however, would be an
invalid modification.

Follow the steps below to change the name or description of a
controller’s configuration tables:

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Double click on a controller to views its table types.

3. Double click on the type of table whose name or description
you wish to modify: Status Display, Maintenance Display,
Configuration, Service Configuration, Setpoint Configura-
tion.

ComfortVIEW displays the table names in the right half of
the window.

4. Click to select the table whose name or description you wish
to modify.

Certain tables may contain additional tables. If you select a
table of this type, another list of tables will be shown and you
should double click on a table from this list.

5. Click on Configure and then click on Modify.
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Note: You may also perform this command by clicking on
the Modify icon in the toolbar.

ComfortVIEW displays the Table Definition dialog box
shown in Figure 2-26.

This dialog box gives you the capability to modify the se-
lected table’s name or description.

Refer to Table 2-26 for instructions on using this dialog box.

Table Definition

Table name:

LDSHDOIE

Table description:

Loadshed Equipment

OK Cancel Help...

Figure 2-26
Table Definition Dialog
Box

6. After modifying the name and description, click on OK to
close the dialog box and save your modifications, or click on
Cancel to exit the box and restore the previous settings.

Click on To

the Table name: edit box modify the table name. The name can
consist of up to eight characters.

the Table description:
edit box modify the controller description. The

description can consist of up to 24
characters.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 2-26
Table Definition Dialog
Box
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You can also modify controller table names and descriptions by follow-
ing the steps below:

1. Display the Controller List window.  If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller containing the table names and descrip-
tions to modify.

3. Click on the Configure menu item and then click on Table names.

ComfortVIEW displays the Table Names list shown in Figure 2-
27. This list displays the 8 character name and 24 character
description of each table in the selected controller.

Refer to Table 2-27 for additional information about this list.

4. Click on the table you wish to modify.

5. Click on Modify.

ComfortVIEW displays the Table Definition dialog box. Refer to
Figure 2-26 and Table 2-26 for instructions on using this dialog
box.

6. After modifying the name and description, click on OK to close
the dialog box and save your modifications, or click on Cancel to
exit the box and restore the previous settings.

Alternate Method

AHU - Device Configuration

Table Names

Close Help...

Select a table:

Closes this dialog box

Modify...

ALARMDEF: Configuration
ALARMLIM: Service Configuration
ALARMSO1: Alarm POC Data
AOSS-01E: AOSS Equipment
AOSS-01S: AOSS Supervisory
AOSSDEFC: Configuration
AOSSDEFM: Maintenance Display
BASEUNIT: Status DIsplay
BROCASTS: Broadcast Supervisory
BRODEFS: Broadcast Supervisory
CNS-POC1: Configuration
CONFIG: Configuration
CONSUME: Data Collect Consum Eqp
CtlrID: Device Configuration
DXCOOL: Status Display
ELECHEAT: Status DIsplay
HOLDY01S: Holiday
HOLDY02S: Holiday
HOLDY03S: Holiday
HOLDY04S: Holiday

Figure 2-27
Table Names List Window
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Table 2-27
Table Names Dialog Box

Click on To

the Select a table: list select a table to modify.

Modify modify the selected table.
ComfortVIEW displays the Table
Definition dialog box described previ-
ously.

Close close the dialog box and restore the
previous settings.

Help display help information.

ComfortVIEW provides you with the capability to duplicate a
controller’s configuration data and copy it to another similar
controller — either in the same area or in any other area in your
ComfortVIEW database. When you copy a controller,
ComfortVIEW copies all of the controller’s configuration tables to
the specified controller or area. You can use this feature to expedite
the entry of configuration data.

In addition to copying an entire controller’s-worth of configuration
data, you can also copy individual configuration tables. For instruc-
tions, refer to Copying Individual Tables later in this manual section.

To Copy All Tables:

There are two ways to copy all controller configuration tables:

• Choosing the Configure and Copy commands from the menu

• Dragging and dropping the controller icon on top of another
controller icon using the mouse

Table 2-28 summarizes the ComfortVIEW drag and drop copy
process.

Copying and
Moving Controller
Configuration
Data

Copying Controllers
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Table 2-28
Drag and Drop Drag From Drag To

Single
Controller Area
Icon Icon

Single Controller Copies configuration Copies configura-
Icon data from source to tion data to create

destination. new controller
with same ad-
dress.

Multiple Controller Copies first controller’s Copies all
Icons configuration list to controller’s con-

destination controller. figurations to
The data in the other create new
controllers is not applied. controllers with

same addresses.

To Copy All Tables by Dragging:

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

Note: If you are copying controllers between areas, display
both the source and destination controller lists. You
can use the Cascade or Tile command in the Win-
dow menu to re-arrange controller list windows.

2. Position the mouse pointer on the controller that you wish to
copy from.

Note: ComfortVIEW allows you to copy multiple control-
lers between areas. Use the Windows-standard
mouse or keyboard techniques to select multiple
controllers. You can however, only select multiple
controllers from the right side of the Controller List
window.

3. Press and hold down the Ctrl key.

4. Press and hold down the mouse button and drag the mouse to
re-position it on the controller that you wish to copy to. If
there is no specific controller that you wish to copy to, re-
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position the mouse on the area icon. This will create a new
controller in the area.

A small square icon appears next to the mouse pointer. A plus
sign appears inside the icon to indicate that you are copying,
not moving, the controller to another area.

5. Release the mouse button and then release the Ctrl key when
the square is positioned on the controller or area you are
copying to.

ComfortVIEW displays a dialog box asking for confirmation
before copying the controller.

6. Click on Yes to complete the copy or click on No to prevent the
copy from taking place. If you have selected multiple control-
lers and wish to copy all, click on Yes to All. Clicking on
Cancel aborts the copy. If you have selected multiple control-
lers and wish to step through the copies one by one, click on
Yes.

A Copy Status Box is displayed during the copy. This box
displays each table and block number as it is being copied.
Clicking on Abort will stop the copy.

To Copy All Tables with the Configure Menu’s Copy Command:

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller that you wish to configure (copy from).

Note: ComfortVIEW allows you to copy multiple control-
lers. Use the Windows-standard mouse or keyboard
techniques to select multiple controllers. You can
however, only select multiple controllers from the
right side of the Controller List window.

3. Click on the Configure menu item and then click on Copy.

ComfortVIEW displays the Areas dialog box.

4. In the Select target area: list, click on the area containing the
controller whose tables you wish to copy to, and then click on
OK.

ComfortVIEW displays the CCN Elements dialog box.
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5. Click on the CCN element whose tables you wish to copy to,
and then click on OK.

A confirmation dialog box displays re-confirming the source
and destination controllers.

6. Click on Yes to complete the copy, or on No to prevent the copy.
If you have selected multiple controllers and wish to copy all,
click on Yes to All.

A Copy Status Box is displayed during the copy. This box
displays each table and block number as it is being copied.
Clicking on Abort will stop the copy.

To Copy and Paste Individual Tables:

There are three ways to copy individual tables:

• Dragging and dropping the table icon on top of another table icon
using the mouse

• Choosing the Configure and Copy commands from the menu

• Cutting and pasting selected configuration table cells.

To Copy Individual Tables by Dragging:

1. Display the Controller List window and expand it to display the
configuration table names. If necessary, follow the instructions
listed under Displaying the Controller List and Viewing Con-
figuration Tables.

Note: If you are copying tables between areas, display both
the source and destination controller lists. You can use
the Cascade or Tile command in the Window menu to
re-arrange controller list windows.

2. Position the mouse pointer on the table that you wish to copy
from.

3. Press and hold down the mouse button and drag the mouse to re-
position it on the table that you wish to copy to.

4. Release the mouse button when the square is positioned on the
table you are copying to.

ComfortVIEW displays a dialog box asking for confirmation
before copying the table.
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5. Click on Yes to complete the copy or click on No to prevent
the copy from taking place. Clicking on Cancel aborts the
copy.

To Copy Individual Tables with the Configure Menu’s Copy Com-
mand:

1. Display the Controller List window and expand it to display
the configuration table names. If necessary, follow the in-
structions listed under Displaying the Controller List and
Viewing Configuration Tables.

2. Click on the table that you wish to configure (copy from).

3. Click on the Configure menu item and then click on Copy.

ComfortVIEW displays the Areas dialog box.

4. In the Select target area: list, click on the area containing the
controller whose tables you wish to copy to, and then click
on OK.

ComfortVIEW displays the CCN Elements dialog box.

5. Click on the CCN element whose tables you wish to copy to,
and then click on OK.

ComfortVIEW display the Tables Names dialog box.

6. Click on the table that you wish to copy to and then click on
OK.

A confirmation dialog box displays re-confirming the source
and destination controllers.

7. Click on Yes to complete the copy, or on No to prevent the
copy.

To Copy Individual Cells with Cut and Paste:

ComfortVIEW gives you the capability to copy data from one
configuration table and paste into another configuration table. You
can copy selected or multiple cells.

1. To copy the configuration table data, click on the cell or cells
you wish to copy. Only the Description, Value, and Notes
cells are suitable for copying.

Note: To select an entire column of data, click on the
column header (Description, Value, or Notes). To
select an entire row, click on the box to the left of
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the point description. To select multiple adjacent
cells, drag the mouse.

2. Click on the Edit menu item and then click on Copy.

Note: You may also perform this command by clicking on
the Copy icon in the toolbar.

The selected cell’s data will be copied to the Windows clip-
board. You can now paste this data into another configuration
table.

3. To paste the data into another table, display the destination
table.

4. Click on the destination cell or cells.

Note: To paste into an entire column of data, click on the
column heading.

5. Click on the Edit menu item and then click on Paste.

Note: You may also perform this command by clicking on
the Paste icon in the toolbar.

The selected cell’s data will be copied from the Windows
clipboard to the selected cell.

If you are attempting to paste data into a protected cell or are
attempting to paste incompatible data, an error message
displays. Click on OK to close the error message dialog box.

ComfortVIEW provides you with the capability to transfer control-
lers from one area to any other area in your ComfortVIEW database
by dragging controller icons with the mouse.

When you move a controller, ComfortVIEW transfers the controller
and all of its configuration tables to the specified area. The controller
will now appear in the new area in the controller list. It will no
longer appear in its previous area.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

Note: Moving controllers between areas, display both the
source and destination controller lists. You can use
the Cascade or Tile command in the Window menu
to re-arrange controller list windows.

Moving Controllers
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2. Position the mouse pointer on the controller that you wish to
move.

Note: ComfortVIEW allows you to move multiple control-
lers between areas. Use the Windows-standard
mouse or keyboard techniques to select multiple
controllers. You can however, only select multiple
controllers from the right side of the Controller List
window.

3. Press and hold down the Shift key.

4. Press and hold down the mouse button and drag the mouse to
re-position it on the destination area.

A small square icon appears next to the mouse pointer.

5. Release the mouse button and then release the Shift key when
the square is positioned on the destination area.

ComfortVIEW displays a dialog box asking for confirmation
before moving the controller.

6. Click on Yes to complete the move or click on No to prevent
the move from taking place. Clicking on Cancel aborts the
copy. If you have selected multiple controllers and wish to
step through the moves one by one, click on Yes.

A Move Status Box is displayed during the move. Clicking
on Abort will stop the move.

Note: If ComfortVIEW displays the message Controller
Currently Locked or Controller Is In Use, you have
attempted to move a controller that is currently
being accessed by you or another ComfortVIEW
operator. Attempt the move again when the control-
ler is available.
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You can compare a selected controller’s configuration data with the
associated configuration data that is stored in the ComfortVIEW
database and receive a report of differences that exist.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller whose database you wish to compare.

Note: ComfortVIEW allows you to verify multiple control-
lers. Use the Windows-standard mouse or keyboard
techniques to select multiple controllers.

3. Click on the Configure menu item and then click on Verify.

ComfortVIEW displays a dialog box asking for confirmation
before beginning the controller verify.

4. Click on Yes to verify or click on No to prevent the verify
from taking place. If you have selected multiple controllers
and wish to verify all, click on Yes to All.

A Function Status Box is displayed during the verification.
Clicking on Abort will stop the verify.

When the verification is complete, and the compared configurations
match, the process concludes and the Controller List window re-
displays. If the compared configurations do not match, a dialog box
displays indicating that errors were encountered. If you wish to view
an error report, click on Yes to view a list of differences. This opens
the Windows Notepad application and displays the list of differ-
ences.

To Print the Verification Results:

Click on Notepad’s File menu item and then click on Print.

To Close the Notepad File:

Click on Notepad’s File menu item and then click on Exit.

Verifying
Controller
Configuration
Against Your
Database
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You use the Download command to send configuration table data to
a selected controller. You can download an entire controller or only
a single configuration table. Performing a download overwrites the
configuration at the controller.

When you download an entire controller, ComfortVIEW sends data
from its database to the controller. When you download a single
table, ComfortVIEW sends the on-screen data (which may be
different from its database data) to the controller. You could, for
example, edit table data and send it to the controller without saving
the edited data in the ComfortVIEW database. Instructions on
downloading data to the Comfort Controller can be found in the
Configuring Comfort Controllers section of this chapter.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller whose configuration you wish to
download.

Note: ComfortVIEW allows you to download multiple
controllers. Use the Windows-standard mouse or
keyboard techniques to select multiple controllers.
You can, however, only select multiple controllers
from the right side of the Contoller List window.

3. Click on the Configure menu item and then click on Down-
load.

Note: You may also perform this command by clicking on
the Download icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before downloading.

4. Click on Yes to complete the download or click on No to
prevent the download from taking place. If you have selected
multiple controllers and wish to download all, click on Yes to
All. Clicking on Cancel aborts the download.

A function status box that indicates the table and block that
are downloading is displayed during the process. The control-
ler list re-displays on completion.

Downloading
ComfortVIEW
Data to
Controllers

To Download
an Entire
Controller
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To Download
a Specific
Table

When the download successfully completes, the Controller List
window re-displays. If there are errors encountered during the
download, a dialog box displays indicating that errors were encoun-
tered. If you wish to view an error report, click on Yes. This opens
the Windows Notepad application and displays the error report.

To Print the Notepad Download Error Report:

Click on Notepad’s File menu item and then click on Print.

To Close the Notepad File:

Click on Notepad’s File menu item and then click on Exit.

1. Display the Controller List window and expand it to display
the list of controller tables.

2. Click once on the configuration table you wish to download or
double-click to display the table whose configuration you
wish to download.

3. Click on the Configure menu item and then click on Down-
load.

Note: You may also perform this command by clicking on
the Download icon in the toolbar.

ComfortVIEW sends the configuration from the selected or the
currently-displayed table to the controller. It overwrites the
controller’s current configuration.

You use the Upload command to copy configuration table data from
a selected controller to the ComfortVIEW database. You can upload
an entire controller or only a single configuration table.

Performing a controller upload overwrites the controller’s configura-
tion that is stored in the ComfortVIEW database. Performing a table
upload displays the table on-screen for viewing or editing. If desired,
you can save the displayed table data in the ComfortVIEW database.

Uploading
Controller Data
to ComfortVIEW
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Perform the steps below to copy a controller’s configuration data from a
specified controller to the ComfortVIEW database.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller whose configuration you wish to upload.

Note: ComfortVIEW allows you to upload multiple controllers.
Use the Windows-standard mouse or keyboard tech-
niques to select multiple controllers. You can, however,
only select multiple controllers from the right side of the
Controller List window.

3. Click on the Configure menu item and then click on Upload.

Note: You may also perform this command by clicking on the
Upload icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before uploading.

4. Click on Yes to complete the upload or click on No to prevent the
upload from taking place. If you have selected multiple control-
lers and wish to upload all, click on Yes to All. Clicking on Can-
cel aborts the upload.

A function status box that indicates the table and block that are
copying is displayed during the upload. The controller list re-
displays on completion.

When the upload successfully completes, the controller list
re-displays.

Perform the steps below to display a controller’s configuration table on-
screen for viewing or editing. If desired, you can save the displayed
table data in the ComfortVIEW database.

Note: If uploading a UT203 FID, it is recommended that you upload
the entire controller. Uploading individual tables may not
update ComfortVIEW with all of the latest FID values.

1. Display the Controller List window and expand it to display the
list of controller tables.

To Upload
an Entire
Controller

To Upload a
Specific Table
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2. Click once on the configuration table you wish to upload or
double-click to display the table whose configuration you
wish to upload.

3. Click on the Configure menu item and then click on Upload.

Note: You may also perform this command by clicking on
the Upload icon in the toolbar.

ComfortVIEW sends the specified table’s configuration from
the controller to the ComfortVIEW screen. If you have up-
loaded with the configuration table displayed, the table re-
displays after the upload and the controller’s configuration
will be displayed on the screen. You must use the Configure
menu’s Save command to retain the uploaded data in the
ComfortVIEW database.

Follow the steps below to modify and send the time of day, date, day
of week, and holiday status to a selected controller or all controllers
in a selected CCN. The holidays that will be sent are those that are
specified using the ComfortVIEW Global Function Manager appli-
cation.

1. Do one of the following depending on whether you want to
broadcast to a CCN or a single controller:

To broadcast to a CCN:

Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Ac-
cessing the Carrier Network Manager.

To broadcast to a single controller:

Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the CCN or the controller to which you wish to send
time and date information.

3. Click on the CCN Tools menu item and then click on Time/Date.

Note: You may also perform this command by clicking on
the broadcast icon in the toolbar.

Modifying
and Sending

Time and Date



119

ComfortVIEW displays the Broadcast Time and Date dialog box
shown in Figure 2-29.

4. To modify the displayed time and date, enter the new time in the
Set time and date edit box. Valid entries range from 00:00 to
12:59, followed by a to indicate am or p to indicate pm.

5. To modify the displayed day of month, click on the new day in
the calendar. To modify the displayed month, click on the scroll
bar’s down or up arrow.

6. Click in the Today is a holiday box if you wish to indicate the
displayed date as a holiday.

7. Click on OK to close the dialog box and broadcast the time and
date to the selected controller or CCN or,

click on Cancel to close the dialog box and restore the previous
settings.

Broadcast Time and Date

Set time and date

02:30 p

OK Cancel Help...

Today is a holiday

March 1994

Su

1 2 3 4 5

6 7 8 9 10 11 12

19181716151413

20 21 22 23 24 25 26

3130292827

M Tu W Th F Sa

Figure 2-29
Broadcast Time and Date
Dialog Box
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Click on To

the Set time and date edit
box modify the displayed time and date.

Valid entries range from 00:00 to 12:59,
followed by a to indicate am or p to
indicate pm.

a day in the calendar modify the displayed day of month.

the scroll bar’s down or up
arrow modify the month.

the Today is a holiday box indicate the displayed date as a holiday.

OK close the dialog box and broadcast time
and data.

Cancel close the dialog box and restore the
previous settings.

Help display help information.

Clicking on CCN Options in the CCN Tools menu gives you the
capability to display and modify tables in all CCN Options.

In addition, the command gives you the capability to add and delete
tables. This command is an alternative, shortcut method to displaying
and modifying option tables by accessing each option module indi-
vidually as described in the Viewing Configuration Tables and Modi-
fying Configuration Table Values sections of this chapter.

Follow the steps below to display a list of all tables in a selected
option and CCN:

Note: Prior to accessing the option’s tables, you must add the
option to the ComfortVIEW database. For instructions on
adding options, refer to the Adding/Modifying Controllers
section of this chapter.

Table 2-29
Broadcast Time and Date
Dialog Box

Displaying and
Configuring CCN
Options
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1. Display the System Overview window and expand it to
display the database’s CCNs and areas. If necessary, follow
the instructions listed under Accessing the Carrier Network
Manager.

2. Click on the appropriate CCN from the list displayed in the
System Overview window.

3. Click on the CCN Tools menu item, and then click on CCN
Options.

ComfortVIEW displays the CCN Options dialog box shown
in Figure 2-30. This dialog box enables you to select a spe-
cific CCN Option to access. Refer to Table 2-30 following
these instructions for a description of each dialog box field.

4. From the dialog box, select the option you wish to access and
then click on OK. ComfortVIEW displays the Option Table
List window. This table displays the 8-character table name
and the 24-character table description for each option table in
the selected CCN. Figures 2-31 and 2-32 show example
Consumable and History Option Table List windows.

Figure 2-30
CCN Options Dialog Box

Broadcast Time and Date

Set time and date

02:30 p

OK Cancel Help...

Today is a holiday

March 1999

Su

1 2 3 4 5

6 7 8 9 10 11 12

19181716151413

20 21 22 23 24 25 26

3130292827

M Tu W Th F Sa



122

Click on To

an option in the Select
a CCN Option: list select the CCN Option whose tables

you wish to access.

OK close the dialog box and display your
selection.

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

Table 2-30
CCN Options Dialog Box

Figure 2-31
Sample Consumable
Option Table List Window

ComfortVIEW Lab: Consumable Table

CONSM02S: Data Collect Consumable
ComfortVIEW Lab: Consumable Tables

ComfortVIEW Lab: Consumable Tables

CONSM03S: Data Collect Consumable
CONSM04S: Data Collect Consumable
CONSM05S: Data Collect Consumable
CONSM06S: Data Collect Consumable
CONSM07S: Data Collect Consumable
CONSM08S: Data Collect Consumable
CONSM02S: Data Collect ConsumableCONSM09S: Data Collect Consumable
CONSM10S: Data Collect Consumable
CONSM11S: Data Collect Consumable
CONSM12S: Data Collect Consumable
CONSM13S: Data Collect Consumable
CONSM14S: Data Collect Consumable
CONSM15S: Data Collect Consumable
CONSM16S: Data Collect Consumable
CONSM17S: Data Collect Consumable
CONSM18S: Data Collect Consumable
CONSM19S: Data Collect Consumable
CONSM20S: Data Collect Consumable
CONSM21S: Data Collect Consumable
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Figure 2-32
Sample History Option
Table List Window

To Add a New
Consumable
or Runtime
Option Table

Follow the instructions below to add Consumable and Runtime Tables to
the Data Collection Option. For specific information on the Data Collec-
tion Option and its consumable and runtime configuration tables, refer to
the Data Collection Option Overview and Configuration Manual.

1. Display the option table list using the instructions listed under
Displaying and Configuring CCN Options.

2. Click on the Configure menu item, then click on New. In the dialog
box displayed, click on Yes to create a new option table.

Note: You may also perform this command by clicking on the
Enter icon in the toolbar.

ComfortVIEW creates the configuration table in the CCN’s Data
Collection Module, opens that table, and displays it on the screen.

3. Enter the necessary values as desired.

4. To send the data to the option module, click on the Configure
menu item, then click on Download.

5. To save the new table in the ComfortVIEW database, click on the
Configure menu item and then click on Save.

6. Edit the table description to make this table a unique entry in the
option table list and to aid you in identifying the table when select-
ing points for ComfortVIEW reports. If necessary, refer to To
Modify an Option Table Description, which appears later in this
Displaying and Configuring CCN Options sections.

ComfortVIEW Lab: History Table

HSTRM17S: Data Collect History Mst

ComfortVIEW Lab:  History Tables

ComfortVIEW Lab: History Tables

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst
HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst

HSTRM17S: Data Collect History Mst
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Follow the instructions below to add History Tables to the Data
Collection Option. For specific information on the Data Collection
Option and its consumable, runtime, and history configuration
tables, refer to the Data Collection Option Overview and Configura-
tion Manual.

1. Display the Option Table list using the instructions listed
under Displaying and Configuring CCN Options.

2. Click on the Configure menu item, then click on New.

Note: You may also perform this command by clicking on
the icon in the toolbar.

3. In the dialog box displayed, enter the number of slave tables
to be added and linked to the master history table that you are
adding and click on OK.

ComfortVIEW creates the master and slave configuration
tables in the CCN’s Data Collection Module, and then opens
the master table and displays it on the screen. You must open
and configure the slave tables on your own. If necessary, refer
to the instructions listed under To Display and Modify Option
Configuration Tables.

4. Enter the necessary values as desired.

5. To send the data to the option module, click on the Configure
menu item, then click on Download.

6. To save the new tables in the ComfortVIEW database, click
on the Configure menu item and then click on Save.

Note: You may also perform this command by clicking on
the Save icon in the tool bar.

7. Edit the table description to make this table a unique entry in
the option table list and to aid you in identifying the table
when selecting points for ComfortVIEW reports. If neces-
sary, refer to To Modify an Option Table Description, which
appears later in this Displaying and Configuring CCN Op-
tions section.

To Add a New
History Option
Table
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1. Display the option table list using the instructions listed under
Displaying and Configuring CCN Options.

2. Double click on the table name that you wish to display or
modify.

ComfortVIEW will display the selected configuration table.

In the example shown in Figure 2-33, ComfortVIEW displays
the Consumable Configuration Table window.

3. Modify the table data as desired. For detailed instructions on
modifying configuration tables, refer to the Modifying Con-
figuration Table Values section of this chapter.

To Display and Modify
Option Configuration
Tables

Figure 2-33
CCN Consumable
Configuration Table

Administration
United Mutual Insurance - Cold Call List::CONSM52S:DATCOLDT - Consumable 52

File Edit Configure Options HelpWindow

Description Value Units Name Notes

Controller name

Direct connection

Controller name CONS-CNT

Point Name CONS-NAM

Bus # 0 CONS-BUS

Element # 0 CONS-ELE

FID pt.# or PIC table # 0 TABLE-NO

Point type Discrete POINT-TP

ma upper limit 0.00 FID-LIMT

Index 0 CONS-INX

Analog meter type Linear METER-TP

Usage report units USAGE-UN

Rate report units RATE-UN

Number of decimal places 0 DEC-PLAC

Data reset No CONS-RES
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Follow the instructions below to modify an option table description.

Caution: You can modify table descriptions only. Do not change
table names. Doing so will cause the tables to be removed
from subsequent Option Table List windows and
ComfortVIEW Report Panel windows.

1. Display the option table list using the instructions listed under
Displaying and Configuring CCN Options.

2. Click on the table whose description you wish to modify.

3. Click on the Configure menu item, then click on Modify.

ComfortVIEW displays the Table Definition dialog box
shown in Figure 2-34.

4. Enter the new description. A description can consist of up to
24 characters.

5. Click on OK to close the dialog box and save the new table
description, or

Click on Cancel to exit the dialog box and restore the previ-
ous settings.

To Modify an Option
Table Description

Figure 2-34
Table Definition Dialog
Box

Table Definition

Table name:

LDSHDOIE

Table description:

Loadshed Equipment

OK Cancel Help...
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Table 2-34
Table Definition Dialog
Box

Click on To

the Table name:
description box enter or edit the table description.

OK close the dialog box and save the new
table description.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Follow the instructions below to delete an option table from the Data
Collection Option.

1. Display the Option Table List using the instructions at the
beginning of this section.

2. Click on the table to delete.

3. Click on the Configure menu item, then click on Delete. In
the dialog box displayed, click on Yes to delete the table.

ComfortVIEW relinquishes that table to the option module for
another use.

To Delete any Option
Table
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Configuring
UT203 FIDs

Follow the instructions below to configure a UT203 FID controller. If
necessary, refer to the UT203 FID Overview and Configuration
Manual for an explanation of the UT203 FID’s algorithms and con-
figuration decisions.

Note: ComfortVIEW is compatible with UT203 FID Phase IV and
subsequent version controllers.

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the UT203 FID controller that you wish to configure.

3. Activate the FID points:

a. Click on the Configure menu item and then click on
Controller.

ComfortVIEW displays the FID Point Selection dialog box
shown in Figure 2-35.

b. In the Data Points Available list, select the points that you
wish to activate.

Note:   You can select multiple points using the Windows-
standard mouse or keyboard techniques.

c. Click on Add. The points will appear in the Data Points in
System list.

Note: Use of the Controller command (by you or any
other operator) while displaying any FID table will
result in the display of a  Controller in use or Con-
troller currently locked message.

4. Assign the point types:

a. In the Data Points in System list, click on the point that you
wish to configure and then click on Modify.

ComfortVIEW displays the FID Point Assignment dialog
box shown in Figure 2-36. The current point name and
description display in the Name and Description text box.

b. If desired, click on the point name and description text
boxes to modify the point name and description.
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c. Click on the point type (Discrete Output, Analog Output,
Analog Input, Discrete Input). The type’s associated
algorithms will display in the Select an algorithm list.

d. In the Select an algorithm list, click to select the point’s
algorithm (control type).

e. Click on OK to close the FID Point Assignment dialog
box.

f. Click to enable the Download new point assignments
option.

g. Click on OK to close the FID Point Selection dialog box.
The Controller List window re-displays.

5. Configure each point’s service configuration tables.

6. Configure each point’s configuration tables.

If necessary, refer to the Viewing Configuration Tables and
Modifying Configuration Table Values sections of this chapter.

Figure 2-35
FID Point Selection Dialog
Box

FID Point Selection 203FID: Air Handler Control - 0,33

OK Cancel Help...

Download new point assignments

IO01:

Data Points in System:

<< Add

Remove >>

IO02:
IO03:
IO04:
IO05:
IO06:
IO11:
IO12:
IO13:
IO14:
IO15:
IO16:
IO17:
IO18:
IO19:

Modify...

IO03:
Analog Input: 3% Humidity

IO07:

Data Points Available:

IO08:
IO09:
IO10:
IO22:
IO23:
IO24:
IO26:
IO27:
IO28:
IO29:
IO30:
IO42:
IO60:
IO61:

Shows the selected data points



130

Click on To

points in the Data Points
Available list select the FID points that you wish to

activate.

Add activate the selected points. The point
names will display in the Data Points
in System list.

Remove de-activate the selected points. The
point names will be removed from the
Data Points in System list and returned
to the Data Points Available list.

Download new point
assignments enable or disable downloading of point

selections to the FID controller.

Modify assign the point type and algorithm to
the point currently selected in the Data
Points in System list. ComfortVIEW
displays the FID Point Assignment
dialog box. Refer to Figure 2-36 and
Table 2-36 for instructions on using
this dialog box.

OK close the dialog box and save settings.

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

Table 2-35
FID Point Selection Dialog
Box
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Figure 2-36
FID Point Assignment
Dialog Box

Click on To

Discrete Output configure this point as a discrete
output.

Analog Output configure this point as an analog
output.

Analog Input configure this point as an analog input.

Discrete Input configure this point as a discrete input.

an algorithm in the Select
an algorithm list select the point's control type.

the Name text box modify the point name.

the Description text box modify the point description.

OK close the dialog box and save settings

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

Table 2-36
FID Point Assignment
Dialog Box
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Configuring
Comfort
Controllers

ComfortVIEW contains a programming interface for the Comfort
Controller. Comfort Controller configuration consists of two phases:

• Creating database objects (hardware and software points, algo-
rithms, setpoints, alarms, functions, and system tables) in the
blank Comfort Controller database.

• Configuring the objects.

If necessary, refer to the Comfort Controller Overview and Configu-
ration Manual (808-891) for a list of the Comfort Controller's
database objects and a description of the accompanying configura-
tion decisions.

The Comfort Controller receives commands from ComfortVIEW as
you work to create and configure the database objects.

Note: The ComfortVIEW Comfort Controller configuration
feature only applies to Comfort Controllers 1600 and 6400
Version 1.3 and greater.

The ComfortVIEW programming interface is very different from
Carrier's Network Service Tool Quickstart and On-line Comfort
Controller configuration tools. ComfortVIEW requires fewer in-
terim steps for the creation of an object and offers an easier method
of object configuration. Also, any object additions, deletions, or
modifications made to the Comfort Controller are also simulta-
neously made to the ComfortVIEW controller database image.

As you use ComfortVIEW to create, delete, or modify objects and
enable the download  to  Comfort Controller option, programming
commands are sent (downloaded) from ComfortVIEW to the Com-
fort Controller. As this happens, ComfortVIEW creates an image of
the controller in its own database. ComfortVIEW records and
maintains all controller object changes made in this way. As a result,
you never have to upload your Comfort Controller to the
ComfortVIEW database, and any changes that are made to the
number and types of controller objects are automatically synchro-
nized with the contents of your ComfortVIEW database. You must
still, however, save and manually download Comfort Controller
table configuration changes.

As long as you enable the download to Comfort Controller option,
and also download table configuration changes to the controller, the
ComfortVIEW database remains synchronized with the actual

Important Features
and Considerations
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controller object database and configuration. If, however, you opt
not to download an object or configuration table change from
ComfortVIEW to the Comfort Controller, you will have a mismatch
between the controller's and the ComfortVIEW database.

If you suspect a mismatch between the Comfort Controller and the
ComfortVIEW database, perform a controller verification by click-
ing on the Configure menu item and then clicking on Verify . Any
differences will be detected and recorded for your viewing. If there
are differences that you wish to rectify, either upload the existing
Comfort Controller to ComfortVIEW or download the existing
ComfortVIEW database to the Comfort Controller.

If you have programmed and configured a new Comfort Controller
using the Network Service Tool's Quickstart and On-Line configura-
tion tools or some other user interface, simply upload the controller
to ComfortVIEW. Once it is uploaded, you can use ComfortVIEW
to make all future configuration changes.

If you use the Network Service Tool's Quickstart and On-Line
configuration tools, or some other user interface to locally make
object or configuration modifications to a Comfort Controller that
already exists in the ComfortVIEW database, simply upload the
controller to ComfortVIEW. There is no need to delete the Comfort
Controller and re-add it to the ComfortVIEW database, as there was
in previous ComfortVIEW versions. Uploading makes all the
necessary changes to the ComfortVIEW database to keep
ComfortVIEW and the Comfort Controller's database synchronized.

Note: Uploading a Comfort Controller to an existing Comfort
Controller in the ComfortVIEW database will overwrite
the ComfortVIEW database as necessary in order to create
an exact image of the actual Comfort Controller database.
It is recommended that you use the Verify command prior
to performing the upload to note the differences in the two
databases.

If you use ComfortVIEW to assign custom engineering units to a
Comfort Controller point, the custom units will not display if you
use another user interface to display the point.

Recovering from
Database Mismatch

Use of Other User
Interfaces to Program
Comfort Controllers
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This procedure provides instructions for creating, modifying, and
configuring objects in the ComfortVIEW database, and optionally
creating and configuring them in the Comfort Controller. Prior to
beginning these instructions, you must add the Comfort Controller
to your ComfortVIEW database. For instructions on adding control-
lers, follow the instructions in the Adding/Modify Controllers
section of this Carrier Network Manager chapter.

If desired, you can perform this procedure without being physically
connected to an actual Comfort Controller. Use the Comfort Controller
Version 1.3 templates that are provided with your ComfortVIEW
software for importing.` These templates are named CC640013.CWX
and CC160013.CWX and are located in the directory path
\CCNPATH\TEMPLATE. This directory path will be located in the
\CVIEW , \CWORKS or other directory in which you installed
ComfortVIEW. Once your configuration is complete, you can export
the file to disk in order to import it at another ComfortVIEW site, or
you may connect a Comfort Controller to your ComfortVIEW PC and
download the configuration to the Comfort Controller. For Comfort
Controller downloading instructions, refer to Downloading
ComfortVIEW data to a Comfort Controller, which appears later in this
Configuring Comfort Controllers section.

1. Display the Controller List window. If necessary, follow the
instructions listed in the Displaying the Controller List sec-
tion of this chapter.

2. Click on the Comfort Controller that you wish to create.

3. Click on the Configure menu item and then click on Controller.

ComfortVIEW displays the Configure Comfort Controller
tabbed dialog box shown and described in Figure 2-36a and
Table 2-36a. This dialog box contains a series of tabs, each of
which provides access to the Comfort Controller's different
database objects. When you initially display this dialog box,
the Hardware tab will be selected.

Note: The tabs in this dialog box are arranged in the
recommended order of configuration.

4. Create and configure the hardware and software points that
your application requires by following the Creating and Modi-
fying Hardware and Software Points procedure, which appears
later in these Configuring Comfort Controllers instructions.

Procedure Overview
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5. Create and configure the setpoint schedules that your applica-
tion requires by following the Creating Other Database
Objects: Setpoints, System Tables, Alarms, Functions, Algo-
rithms procedure, which appears later in these Configuring
Comfort Controllers instructions.

6. Create and configure the system tables (Consumable,
Runtime, Holiday, Network Time Schedule, Loadshed,
Language Conversion) that your application requires by
following the Creating Other Database Objects: Setpoints,
System Tables, Alarms, Functions, Algorithms procedure,
which appears later in these Configuring Comfort Controllers
instructions.

7. Create and configure the alarms (Limit, Setpoint Limit,
Discrete State, First Out, Runtime, Number of Starts) that
your application requires by following the Creating Other
Database Objects: Setpoints, System Tables, Alarms, Func-
tions, Algorithms procedure, which appears later in these
Configuring Comfort Controllers instructions.

8. Create and configure the functions (Analog Trace Point,
Discrete Trace Point, Internal Consumable, Adaptive Optimal
Start/Stop, Network Broadcast, Linkage/AOSS Schedule,
Night Time Free Cooling, Occupancy) that your application
requires by following the Creating Other Database Objects:
Setpoints, System Tables, Alarms, Functions, Algorithms
procedure, which appears later in these Configuring Comfort
Controllers instructions.

9. Create and configure the algorithms that your application
requires by following the Creating Other Database Objects:
Setpoints, System Tables, Alarms, Functions, Algorithms
procedure, which appears later in these Configuring Comfort
Controllers instructions.

10. After you create and configure all database objects, click on
the Configure Comfort Controller dialog box's Close button.
ComfortVIEW closes the dialog box and proceeds to build
the status display tables. A message dialog box displays
during this process.
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Figure 2-36a
Configure Comfort
Controller Dialog Box

Modify...

Hardware points:

Configure CC6400: ComfortController 6400 - 0, 101

SPT_01: Space Temperature 01 New...

Clone...

Configure...

Delete...

Alarms Functions AlgorithmsSetpoints SystemHardware Software

Temperature input
Hardware channel 01

Database status...

SAT_01: Supply Air Temp 01
RAT_01: Return Air Temp 01
MAT_01: Mixed Air Temp 01
FAN_01: Fan Status 01
Channel 06: unconfigured
Channel 07: unconfigured
Channel 08: unconfigured
CCV_01: Cooling Coil Valve 01
Channel 10: unconfigured
Channel 11: unconfigured
Channel 12: unconfigured
Channel 13: unconfigured
Channel 14: unconfigured

Delete marked...

Unmark all... Close Help...
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Click on To

the Hardware, Software,
Setpoints, System, Alarms,
Functions, or Algorithms tab select the category of object to create

or modify. If necessary, refer to the
Terminology section at the beginning
of this Carrier Network Manager
chapter for an explanation and list of
tables in each of these categories.

a point in the Hardware
or Software points list
(available under Hardware
or Software tab only) select the point to create or modify.

a setpoint, system
table, alarm, function, or
control algorithm name
(available under Setpoints,
System, Alarms, Functions,
or Algorithms tab only) select the database object to modify.

New create a new database object.
ComfortVIEW will display the Object
Definition dialog box. Refer to Figure
2-37 and Table 2-37 for instructions
on using this dialog box.

Modify modify the selected database object's
name, description, and units.
ComfortVIEW will display the Object
Definition dialog box. Refer to Figure
2-37 and Table 2-37 for instructions
on using this dialog box.

Configure modify the configuration table for the
selected database object. For detailed
instructions on modifying configura-
tion table values, refer to the Modify-
ing Configuration Table Values
section of this Carrier Network Man-
ager chapter.

       (continued)

Table 2-36a
Configure Comfort
Controller Dialog Box
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Clone create a new database object by
replicating the selected database
object and its configuration.
ComfortVIEW displays the Select
Comfort Controller Objects dialog
box. From the list of suggested ob-
jects, select the new object(s) that you
wish to create. ComfortVIEW will
create the selected objects and repli-
cate the existing object's configura-
tion. Refer to Figure 2-38 and Table 2-
38 for detailed instructions on using
this dialog box.

Delete delete the selected object.
ComfortVIEW displays a dialog box
asking for confirmation before delet-
ing the object.

Database status check on the error status and available
program space in your Comfort
Controller database. ComfortVIEW
displays the Database Status dialog
box. If there is a database error,
perform a controller verify to deter-
mine the differences between the
Comfort Controller and the
ComfortVIEW database. For addi-
tional information, refer to Recovering
from Download Errors, which appears
later in this Configuring Comfort
Controllers section.

Delete marked delete the currently-selected objects in
all Configure Comfort Controller
dialog box tabs.

       (continued)

Table 2-36a
Configure Comfort
Controller Dialog Box
(continued)
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Note:   If there are objects selected in
more than one tab, ComfortVIEW will
display the Select Comfort Controllers
Objects dialog box. This dialog box
will display the names of all currently-
selected objects. From the list dis-
played, select the objects that you
wish to delete. Clicking on Select All
will delete all listed objects. Clicking
on Select None will delete none of the
listed objects. ComfortVIEW displays
a dialog box asking for confirmation
before deleting any object.

Unmark all de-select the currently-selected objects
in all Configure Comfort Controller
dialog box tabs.

Close exit the dialog box and restore the
previous settings.

Help display help information.

Follow the instructions below to create a new Comfort Controller
hardware or software point or to modify an existing point's sensor
type, name, or description.

1. In the Configure Comfort Controller dialog box, click on the
Hardware tab to create or modify a hardware point or,

click on the Software tab to create or modify a software point.

The list of configured and unconfigured hardware or software
channels will be displayed. For hardware points, the channels
list depicts the actual controller I/O channel point assignment.
For software points, the channel list depicts internal software
channel assignments.

If you are accessing a Comfort Controller that has been newly
added to the ComfortVIEW database, all points will display
Unconfigured. If you are modifying a previously configured
Comfort Controller, the configured points will display in the

Table 2-36a
Configure Comfort
Controller Dialog Box
(continued)

Creating and
Modifying Hardware
and Software Points
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format Channel Name:  Description where Channel Name
consists of the up to eight-character user-selectable point
name and Description is the up to 24-character point descrip-
tion.

2. Click in the Points list to select the point to create or modify.

3. Click on New to create a new point, or

click on Modify to modify the selected existing point.

ComfortVIEW displays the Object Definition dialog box
shown and described in Figure 2-37 and Table 2-37. If you
are modifying an existing point, the channel type, sensor
type, point name, and description display in the dialog box's
corresponding fields. If the point is currently unconfigured,
all fields will appear blank.

(Continue to Step 4.)

Figure 2-37
Object Definition
Dialog Box

Hardware points:

Create Cancel Help...

Description:

Name:

Sensor type/units:

Temperature input

1 K RTD Temp Sensor

MAT_01

Mixed Air Temp 01

1

Quantity:

Download to Comfort Controller

X

Object Definition
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the Hardware points,
Software points,
Setpoints, System tables,
Alarms, Functions, or
Control Algorithms
drop down list select the object's type. The Name

field will update to reflect the selected
type. The selected type will also
automatically display in the Descrip-
tion field.

the sensor type/units/state
drop down list select the object's sensor type, output

units, or state.

Note:   The name of this list will vary
depending on the type of database
object.

This list will display only those sensor
types, units and states that correspond
to the selected object type. Custom
engineering units will appear at the
bottom of the drop down list. You
define custom units using the Setup
application.

the Name text box modify the displayed object name.
You can enter an up to eight-character
name. This name will display in the
Configure Comfort Controller dialog
box's Points list, in status display
tables, and will also display in the
expanded controller list.

Note:    If you will be creating multiple
similarly-named objects (for example,
hardware points SPT_01, SPT_02,
SPT_03, etc.) adding the ** characters
to the point name in place of the
existing numbers expedites the cre-
ation process. For instructions on
using this feature, refer to Creating

       (continued)

Table 2-37
Object Definition
Dialog Box
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Multiple Similarly-Named Database
Objects, which appears later in this
Configuring Comfort Controllers
section.

the up or down arrow
beside the Name text box increment or decrement the numerical

portion of the object name.

This option is available for Comfort
Controller System objects in which
you can modify only the numerical
portion of the table name (Consum-
able, Runtime, Network Time Sched-
ule, Loadshed, Occupancy, and Holi-
day Tables). The text portion of the
table name must remain as displayed.
Clicking on the up or down arrow
leaves the table name as is and only
modifies the number.

Note:   Clicking on the up arrow when
the uppermost table number is dis-
played causes ComfortVIEW to
replace the numerical portion of the
table name with the characters ** and
to enable the Quantity field, which
gives you the capability to simulta-
neously create multiple tables.

Quantity create multiple similarly-named
objects (for example, hardware points
SPT_01, SPT_02, etc.). Enter the
desired number of tables or click on
the up or down arrow to increment or
decrement the displayed value. This
field is enabled only if you include the
** characters in the Name text box.
For additional information on this
feature, refer to Creating Multiple
Similarly-Named Objects, which

       (continued)

Table 2-37
Object Definition
Dialog Box
(continued)
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appears later in this Configuring
Comfort Controllers section of the
manual.

Note:   ComfortVIEW limits the value
that you are permitted to enter in the
Quantity field depending on the object
type and on the number of currently
existent Comfort Controller objects.
For example, if two occupancy tables
currently exist, you will not be permit-
ted to enter a value greater than 97 in
this field. (Assuming that a maximum
of 99 occupancy tables are available in
the Comfort Controller.)

After you click on Create,
ComfortVIEW will create the speci-
fied number of tables and display the
newly-created table names in the
Select Comfort Controller Objects
dialog box. In this dialog box you will
have the opportunity to modify the
table names and descriptions. Refer to
Figure 2-38 and Table 2-38 for instruc-
tions on using this dialog box.

the Description text box modify the displayed object descrip-
tion. You can enter an up to 24-
character description. This description
will display in the Configure Comfort
Controller dialog box's Hardware
points, Software points, Setpoints,
System tables, Alarms, Functions, or
Control Algorithms list. The descrip-
tion will also display in status display
tables, and in the expanded controller
list.

                   (continued)

Table 2-37
Object Definition
Dialog Box
(continued)
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Note:    If you will be creating multiple
similarly-named objects (for example,
hardware points SPT_01, SPT_02,
SPT_03, etc.) you can enter the **

characters in this field to expedite the
channel creation process. For instruc-
tions on using this feature, refer to
Creating Multiple Similarly-Named
Database Objects, which appears later
in this Configuring Comfort Control-
lers section of the manual.

Download to
Comfort Controller create or modify this object in the

Comfort Controller as well as save it
in the  ComfortVIEW database. The
download, however, does not actually
occur until you click on Create.

Create create the new Comfort Controller
object. ComfortVIEW displays a
message dialog box during the object
creation.

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

4. In the Object Definition dialog box, select the point type by
clicking in the Hardware or Software Points drop down list.

Note: For the Comfort Controller 1600, the displayed
channel types are limited to correspond to the 1600's
available channel type selection.

If you are modifying an existing point,
ComfortVIEW will not permit you to modify the
displayed point type. To do so, you must delete the
point by clicking on the Configure Comfort Control-
ler dialog box's Delete button and then create a new
point of the desired type.

Table 2-37
Object Definition
Dialog Box
(continued)
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The Name field will update to reflect the selected point type.
For example, if you are creating a point on Channel 8 and
select the point type Milliamp Output, the point name
MAOUT08 will automatically display in the Name field.

The selected point type will also automatically display in the
Description field.

5. If desired, you can modify the point name and description by
clicking in the appropriate fields.

The point name and description will display in the Points list,
in status display tables, and in the expanded controller list.

Note: If you will be creating multiple similarly-named
channels  (for example, SPT_01, SPT_02, SPT_03,
etc.), you can enter the ** characters in the numeric
fields of these names to expedite the channel cre-
ation process. For instructions on using this time
saving feature, refer to Creating Multiple Similarly-
Named Database Objects, which appears later in this
Configuring Comfort Controllers section of the
manual.

6. Select the sensor type or output units by clicking in the
Sensor Type/Units drop down list.

Note: The sensor type list will display only those sensor
types that correspond to the selected point type. To
select custom engineering units, pull down to the
bottom of the list. Custom units are defined using
ComfortVIEW Setup application.

7. If you wish to create or modify this channel in the Comfort
Controller as well as in the ComfortVIEW database, click on
Download to Comfort Controller.

Note: If you do not select this option, ComfortVIEW will
create the channel only in its database. The channel
will not be created in the Comfort Controller. If
desired, you can work off-line and create the con-
figuration in the ComfortVIEW database only.
Then, when you are ready to send the information to
the Comfort Controller, you can simply perform a
controller download of the entire configuration
using the Configure menu's Download command.
To Download an entire Comfort Controller instruc-
tions, refer to the instructions which appear later in
this Configuring Comfort Controllers section.
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When working off-line, however, be sure to keep
track of the amount of Comfort Controller memory
you will be using. Refer to the EEPROM Memory
Usage Summary Sheet in the Comfort Controller
Overview and Configuration Manual for approxi-
mate database object memory usages.

8. Click on Create to create the new or modified point informa-
tion and display the configuration table, or

Click on Cancel to exit the dialog box and restore the previ-
ous settings.

ComfortVIEW displays a message dialog box during the
creation process. At the conclusion, the point's configuration
table is displayed.

9. You can opt to configure the point here, or you can exit the
configuration table and return to configure the point at a later
time using the Configure Comfort Controller dialog box's
Configure button. For configuration instructions, refer to
Configuring Database Objects, which appears later in this
Configuring Comfort Controllers section.

Follow the instructions below to create or modify the following
Comfort Controller database objects:

• Setpoint schedules
• System tables (Consumable, Runtime, Holiday, Network Time

Schedule, Loadshed, Language Conversion)
• Alarms (Limit, Setpoint Limit, Discrete State, First Out,

Runtime, Number of Starts)
• Functions (Analog Trace Point, Discrete Trace Point, Internal

Consumable, Adaptive Optimal Start/Stop, Network Broadcast,
Linkage/AOSS Schedule, Night Time Free Cooling, Occupancy)

• Algorithms.

Note: ComfortVIEW gives you the capability to create up to 99
setpoint schedules. If you are using Carrier's Network
Service Tool or Building Supervisor interface, however,
you will only be able to access the first 16 of these sched-
ules. The same situation holds true for alarms, functions,

Creating and
Modifying Other
Database Objects:
Setpoints, System
Tables, Alarms,
Functions, Algorithms
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and algorithms. ComfortVIEW allows you to create an
unlimited number of these objects. If you are using the
Network Service Tool or Building Supervisor, however,
you will only have access to the first 96 objects of these
types in the Comfort Controller 6400 and the first 24 in
the Comfort Controller 1600. You will still, however, be
governed by the amount of available Comfort Controller
memory.

1. In the Configure Comfort Controller dialog box, click on the
tab that corresponds to the type of database object you wish
to create or modify:

Setpoint
System
Alarms
Functions
Algorithms

A list of existing database objects will be displayed in the
format Object Name:  Description where Object Name
consists of the up to eight-character user-selectable name and
Description is the up to 24-character description. If you are
accessing a Comfort Controller that has been newly added to
the ComfortVIEW database, this list will be empty.

2. Click on New to create a new object, or

select an existing object and then click on Modify to modify
the selected object's type/units/state, name, or description.

ComfortVIEW displays the Object Definition dialog box
shown and described in Figure 2-37 and Table 2-37. If you
are modifying an existing object, the object's identification
information will display in the corresponding fields. If you
are adding a new object, all fields will appear blank.

3. In the Object Definition dialog box, select the object type by
clicking in the top most drop down list. Depending on the
type of database object you are working with, this list will be
labelled Setpoints, System tables, Alarms, Functions, or
Control Algorithms drop down list.

Note: If you are modifying an existing object,
ComfortVIEW will not permit you to modify the
displayed object type. To do so, you must delete the
object by clicking on the Configure Comfort Con-
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troller dialog box's Delete button and then create a
new one of the desired type.

The Name field will update to reflect the selected object type.
For example, if you are creating a system table and select the
system table type Holiday, the name HOLDY01 will auto-
matically display in the Name field.

Note: When naming new tables, ComfortVIEW keeps
track of existing table instances. For example, If
HOLDY01 and 02 already exist, ComfortVIEW
would name a new table HOLDY03.

The selected object type will also automatically display in the
Description field.

4. If desired, you can modify the object name and description by
clicking in the appropriate fields.

Note: You cannot modify the full name of system objects.
You can only modify the numerical portion of the
name. To do this, click on the up or down arrow that
is located beside the Name text box.

The name and description will display in the expanded con-
troller list.

Note: If you will be creating multiple similarly-named
objects  (for example, multiple Limit Alarm objects,
LMALM_01, LMALM_02, LMALM_03, etc.), you
can enter the ** characters in the numeric fields of
these names to expedite the object creation process.
For instructions on using this time saving feature,
refer to Creating Multiple Similarly-Named Data-
base Objects, which appears later in this Configur-
ing Comfort Controllers section of the manual.

5. Select the sensor type, output units, or state by clicking in the
Sensor Type/Units/State drop down list.

6. If you wish to create or modify this object in the Comfort
Controller as well as in the ComfortVIEW database, click on
Download to Comfort Controller.

Note: If you do not select this option, ComfortVIEW will
create the object only in its database. The object
will not be created in the Comfort Controller. If
desired, you can work off-line in this way and create
the configuration in the ComfortVIEW database
only. Then, when you are ready to send the informa-
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tion to the Comfort Controller, you can simply
perform a controller download of the entire configu-
ration using the Configure menu's Download com-
mand.

When working off-line, however, be sure to keep
track of the amount of Comfort Controller memory
you will be using. Refer to the EEPROM Memory
Usage Summary Sheet in the Comfort Controller
Overview and Configuration Manual for approxi-
mate database object memory usages.

7. Click on Create to create the the new or modified object and
display the configuration table, or

Click on Cancel to exit the dialog box and restore the previ-
ous settings.

ComfortVIEW displays a message dialog box during the
creation process. At the conclusion, the point's configuration
table is displayed.

8. You can opt to configure the object here, or can exit the
configuration table and return to configure the object at a later
time using the Configure Comfort Controller dialog box's
Configure button. For configuration instructions, refer to
Configuring Database Objects, which appears later in this
Configuring Comfort Controllers section.

ComfortVIEW includes a feature that is designed to expedite the
creation of multiple similarly-named and/or similarly-described objects
(For example, SPT_01 (Space Temperature 01), SPT_02 (Space Tem-
perature 02), SPT_03 (Space Temperature 03)). You initiate this feature
while creating or modifying an existing database object.

To create multiple objects:

1. Following the instructions listed under Creating and Modify-
ing Hardware and Software Channels or Creating and Modi-
fying Other Database Objects: Setpoints, System Tables,
Alarms, Functions, Algorithms, display the Object Definition
dialog box.

2. In the Object Definition dialog box's name and description
fields, substitute the characters ** in place of the numerical
portion. (For example, for a hardware point, enter SPT_** in
the Name field and Space Temperature ** in the Description
field.)

Creating Multiple
Similarly-Named
Database Objects
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Note: For System objects, you are not permitted to modify
the name or description. You must display the ** by
clicking on the up arrow that is located next to the
Name field.

This enables the Quantity field.

3. In the Quantity field, enter the number of tables that you wish
to create (For example, 3.)

After you click on the dialog box's Create button,
ComfortVIEW will create the specified number of tables and
will substitute the ** portion of the name with an instance
number.

In the above example, ComfortVIEW would create the
following tables (assuming you currently have Channel 01
selected in the Hardware Channels list):

SPT_01 (Space Temperature 01)
SPT_02 (Space Temperature 02)
SPT_03 (Space Temperature 03).

Note that if you have Channel 02 selected, ComfortVIEW
would create SPT_02, SPT_03, and SPT_04.

ComfortVIEW will then display the Select Comfort Control-
ler Object dialog box. This dialog box lists the newly-created
table names and descriptions and gives you the opportunity to
modify them.

4. In the Select Comfort Controller dialog box, make any de-
sired modifications by selecting the object to modify and
clicking on Modify.  Refer to Figure 2-38 and Table 2-38 for
instructions on using the Select Comfort Controller Objects
dialog box.

5. Click on the individual objects that you wish to create or click
on Select all to select all displayed objects.

6. Click on OK to create the objects or on Cancel to exit the
dialog box.

ComfortVIEW displays the message Create object(s) in
Comfort Controller also?.

7. Click on Yes to create (download) the object in both
ComfortVIEW and the Comfort Controller. Click on No to
create the object in the ComfortVIEW database only.
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an object in the
Selected objects list select the object.

Select all select all objects in the list.

Select none de-select all objects.

Modify modify the selected object's name and
description. ComfortVIEW displays
the Modify Object dialog box. Refer
to Figure 2-39 and Table 2-39 for
instructions on using this dialog box.

OK exit the dialog box and save settings.

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

Figure 2-38
Select Comfort
Controller Objects
Dialog Box

CCCV_02: - Cooling CV
CCCV_03: - Cooling CV
CCCV_04: - Cooling CV
CCCV_05: - Cooling CV

Select Comfort Controller Objects

Selected objects:

CCCV_06: - Cooling CV
CCCV_07: - Cooling CV
CCCV_08: - Cooling CV
CCCV_09: - Cooling CV
CCCV_10: - Cooling CV
CCCV_11: - Cooling CV
CCCV_12: - Cooling CV

Modify... Select all

Select none

OK Cancel Help...

Table 2-38
Select Comfort
Controller Objects
Dialog Box
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Figure 2-39
Modify Object
Dialog Box

Click on To

Name edit the object's name. You can enter
up to 8-alphanumeric characters.

Description edit the object's description. You can
enter up to 24-alphanumeric charac-
ters.

Channel set a hardware or software point's
channel number.

OK exit the dialog box and save settings.

Cancel exit the dialog box and restore the
previous settings.

Help display help information.

Table 2-39
Modify Object
Dialog Box

Modify Object

Description:

Name:

OK Cancel Help...

16

Channel:

TEMPIN16

Temperature input 16
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Follow the instructions below to configure a Comfort Controller
object.

Prior to beginning this procedure, you must create the object. If
necessary, refer to Creating and Modifying Hardware and Software
Points or Creating and Modifying Other Database Objects: Set-
points, System Tables, Alarms, Functions, Algorithms for instruc-
tions on creating objects. These instructions appear earlier in this
Configuring Comfort Controllers section.

1. Display the object's configuration table.

Note: ComfortVIEW automatically displays the configura-
tion table as the last step in the new point or object
creation process. You can also display an object's
configuration table at any time by clicking on the
Configure Comfort Controller tabbed dialog box's
Configure button, or by selecting the configuration
table from the expanded controller list.

2. Modify the configuration table data as desired. For detailed
instructions on modifying configuration tables, refer to the
Modifying Configuration Table Values section of this chap-
ter.

Note: Be sure to Save each table modification. If you are
operating on-line with a Comfort Controller, down-
load your table modifications to the Comfort Con-
troller.

In certain configuration tables, you may notice a
magenta (pink) shading on point names and descrip-
tions. This shading indicates the availability of
ComfortVIEW List Entry (F7) feature. List Entry is
designed to expedite the configuration process.
Refer below to List Entry for instructions on using
this feature.

The presence of magenta shading on a point name indicates that the
List Entry feature is available. This feature helps expedite the
configuration process by presenting a list of available entries for a
configuration decision. If a configuration decision's point name and
description text includes a magenta (pink) shading, you can use this
timesaving feature by following the steps below.

1. In the configuration table worksheet, position the cursor on
the magenta-shaded Name or Description cell.

Configuring Database
Objects

List Entry
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2. Press the F7 key.

ComfortVIEW will display the Current Object Set dialog box,
which will display a list of previously-created Comfort
Controller objects that are eligible entries for the decision.

For example, if a magenta-shaded configuration decision is
asking for a time schedule name, you can press the F7 key
and display a list of the time schedules that are available in
the controller. Note that you must have previously created the
time schedules in the Comfort Controller.

3. In the Current Object Set dialog box, select the name of the
object that you would like to enter into this configuration
decision, and click on OK.

ComfortVIEW will place your selected object name in the
selected Name cell.

Be sure to Save each table modification. If you are operating
on-line with a Comfort Controller, download your table
modifications to the Comfort Controller.

Figure 2-40
Current Object Set
Dialog Box

CCCV_02: - Cooling CV
CCCV_03: - Cooling CV
CCCV_04: - Cooling CV
CCCV_05: - Cooling CV

Current Object Set

Select object:

OK Cancel Help...
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Click on To

an object name select the desired Comfort Controller
object.

OK place the selected object name into the
selected cell.

Cancel exit the dialog box without making a
selection.

Help display help information.

While viewing configuration tables, the Carrier Network Manager
provides you with a short cut to display and modify a configuration
entry's associated configuration, maintenance, time schedule, or
setpoint table.

Follow the instructions below:

1. In the configuration table worksheet, position the cursor on a
configuration decision's Name or Description cell.

2. Click on the Configure menu item and then click on one of
the following commands, depending on the type of table you
wish to display:

Configuration
Maintenance
Time Schedule
Setpoint

ComfortVIEW  displays the Table Jump Selection dialog
box, which contains a list of the controller's configuration,
maintenance, time or setpoint schedule tables.

Note: If you select the Configuration or Maintenance
command from a magenta-shaded cell,
ComfortVIEW will jump directly to the configura-
tion entry's associated configuration or maintenance
table.

3. From the Table Jump Selection dialog box, select the table
that you wish to display and then click on OK.

ComfortVIEW will display the selected table.

Table 2-40
Current Object Set Dialog
Box

Table Jumps from
Configuration Tables
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While viewing configuration tables, the Carrier Network Manager
provides you with a means to list the names of all Comfort Control-
ler objects that are using the selected configuration entry in their
configuration. This feature, however, is available only for those
configuration decisions that contain a magenta (pink) highlighting.

To display a configuration entry's associated objects:

1. In the configuration table worksheet, position the cursor on
the magenta-highlighted Name or Description cell for the
configuration decision.

2. Click on the Configure menu item and then click on
Reference tables.
ComfortVIEW displays the Table Jump Selection dialog box,
which contains a list of all Comfort Controller object tables
that use the selected configuration point.

3. If desired, you can display a selected object's associated
configuration or maintenance table by following the steps
below:

a. Click on the object name.

b. Click on Configuration or Maintenance.

c. Click on OK.

ComfortVIEW will display the selected configuration or
maintenance table.

Reference Jumps
from Configuration
Tables
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Click on To

a table or object name select the Comfort Controller table or
object.

Maintenance
(available for the
Reference table
command only) display the selected object's mainte-

nance table.

Configuration
(available for the
Reference table
command only) display the selected object's configura-

tion table.

OK display the selected table.

       (continued)

Table 2-41
Table Jump Selection
Dialog Box

Figure 2-41
Table Jump Selection
Dialog Box

CCCV_02: - Cooling CV
CCCV_03: - Cooling CV

Table Jump Selection

Select reference table:

OK Cancel Help...

Configuration table

Maintenance table
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Click on To

Cancel exit the dialog box without making a
selection.

Help display help information.

As with all other controllers, you use the Download command to
send configuration table data to the Comfort Controller. You can
download the entire controller or only a single configuration table.

When you download an entire Comfort Controller, ComfortVIEW
sends data from its database to the controller. You can optionally
re-program the entire Comfort Controller with the ComfortVIEW
database data, or preserve the Comfort Controller data and add only
new or revised objects in the Comfort Controller database.

To Download a Specific Table:  To download a specific Comfort
Controller configuration table, display the configuration table and
click on the Configure menu item and then click on Download.

Note: You may also perform this command by clicking on the
Download icon in the toolbar.

ComfortVIEW sends the configuration shown on-screen to the
controller. It overwrites the controller's current configuration.

To Download an Entire Comfort Controller:

1. Display the Controller List window and select the Comfort
Controller whose configuration you wish to download.

2. Click on the Configure menu item and then click on Down-
load.

Note: You may also perform this command by clicking on
the Download icon in the toolbar.

ComfortVIEW displays a message dialog box with the ques-
tion Should the Comfort Controller be initialized?

3. Clicking on Yes will cause the entire Comfort Controller
database to be re-programmed with the configuration con-
tained in the ComfortVIEW database.

Table 2-41
Table Jump Selection
Dialog Box
(continued)

Downloading
ComfortVIEW Data to
a Comfort Controller
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Clicking on No will cause the existing Comfort Controller
database to be preserved and will add only new or revised
objects that do not yet exist in the Comfort Controller data-
base.

Caution:  If you answer Yes, all controller outputs will be-
come unconfigured (disabled) for the period of time
that it takes to complete the download and re-
programming. If you answer No, all controller
outputs will be held at their last commanded state as
your new objects are added and as any object modi-
fication are made.

A function status box displays during the download process.
The controller list re-displays on successful completion. If
there are errors encountered during the download, a dialog
box displays indicating that errors were encountered. If you
wish to view an error report, click on Yes. This opens the
Windows Notepad application and displays the error report.

Recovering from Download Errors:

A typical Comfort Controller download failure indicates that one or
more Comfort Controller objects could not be created. Typically,
these errors mean that you have run out of available memory space
in the Comfort Controller. Follow the steps below to examine the
database status of your Comfort Controller:

1. Display the Controller List window and click on the control-
ler that you have just attempted to download.

2. Click on the Configure menu item and then click on Controller.

ComfortVIEW displays the Configure Comfort Controller
dialog box.

3. Click on the dialog box's Database status button.

ComfortVIEW displays the Database Status dialog box. Refer
to Table 2-42 for an explanation of the fields in this dialog
box and recommended actions.
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Field Value Recommended Action

Database error Yes Examine available bytes of
memory. If the Comfort Controller
is near 100% utilization for either
category, it is likely that the objects
that you have tried to create would
not fit into available Comfort
Controller memory space.
ComfortVIEW discontinues the
object creation process if you run
out of controller memory. To clear
this error, delete one of the existing
objects. Free memory space for the
creation of additional objects by
deleting less important objects. If
the Comfort Controller has an
existing Database Error, do NOT
upload the Comfort Controller to
ComfortVIEW. You risk losing
your last known good configuration.

EEPROM error Yes Follow instructions for Database
error. If condition persists, reset the
Comfort Controller using the RJ-14
reset jumper. If the Comfort Con-
troller has an existing EEPROM
Error, do NOT upload the Comfort
Controller to ComfortVIEW. You
risk losing your last known good
configuration.

RAM error Yes Follow instructions for Database
error.  If condition persists, reset the
Comfort Controller using the RJ-14
reset jumper. If the Comfort Con-
troller has an existing RAM Error,
do NOT upload thea Comfort
Controller to ComfortVIEW. You
risk losing your last known good
configuration.

Table 2-42
Database Status Dialog
Box and Recommended
Actions
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Viewing or Modifying
BEST++ Tables

Follow the instructions below to directly access and view BEST++
maintenance and configuration table program variables. You must
be communicating (operating on-line) with the Comfort Controller
in order to access these BEST++ tables.

1. Display the System Overview window and expand it to
display the database’s CCNs and areas. If necessary, follow
the instructions listed under Accessing the Carrier Network
Manager.

2. Display the controller list. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

3. Double click on a controller to view its table categories.

4. Double click on BEST++ Tables.

5. In the right half of the window, double click on BEST++
Program List. ComfortVIEW displays the BEST++ Programs
dialog box. Refer to Figure and Table 2-42A for instructions
on using this dialog box.

Note:  You must be communicating with the Comfort
Controller to access these tables.

6. In the BEST++ Programs dialog box, select the BEST++
program and then click on Configuration table or Mainte-
nance table and OK to display the corresponding BEST++
table.

7. You can modify BEST++ configuration table or force mainte-
nance table data. If necessary, refer to the Modifying Con-
figuration Table Values or Modifying (Forcing) Status Dis-
play or Maintenance Table Values section of this chapter for
instructions.

Note: Be sure to Save and Download any configuration
table modifications.
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Figure 2-42A
BEST++Programs
Dialog Box

CHILLER:  Custom Program chiller
AH: Custom program ah

BEST++ Programs

Select a BEST++ program:

OK Cancel Help...

Configuration table

Maintenance table

Selects an object for table display

Table 2-42A
BEST++Programs
Dialog Box

Click on To

a program in the
Select a BEST++ program
list select the BEST++ program whose

configuration or maintenance table
you wish to display.

Configuration table to display the configuration table for
the selected BEST++ program.

Maintenance table to display the maintenance table for
the selected BEST++ program.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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ComfortVIEW gives you the capability to back up an entire
controller’s database to another directory, sub-directory, or drive.
You should make it a practice to periodically back up your control-
ler database in the event that a malfunction should occur with your
hard disk.

Export copies the selected controller’s entire database to the speci-
fied drive. This drive can be the ComfortVIEW floppy diskette
drive, another ComfortVIEW hard drive partition, or another com-
puter on the local area network. The information that will be copied
includes:

• the controller name, description, and address
• configuration data.

This database information can be copied back, or imported to
ComfortVIEW at any time, using the Configure menu’s New com-
mand. For additional information, refer to the Adding/Modifying
Controllers section of this chapter.

ComfortVIEW also gives you the capability to back up an entire
CCN's database. For instructions on this function, refer to Exporting
CCNs in the Setup chapter of this manual.

Follow the instructions below to export a controller’s database from
the ComfortVIEW hard disk. You can export single or multiple
controllers:

1. Display the Controller List window. If necessary, follow the
instructions listed under Displaying the Controller List.

2. Click on the controller you wish to export.

Note: You can also export multiple controllers. Use the
Windows-standard mouse or keyboard technique to
select multiple controllers from the right side of the
window.

3. Click on File and then click on Export.

Note: You may also perform this command by clicking on
the Export icon in the toolbar.

ComfortVIEW will display either the Save As dialog box or
the Select Directory dialog box, depending on whether you
have selected a single or multiple controllers.

Exporting
Controller

Configuration
Data
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4. Do one of the following depending on whether you wish to
export a single or multiple controllers:

To export a single controller:

In the File Name edit box, enter a file name for the controller
export file. Use the file extension .CWX, and select the
directory and drive where you want the file saved. Refer to
Table 2-43 for more information on using the Save As dialog
box.

Note: If you want to save the file to another computer on
the local area network, click on Network.

ComfortVIEW displays the Connect Network Drive dialog
box. Select the pre-defined drive and path to where you wish
to save the file, or double click on a computer in the Shared
Directories list and select the desired directory.

To export multiple controllers:

Select the directory path where you wish to save the file.
ComfortVIEW will save the export file to this directory using
the following file naming convention: BxxxCyyy.CWX,
where xxx is the bus number and yyy is the system element
number.

5. Click on OK to save the file to the specified file name and
location.

ComfortVIEW displays a dialog box asking for confirmation
before copying the selected controller. Click on Yes to com-
plete the export, or click on No to prevent the export from
taking place. If you have selected multiple controllers and
wish to export all, click on Yes to All.
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Figure 2-43
Save As Dialog Box

Click on To

the File Name: edit box enter a file name for the file you are export-
ing.

Save File as Type select the ComfortVIEW file type *.CWX.

Directories select a directory where you want the file
saved.

Drives select a drive where you want the file saved.

Network save the file to another computer on the local
area network. ComfortVIEW displays the
Connect Network Drive dialog box. Select
the drive and path to where you wish to save
the file, or double click on a computer in the
Shared Directories list and select the desired
directory. Click on Help to display Win-
dows’  help for further instructions on using
this dialog box. Click on OK to save the
settings. The Save As dialog box re-displays.

OK close the dialog box and save the changes
made.

Cancel exit the dialog box and restore the previous
settings. Any changes made are not saved.

Table 2-43
Save As Dialog Box

File Name:

Network...

Save As

OK

Cancel
*.CWX

Save File as Type: Drives:

d:

d:\

cworks

ccnpath

d:\bsiv

Directories:
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Dedicating
Autodial
Gateways to a
Specific
Operation

If you have more than one Autodial Gateway in a selected CCN, you
can, if desired, reserve selected Gateways to perform the following
operations:

• Timed data retrieval — Reserves the selected Gateway for use
when connecting to remote CCNs to perform automatic timed data
retrieval for ComfortVIEW reports.

• Standard connection — Reserves the selected Gateway for use
when manually connecting to remote CCNs.

• Receipt of Incoming alarms — Reserves the selected Gateway for
use when receiving incoming alarms.

• Transmission of Outgoing alarms — Reserves the selected Gate-
way for use when sending outgoing alarms.

Keep in mind that reserving an Autodial Gateway for a particular
operation does not prevent ComfortVIEW from using the Gateway for
other operations. It only allows ComfortVIEW to make the best
possible selection under the given conditions.

This option is not available if you are using an internal Gateway for
remote CCN communication.

Note: Reserving a Gateway for a particular operation is entirely
optional. If you do not make specific operational assign-
ments, ComfortVIEW automatically selects an idle Gateway
for use.

Follow the steps below to assign operations to Autodial Gateways:

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs and
areas. If necessary, follow the instructions listed under Access-
ing the Carrier Network Manager.

2. Click on the CCN whose Autodial Gateways you wish to
assign.

3. Click on the CCN Tools menu item and then click on Gateways.

ComfortVIEW displays the Gateway Configuration dialog box
(shown in Figure 2-44). This box lists the name and description
of all Gateways in the selected CCN.
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4. Click on an Autodial Gateway and then click on each function
that you wish to assign to it.

Refer to Figure 2-44 and Table 2-44 for information on using
this box.

5. Repeat Step 4 for each Autodial Gateway in the list.

6. Click on OK to close the dialog box and save the settings or,

click on Cancel to close the dialog box and restore the previ-
ous settings.

Note: In the procedure above, you have reserved selected Gate-
ways for particular operations. Keep in mind that you still
must set up each Autodial Gateway’s configuration tables
in order for the Gateway to perform its specific alarm
handling functions.

Figure 2-44
Gateway Configuration
Dialog Box Select a gateway:

Standard connection

Gateway Configuration

AUTODIAL: Autodial Gateway - 0, 51

OK Cancel Help...

Timed data retrieval [reports]

Incoming alarms

Outgoing alarms

AUTODIAL: Autodial Gateway - 0, 50

X

X

Selects a gateway
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Table 2-44
Gateway Configuration
Dialog Box

Click on To

a Gateway in the Select
a Gateway List select a Gateway to which you wish

to assign a function.

Standard connection make this Gateway the one that will
connect to remote CCNs to perform
all ComfortVIEW functions, with the
exception of timed data retrieval.

Note:   An Autodial Gateway assigned
to perform this function in the CCN
Access Definition Dialog Box will
take precedence over this assignment.
Refer to Figure and Table 2-6 for
more information on the CCN Access
Definition Dialog Box.

Timed data retrieval make this Gateway the one that will
connect to remote CCNs to perform
timed data retrieval for
ComfortVIEW reports.

Incoming alarms reserve this Gateway to receive
alarms.

Outgoing alarms reserve this Gateway to send alarms.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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Connecting

to a Remote

CCN Using an

Autodial

Gateway

Follow the steps below to establish a telephone connection to a
remote CCN:

1. Display the Carrier Network Manager’s System Overview
window and expand it to display the database’s CCNs. If
necessary, follow the instructions listed under Accessing the
Carrier Network Manager.

2. Click on the remote CCN with which you wish to communi-
cate. In the System Overview window, remote CCNs are
preceded by an icon as shown at left.

3. Click on the Access menu item and then click on Connect.

Note: You may also perform this command by clicking on
the Connect icon in the toolbar.

ComfortVIEW displays a confirmation dialog box asking if
you wish to connect to the selected CCN(s).

Note: If you have only one Autodial Gateway on your
CCN and are currently connected to another remote
CCN, ComfortVIEW displays a message indicating
that you are unable to connect. Click on OK to close
the message dialog box.

4. Click on Yes to connect or click on No to prevent the connect
from taking place.

You are now connected to the remote CCN. The status area to the
right of the toolbar displays the connect status. You can now use all
ComfortVIEW applications and functions as if you were connected
locally. If, in the Setup application, you have the Setup menu's
Remote status command enabled, the names of all CCNs to which
you are currently connected will display in the Setup's application's
ComfortVIEW Remote Connections window.

You could now use the CCN Tools, Bus Services command to obtain
a list of all system elements on the remote CCN. For further infor-
mation on the Bus Services command, refer to the Carrier Network
Manager Command Summary, which appears at the end of this
chapter.
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Follow the steps below to disconnect from a remote CCN:

Note : You can disconnect while displaying either the System Over-
view or the Controller List window. If you are disconnecting
from the System Overview window, however, you must click
on the remote CCN from which you wish to disconnect prior
to performing the instructions below.

1. Click on the Access menu item and then click on Disconnect.

Note: ComfortVIEW will display the message CCN Is In Use
and you will not be permitted to disconnect if another
operator is currently viewing a status display or mainte-
nance table in the remote CCN.

ComfortVIEW displays a confirmation dialog box asking if you
wish to disconnect to the selected CCN(s).

2. Click on Yes to disconnect or click on No to prevent the discon-
nect from taking place.

When you are disconnected from the remote CCN, the status line dis-
plays Disconnect.

Be aware that ComfortVIEW automatically disconnects you from a
remote CCN if, after an operator-specified number of minutes, no
communication occurs. The Autodial Gateway will generate an alarm to
notify you of an automatic disconnect. For additional information on the
automatic disconnect feature, refer to the explanation of the Phone
Number Configuration dialog box in the Adding and Modifying CCNs
section of this chapter.

Disconnecting
from Remote
CCNs
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The File menu’s Print command provides you with the capability to print
the following reports:

Report Description

System Overview Window A snapshot of the System Overview
window.

Controller List A list of all controllers in a selected area.
Included for each controller is its 8 charac-
ter controller name, address, and a list of
all tables in the controller.

Controller Database A list of all configuration tables in a
selected controller. Included for each
configuration table is its 8 character table
name, the description, current value, high
and low allowable entries, and name of
every configuration decision.

Table Window A snapshot of the currently-displayed
Points Status, Maintenance, or Configura-
tion Table window.

The report will print on the printer that you have specified using the File
Menu’s Print setup command.

1. Display the window you wish to print: System Overview, Point
Status, Maintenance, or Configuration Table.

2. Click on the File menu item and then click on Print.

Note: You may also perform this command by clicking on the
Print icon in the toolbar.

ComfortVIEW displays a confirmation box asking if you wish to
print the system overview.

3. Click on Yes to print the currently-displayed window or click on
No to prevent the print.

Printing
Carrier

Network
Manager Data
Table 2-45
Available Reports

To Print the System
Overview or Table
Window Report
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1. Display the Controller List window. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

2. Click on the area name in the window.

3. Click on the File menu item and then click on Print. ComfortVIEW
displays a confirmation box asking if you wish to print the area
element list.

Note: You may also perform this command by clicking on the
Print icon in the toolbar.

4. Click on Yes to print the list of all controllers in the selected area, or
click on No to prevent the print. The controller list report prints on
your ComfortVIEW printer. Figure 2-46 displays a sample controller
list report.

1. Display the Controller List window. If necessary, follow the instruc-
tions listed under Displaying the Controller List.

2. Click on the controller whose database you wish to print.

Note: You can also select and print reports on multiple control-
lers. Use the Windows-standard mouse or keyboard tech-
niques to select multiple controllers. You can, however,
only select multiple controllers from the right side of the
Controller List window.

3. Click on the File menu item and then click on Print. ComfortVIEW
displays a confirmation box asking if you wish to create the database
report.

Note: You may also perform this command by clicking on the
Print icon in the toolbar.

4. Click on Yes to create the report, or click on No to prevent report
creation.  ComfortVIEW creates the report and displays it using the
Windows Notepad application.

5. To print the report, click on Notepad’s File menu item and then click
on Print.

6. To close the report file, click on Notepad’s File menu item and then
click on Exit.

To Print a Controller
List Report

To Print a Controller
Database Report
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Figure 2-46
Sample Controller List
Report

United Mutual Insurance - Quicker List
39N: Air Handler Unit - 0, 2
19XL:  Chiller #1 - 0,128
AHU - 0,2
DATCOLL:  Data Collection III - 0,100
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Figure 2-47
Sample Database Report

Device Configuration Report

AHU:  - 0, 2
CONFIG: Configuration

===========================================================================

Description              Value    Units    LoLim    HiLim    Name

Humid(0=no,1=anlg,2=dis) 1                 0        2        HUEN
Occupied Heating         Disable           Disable  Enable   OHEN
Night Time Free Cool     Disable           Disable  Enable   NTEN
NTFC Lockout Temperature 55       dF       40       70       NTLO
Space Temperature Reset  Enable            Disable  Enable   RSEN
Reset Ratio              3        ^F       0        10       RTIO
Reset Limit              10       ^F       0        20       LIMT
Demand Limiting          Enable            Disable  Enable   DLEN
Loadshed Group Number    2                 1        16       LSGP
Demand Limit Setpoint 1  23       %        0        100      DL1
Demand Limit Setpoint 2  55       %        0        100      DL2
Timed Override Schedules 2                 1        3        TSCH
Timed Override Value     1        hours    0        4        TOVR
Fan Tracking             Enable            Disable  Enable   FTEN
Night Purge              Enable                              NPEN
Night Purge Duration     15       min      5        240      NPMN
Night Purge Damper - Lo  12       %        0        100      NPDL
Night Purge Damper - Hi  35       %        0        100      NPDH
Constant Outside Air CFM Enable                              OAEN
Indoor Air Quality       Enable                              AQEN

IAQ Type                 2                 1        2        IAQT

(1=Diff gas,2=2 gases)
IAQ Priority level       2                 1        3        IAQP
(1=Hi,2=Lo,3=None)

AHU:  - 0, 2
!CtlrID: Device Configuration
AHU: Device Configuration

===========================================================================

Description              Value    Units    LoLim    HiLim    Name

Description: AIR HANDLER UNIT                    DevDesc
Location: United Mutual Insurance            Location

Software Part Number: CESR-121498-05                      PartNum
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You can send real time CCN system element data from
ComfortVIEW to other PC software applications that are running on
your ComfortVIEW workstation. This is accomplished using
ComfortVIEW Dynamic Data Exchange (DDE) feature. The PC
software application to which you intend to send data must support
DDE. You set up DDE links between ComfortVIEW and the other
PC software application in order to send the data.

You can also use another PC application that supports DDE "poke"
to override forceable CCN point values. Refer below to DDE Poke
for further information on this feature.

• Controller point data

The following controller point data will be sent any time there is
a change in the data:

Point description
Point value
Point units
Point status
Point force status

• The most recently received Carrier Comfort Network alarm

The following alarm data can be sent:

Alarm message and associated custom alarm message
Alarm message only
Custom alarm message only

• The application that is to receive the data must be linked to the
appropriate ComfortVIEW data point. See Linking Controller
Point Data to Applications that Support Paste Link, Linking
Controller Point Data to Applications that Do Not Support Paste
Link, and Linking Alarm Messages to Other Applications
below.

• You must be logged in to ComfortVIEW

• The dynamic data must be changing in order to receive an
update in the linked application.

One application that supports DDE, is Microsoft’s Excel spread-
sheet program. To send data from ComfortVIEW to Excel you must
establish a DDE link between the two applications. This link is

Sharing
ComfortVIEW
Dynamic Data
with Other
Applications
(DDE)

What Data can be
Sent?

Linking Controller
Point Data to
Applications that
Support Paste Link

Required Conditions
for Successful Data
Sharing
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easily established using commands available in the ComfortVIEW
and Excel menu structures.

To establish a DDE link, use each application’s Copy and Paste
commands as follows:

1. Launch your Excel spreadsheet program and open a new
worksheet.

2. Launch the Carrier Network Manager application and access
the controller whose data you wish to share.

3. Select the controller’s status or maintenance display table and
open the table for display.

4. Find the point that you wish to use.

5. Use the mouse to select the point’s description, point value,
units, or force status.

Note: You can select one, or all of the point’s fields.To
select all of the fields and to include the time of the
last point update, click on the button to the left of the
point description and select the entire row. You can
only select one point at a time.

6. Click on the Edit menu item and then click on Copy.

7. Simultaneously press the Alt and Tab keys to switch to your
Excel application.

8. Select the cell that you wish to link to your selected
ComfortVIEW point data. When pasting an entire row, select a
range of cells equal to the number being copied from
ComfortVIEW.

9. Click on Excel’s Edit menu item and then click on Paste
Special and Link.

10. Your selected ComfortVIEW point data will appear in the
appropriate worksheet cells.

If the application to which you are linking does not support the Paste
Link function, you must specify the ComfortVIEW DDE link infor-
mation manually. Use your application’s specified method for creat-
ing programmed DDE links.

To link ComfortVIEW data, you must specify the following link
information in the DDE-supported application for each piece of

Linking Controller
Point Data to
Applications that Do
Not Support Paste Link
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ComfortVIEW data you wish to read:

• ComfortVIEW application name — ComfortWORKS
• Topic Name — See Table 2-47 for topic names of available

ComfortVIEW point information. You will notice that there are
two topic names included in this table. Use the name shown in
parentheses if the ComfortVIEW table is not currently open for
display.

• Item Reference Number — Point ID Number

To display the point ID number, click on the Carrier Network
Manager’s Options menu item and then click on Point IDs. The
number will display in the Name column following the 8 charac-
ter point name.

Data Topic Name

Description PntDesc (CCNPntDesc)
Point Value PntValue (CCNPntValue)
Units PntUnits (CCNPntUnits)
Status PntStatus (CCNPntStatus)
Force Status PntFrcStatus (CCNPntFrcStatus)
All of the above PntAll (CCNPntAll)

Example of Excel's requirements for creating programmed DDE
point data links.

You would enter DDE point data link information in an Excel
cell in the format shown below. Note that this format varies
dependent on the PC application to which you are linking.

=ComfortWORKS|Topic Name!’ Item Reference Number’

Example of Excel’s actual cell formula (where the
ComfortVIEW table from which you are linking is currently
open):  =ComfortWORKS|PntAll!’35304'

Explanation:
The Excel spreadsheet will be able to read the following data for
the ComfortVIEW point that corresponds to item number 35304:
Description, Point Value, Units, Status, and Force Status.

Table 2-47
ComfortVIEW Topic
Names
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To link ComfortVIEW alarm messages to other PC applications, use
your application’s specified method for creating programmed DDE
links.

To link ComfortVIEW alarm messages, you must specify the fol-
lowing link information in the DDE-supported application:

• ComfortVIEW application name — ComfortWORKS

• Topic Name — AlmNew

• Item Reference — See Table 2-48 for names of available alarm
data

Data Item Reference

Alarm Message and
Associated Custom Message AlmAll
Alarm Message Only AlmMsg
Custom Message Only AlmCMsg

Example of Excel’s requirements for creating programmed DDE
alarm message links.

You would enter DDE alarm data link information in an Excel
cell in the format shown below. Note that this format varies
dependent on the PC application to which you are linking.

=ComfortWORKS|Topic Name!’ Item Reference ‘

Example of Excel’s actual cell formula:
=ComfortWORKS|AlmNew!’AlmMsg’

Explanation:
The Excel spreadsheet will be able to read the most current
alarm message  received by ComfortVIEW.

Using an established link from a third party application that supports
DDE poke, you can override (force) any forceable dynamic CCN
point by establishing a DDE link to either the PntValue or
CCNPntValue topic name. The exact method to use to accomplish
this varies, based on the third party application. If the target CCN
point is analog, the "poked" value must be an ASCII string represen-
tation of a number within the point's forceable limits. The CCN

Linking Alarm
Messages to Other
Applications

Table 2-48
ComfortVIEW Item
Reference Names

DDE Poke
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point will be forced with a priority equal to that of a ComfortVIEW
force. If the target CCN point is discrete, the value can take on
several formats:  it can be an ASCII string representing a number, in
which case 0 will force the point to its off state and a non-zero value
will force the point to its on state, or it can be an ASCII string
equivalent to one of the two possible discrete states. To auto (re-
move a poked force), poke a null value (empty string) or a carriage
return-line feed string to the DDE point.

This section describes each of the commands that appear in the
Carrier Network Manager menus.

Command Use this command to

Import copy a .CWX configuration table file
to a controller in the ComfortVIEW
database. Either enter the file name
(with extension .CWX) with the
appropriate path or click on the button
to the right of the Import from edit
box and select the file from the File
Open dialog box. You could use this
command after performing a Cold call
to copy data to a controller that ap-
pears dimmed in the Controller List
window, or to overwrite configuration
data in an existing controller.

Export copy the selected controller’s database
to the specified drive. This drive can
be the ComfortVIEW floppy diskette
drive, another ComfortVIEW hard
drive partition, or another computer
on the local area network.

(continued)

Carrier Network
Manager
Command
Summary
File Menu

Table 2-49
File Menu
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Command Use this command to

Print (continued) take a snapshot and print the contents
of the currently displayed System
Overview or Status Display, Mainte-
nance, or Configuration Table win-
dow. You can also use this command
to print the following database re-
ports:
A controller list report

This report lists all controllers in a
selected area. Included for each
controller is its up to 8 character
controller name, address, and a list of
all tables in the controller. To generate
this report, you must display the
Controller List window and click on
the desired area prior to selecting the
Print command.

A controller database report

This report lists all configuration
tables in a selected or multiple con-
trollers. Included for each configura-
tion table is its 8 character table name,
and the description, current value,
high and low allowable entries, and
name of every configuration decision.
To generate this report, you must
display the Controller List window
and click on the desired controller(s)
prior to selecting the Print command.

Print setup select a printer and set up your print
characteristics. Print requests made
using the File Menu’s Print command
will print to this printer.

       (continued)

Table 2-49
File Menu
(continued)
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Command Use this command to

Print setup (continued) ComfortVIEW will display the Print
Setup dialog box, where you can
select another printer and additional
print characteristics such as page size,
orientation, and two sided printing.
Clicking on the Print Setup dialog
box’s More button displays the Ad-
vanced document Properties dialog
box, where you can specify additional
print characteristics. Click on the Help
button to display Windows’  help
information. Clicking on the Print
Setup dialog box’s Network button
displays the Connect to Printer dialog
box, which gives you the capability to
print to another printer on the local
area network. Click on the Help button
to display Windows’  help information.

Exit exit the Carrier Network Manager
function.

The following table describes each of the commands for the File
menu that displays when you are viewing a Basic Bus Scan, De-
tailed Bus Scan, or System Summary window.

Command Use this command to

System summary search the Bus Scan window for the
highest addressed CCS or ComfortID
monitor or master thermostat. If no
such stat is located, ComfortVIEW
will display a message and the system
summary will be terminated. When
such a stat is located, ComfortVIEW
will perform a scan to locate all zone
and bypass controllers in the master
thermostat's system and will then
display the System Summary window.
Refer to Figure 2-22c.

        (continued)

Table 2-49
File Menu
(continued)

File Menu

Table 2-49a
File Menu
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Command Use this command to

Print print the bus scan, detailed bus scan,
or system summary results. The
printout will include all scanned data
with a time/date stamp. Monitor stats
and linkage masters will be preceded
by >>.

Print Setup select a printer and set up your print
characteristics. Print requests made
using the File Menu's Print command
will print to this printer.

Exit exit the Carrier Network Manager
function.

The following table describes each of the commands in the Edit
menu.

Command Use this command to

Copy copy selected ComfortVIEW configu-
ration table data from one cell to
another. Click on the cell or cells you
wish to copy, click on the Edit menu
item, and then click on Copy. To copy
an entire column, click on the column
header (Description, Value, or Notes).
To copy an entire row, click on the
box to the left of the point description.
The data is copied to the Windows
Clipboard. You can then click on a
destination cell and use the Paste
command to paste the copied data.
The destination cell can be in the same
or another CCN table.

(continued)

Edit Menu

Table 2-50
Edit Menu

Table 2-49a
File Menu
(continued)
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Table 2-50
Edit Menu
(continued)

Command Use this command to

You can also copy CCN table data to
other PC applications such as Win-
dows Notepad, and link CCN table
data to other PC applications that
support dynamic data exchange
(DDE) — for example, third party
spreadsheet programs. When the
ComfortVIEW table is active and
point data changes, the data will
automatically update in the other
application. For more information on
linking table data, refer to the Sharing
ComfortVIEW Dynamic Data with
Other Applications (DDE) section of
this chapter.

Paste paste ComfortVIEW table data from
the Windows clipboard to a table.
Copy the data to the Windows Clip-
board using the Copy command. Then
click on a destination cell, click on
Edit and then click on Paste. The data
that you are pasting overwrites the
data that is currently in the destination
cell. The data you are pasting must
conform to the allowable entries for
the destination cell. If you attempt to
paste incompatible data,
ComfortVIEW displays an error
message indicating that the data target
is not available or incompatible. You
cannot paste data into status display
table’s Value cells or into any
ComfortVIEW table’s Names cells.

Modify edit configuration table cell data.
Click on the cell you wish to modify.
Then click on Edit and Modify. Type

       (continued)
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Command Use this command to

the new value or text. The value
appears in the cell and in the edit bar,
which is located below the window’s
status bar. Click on the edit bar’s
checkmark (✓ ) or press Enter to
complete the entry. Click on the X to
cancel the entry.

Force override status display table point
values. Forcing overrides a
controller’s automatic control of a
selected point.

Auto clear a force and return a point to a
controller’s automatic control.

Submaster force transmit a submaster reference force to
the selected point in the selected
UT203 FID controller. When you
force the submaster reference,
ComfortVIEW will disregard the
submaster reference value that was
calculated in the master control loop.

Note:  You cannot use Submaster
force if the selected point already has
a Supervisor force.

The following table describes each of the commands in the Access
menu.

Command Use this command to

Open display a list of all areas in your
database. You can then double click
on an area and display the list of
controllers. This is an alternative to
displaying the list of areas and control-
lers by double clicking on a CCN in
the System Overview window.

Table 2-50
Edit Menu
(continued)

Table 2-51
Access Menu

Access Menu
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Command Use this command to

Connect establish a remote telephone connec-
tion to the selected CCN. When the
connection is established, the message
Remote: Connected displays in the
status area to the right of the toolbar.

Disconnect disconnect from the selected remote
area. ComfortVIEW automatically
disconnects you from a remote CCN if,
after an operator-specified number of
minutes, no communication occurs.
Notification of an automatic disconnect
will be by an alarm from the Autodial
Gateway. For additional information on
the automatic disconnect feature, refer
to the explanation of the Phone Num-
ber Configuration dialog box in the
Adding and Modifying CCNs section
of this chapter.

The following table describes each of the commands in the Configure
menu. Note that from CCN Option windows, only the New, Modify,
Delete, and View commands are available.

Command Use this command to

New add a new CCN, area, or controller to
your ComfortVIEW database. To add a
new CCN, the System Overview
window must be displayed. To add a
new area, the System Overview win-
dow must be expanded to display the
database’s CCNs, and you must select
the CCN in which the new area will
appear. To add a new controller, you
must display the controller list into
which you wish to add the new control-
ler.

         (continued)

Configure Menu

Table 2-52
Configure Menu

Table 2-51
Access Menu
(continued)
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Table 2-52
Configure Menu
(continued)

Command Use this command to

The dialog box that displays depends on
whether you are adding a new CCN, area,
or controller. For an explanation of each
dialog box option, refer to the Adding/
Modifying CCNs, Adding/Modifying
Areas, or Adding/Modifying Controllers
sections of this chapter.

Modify modify the selected CCN (name, number,
or access parameters), area name, or
controller (name or sort key).

The dialog box that displays depends on
whether you selected a CCN, area, or
controller. For an explanation of each
dialog box option, refer to the Adding/
Modifying CCNs, Adding/Modifying
Areas, or Adding/Modifying Controllers
sections of this chapter.

Copy copy the selected controller’s or table’s
database to one or more similar control-
lers or tables.

The Areas dialog box will be displayed.
Select the target area. The CCN Elements
dialog box will then be displayed. Select
one or more system elements as the target
to the copy. If desired, you can also
enable this dialog box's download option,
which will download the source element's
configuration to the target system element
as part of the configuration copy.

Note:   You can also use drag and drop to
move (or transfer) a selected controller
from one area to another.

Delete delete the selected CCN, area, or control-
ler from the ComfortVIEW database.

       (continued)
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Command Use this command to

Upload copy the selected controller’s data-
base from the controller to
ComfortVIEW database. You can
upload an entire controller, in which
case you get all configuration tables,
or you can upload only a selected
configuration table. Performing a
controller upload overwrites the
controller’s configuration that is
stored in the ComfortVIEW database.
Performing a table upload displays the
table on-screen for viewing or editing.
If desired, you can save the displayed
table data in the ComfortVIEW
database.

Download send configuration table data to a
selected controller. You can download
an entire controller or only a single
configuration
table. Performing a download over-
writes the configuration at the control-
ler. When you download an entire
controller, ComfortVIEW sends data
from its database to the controller.
When you
download a single table,

ComfortVIEW sends the on-screen
data (which may be different from its
database data) to the controller.

Verify compare the selected controller’s
database as it is stored in the control-
ler with the associated database that is
stored in the ComfortVIEW database.

Table names modify controller table names and
descriptions.

       (continued)

Table 2-52
Configure Menu
(continued)
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Command Use this command to

Note:   You can modify the description
of all tables. You can only, however,
modify the names of CCN Option
tables. Exercise caution when modify-
ing these names. You must only
change the numbers that appear in the
table name. For example, only change
the name of the Loadshed Option’s
LDSHD01S Table to a name such as
LDSHD02S. Do not modify any other
characters in the name. You can also
modify table names and descriptions
using the Configure menu’s Modify
command. For additional information,
refer to the Modifying Table Names/
Descriptions section of this chapter.

Controller configure the selected UT203 FID or
Comfort Controller. Selecting this
command with a UT203 FID selected
presents the FID Point Selection
dialog box, where you select the FID
points that you wish to activate, select
point types (DO, AO, AI, DI), and
then select each point's algorithm
(control type). Selecting this com-
mand with a Comfort Controller
selected presents the Configure Com-
fort Controller tabbed dialog box,
where you select the tab that corre-
sponds to the database object that you
wish to create and configure.

Table 2-52
Configure Menu
(continued)
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Command Use this command to

View display an area's Controller list or to
display a controller or CCN Option
table. This is an alternative to display-
ing the Controller list by double-
clicking on an area name or to dis-
playing a table by double-clicking on
the table name.

The following table describes each of the commands for the Config-
ure Menu that displays when you are viewing a configuration,
maintenance, or status display table.

Command Use this command to

Save save point description, values, and
notes modifications in the
ComfortVIEW database.

Upload copy the selected table’s database
from the controller to ComfortVIEW
database.

Download copy the selected table’s database
from the ComfortVIEW database to
the controller.

Verify compare the selected table’s database
as it is stored in the controller with the
associated database that is stored in
the ComfortVIEW database.

Configuration table display the selected point's associated
configuration table.

Maintenance table display the selected point's associated
maintenance table.

Time schedule display the selected point's associated
time schedule configuration table.

Setpoint table display the selected point's associated
setpoint configuration table.

Reference tables display object tables that reference
that use the selected Comfort Control-
ler point in their configuration.

Table 2-52
Configure Menu
(continued)

Configure Menu

Table 2-53
Configure Menu
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The following table describes each of the commands for the Config-
ure Menu that displays when you are viewing a Basic Bus Scan,
Detailed Bus Scan, or System Summary window.

Command Use this command to

Modify when viewing a Bus Scan window,
modify the selected controller's name,
sort key, or linked WorkSPACE.

The CCN Element Definition dialog
box will be displayed. For an explana-
tion of each dialog box option, refer to
the Adding/Modifying Controllers
section of this chapter.

Copy copy a selected system element's
database to one or more similar
system elements.

The Areas dialog box will be dis-
played. Select the target area. The
CCN Elements dialog box will then be
displayed. Select one or more system
elements as the target for the copy. If
desired, you can also enable this
dialog box's download option, which
will download the source element's
configuration to the target system
element(s) as part of the configuration
copy.

Add to database add the selected system elements to
the ComfortVIEW database. In the
Bus Scan and System Summary
windows, those system elements that
have not been added to the
ComfortVIEW database will be
preceded by "dimmed" icons. You can
use the Add to database command to
add all such system elements to the
database.

       (continued)

Table 2-53a
Configure Menu
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Command Use this command to

The Areas dialog box will be dis-
played. Select the target area and click
on OK.

On completion of the add process the
Controller List will be displayed. You
can then upload the shadow controller
configuration to the ComfortVIEW
database if desired. To incorporate the
new database statuses into the Bus
Scan or System Summary window,
you must use the Refresh command
that is located in the Bus Scan or
System Summary window's Window
menu.

The following table describes each of the commands in the CCN
Tools menu.

Command Use this command to

Time/Date modify and send the time of day, date,
day of week and holiday status to all
controllers or a selected controller in a
CCN. You can use this command to
synchronize all CCN controllers to the
same time and date or to change a
single controller’s time and date.
ComfortVIEW displays the Broadcast
Time and Date dialog box.

Bus Services scan a specified CCN Bus and obtain a
list of the system elements and snap-
shot of activity.

The Bus Services dialog box will be
displayed. Refer to Figure and Table
2-22a. From this dialog box you can
perform an update poll or cold call, or

       (continued)

Table 2-53a
Configure Menu
(continued)

CCN Tools Menu

Table 2-54
CCN Tools Menu
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Table 2-54
CCN Tools Menu
(continued)

Command Use this command to

produce a basic or detailed bus scan
display. From either bus scan display,
you can produce a system summary,
which searches the specified bus for
CCS and ComfortID thermostats,
zone, and bypass controllers.

Gateways use this command to reserve selected
Gateways to perform the following
operations:

Timed data retrieval — Reserves the
selected Gateway for use when con-
necting to remote CCNs to perform
automatic timed data retrieval for
ComfortVIEW reports.

Standard connection — Reserves the
selected Gateway for use when con-
necting to remote networks to perform
other ComfortVIEW monitoring
functions.

Receipt of incoming alarms — Re-
serves the selected Gateway to receive
incoming alarms.

Transmission of outgoing alarms —
Reserves the selected Gateway to send
outgoing alarms.

Keep in mind that reserving an Auto-
dial Gateway for a particular opera-
tion does not prevent ComfortVIEW
from using the Gateway for other
operations. It only allows
ComfortVIEW to make the best
possible selection under the given
conditions.
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Table 2-54
CCN Tools Menu
(continued)

Command Use this command to

Note: Reserving a Gateway for a
particular operation is entirely op-
tional. If you do not make specific
operational assignments,
ComfortVIEW automatically selects
an idle Gateway for use.

CCN Options display, modify, add, and delete CCN
Option tables on a selected CCN. This
command is an alternate to accessing
CCN Option tables by accessing each
option module individually as de-
scribed in the Viewing Configuration
Tables and Modifying Configuration
Table Values sections of this chapter.

The following table describes each of the commands for the Options
Menu that displays when you are displaying the System Overview
window.

Command Use this command to

Font change the font that ComfortVIEW
uses to display Carrier Network
Manager text. When you change the
font, all Carrier Network Manager text
is affected.

Dialog Box Options:

Font:  Select the font to use.

Font Style:  Select any style options
(for example, bold or italic)

Size:  Select the point size. The larger
the point size, the larger the characters
appear on your screen.

Sample:  The text in this box changes
to reflect the font, font style, and size
you select.

        (continued)

Table 2-55
Options Menu

Options Menu
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Command Use this command to

OK:  Closes the dialog box and save
changes made.

Cancel:  Exits the dialog box and re-
stores the previous settings.

Toolbar hide or display the Carrier Network
Manager toolbar.

Status bar hide or display the status bar that appears
in the third line of Carrier Network
Manager windows. In the System Over-
view and Controller List window, this
status bar displays the path you have
taken in the Carrier Network Manager to
arrive at the current window selection.
(For example, the CCN, area, and con-
troller
name that you have selected.) In a status
display, maintenance, or configuration
table window,  the status bar displays
help information that is peculiar to a
controller point or configuration deci-
sion.

Sort sort the presentation of the controller list.
You can sort the controller list alphabeti-
cally by name, ascending address (bus
and system element) number, or numeri-
cally by sort key.  A controller with a
sort key of 1 appears before a controller
with a sort key of 2, and so on. For
further information on sort keys, refer to
the Adding/Modifying Controllers
section of this manual. You may also sort
the controller list by clicking on the
appropriate icon in the toolbar.

Save settings on exit save any changes you make by using
commands on the Options menu. For
example, if you change the font and then

(continued)

Table 2-55
Options Menu
(continued)
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Command Use this command to

exit the Carrier Network Manager, the
text appears in the new font the next
time you start the Carrier Network
Manager. This command also saves
the size and position of all Carrier
Network Manager windows. The
command does not however, save
sorts. Settings are saved for individual
operators.

The following table describes each command for the Options Menu
that displays when you are viewing a configuration, maintenance, or
status display table.

Command Use this command to

Font change the font that ComfortVIEW
uses to display Carrier Network
Manager text. When you change the
font, all Carrier Network Manager text
is affected.

Dialog Box Options:

Font:  Select the font to use.

Font Style:  Select any style options
(for example, bold or italic)

Size:  Select the point size. The larger
the point size, the larger the characters
appear on your screen.

Sample:  The text in this box changes
to reflect the font, font style, and size
you select.

OK:  Closes the dialog box and save
changes made.

Cancel:  Exits the dialog box and
restores the previous settings.

       (continued)

Table 2-55
Options Menu
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Options Menu
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Command Use this command to

Toolbar hide or display the Carrier Network
Manager toolbar.

Status bar hide or display the status bar that
appears in the third line of Carrier
Network Manager windows. In the
System Overview and Controller List
window, this status bar displays the
path you have taken in the Carrier
Network Manager to arrive at the
current window selection. (For ex-
ample, the CCN, area, and controller
name that you have selected.) In a
status display, maintenance, or con-
figuration table window,  the status bar
displays help information that is
peculiar to a controller point or con-
figuration decision.

Hide hide rows and columns in status
display, maintenance, or configuration
table worksheets. Click on the header
of the column you wish to hide or
click on the box to the left of the row
you wish to hide. Click on the Options
menu item and then click on Hide.

The highlighted column or row will be
removed from the worksheet. To
Make Row Hides Permanent:  Click
on the Configure menu item and then
click on Save. The row will not appear
the next time you view this table.

To Make Column Hides Permanent:
Click on the Options menu item and
then click on Save settings on exit. A
checkmark (✓ ) appears before the
command to indicate that it is enabled.
The column will not appear the next
time you view this table.

        (continued)

Table 2-55
Options Menu
(continued)
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Command Use this command to

Note:  Row hides apply to specific
tables. Column hides apply to all
tables in all controllers. Also, row
hides are hidden for all operators.
Column hides are hidden for indi-
vidual operators.

Show show hidden rows and columns in
status display, maintenance, or con-
figuration table worksheets. Click on
the Options menu item and then click
on Show. The Show Rows/Columns
dialog box displays. The dialog box

       (continued)
shows any hidden rows or columns.
Select the rows or columns to add and
click on OK. Any hidden columns will
be added to the worksheet.

Point IDs display each point’s item reference
number along with the point name.
This number is used when linking
table data to other PC applications,
such as third party spreadsheet pro-
grams.

Best fit set each column to a width that best
fits the data.

Save settings on exit save any changes you make by using
commands on the Options menu. For
example, if you change the font and
then exit the Carrier Network Man-
ager, the text appears in the new font
the next time you start the Carrier
Network Manager. This command
also saves the size and position of all
Carrier Network Manager windows.
The command does not however, save
sorts. Settings are saved for individual
operators.

Table 2-55
Options Menu
(continued)
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The following table describes each of the commands in the Window
menu. Note that the Graphical command is only available from the
Setpoint and Time Schedule windows.

Command Use this command to

Cascade arrange open Carrier Network Man-
ager windows to overlap so that each
title bar is visible.

Tile horizontally arrange open Carrier Network Man-
ager windows in smaller sizes so that
they fit next to each other horizontally
and are all visible on your desktop.

Tile vertically arrange open Carrier Network Man-
ager windows in smaller sizes so that
they fit next to each other vertically
and are all visible on your desktop.

Arrange icons evenly arrange all minimized Carrier
Network Manager window icons.

Refresh update the information displayed in
open Carrier Network Manager
windows. ComfortVIEW updates the
currently selected window with the
most recent data that has been written
to the database.

Graphical when viewing an occupancy or set-
point configuration table, display data
in either a tabular (worksheet) or
graphic format.

To use the Setpoint Table graphical
format:
Enter the desired setpoint in the edit
box below the slidebar, or simply drag
the slidebar to display the desired
setpoint. You can click on the
slidebar's < or > buttons to decrement
and increment the displayed setpoint
in increments of .1 or 1.0. Each

       (continued)

Table 2-57
Window Menu

Window Menu
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Command Use this command to

graphic screen displays up to 9 deci-
sions-worth of table data. Use the |<< or
>>| buttons that are located at the bot-
tom of the screen to display the first or
last 9 decisions. Use << or >> to move
through the up to  9 decision display,
decision by decision.

To use the Occupancy Table graphical
format:
Click to enable/disable days of the
week, and enter the Occupied From and
To times in the corresponding edit
boxes. The bar graph will update to
display the occupied times.

Jump to Table/WorkSPACE when viewing a Bus Scan or System
Summary window, CCN Option Table
window or Controller List, to display the
status display table for a selected system
element. If the system element has
multiple display tables (for example, an
AHU PIC) you will be presented with
the Display Tables dialog box, from
which you can select the desired table. If
the system element also has a config-
ured WorkSPACE, that WorkSPACE
will be displayed. If the selected system
element has no display table and has not
been configured with a linked
WorkSPACE, you will be given an
opportunity to identify a WorkSPACE
to link to the given system element.

Table 2-57
Window Menu
(continued)
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The following table describes each of the commands in the Help
menu.

Command Use this command to

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
components, and copyright.

Table 2-58
Help Menu

Help Menu



Remote Site Manager



Alarm Manager



201

This chapter provides instructions on ComfortVIEW Remote Site
Manager application.

For instructions on... Turn to page

using ComfortVIEW Remote Site Manager 202

verifying required conditions for successful connection 202

connecting to a remote ComfortVIEW
Server workstation 205

disconnecting from a remote ComfortVIEW
Server workstation 208

adding a site to the ComfortVIEW
Remote Site list 209

removing a site from the ComfortVIEW
Remote Site list 212

The following terms are used throughout this chapter.

Server — A computer running ComfortVIEW communication, user
interface, service, and database software.

Client —  A computer on a local area network running
ComfortVIEW communication and user interface software, or
ComfortVIEW user interface software only.

Remote Site
Manager
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You can use the ComfortVIEW Remote Site Manager application to
dial in to a remote ComfortVIEW Server. You can dial in from a
computer that is running either ComfortVIEW Server or
ComfortVIEW Client software. When you dial in to a
ComfortVIEW Server, your computer and the Server to which you
are connected operate as if they were connected on a local area
network. All of the capabilities that you would have as a local Client
computer are yours when you dial in as a remote Client computer.

Note: The Remote Site Manager application is not available for
the ComfortVIEW Stand-alone installation option.

When you connect to a remote ComfortVIEW Server from a local
ComfortVIEW Server, the operation of your local Server is unaf-
fected. However, any alarms received from the local CCN will not
be visually or audibly indicated. They will still, however, be printed
and logged to the database. Your local Server will remain active and
will continue to operate as a Server for the other ComfortVIEW
Clients on your system.

Note: ComfortVIEW Remote Site Manager application gives
you access to the ComfortVIEW applications of the
remote Server. If you want to directly access the Server’s
disk, registry, event log or any other Windows networking
features, you should use the more powerful Windows
Network and Dial-up Connections application.

The following conditions must exist for you to successfully dial in
and log on to a remote ComfortVIEW Server.

Note: You cannot dial to a remote Server that is running a
ComfortVIEW version that is greater than the source
workstation version.

Source ComfortVIEW Workstation (the Workstation Placing the Call):

Verify that the conditions listed below exist at the workstation that
is placing the call. If they do not, perform the listed instructions at
this workstation.

1. If you wish to dial into a remote Server that is running an
earlier version of ComfortWORKS software, you must create
a separate bootable partition on your workstation onto which
you will install the earlier version of ComfortWORKS Client.

Introduction

Required Conditions
for a Successful
Connection
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For example, to dial into ComfortWORKS Version 4.1 from
a ComfortWORKS Version 5.0 workstation, you must create
a separate partition and install ComfortWORKS Version 5.0
Client.

2. Windows Remote Access Connection Manager Service (Dial-
up Networking) software must have been installed along with
the appropriate modem device driver. Refer to your Windows
Remote Access Connection Manager installation instructions.

3. Windows Remote Access Connection Manager (Dial-up
Networking) must be configured to dial out calls (as a mini-
mum). See your Windows Remote Access Connection Man-
ager (Dial-up Networking) setup instructions.

4. The ComfortVIEW Remote Site Manager application must
have been installed. This application is automatically installed
when you install your ComfortVIEW software on a computer
that has the Windows Remote Access Connection Manager
(Dial-up Networking)  installed. You can perform the
ComfortVIEW installation procedure at any time if you need
to load the ComfortVIEW Remote Site Manager application.

5. The modem must be operational. You can verify this by
attempting to dial the remote Server using the Windows
Remote Access Connection Manager feature.

Verify that you are using compatible source and remote
modems. It is recommended that you use the same make and
model modem for both source and remote workstations.

6. The remote ComfortVIEW Server computer name, and the
remote Server modem phone number must be added to the
ComfortVIEW Remote Site Manager dialog box’s
ComfortVIEW Remote Site list. For instructions, refer to the
Adding a Site to the ComfortVIEW Remote Site List section
of this chapter.

7. You must have a valid login name and password to log on to
the remote Server’s Windows operating system.
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Remote ComfortVIEW Server (the Workstation Receiving the call):

Verify that the conditions listed below exist at the workstation that
is receiving the call. If they do not, perform the listed instructions at
the workstation that is receiving the call.

1. The remote Server must be turned on and running Windows
XP/2000.

2. Windows Remote Access Connection Manager Service (Dial-
up Networking) software must have been installed along with
the appropriate modem device driver. Refer to your Windows
Remote Access Connection Manager Service (Dial-up Net-
working) installation instructions.

3. The Windows Remote Access Connection Manager (Dial-up
Networking) must be configured to dial out and receive calls.
See your Windows Remote Access Connection Manager
Service (Dial-up Networking) setup instructions.

4. You must grant dial-in access permissions to all or selected
users via the Windows Remote Access Connection Manager
Service (Dial-up Networking). See your Windows Remote
Access Connection Manager Service (Dial-up Networking)
setup instructions.

5. The Windows Remote Access Connection Manager Service
(Dial-up Networking) must be running.

You can start and run the Remote Access Connection Man-
ager Service using the Windows Remote Access Connection
Manager, or you can configure the Remote Access Connec-
tion Manager Service (Dial-up Networking) to automatically
start on XP/2000 boot-up.

To start the service automatically on boot-up:

a. Click on the Start menu, then select Settings, and click
on Control Panel.

b. In the Control Panel window, double click on Adminis-
trative Tools and then double click on Services. In the
Services list, find and double click on Remote Access
Auto Connection Manager.
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c. In the Remote Access Connection Manager Properties
dialog box, select the General tab, and then under
Startup Type, select Automatic. Then click on Apply and
OK to close the dialog boxes.

6. The modem must be operational when operating under the
Windows XP/2000 operating system.

You can verify this by attempting to dial out to another
Windows XP/2000 computer using the Windows Network
and Dial-up Connections feature, or by dialing out to an
active phone number using the HyperTerminal application in
Windows Accessories.

7. The computer names of any users who will be dialing in from
other locations must be entered into the Setup Workstations dialog
box, which appears in the ComfortVIEW Setup application.

8. The Windows login names and passwords of any users who
will be logging in from other locations must be entered into
the Windows operating system.

9. The ComfortVIEW login names and passwords of any users
who will be logging in from other locations must be regis-
tered in this ComfortVIEW Server. If necessary, refer to the
Adding, Modifying, Deleting Operators section in this
manual’s Setup chapter.

Follow the instructions below to use the ComfortVIEW Remote Site
Manager application to dial from a ComfortVIEW Server or Client
to a remote ComfortVIEW Server.

1. Close all active ComfortVIEW applications, and log out of
ComfortVIEW.

2. Double click on the ComfortVIEW Remote Site Manager
icon.

Note: It is not necessary to log in to ComfortVIEW before
running this application.

ComfortVIEW launches the Remote Site Manager applica-
tion and displays the ComfortVIEW Remote Site Manager
dialog box. Refer to Figure 3-1.

Connecting
to a Remote

ComfortVIEW
Server
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3. In the ComfortVIEW Remote Sites list, click on the remote
site and then click on Connect.

ComfortVIEW displays two message dialog boxes followed
by the Authentication dialog box.

4. Enter the remote Server's Windows XP/2000 user name and
password, and then click on OK.

ComfortVIEW begins the connection process. The status of
the connection process will be displayed in a status message
box and by a series of messages on the bottom of the Remote
Site Manager dialog box.

Once the telephone connection is successfully established,
ComfortVIEW attempts to log in to the remote site’s Win-
dows operating system using your specified user name and
password.  If the user name or password are not valid, you
will be so notified. Click on Retry to enter a new user name
and password or on Cancel to terminate the connection.

Once ComfortVIEW has successfully logged in to the remote
site’s Windows operating system, you can begin your
ComfortVIEW session. Successful connection is indicated by
the presence of the word Connected in the Remote Site
Manager dialog box’s status bar.

Note: If you receive an Access Denied message at any
time during the connection process, one of the
following conditions exists:

• Your computer name does not exist in the
remote Server’s database. See Condition #8
under Required Conditions for a Successful
Connect.

• There are too many logged in users at the
remote site.

• The remote site does not have an access key
attached to the Server workstation’s parallel
port.

5. Begin your session by logging in to ComfortVIEW.

If the message RPC Server Unavailable is displayed during
ComfortVIEW operation, the remote connection has been lost. If
this situation occurs, disconnect from the remote Server and then re-
connect.
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Figure 3-1
ComfortVIEW Remote Site
Manager Dialog Box
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1. End your current remote ComfortVIEW session by closing all
current ComfortVIEW applications (except the
ComfortVIEW Remote Site Manager application), then log
out of ComfortVIEW.

2. Switch to the ComfortVIEW Remote Site Manager applica-
tion.

3. In the ComfortVIEW Remote Site Manager dialog box, click
on Disconnect.

A confirmation dialog box will be displayed.

4. Click on Yes.

5. At the second confirmation dialog box, click on  OK to
proceed with the disconnect.

ComfortVIEW begins the disconnect process. A  status
message box shows the status of the disconnect process.

6. The connection has been successfully terminated when the
Remote Site Manager dialog box's status bar displays Not
Connected.

Disconnecting
from a Remote
ComfortVIEW Server
Workstation
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Follow the instructions below to add a new or modify an existing
ComfortVIEW site.

Note: Modifying an existing remote site name maintains the
existing site name and adds a new site with the modified
site name. If desired, you can delete the existing site by
following the Deleting a Site from the ComfortVIEW
Remote Site List instructions below.

1. Double click on the ComfortVIEW Remote Site Manager
icon to launch the application.

Note: It is not necessary to log in to ComfortVIEW before
running this application.

ComfortVIEW launches the Remote Site Manager application
and displays the ComfortVIEW Remote Site Manager dialog
box. Refer to Figure 3-1.

2. Do one of the following depending on whether you wish to
add a new or modify an existing site:

• Click on New.

ComfortVIEW displays the Add Remote Site dialog box.
See Figure 3-2.

• Click on an existing remote site name and then click on
Modify.

ComfortVIEW displays the Modify Remote Site dialog
box. See Figure 3-3.

3. Enter the new or modify the existing remote site and remote
Server computer name in the appropriate text boxes.

You can either enter the remote modem phone number, or
enable the Phone Book Entry option to use the telephone
number that is specified using the Windows NT/2000 RAS
function.

Note: Commas may be used in the phone number as
pauses between numbers so that internal building
telephone exchanges can be accommodated.

4. Click on OK to accept the entries as entered or click on
Cancel to exit the dialog box without saving.

Adding a Site
to the

ComfortVIEW Remote
Site List
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If you enabled the Phone Book Entry option, you will be presented
with either the Windows XP/2000 New Phone Book Entry Wizard
or the Windows NXP/2000 Remote Action service configuration
series of dialog boxes, depending on whether you are adding a new
or modifying an existing site.

Note: Be sure that the Windows XP/2000 phonebook entry name
matches the ComfortVIEW Add or Modify Remote Site
dialog box's Remote Site Name exactly.



211

Figure 3-2
New Remote Site
Dialog Box

Figure 3-3
Modify Remote Site
Dialog Box
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1. Double click on the ComfortVIEW Remote Site Manager
icon to launch the application.

Note: It is not necessary to log in to ComfortVIEW
before running this application.

ComfortVIEW launches the Remote Site Manager application
and displays the ComfortVIEW Remote Site Manager dialog
box. Refer to Figure 3-1.

2. In the ComfortVIEW Remote Sites list, click on the remote
site that you wish to delete and then click on Delete.

Deleting a
Site from the

ComfortVIEW Remote
Site List
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WorkSPACE
Manager

This chapter provides instructions on ComfortVIEW WorkSPACE
Manager application.

For instructions on... Turn to page

using WorkSPACEs in run mode:
• accessing the WorkSPACE Manager and displaying a

WorkSPACE 216

using trends in run mode:
• displaying and using trends 225

using ViewSPACEs in run mode:
• displaying and using a ViewSPACE 233

using WorkSPACEs in design mode:
• creating a new WorkSPACE 245
• cloning WorkSPACEs 246
• modifying an existing WorkSPACE 251
• deleting a WorkSPACE 253

using ViewSPACEs in design mode:
• creating a new ViewSPACE 255
• modifying an existing ViewSPACE 272
• creating tabular data box displays 277
• deleting/removing ViewSPACEs 278

using trends in design mode:
• creating and modifying trends 279
• deleting/removing trends 288

connecting to/disconnecting from a Remote
CCN in run mode 290

printing ViewSPACEs and trends in run or
design mode 294

animated data box frame creation guidelines 298

a summary of all WorkSPACE Manager commands 301
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The following terms are used throughout this WorkSPACE Manager
chapter.

Animated Data Box — A graphic that displays an animated (mov-
ing) picture of the discrete point it is representing. For example, a
fan circulating air or a filter with air passing through it.

Auto — To remove a force and return a point to the controller’s
automatic control.

Bookmark — A tag, which you place on a WorkSPACE while
operating in run mode, to allow you to quickly jump to and display it
using the File menu’s Open bookmark command. The presence of a
bookmark icon in the lower right corner of a WorkSPACE window
indicates that the WorkSPACE is currently bookmarked.

Controller — A CCN system element with an address, status
display, and configuration tables. A controller performs the actual
HVAC monitoring and control operations. The Carrier Comfort
Network supports several types of controllers. These include PICs,
FIDs, Comfort Controllers, System Managers (examples:  TSM,
FSM, CSM), and CCN options.

Data Box — A rectangular box, which is superimposed on a
ViewSPACE’s graphic background, that contains the following
user-configurable information:  configuration, status display, or
maintenance point’s name, 24 character description, value and units,
communication or alarm status, and/or force state. Data boxes for
discrete points can also appear as animated graphics.

Design Mode — The WorkSPACE Manager mode that you enter to
create or modify ViewSPACEs and trends. While in design mode
you perform operations such as selecting a graphic background,
assigning data points to display on the ViewSPACE or trend, and
establishing links to other WorkSPACEs. You enter design mode by
clicking on the run mode’s Run menu item and then clicking on
Enter design mode (or by pressing the F6 key).

Download — To copy configuration table data from the
ComfortVIEW database to a controller. Performing a download
overwrites all configuration at the controller.

Terminology
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Force — To override a controller’s automatic control and modify
the point’s value.

Global — A WorkSPACE, ViewSPACE, or trend that can be used,
modified, or deleted by any user. You designate whether a
WorkSPACE, ViewSPACE, or trend will be “Global”  during the
save process.

Link areas — Boxes, which you add to ViewSPACEs, to provide a
quick jump to another WorkSPACE. You can create up to 15 link
areas in a ViewSPACE window. Double-clicking on a link area
while in run mode closes the current ViewSPACE and WorkSPACE
and displays the linked WorkSPACE.

Object — A Comfort Controller hardware or software point, system
table, algorithm, setpoint, alarm, or function.

Owned — A WorkSPACE, ViewSPACE, or trend that can be
displayed by any user, but can only be modified or deleted by the
creator. You designate whether a WorkSPACE, ViewSPACE, or
trend will be “Owned”  during the save process.

Run Mode — The WorkSPACE Manager mode that you enter to
display ViewSPACEs and trends. While in this mode, ViewSPACE
and trend plot values dynamically update. You perform operations
such as forcing and autoing point values and statuses, modifying
configuration table values, and displaying linked WorkSPACEs.
You enter run mode by clicking on the design mode’s Run menu
item and then clicking on Start run mode (or by pressing the F5
key).

System Element — A CCN controller with an address and configu-
ration tables. A controller performs the actual HVAC monitoring
and control operations. The Carrier Comfort Network supports
several types of system elements. These include PICs, FIDs, Com-
fort Controllers, System Managers (examples:  TSM, FSM, CSM),
and CCN options.

Trend — A window consisting of a dynamic plot of up to six
points-worth of data.

Upload — To copy configuration table data from a controller to the
ComfortVIEW database.
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Accessing the
WorkSPACE
Manager

ViewSPACE — A window consisting of a graphic background (for
example, a chiller or an air handler graphic) with up to 60 dynamic
or animated data boxes, which display point value or status informa-
tion, and up to 15 link areas, which provide a quick jump to another
WorkSPACE. ViewSPACEs may also contain data boxes only,
without a graphic background.

WorkSPACE —A collection of up to ten ViewSPACE and up to
ten trend windows.

The WorkSPACE Manager application gives you the ability to
create and use customized graphic and trend displays of critical
ComfortVIEW data. These graphic and trend displays are referred to
respectively as ViewSPACEs and trends. The data that can be
displayed in a ViewSPACE or trend can be of any type — status
display, maintenance, and configuration, and can include informa-
tion from any controller in one, or multiple CCNs.

You create and save ViewSPACEs and trends in collections or
groupings known as WorkSPACEs. A WorkSPACE can contain of
up to ten individual ViewSPACE windows and up to ten individual
trend windows.

You can create a WorkSPACE to simultaneously see all the critical
information about your system on a single screen. For example, you
can create a WorkSPACE with a ViewSPACE graphic of your main
chiller and air handler, plus trends plotting key operating data for
your chilled water system. You can then save the WorkSPACE so it
is available to access time and again. WorkSPACEs containing
trends and ViewSPACES displaying data from multiple controllers
are troubleshooting time-savers, allowing you to adjust the operation
of one parameter and see how it affects another part of the system
— all on the same screen.

You operate the WorkSPACE Manager in one of two modes: design
mode or run mode. Design mode is for creating or modifying
ViewSPACEs and trends, while run mode is for displaying
ViewSPACEs and trends with their data dynamically updating. You
can, for example, work in the WorkSPACE Manager’s design mode
to create a WorkSPACE containing a ViewSPACE window that

Design Mode Versus
Run Mode
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WorkSPACE
Manager

displays data from your main chiller, a ViewSPACE window that
displays data from your main air handler, and a trend window that
samples space temperatures. You can then switch to the
WorkSPACE Manager’s run mode and view the data in these
ViewSPACE and trend windows dynamically updating. You can
force and auto display points, and modify configuration point
values.

1. Double click on the WorkSPACE Manager icon.

ComfortVIEW displays the Open WorkSPACE dialog box
shown and described in Figure 4-1 and Table 4-1.

Note: If, however, you have identified a default
WorkSPACE using the Configure menu’s Set
default WorkSPACE command (in Design mode),
the selected default WorkSPACE window opens and
its associated ViewSPACEs and trends display in
run mode.

To Open a Different WorkSPACE:  Display the
Open WorkSPACE dialog box by clicking on the
File menu item and then clicking on Open
WorkSPACE, or click on the Open WorkSPACE
icon in the toolbar.

2. In the Select WorkSPACE list, click on the WorkSPACE that
you wish to open and then click on OK.

To Launch the
WorkSPACE

Manager Application
and Open an Existing
WorkSPACE
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Figure 4-1
Open WorkSPACE
Dialog Box

23XL Chiller Monitor

Open WorkSPACE

OK Cancel Help...

Select WorkSPACE:

Unity Mutual Insurance Campus

Selects a WorkSPACE to open

Unity Mutual Remote Office
WorkSPACE: PID Loop Trends

Click on To

a WorkSPACE in the
Select WorkSPACE list select the WorkSPACE to

open.

OK close the dialog box and open
the selected WorkSPACE.

Cancel exit the dialog box and restore
the previous settings.

Help display help information.

Table 4-1
Open WorkSPACE
Dialog Box
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General Operation ComfortVIEW opens the selected WorkSPACE window in run
mode. The ViewSPACEs and trends that have been assigned to the
WorkSPACE open sequentially inside the WorkSPACE window.
The messages Loading background screens and Loading data
display in the lower left corner of the WorkSPACE window during
the load process.

For instructions on using ViewSPACEs and trends, refer to the
Displaying and Using a ViewSPACE and Displaying and Using
Trends sections of this chapter.

Figure 4-2 shows a sample WorkSPACE window containing two
ViewSPACEs and a trend. The trend's legend is also displayed.

The top line of the WorkSPACE window contains the menu bar.
Note that this menu bar changes when you switch between the
WorkSPACE Manager’s run and design modes. Refer to
WorkSPACE Manager Menu Command Summary at the end of this
WorkSPACE Manager chapter for a description of each run and
design mode menu item and command.

Menu Bar
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Figure 4-2 Sample WorkSPACE Window
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Clicking on the drop down list to the left of the window’s toolbar
displays the names of the WorkSPACE’s associated ViewSPACEs
and trends. Selecting a ViewSPACE or trend from this list while
you are in run mode opens the ViewSPACE or trend for viewing of
dynamic data. Selecting a ViewSPACE or trend while you are in
design mode displays the ViewSPACE or trend for modification.

The second line of the WorkSPACE window contains the toolbar. If
you use a mouse, the toolbar gives you instant access to the most
frequently used WorkSPACE Manager commands. By simply
clicking the mouse button, you can perform operations such as
opening a WorkSPACE, opening a ViewSPACE or trend, and
downloading configuration data to the controller.

Note: If desired, you can remove the toolbar from the
WorkSPACE window by clicking on the Options menu
item followed by clicking on Toolbar. To return the
toolbar to the window, perform these two commands
again.

The table below describes the buttons that appear on the
WorkSPACE Manager toolbar.

Click To

open an existing WorkSPACE

save the WorkSPACE

open a bookmarked WorkSPACE

open an existing ViewSPACE or trend

save the ViewSPACE or trend

(continued)

Drop Down List

WorkSPACE Manager
Toolbar

Table 4-2
WorkSPACE  Manager
Toolbar Icons
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Table 4-2
WorkSPACE  Manager
Toolbar Icons
(continued)

Click To

print the contents of a ViewSPACE or
trend window or print a WorkSPACE,
ViewSPACE, or trend definition
report

modify the ViewSPACE or trend

create a new data box

create a new link area

connect to a remote CCN

disconnect from a remote CCN

save configuration data displayed in
the ViewSPACE to the database

upload configuration data from the
CCN

download configuration data to the
system element(s)

start/stop trend scanning

return to the first WorkSPACE you
displayed on launching the
WorkSPACE Manager application.

       (continued)
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Table 4-2
WorkSPACE  Manager
Toolbar Icons
(continued)

Click To

display the WorkSPACE that you
jumped from

jump to the Alarm Manager applica-
tion

jump to the Report Panel application

launch the report wizard and quickly
and easily add a new consumable,
history, or runtime report definition.

launch the data box wizard and add a
new data box to an existing
ViewSPACE.

launch the trend wizard and and
quickly and easily add a new trend.

launch the alarm wizard and configure
an alarm for the currently-selected
point.

update the current WorkSPACE with
the most recent data from the
ComfortVIEW database.

display help
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Bookmarks give you the capability to tag a WorkSPACE in run mode
so that you can quickly jump to it using the File menu’s Open book-
mark command.

To Place or Remove a Bookmark

In run mode:

1. Click on the Configure menu item and then click on Set book-
mark.

A checkmark (✓ ) appears before the Set bookmark command to
indicate that it is enabled.

The presence of the bookmark icon in the lower right corner of a
WorkSPACE window also indicates that the WorkSPACE is
currently bookmarked.

2. To remove a bookmark, perform these two commands again.

To Jump to a Bookmarked WorkSPACE

In run mode:

1. Click on the File menu item and then click on Open bookmark.

Note: You may also perform this command by clicking on
the Open Bookmark icon in the toolbar.

If there is only one bookmarked WorkSPACE in your
ComfortVIEW database, the WorkSPACE Manager displays the
bookmarked WorkSPACE  in run mode.

If there is currently more than one bookmarked WorkSPACE in
your database, the WorkSPACE Manager displays the Open
WorkSPACE dialog box. This dialog box lists the names of all
WorkSPACEs that have been bookmarked by you and other
ComfortVIEW operators.

2. In the Select WorkSPACE list, click on the WorkSPACE that
you wish to open and then click on OK.

The WorkSPACE Manager closes the currently-displayed
WorkSPACE and opens the selected WorkSPACE.

Bookmarks
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Displaying and
Using Trends

While displaying a trend in run mode, you can perform the follow-
ing functions:

• View the trend dynamically plotting data

• View, modify, upload, download, or save the following trend
point parameters:
• Value
• Description
• Operator note

• Stop (pause) and start the trend

• Re-start the trend (re-initialize values)

• Jump to and display a point's associated configuration, mainte-
nance, time schedule, or setpoint table.

• Display the names of all Comfort Controller objects (hardware
and software points, algorithms, setpoints, alarms, functions, and
system tables) that are using the selected trend point in their
configuration.

• Jump to and display a trend point's table of origin (status dis-
play, maintenance, or configuration table).

A trend will run until one of the following conditions is met:

• You stop the trend
• 1000 scans have been completed
• You remove the trend from the current WorkSPACE
• You leave run mode and enter design mode
• You close the WorkSPACE (via a linked jump to another

WorkSPACE or by exiting the current WorkSPACE Manager
application entirely).

Note: You can simultaneously run a trend while viewing
other WorkSPACEs by running another instance of the
WorkSPACE Manager application. Use the second
WorkSPACE Manager to view other WorkSPACEs
while the first WorkSPACE Manager is running your
trend.
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To Launch the
WorkSPACE Manager
Application and
Display a Trend in Run
Mode

Note: If the WorkSPACE Manager application is already run-
ning, you can display a trend at any time by:

• if necessary, entering run mode (by clicking on the
Run menu item and then clicking on Start run mode).

• opening the trend (by clicking on the File menu item
and then clicking on Open ViewSPACE/Trend).

• proceeding to Step 2 in the following list.

1. Launch the WorkSPACE Manager application and select the
WorkSPACE containing the trend you wish to display. If
necessary, refer to Accessing the WorkSPACE Manager.

ComfortVIEW opens the selected WorkSPACE window. The
ViewSPACEs and trends that have been assigned to the
WorkSPACE open sequentially inside the WorkSPACE
window. The messages Loading background screens and
Loading data display in the lower left corner of the
WorkSPACE window during the load process.

Trends display in run mode and, if the auto start option was
enabled, will begin plotting data when opened. The presence
of the message Plotting in the top right corner of the trend
window indicates that the trend is sampling data.

Note: If the trend you wish to display is not currently
displayed on the screen, click on the drop down list
to the left of the window’s toolbar to display the
name of each of the WorkSPACE’s associated
ViewSPACEs and trends. Then, click on the trend
that you wish to display.

If the trend you wish to display is in another
WorkSPACE, you can display a list of all
ViewSPACEs and trends by clicking on the File
menu item and then clicking on Open ViewSPACE/
Trend. The Open ViewSPACE/Trend dialog box is
displayed. Select the trend that you wish to display
and then click on OK.
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2. If any trend contains points from a remote CCN, and the trend
has not been configured to automatically establish remote
connection on display (refer to Figure and Table 4-16), you
must connect to the remote CCN in order to sample the remote
point data. To connect to a remote CCN, click on Connect
toolbar icon shown at left.

3. If necessary, start the trend by clicking on the Run menu item
and then click on Start trend.

Note: You may also perform this command by clicking on
the Start/Stop Trend icon in the toolbar.

The sample trend shown in Figure 4-3 is plotting the value or
status of the following points:  %LOAD, ECW, LCW, CWFL.
The trend started at 2:18:11 pm. The X-axis (horizontal axis)
displays the time, and the Y-axis (vertical axis) displays the
point value range. The currently-displayed Y-axis displays the
range for the %LOAD point. The legend, which is displayed to
the right of the trend plot, displays the area name, controller
name and description, and point name and description for each
trend point.
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Status Bar The second line of the trend window contains the status bar. This
status bar displays the time the displayed trend started (First Scan),
the most recent scan time, and the trend status (Not Active or Plot-
ting).

Note: If desired, you can remove the status bar from the window
by clicking on the Options menu item followed by clicking
on Status bar. To return the status bar to the window,
perform these two commands again.

Trend point names display above the trend.

To activate the Y-axis to display a point’s range, click on the
point name as it is displayed above the trend.

The minimum and maximum values that are displayed in the plot’s Y-
axis change to display the selected point’s range.

1. Display the range for the point in question in the Y-axis. See
above.

2. Point to a location on the trend line and hold down the left
mouse button.

The point value will be displayed along with its corresponding trend
sample time and date.

1. Click on the Run menu item and then click on Stop Trend.

Note: You may also perform this command by clicking on
the Start/Stop Trend icon in the toolbar.

The message Paused displays in the window’s status bar to
show that the trend is stopped.

To Display a Point’s
Range in the Y-Axis

To Display a Trend
Value at a Selected
Time

To Stop (Pause) a Trend
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To Start or Re-start a
Trend

You can start or re-start a trend at any time. Starting a trend causes it
to resume trending data from the point it was at when you stopped
it. Re-starting a trend clears out (initializes) all previous trend data
and starts the trend again.

Once you’ve started a trend, the trend keeps running until one of the
following conditions is met:

• You stop the trend by clicking on the Run menu item and then
clicking on Stop Trend

• You close the WorkSPACE (by double-clicking on a
ViewSPACE’s link area, by opening a new WorkSPACE, or by
exiting the WorkSPACE Manager application entirely)

• 1000 scans have been completed

• You remove the trend from the current WorkSPACE

• You leave run mode and enter design mode

To Start a Trend:

Click on the Run menu item and then click on Start Trend.

The message Plotting displays in the window’s status bar to show
that the trend has been started.

To Re-start a Trend:

Click on the Run menu item and then click on Re-Start Trend.

The message Plotting displays in the window’s status bar to show
that the trend has been started.
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To View or Modify
Trend Data Point
Parameters and
Trend History

Follow the instructions below to modify a trend point’s value, description,
or operator note, or to view the last 50 trend data samples for the point.
For configuration points, you can upload configuration data from the
controller, download data to the controller, and save configuration data
changes in the ComfortVIEW database. For point status or maintenance
table points, you can force and auto point values and save changes.

You can also use ComfortVIEW table jump feature to display and
modify a trend point's associated configuration, maintenance, time
schedule, or setpoint table. In addition, you can display the names of
all Comfort Controller objects that are using a selected trend point in
their configuration. For other CCN system element points, you can
display the point's table of origin (status display, maintenance, or
configuration table).

1. Double click on the point name  corresponding to the point
whose parameters or history you wish to view. These point
names are displayed above the plot.

The WorkSPACE Manager displays the Point Data dialog
box. This box displays the point’s value, description, operator
note, and trend history.

If there is an alarm or force condition currently in effect, an
alarm or force status indication message is displayed in the
lower half of the dialog box.

2. Make point description, value, or operator note changes as
desired. Refer to Figure 4-6 and Table 4-6, which appear later
in this WorkSPACE Manager chapter, for an explanation of
the fields in the Point Data dialog box.

3. To view the last 50 trend data samples, click on the History
drop down list box. If you wish to view all trend data
samples, you can do so by saving your trend data to a file.
Refer to To Save Trend Data to a File.

4. To display a point's associated configuration, maintenance,
time schedule, or setpoint table, click on Configuration table,
Maintenance table, Time schedule, or Setpoint table.

5. Clicking on Reference table(s) with a Comfort Controller
point selected will display a list of all Comfort Controller
objects that are using the trend point in their configuration.
Clicking on Table of Origin with a point from any CCN
system element selected will display the point's table of origin
(status display, maintenance, or configuration table).

6. Click on Close to exit the dialog box and save any modifications.
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There are two ways to permanently save your trend data samples:

• In run mode, use the File menu's Save trend data to file com-
mand. This command takes a snapshot of the current data and
writes the data to a file name that you specify in the File Save
As dialog box. This tab-separated file will contain all data that's
been gathered since the trend was started for your current
WorkSPACE session. You can then examine this trend data file
at a later time, by reading it into a third party spreadsheet, word
processor, or the Windows Notepad application.

• In design mode, select the Edit menu's Modify ViewSPACE/
Trend command to display the Modify Current Trend dialog box
(refer to Figure and Table 4-18). In that dialog box, specify an
archive file directory path and file name. When the trend is
activated in run mode, the data will be written to this file as it is
plotted. You can then re-display the archived trend data in  an
inactive WorkSPACE Manager trend window using the File
menu's Open Archived Trend command. This command is
available in run mode.

Be aware that these are the only methods in which to permanently
save trend data. Trend data is lost under the following conditions:

• You remove the trend from the current WorkSPACE

• You leave run mode and enter design mode

• You exit the WorkSPACE (by double-clicking on a
ViewSPACE’s link area, by opening a new WorkSPACE, or by
exiting the WorkSPACE Manager application entirely).

To Save Trend Data to a
File
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Displaying and
Using a
ViewSPACE

While displaying a ViewSPACE in run mode, you can perform the
following functions:

• Connect to a remote CCN to view dynamic remote values. To
connect to a remote CCN, click on the Connect toolbar icon.

• View, modify, upload, download, and save the following data
point parameters:

• Value
• Description
• Operator note

• Jump to and display a linked WorkSPACE.

• Jump to and display a point's associated configuration, mainte-
nance, time schedule, or setpoint table.

• Display the names of all Comfort Controller objects that are
using a selected Comfort Controller point in their configuration.

• Jump to and display a point's table of origin (status display,
maintenance, or configuration table).

• Use the trend wizard to quickly and easily create a new trend.

• Use the report wizard to quickly and easily add a new consum-
able, runtime, or history report definition.

• Use the alarm wizard to quickly and easily configure an alarm
for the currently-selected point.

• Use the data box wizard to quickly and easily add a new data
box to the ViewSPACE.

Note: If the WorkSPACE Manager application is already run-
ning, you can display a ViewSPACE at any time by:

• if necessary, entering run mode (by clicking on the
Run menu item and then clicking on Start run mode)

• opening the ViewSPACE (by clicking on the File
menu item and then clicking on Open ViewSPACE/
Trend or by clicking on the Open ViewSPACE/Trend
icon in the toolbar.)

Launch the WorkSPACE Manager application and, in the
Open WorkSPACE dialog box, select the WorkSPACE
containing the ViewSPACE you wish to display. If necessary,
refer to the Accessing the WorkSPACE Manager section of
this chapter.

To Launch the
WorkSPACE Manager
Application and
Display a ViewSPACE
in Run Mode
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The ViewSPACEs and trends that have been assigned to the
WorkSPACE open sequentially inside the WorkSPACE
window. The messages Loading background screens and
Loading data display in the lower left corner of the
WorkSPACE window during the load process.

Note: If the ViewSPACE you wish to display is not cur-
rently displayed on the screen:

Click on the drop down list to the left of the
window’s toolbar to display the name of each of the
WorkSPACE’s associated ViewSPACEs and trends.
Then, click on the ViewSPACE that you wish to
display.

If the ViewSPACE you wish to display is in another
WorkSPACE:

You can display a list of all ViewSPACEs by
clicking on the File menu item and then clicking on
Open ViewSPACE/Trend.

You may also perform this command by clicking on
the Open ViewSPACE/Trend icon in the toolbar.

The Open ViewSPACE/Trend dialog box is dis-
played. Select the ViewSPACE that you wish to
display and then click on OK.

General Operation:  ViewSPACEs display in run mode. Data
boxes displaying status display table values dynamically
display the controller’s latest values and statuses. Data boxes
displaying configuration table values display configuration
data as it is stored in the ComfortVIEW database. If desired,
you can click on the Configure menu item and then click on
Upload ViewSPACE data to display configuration values that
are stored in the controller.

The sample ViewSPACE shown in Figure 4-4 displays a
23XL Chiller graphic with five data boxes.

If any ViewSPACE contains points from a remote CCN, and
the ViewSPACE has not been configured to automatically
establish remote connection on display (refer to Figure and
Table 4-16), you must connect to the remote CCN in order to
view the remote point data. To connect to a remote CCN,
click on the Connect toolbar icon shown at left.
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Figure 4-4
Sample ViewSPACE
Window

ViewSPACE: 23XL Mechanical

Motor Starts Today
2

OILT: Oil Temperature

Oil Temperature
130 dF

Oil Pressure
90 PSI

Motor
Bearing Temp

140° dF
Oil Quality

OK

Position the mouse on any data box and click the left mouse button. The
point name and description display in the ViewSPACE window’s status
bar, which is the second line of the window. This feature can be used to
view point names of animated data boxes.

Follow the instructions below to view or modify CCN data point pa-
rameters and values. For instructions on modifying Dynamic Data
Exchange (DDE) point parameters, refer to To Share ViewSPACE Data
with Other Applications (DDE), which follows Figure and Table 4-7.

1. Double click on the data box corresponding to the point you wish
to view or change.

The WorkSPACE Manager displays the Point Data dialog box.
Refer to Figure 4-5. From this box you can modify the point’s
value, description, or operator note, and, if the point is currently
being sampled in a trend, view the last 50 trend samples. For
configuration points, you can also upload configuration data from
the controller, download data to the controller, and save configu-
ration data changes to the ComfortVIEW database. For point
status or maintenance table points, you can also force, submaster
force (for UT203 FID controllers) and auto point values, and
save changes.

If there is an alarm or force condition currently in effect, an
alarm or force status indication message will be displayed in the
lower half of the dialog box.

To View a Data Box’s
Point Name and
Description

To View or Modify Data
Point Parameters and
Values
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2. Make point description, value, or operator note changes as
desired. Refer to Figure 4-5 and Table 4-5 for an explanation
of the fields in this dialog box.

3. To save configuration data changes in the ComfortVIEW
database, click on the Save button.

4. To send configuration data changes to the controller, click on
the Download button.

5. To display a point's associated configuration, maintenance,
time schedule, or setpoint table, click on Configuration table,
Maintenance table, Time schedule, or Setpoint table.

6. Clicking on Reference table(s) with a Comfort Controller
point selected will display a list of all Comfort Controller
objects that are using a point in their configuration.
Clicking on Table of Origin with a point from any CCN
system element selected will display the point's table of origin
(status display, maintenance, or configuration table).

7. Click on Close to exit the dialog box.

If desired, you can save and download all configuration data
changes simultaneously using the Configure menu’s Save
ViewSPACE data and Download ViewSPACE data commands.

Note: You may also perform these commands by clicking on the
Save and Download icons in the toolbar.

While viewing a ViewSPACE in run mode, you can use the new
data box wizard to quickly and easily create a new data box.

1. While viewing a ViewSPACE in run mode, click on the
toolbar's New Data wizard icon (shown at left).

The WorkSPACE Manager switches you to design mode and
displays the Modify Data Box dialog box (refer to Table and
Figure 4-12).

Note: If you select an existing data box prior to invoking
the wizard, the Modify Data Box dialog box settings
will default to those for the selected data box.

2. Select the new data point, style, colors, etc. and when fin-
ished, click on OK to close the Modify Data Box dialog box.

3. Once you have re-positioned and re-sized the data box as
desired, click on the ✓  button in the lower left corner of the
WorkSPACE Manager window to save the new ViewSPACE
and return to run mode, or on the X button to exit the
ViewSPACE without saving and return to run mode.

To Add a New Data
Box
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Point Data

No alarm condition

Force in effect: Supervisor

Modifies this point's description

Point description:

Point value:

Operator note:

History:

Space Temperature

75.0

Sensor Broken

Mutual Of Farmington - Cold Call
AHU: - 0,2
SPT [dF]

Close Help...

Configuration table...

Maintenance table...

Time schedule...

Setpoint table...

Reference table(s)...

Table of origin...
Download

Save

Upload

Force...

Auto

Submaster

Figure 4-5
Point Data Dialog Box

Click on To

Point description edit box modify the point’s description. Up to
24 characters are allowed.

Point value edit box modify the displayed point value. This
edit box is available for configuration
points only. To modify a status dis-
play or maintenance point’s value or
status, click on Force.

Operator note edit box add a new or modify the existing
operator note.

History drop down list if the point is currently being sampled
in a trend, display a tabular display of
the point’s last 50 trend samples.

Force override the controller’s automatic
control and modify the point’s value.
The Force dialog box is displayed.
Refer to Figures 4-6 and 4-7 and
Table 4-7 for instructions on using
this dialog box.

       (continued)

Table 4-5
Point Data Dialog Box
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Click on To

Submaster transmit a submaster reference force
value to an analog out data point in a
UT203 FID controller. When you force
the submaster reference, ComfortVIEW
will disregard the submaster reference
value that was calculated in the FID’s
master control loop. For more informa-
tion on the FID’s submaster reference
value, refer to the UT203 FID Overview
and Configuration Manual.

Note:  You cannot transmit this
submaster force if the selected data point
already has a Supervisor force.

Auto remove a force and return the point to
the controller’s automatic control.

Save save point changes in the ComfortVIEW
database.

Upload copy configuration data point values
from the controller to the ComfortVIEW
database.

Download send modified data to the controller.

Note:  Clicking on this Download button
sends this specific configuration change
to the controller. To send all
ViewSPACE configuration data point
changes to the controller, click on the
Configure menu item and then click on
Download.

Configuration table display the point's associated configura-
tion table.

       (continued)

Table 4-5
Point Data Dialog Box
(continued)
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Table 4-5
Point Data Dialog Box
(continued)

Click on To

Maintenance table display the point's associated mainte-
nance table.

Time schedule display the point's associated time
schedule configuration table.

Setpoint table display the point's associated setpoint
configuration table.

Reference tables if the point is in a Comfort Controller,
display the names of all Comfort
Controller objects that are using the
point in their configuration.

Table of origin display the point's table of origin
(status display, maintenance, or
configuration table).

Close close the dialog box.

Help display help information.

Force value:

Force: Input/Output Channel 1

Increment:

1+-40.0

Auto time...

Note...

Force Cancel Help...

Auto

Figure 4-6
Force Dialog Box —
Analog
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Figure 4-7
Force Dialog Box —
Discrete

Clean Dirty

Force value:

Clean

Force Cancel Help...

Auto time...

Force: Filter Status

Note...

Auto

Click on To

the override state button
(Example: Clean, Dirty,
On, Off) select the desired override state

(for discrete points only).

the Force value edit box enter the desired override value
(for analog points only).

the Increment: up or
down arrow select the increase or decrease granu-

larity (for example, .1, 1, 100, 1000).

the Force value up or
down arrow increase or decrease the override value

for analog points.

Auto time indicate the time and date to remove
the force. This option is only available
for those PIC controllers that support
a force expiration. ComfortVIEW
displays the Auto Time and Date
dialog box. Click on the day of the
month and enter the time to remove
the force. To change the month, click
                                           (continued)

Table 4-7
Force Dialog Box
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Table 4-7
Force Dialog Box
(continued)

To Jump to a Linked
WorkSPACE

To Share ViewSPACE
Data with Other
Applications (DDE)

Click on To

on the scroll bar’s down or up arrow.
Click on OK to close the dialog box and
save your settings.

Note add an operator note in the Force dialog
box. The Force Note dialog box displays.
In the Force note box, enter a new or edit
the existing note. Click on OK to save the
changes or click on Cancel to exit without
saving changes.

Auto remove any current force that may exist
on the point.

Force transmit the force to the point.

Cancel exit the dialog box and restore the previous
settings. Any changes made are not saved.

Help display help information.

1. Position the mouse within the boundaries of the ViewSPACE’s
link area.

The cursor pointer changes shape to indicate that you are posi-
tioned on a link area.

2. Double click the left mouse button.

ComfortVIEW will close the existing WorkSPACE and open the
linked WorkSPACE.
Note: If you plan on returning to the original WorkSPACE,

you can hold down the Ctrl key when double-clicking.
This will leave the current WorkSPACE open, and open
the linked WorkSPACE in a new instance of the
WorkSPACE Manager application.

Home or Previous WorkSPACE:  You can click on the Home or Previ-
ous toolbar icon shown at left to quickly return to the first WorkSPACE
that you displayed when the WorkSPACE Manager was launched, or to
the WorkSPACE that you jumped from.

To View ViewSPACE Data in a DDE-supported Application:  You can
link ViewSPACE data to a Dynamic Data Exchange (DDE)-supported
third party spreadsheet application. If the application to which you wish
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to link supports the Paste Link command, click on the ViewSPACE
data box containing the value you wish to link, click on the Edit menu
item and then click on Copy. ComfortVIEW automatically copies the
data (and its DDE link information) to the Windows Clipboard. You
can then open the DDE-supported application, and use the
application’s Paste Link command to insert and link the selected
ComfortVIEW data. When the ViewSPACE is active and point data
changes, the data will automatically update in the other application.
For further information on sharing ComfortVIEW dynamic data, and
a list of the data elements that can be sent, refer to Sharing
ComfortVIEW Dynamic Data with Other Applications, which ap-
pears in the Carrier Network Manager chapter of this manual.

To View or Modify DDE-supported Application Data in a
ViewSPACE:  You can display DDE-supported application data in a
ComfortVIEW ViewSPACE. You can also modify DDE data. When
you create the ViewSPACE, specify the appropriate DDE point
information in the Create Data Box dialog box. To modify the DDE
data:  In Run mode, double-click on the DDE point data box. The
DDE Source Interface dialog box is displayed. Enter any desired
point modification in the Data to send edit box and click on Send
data. Refer to Figure and Table 4-8 for instructions on using this
dialog box.

Figure 4-8
DDE Source Interface
Dialog Box

DDE Source Interface

Data to send:

Link poke

Link execute

Send data 5Timeout [secs]:

Close Help...

Current DDE link:
Excel[Book1]Sheet1!R8C3

1E+19
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Click on To

the Data to send edit box enter the new value to send to the
DDE-linked application.

Link poke update the data in the DDE-linked
application. For example, if the DDE
link represents a cell in an Excel
spreadsheet, Link Poke will update the
data in that cell.

Link execute trigger functions in the DDE-linked
application. For example, in the DDE
link represents a cell in an Excel
spreadhsheet, Link Execute could be
used to save or close the spreadsheet.

the Timeout edit box indicate the number of seconds that
the process should wait after initiating
a Poke or Execute before reporting
that no response was received from
the DDE source.

Send Data send the specified data back to the
DDE-linked application.

Close close the dialog box.

Help display help information.

While displaying a ViewSPACE in run mode, you can select a data
box and then click on the Alarm Wizard toolbar icon to quickly and
easily configure an alarm for the selected point. Note that wizard
operation will differ, depending on the type of point and CCN
system element. For Comfort Controllers and UT203 FIDs, the
wizard first guides you through point alarm creation and configura-
tion, and then ComfortVIEW custom message creation. For all other
CCN system elements, the wizard provides ComfortVIEW custom
alarm creation only. Follow the steps as presented.

Table 4-8
DDE Source Interface
Dialog Box

Alarm Wizard
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While displaying a ViewSPACE, you can select any data box and
then click on the trend wizard toolbar icon (shown at left) to quickly
and easily set up a trend of that point.

1. In the Trend Wizard dialog box, enter the new trend name
and click on Finish if you are satisfied with the trend's default
15 second scan rate, or click on Modify to display the Modify
Current Trend dialog box and add other points to the same
trend, or change the default scan rate. Refer to Table and
Figure 4-18 for instructions on using this dialog box. Clicking
on Finish saves the trend for later use.

Note: To view and run the newly-created trend, use the
WorkSPACE Manager's File menu's Open
ViewSPACE/trend command. To associate and save
the trend in a WorkSPACE, enter design mode,
open a WorkSPACE, open the trend and then save
the WorkSPACE.

While viewing a ViewSPACE in run mode, you can click on any
data box and then on the Report Wizard toolbar icon to quickly and
easily add a new consumable, runtime, or history report definition to
the Report Panel. Follow the steps presented:

1. Select the report type.

2. Specify the report name and description.

3. Select the points to be included in the report. Initially, the list
of points presented will include those that were selected from
the ViewSPACE.

4. Select a specific Data Collection Module in which to allocate
the Data Collection Tables. By default, the wizard locates an
available module on the current CCN. But you also have the
ability to identify a specific module, if desired.

5. From the next dialog box, click on Report Options to view or
modify the default settings, if desired.

Trend Wizard

Report Wizard
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Follow the steps below to launch the WorkSPACE Manager appli-
cation and create a new WorkSPACE.

Note: If the WorkSPACE Manager application is already run-
ning and is operating in run mode, start with Step 3 below.
When in design mode, you can create a new WorkSPACE
at any time by clicking on the File menu item and then
clicking on the New WorkSPACE  command.

1. Double click on the WorkSPACE Manager icon to launch the
WorkSPACE Manager application.

The Open WorkSPACE dialog box is displayed.

2. In the Open WorkSPACE dialog box, click on Cancel.

The dialog box closes and ComfortVIEW displays a new
blank WorkSPACE window in run mode.

3. Switch to design mode. To do this, click on the Run menu
item and then click on Enter design mode.

4. Click on No if asked whether you wish to load the current
WorkSPACE for design.

The WorkSPACE Manager enters design mode and displays a
blank WorkSPACE. The message Design displays in the
lower right corner of the window to indicate that you are in
design mode.

5. You can now create new or add existing ViewSPACEs and
trends to your new WorkSPACE.

To do this, click on the File menu item and then click on one
of the following commands:

• New ViewSPACE/Trend — to create a new ViewSPACE
or trend.

For instructions on using this command, refer to the
Creating a New ViewSPACE or  Creating and Modifying
Trends section of this chapter.

• Open ViewSPACE/Trend — to open an existing
ViewSPACE or trend window. ComfortVIEW displays

Creating a New
WorkSPACE
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the Open ViewSPACE/Trend dialog box. Refer to Table
4-9 and Figure 4-9.

Note: You may also perform this command by clicking
on the Open ViewSPACE/Trend icon in the toolbar.

Select the ViewSPACE or trend that you wish to use and
then click on OK. The WorkSPACE Manager displays
the selected ViewSPACE or trend on your screen.

6. After adding and saving all of the ViewSPACEs and trends,
save the WorkSPACE by clicking on the File menu item and
then clicking on the Save WorkSPACE command.

Note: You may also perform this command by clicking on
the Save WorkSPACE icon in the toolbar.

The Save Current WorkSPACE As dialog box is displayed.
Refer to Figure 4-10 and Table 4-10 for instructions on using
this dialog box.

7. Indicate the WorkSPACE’s ownership designation by click-
ing on Owned or Global to enable or disable these options.

8. Click on OK to close the dialog box and save the
WorkSPACE, or on Cancel to close the dialog box without
saving.

The WorkSPACE Manager saves the WorkSPACE and all
associated ViewSPACEs and trends with their current win-
dow locations and sizes. When you display the WorkSPACE
in run mode, all ViewSPACEs and trends display with the
window location and size that they had when the
WorkSPACE was saved.

If you have a WorkSPACE containing ViewSPACEs and trends
with points from a single controller, you can use the cloning feature
to quickly create another WorkSPACE containing identical points
from another controller of the same type and version. This feature
would be particularly useful when designing WorkSPACEs for a
zoned system, for example.

WorkSPACE Cloning
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Follow the instructions below to clone a WorkSPACE:

Note: You can only clone a WorkSPACE if all its points are
from a single controller.

1. In design mode, open an existing, or create and save a new
WorkSPACE.

2. Click on the File menu item and then click on Save
WorkSPACE as.

3. In the Save WorkSPACE As dialog box (refer to Figure 4-
10), click on the Clone button.

The Clone WorkSPACE dialog box is displayed. Refer to
Figure and Table 4-10a.

4. Enter the name of the new WorkSPACE and click on OK.

The Select Element dialog box will be displayed.

In the Select Element dialog box, select the new system
element's area and element name and address, and click on
OK.

Note: If all of the original ViewSPACE and trend points
are from a single table, the Select Table dialog box
will be displayed in place of the Selec Element
dialog box. In this dialog box you can select the
area, element, table category, and table name for the
new WorkSPACE's points. Then, click on OK to
save your selection and close the dialog box.

ComfortVIEW will create a new WorkSPACE and copy all
existing ViewSPACEs and trends along with all associated
points to it.

A dialog box, titled with the name of your new WorkSPACE
and listing the names of all of the cloned ViewSPACEs and
trends, will now be displayed.

5. Click on Close to close the dialog box.
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23XL Chiller Monitor Trend

Open ViewSPACE/Trend

OK Cancel Help...

Select ViewSPACE/Trend:

23XL Status Display
23XL Mechanical
Annex - Space Temps and Setpoints
Engineering Offices - Space Temps and Setpoints
Executive Offices - Space Temps and Setpoints
Physical Plant - Air Handler Mechanical
PID Loop Tuning Trend
Syracuse Offices - Space Temps and Setpoints

Figure 4-9
Open ViewSPACE/Trend
Dialog Box

Click on To

a ViewSPACE or trend
in the Select
ViewSPACE/Trend list select the ViewSPACE or trend to

open.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 4-9
Open ViewSPACE/Trend
Dialog Box
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Figure 4-10
Save Current WorkSPACE
As Dialog Box

Click on To

the Name edit box enter the new WorkSPACE name. Up
to 48 characters are allowed.

Owned allow this WorkSPACE to be dis-
played by any user, but only modified
or deleted by you (the creator).

Global allow this WorkSPACE to be dis-
played, modified, or deleted by any
user.

Clone copy all ViewSPACEs, trends, and
associated points to a new
WorkSPACE. The Clone
WorkSPACE dialog box will be
displayed. Refer to Figure and Table
4-10a.

OK close the dialog box and save current
settings.

Cancel exit the dialog box without saving.

Help display help information.

Table 4-10
Save Current WorkSPACE
As Dialog Box
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Figure 4-10a
Clone WorkSPACE Dialog
Box

Table 4-10a
Clone WorkSPACE Dialog
Box

Click on To

the Name edit box enter the new WorkSPACE name. Up
to 48 characters are allowed.

OK close the dialog box and save current
settings.

Cancel exit the dialog box without saving.

Help display help information.
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Modifying an
Existing
WorkSPACE

Follow the instructions below to launch the WorkSPACE Manager
application and modify an existing WorkSPACE. You can modify the
WorkSPACE name and its owned/global designation. If desired, you can
also modify or delete the WorkSPACE’s existing ViewSPACEs and
trends, or add new ViewSPACEs and trends to the WorkSPACE.

Note: If the WorkSPACE Manager application is already running and
in design mode, you can modify an existing WorkSPACE at
any time by:

• clicking on the File menu item and then clicking on the
Open WorkSPACE command (or by clicking on the Open
WorkSPACE icon in the toolbar).

• selecting the WorkSPACE that you wish to modify.

• proceeding to Step 6 in the following list.

1. Double click on the WorkSPACE Manager icon to launch the
WorkSPACE Manager application.

The Open WorkSPACE dialog box is displayed.

2. In the Open WorkSPACE dialog box, click on Cancel.

The dialog box closes and ComfortVIEW displays a new blank
WorkSPACE window in run mode.

3. Switch to design mode. To do this, click on the Run menu item
and then click on Enter design mode.

4. Click on Yes when asked whether you wish to load the current
WorkSPACE for design.

The WorkSPACE Manager enters design mode and displays a
blank WorkSPACE. The message Design displays in the lower
right corner of the window to indicate that you are in design mode.

5. Open the WorkSPACE that you wish to modify. To do this, click
on the File menu item and then click on Open WorkSPACE.

Note: You may also perform this command by clicking on the
Open WorkSPACE icon in the toolbar.

6. To modify the WorkSPACE name, click on the Edit menu item
and then click on Modify WorkSPACE.

The Modify Current WorkSPACE dialog box is displayed. Refer
to Figure 4-11 and Table 4-11.
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7. Modify the WorkSPACE name as desired, and then click on OK.

The name change will be made permanent when you save the
WorkSPACE.

8. You can now modify or delete existing ViewSPACEs and trends,
or add new ViewSPACEs and trends to the WorkSPACE.

Instructions on performing these operations can be found in the
following sections of this chapter:

• Modifying an Existing ViewSPACE
• Displaying and Using Trends
• Creating and Modifying Trends
• Deleting/Removing ViewSPACEs
• Deleting/Removing Trends

9. Save the modified WorkSPACE as follows:

• To save the WorkSPACE and overwrite previous modifica-
tions:  Click on the File menu item and then click on the Save
WorkSPACE command.

This command will overwrite the existing WorkSPACE.

Note: You may also perform this command by clicking on the
Save WorkSPACE icon in the toolbar.

• To save the WorkSPACE with a new name:  Click on the File
menu item and then click on the Save WorkSPACE as com-
mand.

This command saves a new version of an existing
WorkSPACE. The Save Current WorkSPACE As dialog box is
displayed. Refer to Figure 4-10 and Table 4-10 for instructions
on using this dialog box.

The WorkSPACE Manager saves the WorkSPACE and all associ-
ated ViewSPACEs and trends with their current window locations
and sizes. When you display the WorkSPACE in run mode, all
ViewSPACEs and trends display with the window location and size
that they had when the WorkSPACE was saved.
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Figure 4-11
Modify Current
WorkSPACE Dialog Box

Click on To

the Name edit box modify the existing WorkSPACE
name. Up to 48 characters are al-
lowed.

OK close the dialog box and save the
current settings.

Cancel exit the dialog box without saving

Table 4-11
Modify Current
WorkSPACE Dialog Box

settings.

Help display help information.

Follow the instructions below to launch the WorkSPACE Manager
application and delete a WorkSPACE from the ComfortVIEW
database. Note that deleting a WorkSPACE does not delete its
associated ViewSPACEs and trends. You can display these
ViewSPACEs and trends by opening them from another
WorkSPACE window.

Note: If the WorkSPACE Manager application is already run-
ning and is operating in run mode, it is not necessary to
perform the instructions below. Instead, you can delete a
WorkSPACE at any time by:

Deleting a
WorkSPACE

Owned

Modify Current WorkSPACE

Name:

23XL Chiller Monitor

OK Cancel Help...

Global

Modifies the window's name
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• entering design mode (by clicking on the Run menu
item and then clicking on Enter design mode).

• clicking on the Edit menu item and then clicking on
the Delete WorkSPACE command.

• proceeding to Step 6 in the following list.

1. Double click on the WorkSPACE Manager icon to launch the
WorkSPACE Manager application.

The Open WorkSPACE dialog box is displayed.

2. In the Open WorkSPACE dialog box, click on Cancel.

The dialog box closes and ComfortVIEW displays a new
blank WorkSPACE window in run mode.

3. Switch to design mode. To do this, click on the Run menu item
and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

4. Click on Yes.

The WorkSPACE Manager enters design mode and the mes-
sage Design displays in the lower right corner of the window.

5. Click on the Edit menu item and then click on Delete
WorkSPACE.

6. In the confirmation dialog box displayed, click on Yes to
delete the WorkSPACE or on No to prevent its deletion.

The WorkSPACE Manager closes any currently-displayed
ViewSPACE and trend windows, deletes the WorkSPACE from the
ComfortVIEW database, and displays a new undefined WorkSPACE
window.
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To create a new ViewSPACE, you must perform the tasks listed
below. Step-by-step instructions for completing each task follow.

• Enter design mode.

• Create a new or open an existing WorkSPACE into which you
wish to include the new ViewSPACE graphic.

• Create the new ViewSPACE and select the pre-drawn graphic
display background. Refer to Graphic Background Drawing
Specifications on the following page.

• Create data boxes and assign the data points on the display.
Depending on how you configure them, data boxes can appear
as rectangular boxes or as animated graphics. A rectangular data
box can contain a configuration, status display, or maintenance
point’s name, 24 character description, value and units, commu-
nication or alarm status, and/or force state. An animated graphic
data box displays an animated picture of a discrete point (for
example, a fan circulating air). A data box can also display data
from a Dynamic Data Exchange (DDE)-linked application.

• Establish links to other WorkSPACEs. Link boxes give you the
capability to jump to another WorkSPACE by double clicking
within a ViewSPACE’s link box boundaries.

• Save the new ViewSPACE and/or WorkSPACE in your
ComfortVIEW database.

Graphic backgrounds should be created using a third party drawing
package that supports one of the following file formats:

File Extension Type

.BMP Windows bitmap

.DIB Windows bitmap

.GIF Compuserve

.JPG JPEG

.PCX PC Paintbrush (ZSoft format only)

.TIF TIFF

.TGA Truevision Targa

Creating a New
ViewSPACE

Overview of the
Process

Graphic Background
Drawing Specifications
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Recommended graphic dimensions for use with a 1024 x 768 super
VGA display are as follows:

• Full Screen ViewSPACE Window Size — 1022 x 648 pixels

Multiple full-screen ViewSPACEs can be in one WorkSPACE.
However, only one ViewSPACE will be seen in its entirety at a
time.

• Cascaded ViewSPACE Window Size — 791 x 421 pixels

A cascaded ViewSPACE window size permits a ViewSPACE to
be seen in its entirety when ViewSPACE windows are displayed
using the cascaded window option.

• Tiled ViewSPACE Window Size — Dimensions dependent on
number of ViewSPACEs

A tiled ViewSPACE window size permits all ViewSPACEs to
be seen in their entirety when ViewSPACE windows are dis-
played using the tiled window option. The size of tiled windows
will vary dependent on the number of open ViewSPACE win-
dows.

Follow the steps below to launch the WorkSPACE Manager appli-
cation and create a new ViewSPACE graphic.

Note: If the WorkSPACE Manager application is already run-
ning, you can create a new ViewSPACE at any time by:

• if necessary, entering design mode (by clicking on the
Run menu item and then clicking on Enter design mode).

• opening an existing WorkSPACE (by clicking on the File
menu item and then clicking on Open WorkSPACE) or
opening a new WorkSPACE (by clicking on the File
menu item and then clicking on New WorkSPACE).

• proceeding to Step 6 in the following list.

1. Double click on the WorkSPACE Manager icon to launch the
WorkSPACE Manager application.

The Open WorkSPACE dialog box is displayed.

2. In the Open WorkSPACE dialog box, click on the Cancel
button.

The dialog box closes and ComfortVIEW displays a blank
WorkSPACE window in run mode.

Step-by-step

Instructions
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3. Switch to design mode. To do this, click on the Run menu item
and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

4. Click on Yes.

The WorkSPACE Manager enters design mode and the message
Design  displays in the lower right corner of the window.

5. Open the WorkSPACE into which you wish to add this new
ViewSPACE by clicking on the File menu item and then clicking
on Open WorkSPACE.

You may also perform this command by clicking on the Open
WorkSPACE icon in the toolbar.

Note: If you wish to open a new WorkSPACE for the
ViewSPACE, click on the File menu item and then click
on New WorkSPACE.

6. Open the new ViewSPACE window by clicking on the File menu
item and then clicking on New ViewSPACE.

A blank ViewSPACE window is displayed.

7. Select the Graphic Background:

a. Click on the Configure menu item and then click on Back-
ground.

The File Open dialog box is displayed.

b. Select the graphic background file you wish to display or
type the file name in the File Name box. You can select a
different drive by making your selection from the Drives
drop down list. You can also select a file that is resident on
another network computer by clicking on the Network button.
The selected graphic background loads and displays in the
ViewSPACE window. The message Loading background
image displays in the lower left corner of the window during
the load process.

8. Create the First Data Box:

a. Click on the Configure menu item and then click on New
Data Box.

Note: You may also perform this command by clicking
on the Create New Data Box icon in the toolbar.
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The WorkSPACE Manager creates a data box on your
graphic background screen and displays the Modify Data
Box tabbed dialog box. Refer to Figure and Table 4-12.

b. In the Data selection tab, click on CCN point (if the data
you wish to display originates from the CCN), or,
click on DDE point if the point is being DDE linked to
ComfortVIEW from another application. For example,
Excel.

c. If, in Step 8b above, you selected DDE point, you must
now specify the DDE application, topic, and item names.
If, however, the application from which you are linking
supports the Paste link function (and you have copied the
cell while in the application), you can click on the Paste
link button and the WorkSPACE Manager will automati-
cally fill in this information for you. Then, skip to Step 8f
and select the data box style.

If, in Step 8 above, you selected CCN point, you must
now click on Select point to select the CCN point to
assign to the data box.

The Data Point Selection dialog box is displayed.

d. From the Select Area, Select Element, Select Category,
Select Table, and Select Point drop down lists, select the
area, controller table category, table, and name of the
point that you wish to display on this new ViewSPACE.
Refer to Figure 4-13 and Table 4-13 for instructions on
using the Data Point Selection dialog box.

e. Click on OK to select the currently-displayed point and
close the dialog box, or

Note: If you press the Ctrl key while you click on OK,
you will select the point, and keep the dialog box
open so that you can make additional point
selections.

or click on Cancel to close the dialog box without saving
the point selection.

The Modify Data Box dialog box is re-displayed.

f. In the Modify Data Box dialog box, select the Databox
style tab. Then, specify the desired databox display style
— Normal or Animated (Animated is for discrete points
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only), and the box's background and alarm colors.
If you select an animated (moving picture) data box
style, you must assign graphics that have been pre-drawn
using a third party drawing package and named accord-
ing to the frame creation guidelines listed in this
chapter’s Animated Data Box Frame Creation Guidelines
section.

Refer to Table 4-12 for an explanation of the options in
the Modify Data Box tabbed dialog box.

g. Now, in the Modify Data Box tabbed dialog box, select
the Font and colors tab. Select the font and the data
elements that you wish to display (point name, descrip-
tion, etc.) You can also specify an associated display
color for each element.

h. Clicking on the Modify Data Box dialog box's Layout
tab brings up a sample databox that displays your current
databox style and element selections. You can further
customize your databox presentation by using the Win-
dows drag and drop technique to move data elements
around in the sample data box.

i. After all Modify Data Box dialog box tabs have been
selected and your sample data box appears as desired,
click on OK to close the dialog box and save the data box
settings, or

click on Cancel to close the dialog box without saving
settings.
The ViewSPACE window re-displays with the newly
configured data box placed on the graphic background
screen.

j. Drag the data box to re-position it as desired.

If desired, you can also re-size the box by dragging a
corner.

9. Create Additional Data Boxes:
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Once you’ve designed your first data box, you can copy and
paste it to quickly and easily create additional data boxes.
Follow the steps below:

a. Click on the data box that you created in Step 8.

b. Click on the Edit menu item and then click on Copy.

c. Click on the Edit menu item again and then click on
Paste.

The WorkSPACE Manager copies the selected data box
and pastes the copy on the graphic background screen.
The new data box will be placed partially on top of the
original.

d. Drag the data box to re-position it as desired.

e. Double click on the data box to display the Modify Data
Box dialog box and modify the point selection and other
dialog box options accordingly. Refer to Step 8 of this list
and to Table 4-12 for instructions on using the Modify
Data Box dialog box.

10. Create your link areas. You can place up to fifteen link areas
on a ViewSPACE.

a. Click on the Configure menu item and then click on New
link area.

Note: You may also perform this command by clicking
on the New Link Area icon in the toolbar.

The Modify Link Area dialog box is displayed. Refer to
Figure 4-15.

b. Select the WorkSPACE to which you wish to link, click
on Border to enable or disable display of a border around
the link area, and then click on OK.

The WorkSPACE Manager displays the link area box on
your graphic background screen.

c. You can re-size the link area by dragging the box corner.

d. You can re-position the link area by dragging it.

11. If desired, you can "lock" the ViewSPACE so that its window
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size and position, and its link areas, databoxes, and background
graphic cannot be inadvertently altered. To do this, click on the
Options menu item and then click on Lock window.

If desired, you can also select the Options menu's Size image to
window command to force the background graphic to re-size
itself dynamically based on the size of the ViewSPACE. This
allows you to display large graphics in their entirety inside a
ViewSPACE and eliminates the need for use of scroll bars.

12. Save the ViewSPACE:

a. Click on the File menu item and then click on Save
ViewSPACE/Trend.

Note: You may also perform this command by clicking on
the Save ViewSPACE/Trend icon in the toolbar.

The Save Current ViewSPACE As dialog box is displayed.
Refer to Figure and Table 4-16.

b. Enter a ViewSPACE name.

c. Click on Owned to allow this ViewSPACE to be displayed
by any user, but only modified or deleted by you (the cre-
ator) or,

click on Global to allow this ViewSPACE to be displayed,
modified, or deleted by any user.

d. Click on OK to close the dialog and save the ViewSPACE.

The ViewSPACE window re-displays.

13. Save the WorkSPACE:

a. Click on the File menu item and then click on Save
WorkSPACE.

Note: You may also perform this command by clicking on
the Save WorkSPACE icon in the toolbar.

If the WorkSPACE has not been previously saved, the Save
WorkSPACE As dialog box is displayed. Refer to Figure 4-
10 and Table 4-10.

If the WorkSPACE has already been saved, the WorkSPACE
Manager simply saves the WorkSPACE under the current
name and ownership.
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b. Enter a WorkSPACE name.

c. Click on Owned to allow this WorkSPACE to be dis-
played by any user, but only modified or deleted by you
(the creator) or,

click on Global to allow this WorkSPACE to be dis-
played, modified, or deleted by any user.

d. If desired, you can also click on Clone to quickly create
another WorkSPACE containing identical points from
another controller of the same type and version.

e. Click on OK to close the dialog and save the
WorkSPACE.

The WorkSPACE Manager saves the WorkSPACE and all
ViewSPACEs and trends in their current locations and sizes.
When you display the WorkSPACE in run mode, all
ViewSPACEs and trends display in the location and size that
they were on performing the WorkSPACE save.

You can now display the ViewSPACE in run mode and view its
data dynamically updating. For instructions on Displaying
ViewSPACEs, refer to the Displaying and Using a ViewSPACE
section of this chapter.

Figure 4-12

Modify Data Box

Dialog Box
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Table 4-12
Modify Data Box Dialog
Box

Click on To

Data selection tab:
CCN point specify that the point to be displayed is

from the CCN.

Select point select the CCN point to assign to the
data box. The Data Point Selection
dialog box displays.  Refer to Figure 4-
13 and Table 4-13 for instructions on
using this dialog box.

Origin Origin display a message dialog box
that displays the point’s area, element,
address, table, and point name.

DDE point specify that the point to be displayed is
being DDE linked to ComfortVIEW
from another application. For example,
Excel.

DDE application specify the name of the DDE applica-
tion that is linking to ComfortVIEW. If
the DDE application does not support
the Paste link function, you must
specify this information, as well as the
DDE topic and item. If the application
does support Paste link, you can simply
click on this dialog box's Paste link
button.

DDE topic specify the DDE topic name.

DDE item specify the DDE item name.

Paste link decipher the DDE link and automati-
cally fill in the DDE application, topic,
and item information.

         (continued)
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Table 4-12
Modify Data Box Dialog
Box
(continued)

Click on To

Note:  For you to use the Paste link
option, the application must support
the Paste link function.

Databox style tab:
Normal select the text data box style versus

the animated data box style.

Background

Transparent select a clear data box background.

Opaque select a solid data box background.
Click on the Color button to select the
opaque box’s background color. Click
on the Alarm Color button to select a
background color that will display
when this point is in an alarm or alert
state.

Animated select an animated data box style. An
animated data box is one that includes
a graphic that dynamically changes
based on data point value. For ex-
ample, a fan with turning blades. This
option is available for discrete data
points only.

Frames select the graphics for the animated
data box. The Frame Family Selection
dialog box displays. Refer to Figures
4-14 and Table 4-14 for instructions
on using this dialog box. The selected
graphics display in the dialog box's
State 0 and State 1 boxes.

       (continued)
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Table 4-12
Modify Data Box
Dialog Box
(continued)

Click on To

Font and colors tab:
Border enable or disable display of the data box

border.

Point name include or remove the point name in the
data box. Click on the corresponding
Color button to select the point name text
color.

Description include or remove the 24 character point
description in the data box. Click on the
corresponding Color button to select the
description text color.

Value include or remove the value in the data
box. Click on the corresponding Color
button to select the value text color.
Clicking on Alarm color selects the value
text color that will display when the value
is in alarm. Clicking on Force color
selects the value text color that will
display when the value is Forced (the
controller’s automatic control is being
overridden.)

Units include or remove the units in the data
box. Click on the corresponding Color
button to select the units text color.

Comm/alarm status include or remove the communication/
alarm status in the data box. Click on the
corresponding Color button to select the
communication/alarm status text color.

 Force status include or remove the force status in the
data box. Click on the corresponding
Color button to select the force status text
color.

Color select the color of the corresponding data
element (point name, description, value,
units, etc.).

Font Select the font of the databox text.

(continued)
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Click on To

Layout tab: view a sample databox that displays
your current databox style and ele-
ment selections. You can further
customize your databox presentation
by using the Windows drag and drop
technique to move data elements
around in the sample data box.

OK close the dialog box and save the data
box settings.

Cancel exit the dialog box and without saving
the settings.

Help display help information.

Table 4-12
Modify Data Box
Dialog Box
(continued)

Figure 4-13
Data Point Selection
Dialog Box

Data Point Selection

Select Area:

Cancel Help...

Select Element:

Select Category:

Select Table:

Select Point:

United Mutual Insurance - Physical Plant

23XL: Chiller - 0, 128

Status Display

STATUS 01: Status Display

ECW: Entering Chilled Water

OKReset
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Table 4-13
Data Point Selection
Dialog Box

Click on To

the Select Area drop down list display a list of all areas in
your ComfortVIEW database.
Click to select the area con-
taining the point to display or
trend.

the Select Element drop down list display a list of all elements in
the selected area. Click to
select the controller (system
element) containing the point
to display or trend.

the Select Category drop down list display a list of all table
categories in the selected
system element.

the Select Table drop down list display a list of all tables in the
selected  category.

the Select Point drop down list display a list of all points in
the selected element and table.
Click on a point to select it.

Reset erase any drop down list
selections.

Note:   You will reset the
selections, even if you click on
Cancel before exiting the
dialog box.

OK select the specified point and
close the dialog box.

Note: If you press the Ctrl
key while you click on OK,
you will select the point, and
keep the dialog box open so
that you can make additional
point selections.

Cancel exit the dialog box without
selecting the point.

Help display help information.
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Frame Family Selection

Animated frame family:

OK Cancel Help...

FTLR
FANS

TEST

On: Off:

Selects animated frames

Figure 4-14
Frame Family Selection
Dialog Box
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Table 4-14
Frame Family Selection
Dialog Box

Click on To

the name of an animated
frame family select the graphics that will display in

the selected point’s data box. The
family’s associated graphics display in
the lower half of the dialog box. Refer
to the Animated Data Box Frame
Creation Guidelines section of this
chapter for frame creation guidelines.

OK select the graphic and close the dialog
box.

Cancel exit the dialog box without saving
selections.

Help display help information.

Modify Link Area

OK Cancel Help...

Select WorkSPACE:

Selects linked WorkSPACE

BorderX

23XL Chiller Monitor
Unity Mutual Insurance Campus
Unity Mutual Remote Office
WorkSPACE: PID Loop Trends

Figure 4-15
Modify Link Area Dialog
Box
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Click on To

the name of a WorkSPACE select the target WorkSPACE to
which this link will jump.

Border enable or disable display of the link
area border.

OK select the WorkSPACE and close the
dialog box.

Cancel exit the dialog box without saving
selections.

Help display help information.

Table 4-15
Modify Link Area Dialog
Box

Figure 4-16
Save Current
ViewSPACE/Trend As
Dialog Box
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Click on To

the Name edit box enter the new ViewSPACE or trend
name. Up to 48 characters are al-
lowed.

Owned allow this ViewSPACE or trend to be
displayed by any user, but only modi-
fied or deleted by you (the creator).

Global allow this ViewSPACE or trend to be
displayed, modified, or deleted by any
user.

Auto connect when displaying this ViewSPACE or
trend in run mode, automatically
attempt to establish a connection to all
remote CCNs containing points from
this ViewSPACE or trend.

Auto start on displaying this trend in run mode,
cause the trend to automatically start.

Time Display on displaying this ViewSPACE in run
mode, include time and date on the
display.

OK close the dialog box and save current
settings.

Cancel exit the dialog box without saving.

Help display help information.

Table 4-16
Save Current
ViewSPACE/Trend As
Dialog Box
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Modifying An
Existing
ViewSPACE

Follow the instructions below to modify an existing ViewSPACE.
You can modify the ViewSPACE name, and all data box parameters,
including data box locations and sizes. You can also add new and
delete existing data boxes and link areas.

1. If necessary, enter design mode by clicking on the Run menu
item and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

2. Click on Yes.

The WorkSPACE Manager displays the selected WorkSPACE
in design mode. The message Design will display in the lower
right corner of the window.

3. Display the ViewSPACE that you wish to modify by clicking
on the File menu item and then clicking on Open ViewSPACE/
Trend.

Note: You may also perform this command by clicking on
the Open ViewSPACE/Trend icon in the toolbar.

1. Click on the Edit menu item and then click on Modify
ViewSPACE/trend, or click on the Modify button in the
ViewSPACE window.

The WorkSPACE Manager displays the Modify Current
ViewSPACE dialog box. Refer to Figure 4-17 and Table 4-17.

Note: You can also display this dialog box by clicking on
the Modify ViewSPACE/Trend icon in the toolbar,
or, by double clicking anywhere within the
ViewSPACE window. Do not, however, click on a
data or link box.

2. In the Name edit box, modify the ViewSPACE name as de-
sired.

3. Click on OK to close the dialog box and save modifications, or
on Cancel to close the dialog box and restore the previous
settings.

To Modify the
ViewSPACE Name
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Figure 4-17
Modify Current
ViewSPACE Dialog Box

Modify Current ViewSPACE

Name:

OK Cancel Help...

Modifies the window's name

23XL Chiller Monitor

Owned

Global

Auto start

Auto connect

Click on To

the Name edit box enter a new or modify the existing
ViewSPACE name. Up to 48 charac-
ters are allowed.

Owned specify that this ViewSPACE can
only be modified by the operator who
created it.

Global specify that this ViewSPACE can be
modified by any operator.

Time display have this ViewSPACE include time
and date display.

Auto connect if this ViewSPACE contains points
from a remote CCN, automatically
connect to the remote CCN on dis-
playing the ViewSPACE.

OK close the dialog box and save the
current settings.

Cancel exit the dialog box without saving
settings.

Help display help information.

Follow the instructions below to modify an existing data box's
display parameters, location, or size. Note that if the Option's
menu's Lock window command is enabled, you will not be permit-

Table 4-17
Modify Current
ViewSPACE Dialog Box

To Modify Data Box
Parameters, Location,
and Size
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ted to modify a databox's or link area's location or size. You can
select and modify the display parameters and size of multiple data
boxes by holding down the Ctrl key and clicking on each data box
that you wish to change. Then, follow the instructions below.

To Modify Data Box Parameters

Follow the instructions below to modify the point selection or other
display parameters.

1. Double click on the data box you wish to modify.

Note: If you have selected multiple data boxes, double click
on the first data box you selected. You must continue
to press and hold the Ctrl key while double clicking.

The Modify Data Box dialog box is displayed.

Note: You may also display this dialog box by clicking on
the data box, clicking on the Edit menu item, and
then clicking on Modify Object. However, if you
have enabled the Options menu's Lock window
command, you will not have access to the Modify
Object command.

2. Modify the data box parameters as desired. Refer to Figure 4-12
and Table 4-12 for an explanation of each data box parameter.

3. Click on OK to close the dialog box and save modifications,
or on Cancel to close the dialog box and restore the previous
settings.

The data box re-displays with the newly-selected parameters.

To Modify the Data Box Location and Size

1. Click on the data box you wish to modify.

Note: If you have selected multiple data boxes, double
click on the first data box you selected. You must
continue to press and hold the Ctrl key while double
clicking.

2. To re-size the box, drag a corner.

3. Drag the box to re-position it within the ViewSPACE.

1. Click on the data box or link area you wish to delete.

Note: If you have enabled the Option's menu's Lock
window command, you cannot delete data boxes or
link areas.

To Delete a Data Box or
Link Area
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2. Click on the Edit menu item, then click on Delete.

The WorkSPACE Manager deletes the selected data box or
link area.

Note: If desired, you can place the data box or link area on
the clipboard before deleting it, by clicking on the Edit
menu item, then clicking on Cut. This gives you the
capability to delete a data box or link area from one
location and place it in another.

You can create new data boxes by copying an existing box and
modifying its parameters. You may also create new data boxes by
clicking on the Create New Data Box icon in the toolbar.

Note: If you have enabled the Options menu's Lock
window command, you cannot create new data
boxes.

1. Click on the data box you wish to copy.

2. Click on the Edit menu item and then click on Copy.

3. Click on the Edit menu item and then click on Paste.

4. Drag the data box to re-position it as desired.

1. Click on the Configure menu item and then click on New link
area. You may also perform this command by clicking on the
New Link Area icon in the toolbar.

Note: If you have enabled the Options menu's Lock
window command, you cannot add new link areas.

The Modify Link Areas dialog box is displayed. Refer to
Figure 4-15.

2. Select the WorkSPACE to which you wish to link, click on
Border to enable or disable the box border display, and then
click on OK.

The WorkSPACE Manager displays the link area box on your
graphic background screen.

3. You can re-size the box by dragging the box corner or, can
drag the box to re-position it within the ViewSPACE.

Follow the instructions below to modify a link area. You can modify
the WorkSPACE to which a link will jump, or you can enable or
disable box border display. If desired, you can modify the border
display for multiple link areas by holding down the Ctrl key and
clicking on the link areas. Note that if the Options menu's Lock

To Add a New
Data Box

To Add a New
Link Area

To Modify a Link Area
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window command is enabled, you will not be permitted to modify or
delete a link area using the Edit menu's Modify command.

1. Double click on the link area you wish to modify.

Note: If you have selected multiple link areas, you must click
on the first link area that you selected. You must
continue to press and hold the Ctrl key while double
clicking.

The Modify Link Areas dialog box is displayed.

Note: You may also display this dialog box by clicking on
the data box, clicking on the Edit menu item, and then
clicking on Modify Object. However, if you have
enabled the Options menu's Lock window command,
you will not have access to the Modify Object com-
mand.

2. Click on the name of the WorkSPACE to which you wish this
link to jump.

3. Click on Border to enable or disable display of the box border.

4. Click on OK to close the dialog box and save modifications, or
on Cancel to close the dialog box and restore the previous
settings.

Save the modified ViewSPACE as follows:

1. Click on the File menu item and then click on one of the follow-
ing commands depending on whether you wish to save the
ViewSPACE under the same or under a new name:

• To save the ViewSPACE and overwrite previous modifica-
tions:  Click on the File menu item and then click on the
Save ViewSPACE command.

Note: You may also perform this command by
clicking on the Save ViewSPACE/Trend icon
in the toolbar.

This command will overwrite your existing WorkSPACE.

• To save the ViewSPACE with a new name:  Click on the
File menu item and then click on the Save ViewSPACE as
command.

This command allows you to save a new version of an
existing WorkSPACE.

To Save the Modified
ViewSPACE
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The Save Current ViewSPACE As dialog box is dis-
played. Enter the ViewSPACE name and specify its
ownership designation (Owned or Global). Refer to
Figure 4-16 and Table 4-16 for instructions on using this
dialog box.

2. If, in Step 1, you saved the ViewSPACE under a new name,
you must also save the WorkSPACE.

• To save the WorkSPACE under the same name:  Click on
the File menu item and then click on the Save
WorkSPACE command.

Note: You may also perform this command by
clicking on the Save WorkSPACE icon in the
toolbar.

• To save the WorkSPACE under a new name:  Click on
the File menu item and then click on the Save
WorkSPACE as command.

The Save Current WorkSPACE As dialog box is dis-
played. Refer to Figure 4-10 and Table 4-10 for instruc-
tions on using this dialog box.

The WorkSPACE Manager saves the WorkSPACE and all
associated ViewSPACEs and trends with their current win-
dow locations and sizes. When you display the WorkSPACE
in run mode, all ViewSPACEs and trends display with the
window location and size that they had when the
WorkSPACE was saved.

Follow the instructions below to re-arrange any ViewSPACE's
databoxes in a tabular display format.

Note: If the Options menu's Lock window command is currently
enabled, you will not be permitted to perform this func-
tion.

1. Display the ViewSPACE in design mode. If necessary, refer
to Modifying an Existing ViewSPACE.

2. Click on the Options menu item and then click on Tabularize
Data Boxes.

Creating Tabular
Data Box Displays
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The WorkSPACE Manager displays a dialog box asking if
you wish to tabularize the data boxes.

3. Click on Yes.

The WorkSPACE Manager will remove the graphic back-
ground and re-size and re-arrange all data boxes to appear in a
tabular format.

1. Click on the Options menu item and then click on Cascade
Data Boxes.

The WorkSPACE Manager will re-size all data boxes and
display them in a cascaded format.

2. You can now re-display the graphic background by clicking
on the Configure menu item and then clicking on Back-
ground.

3. After displaying the desired graphic background, you can re-
position the data boxes by dragging them to the desired
location.

Follow the instructions below to delete a ViewSPACE from the
ComfortVIEW database.

1. Display the ViewSPACE that you wish to delete. If necessary,
refer to Displaying and Using a ViewSPACE.

2. If necessary, switch to design mode. To do this, click on the
Run menu item and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if
you wish to reload the current WorkSPACE for design.

3. Click on Yes.

The WorkSPACE Manager displays the selected
WorkSPACE in design mode. The message Design will
display in the lower right corner of the window.

4. Click on the Edit menu item and then click on Delete
ViewSPACE/Trend.

5. In the confirmation dialog box displayed, click on Yes to
delete the ViewSPACE or on No to prevent its deletion.

To Exit the Tabular
Display and Re-Size
Data Boxes

Deleting/
Removing
ViewSPACEs

To Delete a ViewSPACE
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The WorkSPACE Manager closes the ViewSPACE window and
deletes the ViewSPACE from the ComfortVIEW database.

Follow the instructions below to permanently remove a
ViewSPACE from a WorkSPACE. Note that this function does not
delete the ViewSPACE from the ComfortVIEW database. It only
removes the selected ViewSPACE from the selected WorkSPACE.

1. Display the ViewSPACE that you wish to delete. If neces-
sary, refer to Displaying and Using a ViewSPACE.

2. If necessary, switch to design mode. To do this, click on the
Run menu item and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if
you wish to reload the current WorkSPACE for design.

3. Click on Yes.

The WorkSPACE Manager displays the selected
WorkSPACE in design mode. The message Design will
display in the lower right corner of the window.

4. Click on the Edit menu item and then click on Remove
ViewSPACE/Trend.

5. In the confirmation dialog box displayed, click on Yes to
remove the ViewSPACE from the WorkSPACE or on No to
prevent its deletion.

6. Save the WorkSPACE by clicking on the File menu item and
then clicking on the Save WorkSPACE command.

Note: You may also perform this command by clicking on
the Save WorkSPACE icon in the toolbar.

The trending function is best suited for loop tuning and short-term
performance tracking. If you wish to perform extended trending, use
the CCN Data Collection Option Module in coordination with the
ComfortVIEW history report with automatic data retrieval. If
necessary, refer to the Report Panel chapter of this manual.

You can trend data from any controller table. Each trend will scan
up to 1000 samples of data for each point. For example, setting your
trend scan rate to 15 seconds will cause your trend to record data for
4 hours 10 minutes. When 1000 samples of each point are reached,
the trend will stop.

To Remove a
ViewSPACE

Creating and
Modifying Trends
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Follow the steps below to launch the WorkSPACE Manager applica-
tion and create a new or modify an existing trend.

Note: If the WorkSPACE Manager application is already running
you can create a new or modify an existing trend at any
time by:

• if necessary, entering design mode (by clicking on the
Run menu item and then clicking on Enter design
mode).

• opening an existing WorkSPACE (by clicking on the
File menu item and then clicking on Open
WorkSPACE) or opening a new WorkSPACE (by
clicking on the File menu item and then clicking on
New WorkSPACE).

• proceeding to Step 6 in the following list.

1. Double click on the WorkSPACE Manager icon to launch the
WorkSPACE Manager application.

The Open WorkSPACE dialog box is displayed.

2. In the Open WorkSPACE dialog box, click on the Cancel
button.

The dialog box closes and ComfortVIEW displays a blank
WorkSPACE window in run mode.

3. Switch to design mode. To do this, click on the Run menu item
and then click on Stop run mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

4. Click on Yes.

The WorkSPACE Manager enters design mode and the mes-
sage Design displays in the lower right corner of the window.

5. Open the WorkSPACE into which you wish to add this new
trend by clicking on the File menu item and then clicking on
Open WorkSPACE.

You may also perform this command by clicking on the Open
WorkSPACE icon in the toolbar.

Note: If you wish to open a new WorkSPACE for the trend,
click on the File menu item and then click on New
WorkSPACE.
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6. Do one of the following depending on whether you wish to
create a new or modify an existing trend:

• To create a new trend:

Open the new trend window by clicking on the File menu
item and then clicking on New Trend.

A blank trend window is displayed.

• To modify an existing trend:

Click on the File menu item and then click on Open
ViewSPACE/Trend.

In the Open ViewSPACE/Trend window, click on the
trend that you wish to modify and then click on OK.

Note: You may also perform this command by
clicking on the Open ViewSPACE/Trend
icon in the toolbar.

7. Add or modify trend points and configure or modify the trend
operating characteristics. You can trend up to six points:

a. Click on the Edit menu item and then click on Modify
ViewSPACE/Trend.

Note: You may also perform this command by
clicking on the Modify ViewSPACE/Trend
icon in the toolbar or on the Modify button in
the trend window.

The Modify Current Trend dialog box is displayed. Refer
to Figure 4-18 and Table 4-18.

b. Click in the Name edit box to specify a new or modify
the existing name.

c. Click on Select point to select a new or modify an exist-
ing trend point.

The Data Point Selection dialog box is displayed.

d. From the Select Area, Select Element, Select Category,
Select Table, and Select Point drop down lists, select the
area, element and table, and name of the point that you
wish to display on this new trend. Refer to Figure 4-13
and Table 4-13, which appear earlier in this chapter, for
instructions on using the Data Point Selection dialog
box.
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e. Click on OK to select the currently-displayed point and
close the Data Point Selection dialog box, or

click on Cancel to close the dialog box without saving
the point selection.

The Modify Current Trend dialog box is re-displayed.

f. Repeat Steps c to e to select each trend point.

8. In the Scan rate box, enter the rate at which you would like to
sample data. You may also click on the up or down arrow to
increment or decrement the displayed value.

9. Enable the Auto start option if you would like the trend to
start every time the trend is displayed in run mode.

10. If you wish to save trend data to a file which you can then
open and display at a later time, enter an Archive file name.

11. Click on Quick select to display the Data Point Selection
dialog box with the area, element, and point drop down lists
in their previously sorted state. Enabling this option expedites
the point selection process.

12. Click on OK to close the Modify Trend dialog box and save
your trend point selections, or on Cancel to exit the dialog
box without saving point selections.

1. Click on the File menu item and then click on one of the
following commands depending on whether you wish to save
a new trend or save a modified trend under a new name:

• To save a new trend, or to save a modified trend and
overwrite previous modifications:  Click on the File
menu item and then click on the Save Trend command.

Note: You may also perform this command by
clicking on the Save ViewSPACE/Trend icon
in the toolbar.

This command will overwrite your existing trend.

• To save a modified trend with a new name:  Click on the
File menu item and then click on the Save Trend as
command.

This command allows you to save a new version of an
existing trend.

To Save the Trend
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The Save Current Trend As dialog box is displayed.
Enter the trend name and specify its ownership designa-
tion (Owned or Global). Refer to Figure 4-20 and Table
4-20 for instructions on using this dialog box.

2. If, in Step 1, you saved a new trend or a modified trend under
a new name, you must also save the WorkSPACE.

• To save the WorkSPACE and overwrite previous modifi-
cations:   Click on the File menu item and then click on
the Save WorkSPACE command.

Note: You may also perform this command by
clicking on the Save WorkSPACE icon in the
toolbar.

This command will overwrite your existing
WorkSPACE.

• To save the WorkSPACE with a new name:  Click on the
File menu item and then click on the Save WorkSPACE
as command.

This command allows you to save a new version of an
existing WorkSPACE.

The Save Current WorkSPACE As dialog box is dis-
played. Refer to Figure 4-10 and Table 4-10 for instruc-
tions on using this dialog box.

If desired, you can click on the Save Current
WorkSPACE As dialog box's Clone button to quickly
create another WorkSPACE containing identica.l points
from another controller of the same type and version.

The WorkSPACE Manager saves the WorkSPACE and all
associated ViewSPACEs and trends with their current win-
dow locations and sizes. When you display the WorkSPACE
in run mode, all ViewSPACEs and trends display with the
window location and size that they had when the
WorkSPACE was saved.

You can now display the trend in run mode and view the trend data
dynamically plotting:

Click on the Run menu item and then click on Start run mode.

For further instructions, refer to the Displaying and Using
Trends section of this chapter.

To Display the New or
Modified Trend in Run
Mode
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Figure 4-18
Modify Trend Dialog Box

Click on To

Name up to 48 characters are allowed.

Owned specify that this this trend can be
displayed by any operator, but only
modified or deleted by the creator.

Global specify that this trend can be used,
modified, or deleted by any operator.

Select point select the trend point. The Data Point
Selection dialog box is displayed. Refer
to Figure 4-13 and Table 4-13 for
instructions on using this dialog box.

         (continued)

Table 4-18
Modify Trend Dialog Box

Global

Modify Current Trend

Options

OK Cancel Help...

Owned

Name:
23XL CHILLER MONITOR TREND

Select point...

Range...Color...

Select point...

Range...Color...

Select point...

Range...Color...

Select point...

Range...Color...

Select point...

Range...Color...

Select point...

Range...Color...

Point 1: %LOAD: % Cooler Load

Point 2: ECW: Entering Water Temp

Point 3:

Point 4:

Point 5:

Point 6:

LCW: Leaving Water Temp

CWFL: Water Flow (GPM/LPS)

Origin

Auto Start

X

Auto Connect

seconds60Scan rate:

Archive filename:

...

Quick selectX



285

Click on To

Color select the color for the corresponding
point’s trend line.

Range select the range of values within
which to plot the corresponding point.
These are the minimum and maximum
values that will display on the trend’s
Y axis. The Trend Range dialog box is
displayed. Refer to Figure 4-19 and
Table 4-19 for instructions on using
this dialog box.

Auto start specify that this trend should auto-
matically start whenever it is dis-
played in run mode.

Auto connect when displaying this trend in run
mode, automatically attempt to estab-
lish a connection to all remote CCNs
containing points from this trend.

Scan rate select the rate at which the trend
samples data. The default is every 15
seconds. You can enter a value or
click on the up or down arrow to
increment or decrement the displayed
value.

Archive filename specify the name of a file to which
data will be written when the trend is
active. When the trend is activated in
run mode, the data will be archived to
this file as it is plotted. The data can
then be re-displayed in a trend win-
dow from run mode using the File
menu's Open Archived Trend com-
mand.

Quick select display the Data Point Selection
dialog box with the area, element,
category, table, and point drop down
lists in their previously sorted state.
Enabling this option expedites the
point selection process.

       (continued)

Table 4-18
Modify Trend Dialog Box
(continued)
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Click on To

Origin display a message dialog box that
displays the point's area, element,
address, table, and point name.

OK close the dialog box and save the
trend point selections.

Cancel exit the dialog box without saving the
trend point selections.

Help display help information.

Table 4-18
Modify Trend Dialog Box
(continued)

Figure 4-19
Trend Range Dialog Box

Trend Range

Low limit:

High limit:

0

150

Mutual Of Farmington - Cold Call
HPM: High Press. Chiller Mon. - 0, 48
%LOAD (%)

OK Cancel Help...
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Click on To

the Low limit edit box set the low trend limit. This is the
plot’s Y axis minimum value.

the High limit edit box set the high trend limit. This is the
plot’s Y axis maximum value.

OK close the dialog box and save your
selections.

Cancel exit the dialog box without saving
selections.

Help display help information.

Table 4-19
Trend Range Dialog Box

Figure 4-20
Save Current Trend As
Dialog Box

Save Current Trend As

Name:

OK Cancel Help...

Modifies the trend's name

23XL Chiller Monitor Trend

Owned

Global

Auto start

Auto connect
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Click on To

the Name edit box enter the new trend name. Up to 48 charac-
ters are allowed.

Owned allow this trend to be displayed by any
user, but only modified or deleted by you
(the creator) or,

Global allow this trend to be displayed, modified,
or deleted by any user.

Auto Start start the trend when it is displayed in run
mode.

Auto connect when displaying this trend in run mode,
automatically attempt to establish a connec-
tion to all remote CCNs containing points
from this trend

OK close the dialog box and save current
settings.

Cancel exit the dialog box without saving.

Help display help information.

Follow the instructions below to delete a trend from the ComfortVIEW
database.

1. Display the trend that you wish to delete. If necessary, refer to the
Displaying and Using Trends section of this chapter.

2. If necessary, switch to design mode. To do this, click on the Run
menu item and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

3. Click on Yes.

The WorkSPACE Manager enters design mode and the message
Design displays in the lower right corner of the window.

4. Click on the Edit menu item and then click on Delete ViewSPACE/
Trend.

Table 4-20
Save Current Trend As
Dialog Box

Deleting/
Removing Trends
To Delete a Trend



289

5. In the confirmation dialog box displayed, click on Yes to delete
the trend or on No to prevent its deletion.

The WorkSPACE Manager closes the trend window and deletes the
trend from the ComfortVIEW database.

Follow the instructions below to permanently remove a trend from a
WorkSPACE. Note that this function does not delete the trend from the
ComfortVIEW database. It only removes the selected trend from the
selected WorkSPACE.

1. Display the trend that you wish to remove. If necessary, refer to
the Displaying and Using Trends section of this chapter.

2. If necessary, switch to design mode. To do this, click on the Run
menu item and then click on Enter design mode.

The WorkSPACE Manager displays a dialog box asking if you
wish to reload the current WorkSPACE for design.

3. Click on Yes.

The WorkSPACE Manager enters design mode and the message
Design displays in the lower right corner of the window.

4. Click on the Edit menu item and then click on Remove
ViewSPACE/Trend.

5. In the confirmation dialog box displayed, click on Yes to remove
the trend from the WorkSPACE or on No to prevent its deletion.

6. Save the WorkSPACE by clicking on the File menu item and
then clicking on the Save WorkSPACE command.

Note: You may also perform this command by clicking on the
Save WorkSPACE icon in the toolbar.

To Remove a Trend
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Follow the steps below to establish a telephone connection to or
terminate a telephone connection from a remote CCN.

1. Display the ViewSPACE or trend containing the remote CCN
points you wish to view. If necessary, refer to the Displaying
and Using a ViewSPACE or Displaying and Using Trends
sections of this chapter.

2. If necessary, enter run mode.

3. Click on the Run menu item and then click on Connect, or
click on the Connect toolbar icon shown at left.

The Connect to dialog box is displayed. This dialog box
displays the names of all CCNs associated with points in the
active ViewSPACE or trend. Refer to Table 4-21 and Figure
4-21.

Note: If you have only one Autodial Gateway on your
CCN and are currently connected to another remote
CCN, ComfortVIEW displays a message indicating
that you are unable to connect. Click on OK to close
the message dialog box.

4. In the Select Remote CCNs list, click on the CCN to which
you wish to connect.

5. Click on OK  to connect or click on Cancel to prevent the
connect from taking place.

You are now connected to the remote CCN. The status area to the
right of the toolbar displays the connect status. You can now view
all ComfortVIEW data as if you were connected locally.

Connecting to/
Disconnecting
from a Remote
CCN
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Figure 4-21
Connect To Dialog Box

Table 4-21
Connect To Dialog Box Click on To

the Select Remote CCNs list select the CCN to which you wish to
connect.

OK close the dialog box and connect.

Cancel exit the dialog box without connect-
ing.

Help display help information.

Connect to

OK Cancel Help...

Select Remote CCNs:

United Mutual, Farmington Office
United Mutual, Syracuse Office
World Headquarters
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1. Click on the Run menu item and then click on Disconnect.

The Disconnect From dialog box is displayed. This dialog
box displays the names of all CCNs to which you are cur-
rently connected. Refer to Figure 4-22 and Table 4-22.

2. In the Select Remote CCNs list, click on the CCN from which
you wish to disconnect.

3. Click on OK  to disconnect or click on Cancel to prevent the
disconnect from taking place.

You are now disconnected from the remote CCN. The status area to
the right of the toolbar displays the connect status.

Be aware that ComfortVIEW automatically disconnects you from a
remote CCN if, after an operator-specified number of minutes, no
communication occurs (quiet time). The Autodial Gateway will
generate an alarm to notify you of an automatic disconnect. For
additional information on the automatic disconnect feature, refer to
the explanation of the Phone Number Configuration dialog box in
the Adding and Modifying CCNs section of this manual’s Carrier
Network Manager chapter.

To Disconnect from a
Remote CCN
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Figure 4-22
Disconnect From Dialog
Box

Table 4-22
Disconnect From Dialog
Box

Click on To

the Select Remote CCNs list select the CCN from which you wish
to disconnect.

OK close the dialog box and disconnect.

Cancel exit the dialog box without discon-
necting.

Help display help information.

Disconnect from

OK Cancel Help...

Select Remote CCNs:

United Mutual, Farmington Office
United Mutual, Syracuse Office
World Headquarters

Selects one or more CCNs from which to disconnect
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The File menu’s Print command provides you with the capability to
print ViewSPACE and trend windows and definition reports.

Print operation differs depending on whether you select the print
command from run or from design mode. Selecting the print com-
mand from run mode prints a screen captured image of the active
ViewSPACE or trend window. Selecting the print command from
design mode either prints a screen captured image of the active
ViewSPACE or trend window, or prints a WorkSPACE,
ViewSPACE, or trend definition report.

Follow the instructions below to print a screen captured image of a
selected ViewSPACE or trend.

1. If necessary, enter run mode by clicking on the Run menu
item and then clicking on Start run mode.

2. Display the ViewSPACE or trend that you wish to print. If
necessary, refer to the Displaying and Using a ViewSPACE
or Displaying and Using Trends section of this chapter.

Note: If you have several ViewSPACEs or trends opened,
click on the title bar of the window that you wish to
print.

3. Click on the File menu item and then click on Print.

Note: You may also perform this command by clicking on
the Print icon in the toolbar.

A confirmation dialog box is displayed asking if you wish to
print the active ViewSPACE or trend.

4. Click on Yes.

The ViewSPACE or trend will print on the printer that you have
designated using the File menu’s Print setup command.

Printing
ViewSPACEs and
Trends

Run Mode — Printing a
ViewSPACE or Trend
Window
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Design Mode —
Printing a ViewSPACE
or Trend Window or
Printing a WorkSPACE,
ViewSPACE, or Trend
Definition Report

Follow the instructions below to print a screen captured image of a
selected ViewSPACE or trend window, or to print a definition
report. You can also print definition reports for a WorkSPACE,
ViewSPACE or trend.

1. If necessary, enter design mode by clicking on the Run menu
item and then clicking on Stop run mode.

2. Display the WorkSPACE, ViewSPACE, or trend that you
wish to print. If necessary, refer to Accessing the
WorkSPACE Manager, Displaying and Using a ViewSPACE,
and Displaying and Using Trends.

Note: If you have several ViewSPACEs or trends opened,
click on the title bar of the window that you wish to
print.

3. Click on the File menu item and then click on Print.

Note: You may also perform this command by clicking on
the Print icon in the toolbar.

The Print Options dialog box is displayed.

4. Click on Selected ViewSPACE/Trend if you wish to print the
selected ViewSPACE or trend window.

5. To print a definition report, click on Custom Print and then
click on one of the following to enable or disable the defini-
tion you wish to print: WorkSPACE, ViewSPACE, or trend.

6. Click on OK to print the selected ViewSPACE, trend, or
report definition, or
on Cancel to exit the dialog box without printing.

The image or report definition will print on the printer that you have
designated using the File menu’s Print setup command. Sample
WorkSPACE, ViewSPACE, and trend definitions appear in Figures
4-24, 4-25, and 4-26.
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Click on to

Selected ViewSPACE/Trend print the ViewSPACE or trend win-
dow.

Custom Print print the WorkSPACE, ViewSPACE,
or trend definition report.

WorkSPACE enable/disable printing of the
WorkSPACE report definition.

ViewSPACE enable/disable printing of the active
ViewSPACE report definition.

Trend enable/disable printing of the trend
definition.

OK close the dialog box and print the
report.

Cancel exit the dialog box without saving.

Help display help information.

Table 4-23
Print Options Dialog Box
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ComfortVIEW Definition for 23XL Chiller Monitor
01/05/99

23XL Chiller Monitor
Owned

ViewSPACE:23XL Mechanical
ViewSPACE:23XL Status Display

23XL Chiller Monitor Trend

Figure 4-24
Sample WorkSPACE
Definition

Figure 4-25
Sample ViewSPACE
Definition

ComfortVIEW Definition for ViewSPACE:23XL Mechanical
01/05/1999

ViewSPACE:23XL Mechanical
Global

C:\CWORKS\MEDIA\GRAPHICS\23XL.PCX

United Mutual Insurance - Physical Plant
23XL:Chiller - 0,128
OILPRESS: Oil Pressure

United Mutual Insurance - Physical Plant
23XL:Chiller - 0,128
MBTEMP: Motor Bearing Temp

United Mutual Insurance - Physical Plant
23XL:Chiller - 0,128
OILQUAL: Oil Quality

Title

Current Date

ViewSPACE Name

Ownership

Location and Name of
Graphic Background

Point in ViewSPACE

Point in ViewSPACE

Point in ViewSPACE

Title

Current Date

WorkSPACE Name

Ownership

ViewSPACE Name

ViewSPACE Name

Trend Name
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Figure 4-26
Sample Trend  Definition

ComfortVIEW Definition for 23XL Chiller Monitor Trend
01/05/1995

23XL Chiller Monitor Trend
Owned
Scan Rate: 60 seconds

United Mutual Insurance - Physical Plant
HPM: High Press. Chiller Mon. - 0,40
%LOAD: % Cooler Load

United Mutual Insurance - Physical Plant
HPM: High Press. Chiller Mon. - 0,40
ECW: Entering Water Temp (dF)

United Mutual Insurance - Physical Plant
HPM: High Press. Chiller Mon. - 0,40
LCW: Leaving Water Temp (dF)

Title

Current Date

Trend Name

Ownership

Point in Trend

Point in Trend

Point in Trend

Scan Rate

Animated Data
Box Frame
Creation
Guidelines

You can create your own animated discrete point graphics using
nothing more than the third party drawing package that you used to
create your WorkSPACE Manager graphic backgrounds.

To create animated graphics, generate a series of graphic files using
the animated graphic specifications described below. These graphics
will be used as frames for the animation. To achieve maximum
visual effect, each frame in the animation series should be a graphic
depicting either an incremental motion change of an image or an
image color or texture change. The frames that you create are
overlayed on the ViewSPACE's graphic background when you
define the animated data box style. Refer to the Creating a New
ViewSPACE section of this chapter.
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Animated Graphic
Specifications

Create and save each graphic in the animation series in a uniquely
named file using the following specifications:

Graphic Dimensions: Any size

Graphic File Format: Windows .BMP (bitmap)

File Naming Convention: XXXX_Y_Z.BMP

where: XXXX is a unique 4 character
frame family identifier for the anima-
tion sequence. You must assign each
graphic that is part of a particular
animation sequence the same 4 char-
acter identifier. You specify this
identifier when creating animated
ViewSPACE data boxes.

Y is the discrete point state that the
graphic represents. Enter 0 for the off
state, or 1 for the on state.

Z is a number from 0 to 9, which
represents the position that the graphic
holds in the animation sequence. If
there are nine frames of animation the
first graphic (Frame 1) would be
named with Z equal to 0 and the last
graphic would be named with Z equal
to 9. The animation sequence will
repeat continuously using the Z values
assigned.

Directory Path: Store all animation graphic files on
your ComfortVIEW server worksta-
tion in the directory path
MEDIA\FRAMES. This directory will
be located in the \CVIEW,
\CWORKS, or other directory in
which you have installed
ComfortVIEW.
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Example:

To depict a fan as On or Off, you could create and save the family
of graphic files described in the example below. Please note that the
files used in this example are included and installed along with your
ComfortVIEW software.

FANS_0_0.BMP - Fan Off condition, animation Frame 1. Fan
blades in a fixed position.

FANS_1_0.BMP - Fan On condition, animation Frame 1. Fan
blades in Position 1.

FANS_1_1.BMP - Fan On condition, animation Frame 2. Fan
blades rotated to Position 2.

FANS_1_2.BMP - Fan On condition, animation Frame 3. Fan
blades rotated to Position 3.

FANS_1_3.BMP - Fan On condition, animation Frame 4. Fan
blades rotated to Position 4.

FANS_1_4.BMP - Fan On condition, animation Frame 5. Fan
blades rotated to Position 5.

FANS_1_5.BMP - Fan On condition, animation Frame 6. Fan
blades rotated to Position 6.
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WorkSPACE
Manager Menu
Command
Summary

This section describes each of the commands that appear in the
WorkSPACE Manager window menus. Refer to Figure 4-2 in the
Accessing the WorkSPACE Manager section of this chapter to view
a copy of the WorkSPACE Manager window. Note that the menu
changes depending on whether you are in run or design mode.

The table below describes each of the commands that appear in the
WorkSPACE Manager's File menu in design mode.

Click on To

New WorkSPACE create a new WorkSPACE. If a
WorkSPACE, ViewSPACE, or trend
is currently displayed, the
WorkSPACE Manager will prompt
you to save any unsaved changes, and
will display a blank undefined
WorkSPACE window in run mode.

Open WorkSPACE open an existing WorkSPACE. The
Open WorkSPACE dialog box is
displayed. Select a WorkSPACE and
then click on OK.

Save WorkSPACE save the displayed WorkSPACE.

Save WorkSPACE As save the displayed WorkSPACE under
a new name. The Save Current
WorkSPACE As dialog box is dis-
played. Enter a WorkSPACE name,
specify the WorkSPACE’s ownership
designation (owned or global), and
click on OK. If desired, you can use
this dialog box's Clone button to
quickly create another WorkSPACE
containing identical points from this
one.

(continued)

Table 4-27
File  Menu - Design Mode

File Menu — Design
Mode
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Table 4-27
File  Menu - Design Mode
(continued)

Click on To

New ViewSPACE create a new ViewSPACE. The
WorkSPACE Manager displays a
blank ViewSPACE window. You can
now select the graphic background,
create your data boxes and link areas,
and save the new ViewSPACE. For
step by step instructions on creating
new ViewSPACEs, refer to the Creat-
ing a New ViewSPACE  section of
this chapter.

New Trend create a new trend. The WorkSPACE
Manager displays a blank trend
window. You can now select the trend
points, configure the trend operating
characteristics, and save the new
trend. For step by step instructions on
creating new trends, refer to the
Creating and Modifying Trends
section of this chapter.

Open ViewSPACE/Trend open and display an existing
ViewSPACE or trend. The Open
ViewSPACE/Trend dialog box is
displayed. Select the ViewSPACE or
trend that you wish to display and
then click on OK. The selected
ViewSPACE or trend displays in
design mode. You can now modify
the displayed window as desired.

(continued)



303

Table 4-27
File  Menu - Design Mode
(continued)

Click on To

Remove ViewSPACE/Trend remove the active ViewSPACE or
trend from the displayed
WorkSPACE. In the confirmation
dialog box displayed, click on Yes to
remove the ViewSPACE or trend
from the WorkSPACE or on No to
prevent the deletion. Note that this
function does not delete the
ViewSPACE or trend from the
ComfortVIEW database. It only
removes the selected item from the
displayed WorkSPACE.

Save ViewSPACE/Trend save the active ViewSPACE or trend
in the ComfortVIEW database.

Save ViewSPACE/Trend As save the active ViewSPACE or trend
under a new name. The Save Current
ViewSPACE or Trend As dialog box
is displayed. Enter a ViewSPACE or
trend name, specify the ownership
designation (owned or global), enable
or disable the auto start and connect
options, and click on OK.

Print print selected ViewSPACE and trend
screen captures, or to print
WorkSPACE and trend definition
reports. The Print Options dialog box
is displayed. Click on Selected
ViewSPACE/Trend if you wish to
print the selected ViewSPACE or
trend window. Click on Custom Print
and then click on one of the following
to enable or disable the definition you
wish to print:  WorkSPACE,
ViewSPACE, or trend.

       (continued)
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Table 4-27
File  Menu - Design Mode
(continued)

Click on To

Print setup configure the output and select printers.
The Print Setup dialog box is displayed.
Select the printer to which you wish to
print ViewSPACE and trend screen
captures and definition reports, select
additional print characteristics such as
page size, orientation, and two-sided
printing.  Clicking on the Print Setup
dialog box’s More button displays the
Advanced document Properties dialog
box, where you can specify additional
print characteristics. Click on the Help
button to display Windows’  help informa-
tion. Clicking on the Print Setup dialog
box’s Network button displays the Con-
nect to Printer dialog box, which gives
you the capability to print to another
printer on the local area network. Click
on the Help button to display Windows’
help information.

Exit exit the WorkSPACE Manager applica-
tion.

The table below describes each of the commands that appear in the
WorkSPACE Manager's File menu in run mode.

Click on To

Open WorkSPACE open and display an existing
WorkSPACE. The Open WorkSPACE
Trend dialog box is displayed. Select the
WorkSPACE that you wish to display and
then click on OK. The selected
WorkSPACE opens and its ViewSPACEs
and trends open and display sequentially
in run mode.

             (continued)

File Menu — Run Mode

Table 4-28
File  Menu - Run Mode
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Table 4-28
File  Menu - Run Mode
(continued)

Click on To

Open Bookmark open and display a bookmarked
WorkSPACE. If there is only one
bookmarked WorkSPACE in your
ComfortVIEW database, the
WorkSPACE Manager displays the
bookmarked WorkSPACE  in run
mode.

If there is currently more than one
bookmarked WorkSPACE in your
database, the WorkSPACE Manager
displays the Open WorkSPACE
dialog box. This dialog box lists the
names of all WorkSPACEs that have
been bookmarked. In the Select
WorkSPACE list, click on the
WorkSPACE that you wish to open
and then click on OK. The
WorkSPACE Manager closes the
currently-displayed WorkSPACE and
opens the selected WorkSPACE. The
WorkSPACE’s ViewSPACEs and
trends will display in run mode. You
can view and, if desired, modify
displayed point values.

Open ViewSPACE/trend open and display an existing
ViewSPACE or trend. The Open
ViewSPACE/Trend dialog box is
displayed. Select the ViewSPACE or
trend that you wish to display and then
click on OK. The selected
ViewSPACE or trend displays in run
mode. You can view and, if desired,
modify displayed point values.

       (continued)
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Table 4-28
File  Menu - Run Mode
(continued)

Click on To

Open Archived trend open and display a previously-
archived trend. The data will be
displayed in an inactive trend window.
Scrolling, re-sizing, and printing are
supported in this window, but you
cannot re-activate the trend. You also
cannot load the archived version of a
currently-active trend.

Remove ViewSPACE/trend remove the active ViewSPACE or
trend from the displayed
WorkSPACE. In the confirmation
dialog box displayed, click on Yes to
remove the ViewSPACE from the
WorkSPACE or on No to prevent its
deletion. Note that this function does
not delete the ViewSPACE from the
ComfortVIEW database. It only
removes the selected ViewSPACE
from the selected WorkSPACE.

Save Trend data to file If desired, you can save trend data to a
file in your ComfortVIEW database
and then read the file into a third party
spreadsheet application.
ComfortVIEW takes a snapshot of the
current data and creates a tab-delin-
eated file containing your trend data.
The file will contain all data that has
been gathered since the trend was
originally started for your current
WorkSPACE session.

Print prints a screen captured image of the
active ViewSPACE or trend window.

       (continued)
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Click on To

Print setup configure the output and select printers.
The Print Setup dialog box is displayed.
Select the printer to which you wish to
print ViewSPACE and trend screen
captures, select additional print character-
istics such as page size, orientation, and
2-sided printing.  Clicking on the Print
Setup dialog box’s More button displays
the Advanced document Properties dialog
box, where you can specify additional
print characteristics. Click on the Help
button to display Windows’  help infor-
mation. Clicking on the Print Setup
dialog box’s Network button displays the
Connect to Printer dialog box, which
gives you the capability to print to an-
other printer on the local area network.
Click on the Help button to display
Windows’  help information.

Exit exit the WorkSPACE Manager applica-
tion.

The table below describes each of the commands that appear in the
WorkSPACE Manager's Edit menu in design mode.

Click on To

Cut delete the selected data box or link area
after placing it on the clipboard. Click on
the data box or link area you wish to
delete. Then, click on the Edit menu item,
and click on Delete.

The WorkSPACE Manager places the
data box or link area on the clipboard and
deletes it from the ViewSPACE.

            (continued)

Table 4-28
File  Menu - Run Mode
(continued)

Edit Menu — Design
Mode

Table 4-29
Edit  Menu - Design Mode
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Table 4-29
Edit  Menu - Design Mode
(continued)

Click on To

Copy copy the selected data box or link area to
the clipboard.

Paste paste a data box or link area that has
been previously cut or copied to the
clipboard on a ViewSPACE or trend
window.

Delete delete the selected data box or link area.

Delete WorkSPACE close any currently-displayed
ViewSPACE and trend windows, delete
the WorkSPACE from the
ComfortVIEW database, and display a
new undefined WorkSPACE window.
Note that deleting a WorkSPACE does
not delete its associated ViewSPACEs
and trends. You can display these
ViewSPACEs and trends by opening
them from another WorkSPACE win-
dow.

Delete ViewSPACE/Trend close the active ViewSPACE or trend
window and delete the ViewSPACE or
trend from the ComfortVIEW database.

Modify WorkSPACE modify a selected WorkSPACE name
and its owned/global designation. The
Modify Current WorkSPACE dialog box
is displayed.

Modify ViewSPACE/Trend modify the active ViewSPACE or trend
name and ownership designation.

Modify Object modify the selected data box or link area
parameters. The Modify Data Box
Dialog Box is displayed. Refer to Figure
4-12 and Table 4-12, which appear in the
Creating a New ViewSPACE section of
this chapter, for instructions on using this
dialog box.
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The table below describes each of the commands that appear in the
WorkSPACE Manager's Edit menu in run mode.

Click on To

Copy copy data from a selected
ViewSPACE data box to the Windows
clipboard. This command could be
used to copy values from one data box
to another. This command could also
be used if you wish, for example, to
link ViewSPACE data to a DDE-
supported third party spreadsheet
application. If the application to which
you wish to link supports the Paste
Link command, click on the data box
containing the data you wish to link,
click on the Edit  menu item and then
click on Copy. ComfortVIEW auto-
matically copies the data (and its DDE
link information) to the Windows
Clipboard. You can then open the
DDE-supported application, and use
the application’s Paste Link command
to insert and link the selected
ComfortVIEW data. When the
ViewSPACE is active and point data
changes, the data will automatically
update in the other application. For
further information on sharing
ComfortVIEW dynamic data, and a
list of the data elements that can be
sent, refer to Sharing ComfortVIEW
Dynamic Data with Other Applica-
tions, which appears in the Carrier
Network Manager chapter of this
manual.

(continued)

Edit Menu — Run Mode

Table 4-30
Edit  Menu - Run Mode
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Table 4-30
Edit  Menu - Run Mode
(continued)

Click on To

Paste paste configuration point data from
the Windows clipboard to a data box.
Copy the point value data from a data
box to the Windows Clipboard using
the Copy command. Then click on a
destination data box (which can be in
the same or another ViewSPACE or
trend), click on Edit and then click on
Paste. The data that you are pasting
overwrites the data that is currently in
the destination data box. The data you
are pasting must conform to the
allowable entries for the destination
data box. If you attempt to paste
incompatible data, ComfortVIEW
displays an error message indicating
that the data target is not available or
incompatible.

Modify change a selected data box’s point
value, description, or operator note.
For configuration points, you can also
upload configuration data from the
controller, download data to the
controller, and save configuration data
changes in the ComfortVIEW data-
base. For point status or maintenance
table points, you can also force and
auto point values and save changes.
You can also perform this command
by double clicking on a data box.

Force override the selected dynamic point
value. Forcing overrides a controller's
automatic control of a selected point.

Auto clear a force and return a point to a
controller's automatic control.

       (continued)
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Click on To

Submaster force transmit a submaster reference force
to the selected point in the selected UT203
FID controller. When you force the
submaster reference, ComfortVIEW will
disregard the submaster reference value
that was calculated in the master control
loop. For more information on the UT203
FID's submaster reference value, refer to
the UT203 FID Overview and Configura-
tion Manual.

Note:  You cannot use Submaster Force if the
selected point already has a Supervisor force.

The table below describes each of the commands that appear in the
WorkSPACE Manager's Configure Menu in design mode.

Click on To

Background select the active ViewSPACE’s graphic
background. The File Open dialog box is
displayed. Select the graphic background
file that you wish to display or type the file
name in the File Name box. You can select
a different drive by making your selection
from the Drives drop down list. You can
also select a file that is resident on another
network computer by clicking on the
Network button. The selected graphic
background loads and displays in the
ViewSPACE window. The message Load-
ing background image displays in the
lower left corner of the window during the
load process.

New Data Box create a data box on the active

(continued)

Table 4-31
Configure Menu - Design
Mode

Table 4-30
Edit  Menu - Run Mode
(continued)

Configure Menu —
Design Mode
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Click on To

ViewSPACE. The Modify Data Box
dialog box is displayed. Select the data
box style (Normal or Animated -
discrete points only), background, font,
and the data elements that you wish to
display (point name, description, etc.).
You can also select a color for the data
box background and for each data
element. The sample data box that is
displayed in the lower half of the dialog
box displays your current dialog box
style and element selections.

If you select an animated (moving
picture) data box style, you must assign
graphics that have been pre-drawn
using a third party graphics application
and named according to the frame
creation guidelines listed in this
chapter’s Animated Data Box Frame
Creation Guidelines section.

New Link Area place a new link area on the active
ViewSPACE. The Modify Link Areas
dialog box is displayed. Select the
WorkSPACE to which you wish to link,
click on Border to enable or disable the
box border display, and then click on OK.
The WorkSPACE Manager displays the
link area box on your graphic background
screen. You can re-size the box by drag-
ging the box corner or, can drag the box to
re-position it within the ViewSPACE.

Set Default WorkSPACE specify the currently-displayed
WorkSPACE to be the default
WorkSPACE. On launching the
WorkSPACE Manager application, this
selected default WorkSPACE window
will open and its associated
ViewSPACEs and trends will display
in run mode.

Table 4-31
Configure Menu - Design
Mode
(continued)
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The table below describes each of the commands that appear in the
WorkSPACE Manager's Configure Menu in run mode.

Click on To

Save ViewSPACE data save all ViewSPACE configuration
changes in the ComfortVIEW database.

Upload ViewSPACE data to display controller configuration table
values on-screen for viewing or editing.
If desired, you can save the displayed
table data in the ComfortVIEW data-
base using the Save ViewSPACE data
command.

Download ViewSPACE data send ViewSPACE configuration data
from the ComfortVIEW database to the
controller(s).

Set Bookmark place or remove a bookmark on the
active WorkSPACE. A checkmark (✓ )
appears before the Set bookmark
command to indicate that it is enabled.

A bookmark icon displays in the lower
right corner of bookmarked
WorkSPACEs.

Configuration table display the selected point's associated
configuration table.

Maintenance table display the selected point's associated
maintenance table.

Time schedule display the selected point's associated
time schedule configuration table.

Setpoint table display the selected point's associated
setpoint configuration table.

         (continued)

Configure Menu — Run
Mode

Table 4-32
Configure Menu - Run
Mode
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Click on To

Reference tables display the names of all Comfort
Controller objects that are using the
point in their configuration.

The table below describes each of the commands that appear in the
WorkSPACE Manager's Run menu in run mode.

Click on To

Enter design mode terminate run mode for the active
WorkSPACE. The WorkSPACE
Manager displays a confirmation
dialog box asking if you wish to re-
load the current WorkSPACE in
design mode.

Connect establish a remote CCN connection.
You must connect to a remote CCN to
view dynamic status display values.
The Connect to dialog box is dis-
played. Select the CCN to which you
wish to connect and click on OK.

Disconnect disconnect from a remote CCN. The
Disconnect from dialog box is dis-
played. Select the CCN from which you
wish to disconnect and click on OK.

       (continued)

Table 4-32
Configure Menu - Run
Mode (continued)

Table 4-33
Run Menu - Run Mode

Run Menu — Run Mode
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Click on To

Start trend start the plotting process for the active
trend. The message Plotting displays in the
trend window’s status bar to show that the
trend has been started. Selecting this
command after selecting the Stop trend
command resumes the stopped trend.

Stop trend stop the trend plotting process. The mes-
sage Paused displays in the trend
window’s status bar to show that the trend
has been stopped.

Re-start Trend initialize the trend and re-start the trending
process for the active trend. The message
Plotting displays in the window’s status
bar to show that the trend has been started.

The table below describes each of the commands that appear in the
WorkSPACE Manager's Run menu in design mode.

Click on To

Enter run mode activate the run mode for the displayed
WorkSPACE. The WorkSPACE Manager
displays a confirmation dialog box asking
if you wish to re-load the current
WorkSPACE in run mode.

Table 4-33
Run Menu - Run Mode
(continued)

Run Menu — Design
Mode

Table 4-34
Run Menu - Design Mode
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The table below describes each of the commands that appear in the
WorkSPACE Manager's Options menu in run mode.

Click on To

Toolbar hide or display the WorkSPACE
Manager toolbar.

Status bar hide or display the status bar that
appears in the second line of
WorkSPACE Manager windows.

Legend enable/disable display of a legend
window for the active trend. This
window displays the following infor-
mation for each trend point:  area
name, controller name and descrip-
tion, and point name and description
for each trend point.

Show link areas display all of a ViewSPACE's link
areas, including the name of the
WorkSPACE to which each area is
linked.

Hide hide rows and columns in status
display, maintenance, or configuration
table worksheets. Click on the header
of the column you wish to hide or
click on the box to the left of the row
you wish to hide. Click on the Options
menu item and then click on Hide.

The highlighted column or row will be
removed from the worksheet. To
Make Row Hides Permanent:  Click
on the Configure menu item and then
click on Save. The row will not appear
the next time you view this table.

To Make Column Hides Permanent:
Click on the Options menu item and
then click on Save settings on exit. A

       (continued)

Options Menu — Run
Mode

Table 4-35
Options Menu - Run
Mode
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Command Use this command to

Hide (continued) checkmark (✓ ) appears before the
command to indicate that it is enabled.
The column will not appear the next
time you view this table.

Note:  Row hides apply to specific
tables. Column hides apply to all
tables in all controllers. Also, row
hides are hidden for all operators.
Column hides are hidden for indi-
vidual operators.

Show show hidden rows and columns in
status display, maintenance, or con-
figuration table worksheets. Click on
the Options menu item and then click
on Show. The Show Rows/Columns
dialog box displays. The dialog box
shows any hidden rows or columns.
Select the rows or columns to add and
click on OK. Any hidden columns will
be added to the worksheet.

Point IDs display each point’s item reference
number along with the point name.
This number is used when linking
table data to other PC applications,
such as third party spreadsheet pro-
grams.

Best fit set each column to a width that best
fits the data.

Save settings on exit save any changes you make by using
commands on the Options menu. For
example, if you hide the hide the
status bar, it will be hidden the next
time you start the WorkSPACE Man-
ager.  This command also saves the
size and position of all WorkSPACE
Manager windows.

Table 4-35
Options Menu - Run
Mode (continued)
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The table below describes each of the commands that appear in the
WorkSPACE Manager's Options menu in design mode.

Click on To

Toolbar hide or display the WorkSPACE
Manager toolbar.

Status bar hide or display the status bar that
appears in the second line of
WorkSPACE Manager windows.

Lock window lock a ViewSPACE's window size and
position, as well as lock the size and
position of all data boxes and link
areas. You will also not be permitted
to add or delete data boxes or link
areas, or to modify the graphic back-
ground selection. You will not be
permitted to make any modifications
using the Edit menu's Modify com-
mand.

Size image to window dynamically re-size a ViewSPACE's
background graphic based on the
ViewSPACE window size.

Note:   To improve performance, if
your ViewSPACE background image
is larger than your screen dimensions,
you should resize the background as
required using a third party graphics
utility rather than using this command.

Tabularize data boxes remove a ViewSPACE's graphic
background and re-size and re-arrange
all data boxes to appear in a tabular
format.

Cascade data boxes re-arrange and display a
ViewSPACE's data boxes in a cas-
caded format.

        (continued)

Options Menu —
Design Mode

Table 4-36
Options Menu - Design
Mode
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Click on To

Save settings on exit save any changes you make by using
commands on the Options menu. For
example, if you hide the hide the
status bar, it will be hidden the next
time you start the WorkSPACE
Manager.  This command also saves
the size and position of all
WorkSPACE Manager windows.

The table below describes each of the commands that appear in the
WorkSPACE Manager's Windows menu in run mode.

Click on To

Cascade arrange open WorkSPACE Manager
windows to overlap so that each title
bar is visible.

Tile arrange open WorkSPACE Manager
windows in smaller sizes so that they
fit next to each other and are all
visible on your desktop.

Arrange icons evenly arrange all minimized
WorkSPACE Manager window icons.

Refresh update the information displayed in
open WorkSPACE Manager windows.
ComfortVIEW updates the currently
selected window with the most recent
data that has been written to the
database.

Home WorkSPACE return to the first WorkSPACE that
you accessed (in run mode) after you
logged in to ComfortVIEW.

Previous WorkSPACE jump back to the WorkSPACE whose
link caused the display of the current
WorkSPACE.

       (continued)

Table 4-36
Options Menu - Design
Mode

Window Menu — Run
Mode

Table 4-37
Window Menu - Run
Mode
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Click on To

Graphical when viewing an occupancy or set-
point configuration table, display data
in either a tabular (worksheet) or
graphic format.

To use the Setpoint Table graphical
format:
Enter the desired setpoint in the edit
box below the slidebar, or simply drag
the slidebar to display the desired
setpoint. You can click on the
slidebar's < or > buttons to increment
or decrement the display setpoint in
increments of .1 or 1.0. Each screen
displays up to 9 decisions-worth of
table data. Use the |<< or >>| buttons
that are located at the bottom of the
screen to display the first or last 9
decisions. Use << or >> to move
through the up to 9 decision display,
decision by decision.

To use the Occupancy Table graphical
format:
Click to enable/disable days of the
week, and enter the Occupied From
and To times in the corresponding edit
boxes. The bar graphic will update to
display the occupied times.

Table 4-37
Window Menu - Run
Mode
(continued)
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The table below describes each of the commands that appear in the
WorkSPACE Manager's Window menu in design mode.

Click on To

Cascade arrange open WorkSPACE Manager
windows to overlap so that each title
bar is visible.

Tile arrange open WorkSPACE Manager
windows in smaller sizes so that they
fit next to each other and are all
visible on your desktop.

Arrange icons evenly arrange all minimized
WorkSPACE Manager window icons.

The table below describes each of the commands that appear in the
WorkSPACE Manager’s Help menu in both run and design modes.

Click on To

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
components, and copyright.

Table 4-39
Help Menu— Run
and Design Mode

Help Menu — Run
and Design Mode

Window Menu —
Design Mode

Table 4-38
Window Menu - Design
Mode
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This chapter provides instructions on ComfortVIEW alarm viewing
and alarm indication features.

For instructions on... Turn to page

configuring alarm indication methods 326

viewing new and unacknowledged alarms  328

viewing the alarm list 330

changing alarm list font and point size 336

updating the alarm list 337

sorting the alarm list 338

selecting alarms 340

acknowledging alarms 341

attaching an operator’s note to an alarm 343

suppressing alarms 346

deleting alarms 349

printing the alarm list 350

attaching a custom message to an alarm 353

displaying an existing alarm’s WorkSPACE 361

assigning a WorkSPACE to an incoming alarm 364

selecting alarm list display colors 371

exporting alarm data for other uses 374

a summary of all alarm menu commands 374

Alarm
Manager
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Terminology Alarm — The occurrence of an abnormal condition such as a value
outside specified limits or a communication failure detected by the NDS
Module. Alarms can originate from a CCN system element such as FID,
a CCN option, a PIC, an NDS Module, or an Autodial Gateway.

Alert — The occurrence of an abnormal condition such as a value out-
side specified limits or a communication failure detected by the NDS
Module. Alarms can originate from a CCN system element such as a
FID, a CCN Option, a PIC, an NDS Module, or an Autodial Gateway.

Autodial Gateway — A Communications Input/Output (CIO) Module
containing software that enables it to communicate by means of a modem
over telephone lines with other Autodial Gateway-equipped CCNs.

CCN Option — A Communications Input/Output (CIO) Module that
contains a special purpose algorithm and accompanying communication
software designed to provide a function for the entire CCN or a desig-
nated portion of it.

Comfort Controller — A micro-processor-based control module that
provides general purpose HVAC control and monitoring capability in a
standalone or network environment using closed-loop, direct digital
control. The Comfort Controller can monitor or control up to 64 field
points.

NDS Module — The NDS (Network Directory Services) Module is a
Communications Input/Output (CIO) Module that contains software to
enable it to maintain a directory of system elements on the CCN Commu-
nication Bus and to perform periodic diagnostic checks on those system
elements.

PIC — A PIC (Product Integrated Control) is an electronic control that is
factory installed on specific Carrier HVAC equipment. PIC controls
provide standalone operation and can also be connected as a system
element on the CCN Communication Bus.

WorkSPACE — A group of windows containing graphics (known as
ViewSPACEs) and trend plots of CCN data. You use the ComfortVIEW
WorkSPACE Manager application to create and view WorkSPACEs. For
example, you could set up a WorkSPACE to include a temperature trend
and a graphic of the associated chilled water system.  You could then
display all of these windows simultaneously.
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An alarm or alert is the occurrence of an abnormal condition such as
a value outside specified limits or a communication failure detected
by the Network Directory Service (NDS) Module. An alarm can
originate from a CCN system element such as a UT203 FID, a
Comfort Controller, a CCN option, a PIC, an NDS Module, or an
Autodial Gateway.

When a condition arises on the Carrier Comfort Network that causes
an alarm or alert, the system element that is in alarm sends a notifi-
cation message along the communication bus to ComfortVIEW.
ComfortVIEW receives and stores the message in its alarm list, and
depending on how you set up the alarm indication function, pro-
duces an audible “beep” , plays a .wav sound file, and displays a
flashing alarm symbol on the screen. When the value returns to
within specified limits, the CCN system element generates a return-
to-normal message and sends this message to ComfortVIEW.
ComfortVIEW receives and stores return-to-normal messages in the
same fashion as it does for alarms and alerts.

Alarms and alerts can be received from remote CCNs using Carrier's
CCN Autodial Gateway, TeLINK, or NAM products.

Alarms and alerts are indicated in the Carrier Network Manager’s
CCN displays as well.

ComfortVIEW enables you to:

• view, acknowledge, print, and delete the alarm messages.

• sort the presentation of the alarm list (by alarm level, time/date,
or alphabetically by area, zone, element, or point name).

• create custom messages and operator notes for attachment to
alarms or groups of alarms.

• suppress the audible and visual indication of “nuisance”  alarms.

• assign WorkSPACEs to alarms or groups of alarms.

• filter the indication or display of alarms for a logged on user.

Note: Alarm filtering is done using ComfortVIEW Setup
function. Refer to the Setup chapter of this manual for
instructions.

Introduction
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You can configure the manner in which ComfortVIEW notifies you
of the existence of new and unacknowledged CCN alarms and
alerts. ComfortVIEW can notify you in one of three manners:

• An audible beeping sound occurs or a .wav sound file plays
with no visual indication.

You must view the Alarm List to see the alarm or alert. The
alarm/alert is displayed in the list along with all other CCN
alarms and alerts.

• A flashing alarm icon displays along with the word alarm, alert,
or return to normal and the level (0 to 6).

The level indicates the highest level unacknowledged alarm/alert
in the system. The icon displays on top of the current window
and continues to flash until you double click on it and acknowl-
edge receipt of the alarm/alert. This option also produces an
audible beep or plays a .wav sound file plays on initial alarm
reception. Additional information on this option is in the Flash-
ing Icon Alarm Viewing section of this chapter.

• A pop-up window displays on top of the current window.

If you close the window without acknowledging the alarm/alert,
it immediately re-displays until you acknowledge receipt of the
alarm/alert. This option also produces an audible beep or plays a
.wav sound file on initial alarm reception. Additional informa-
tion on this option is in the Pop-up Window Alarm Viewing
section  of this chapter.

Note: If you are logged out of ComfortVIEW and an alarm/alert
occurs, you are notified in the manner that you have
selected using the Setup application's Log out state com-
mand. Refer to the Specifying Operator Alarm Indication
Preferences section of this manual's Setup chapter for
additional information on this command.

Alarm Indication
Methods
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ComfortVIEW also includes a critical alarm indication feature that
you can apply to any of these three alarm indication options. If you
select this option, ComfortVIEW displays a full-screen pop-up
window on top of the current window. ComfortVIEW displays this
full-screen window when it receives any alarm with an alarm level
that is less than or equal to the critical alarm threshold value you
enter in the Setup application's Alarm Indications Preferences dialog
box. Alarm levels range from 0 to 7, with Level 0 alarms being
more severe than Level 7 alarms. Functionally, this pop-up window
is the same as the window described in the Pop-up Window Alarm
Viewing section of this chapter. This window, however, occupies
your entire screen and its background displays in your selected
Windows highlight color.

Double clicking on the title bar reduces the window and subsequent
non-critical alarm indication windows to the normal pop-up window
size.

Note: You should do this to prevent future non-critical alarm
pop-up windows from occupying the full screen.

You select a form of indication using ComfortVIEW’s Setup appli-
cation. For instructions, refer to Specifying Alarm Indication Prefer-
ences in the Setup chapter of this manual.

Critical Alarm
Indication Option

Specifying Your Alarm
Indication Preference
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You view new and unacknowledged alarms in one of the following
ways:

• By clicking on the flashing alarm icon
• By viewing a pop-up alarm window

Follow the steps below to view alarms indicated by the flashing icon:

1. Double click on the flashing alarm indication icon.

ComfortVIEW displays a pop-up alarm window similar to the one
shown in Figure 5-1 below. The window displays on top of the
current window and shows the highest priority unacknowledged
alarm/alert.

The alarm window displays individual alarm messages in a format
nearly identical to that seen when viewing the Alarm List. Refer
to Figure 5-1 and Table 5-1 for instructions on using the alarm
indicator window.

2. After completing the desired operation, click on the Minimize
button in the top right corner of the alarm window. It is the left
button in the set of three:  .

Unlike other windows, you cannot close this alarm window by
clicking on its control menu box.

Note: When the pop-up alarm window is displayed, you will
only receive audible indication of the receipt of any new
alarms. For this reason, it is recommended that you close
the pop-up window after viewing the alarm. If you fail to
close the window, ComfortVIEW automatically closes
the alarm window for you 15 minutes after it is opened.

Viewing
New and

Unacknowledged
Alarms

Flashing Icon
Alarm Viewing

Figure 5-1
Alarm Indicator
Window
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Click on To

update the window with the most critical
unacknowledged alarm.

display the Alarm List.

display help information.

acknowledge this alarm.

attach or display an operator note.

jump to this alarm’s pre-configured
WorkSPACE.

play this alarm's pre-assigned audio .wav
file.

after acknowledging an alarm, disable the
audible and visual alarm indication for
selected re-occuring alarms.

print this alarm.

Note: If desired, you can copy the alarm to the Windows clip-
board by pressing and holding down the Ctrl key and then
typing C.

If you select this alarm indication option, a pop-up window displays
on alarm/alert reception. The window displays on top of the current
window. This pop-up window is the same pop-up window as the one
described previously under Flashing Icon Alarm Viewing. If you
close the window without acknowledging the alarm/alert, the win-
dow immediately re-displays until you acknowledge receipt of the
alarm/alert. If you overlay the window with another window, the
alarm window is brought to the foreground 15 minutes after being
hidden. Critical alarm pop-up windows will not display if there is an
unacknowledged pop-up alarm window.

Table 5-1
Alarm Indicator
Window Functions

Pop-up Window Alarm
Viewing
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Viewing the
Alarm List

Figure 5-2
Sample Alarm List

To view a list of all alarm, alert, and return to normal messages:

Double click on the Alarm Manager icon.

Note: You may also display the alarm list by following the
Flashing Icon Alarm Viewing or Pop-up Window Alarm
Viewing instructions. Then click on the alarm window’s
Alarm List icon to display the alarm list.

ComfortVIEW displays the Alarm List window. If you are initially
starting up the Alarm Manager application, you see messages in the
alarm list sorted according to time/date received. If the Alarm
Manager is running, but was minimized, alarms appear sorted in the
last order defined. For more information on alarm sorting, refer to
the Sorting the Alarm List section of this chapter. A sample Alarm
List window is shown in Figure 5-2 below.



331

The Alarm Menu The top line of the Alarm List window contains the alarm menu.
This menu contains the alarm viewing commands that allow you to
perform functions such as acknowledging, sorting, and deleting
alarms. The Alarm Menu Commands section of this chapter de-
scribes each of the commands that appear in the alarm menu.

The second line of the Alarm List window contains a toolbar. The
toolbar gives you instant access to the most frequently used alarm
viewing commands. By simply clicking the mouse button, you can
print, delete, or acknowledge alarms, update the alarm list, select or
de-select all alarms, or display on-line help.

Note: If desired, you can remove the toolbar from the window
by clicking on the Options menu item and then clicking on
Toolbar. To return the toolbar to the window, perform
these two commands again.

The bottom line of each individual alarm message contains an
alarm-specific toolbar. By clicking the mouse on one of the tools in
this toolbar, you can acknowledge this individual alarm, display or
modify this alarm’s operator note, or invoke the WorkSPACE
Manager and view this alarm’s assigned WorkSPACE.

The following table describes the buttons that appear on the alarm
list and alarm-specific toolbars.

The Toolbars
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Table 5-2
Alarm Toolbar Buttons Click on To

export selected alarms to a file.

print all or selected alarms.

delete selected alarms and copy them to the
Windows clipboard.

copy selected alarms to the Windows clip-
board.

delete selected alarms.

acknowledge selected alarms.

update the alarm list to include the latest
alarms received.

select/de-select all alarms.

attach, view, or edit the selected alarm’s
operator note.

display on-line help.
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Click on To

jump to a pre-configured WorkSPACE or
attach a WorkSPACE to this alarm.

play this alarm's pre-configured .wav audio
file.

suppress future indication of this alarm.

A sample alarm message is shown below. Note that if
ComfortVIEW receives an alarm from a point that is not in its
database, it displays the 8 character zone and point name that are
stored in the system element, as well as the CCN number.

Figure 5-3
Sample Alarm Message

Alarm Message
Format
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An alarm message contains the following information:

• Area name
• Controller name (CCN Options, PICs, Comfort Controller)
• System name (UT203 FIDs only)
• Bus and element number of the system element generating the

alarm
• Alarm status (alarm, alert, return to normal)
• Alarm priority (0 to 7, 0 = the highest; 7 = the lowest). See Table

5-3.
• Time and date of alarm
• Zone name (System Manager-type products only. Ex.:  TSM)
• Point name
• Value or status of point causing alarm — including engineering

units (FIDs, Comfort Controllers, PICs, CCN Options only)
• Alarm explanatory text
• Custom message (if any)
• Operator note indication (if any)
• Name of acknowledging operator (if alarm is acknowledged)
• Time and date of acknowledgement (if alarm is acknowledged)
• Alarm-specific toolbar
• Number of Alarms received since invoked suppression. For

more information, see the Suppressing Nuisance Alarms section
of this chapter.

If you have enabled the Alarm Suppression feature, the bottom line
of each alarm message also displays the number of times that an
identical alarm has been received but not annunciated. Refer to the
Suppressing Nuisance Alarms section of this chapter for more
information on this feature.
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Level Meaning

0 Fire/life safety
1 Critical
2 Service
3 Reserved
4 Maintenance
5 Reserved
6 Point control out of range
7 Return to normal

The third line of the alarm window displays the following status
information:

• Alarms in system — the total number of alarms ComfortVIEW
has received.

• Alarms in viewing buffer — the number of alarms that you are
currently seeing. Note that this number may differ from the
Alarms in System number dependent on whether any operator
filters are in effect. It also could differ if alarms have been
received while you have been viewing the alarm list. To view
new alarms, click on the Update icon.

• Filters in effect — these words will be displayed if any alarm
filters are in effect. ComfortVIEW gives you the capability to
"filter" or specify families of alarms that will be presented to
each user. For more information on filters, refer to Specifying
Operator Alarm Indication Preferences in the Carrier Network
Manager chapter of this manual.

• Sorted by — an indication of how the alarm list is currently
sorted (for example, default (time/date received), alphabetically,
time/date, alarm/alert level). For more information on sorting
alarms, refer to Sorting the Alarm List.

Note: If desired, you can remove the status bar from the window
by clicking on the Options menu item then clicking on
Status bar. To return the status bar to the window, perform
these two commands again.

Table 5-3
Alarm/Alert
Levels

The Status Bar
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You can change the font that ComfortVIEW uses to display alarm
list text. When you change the font, all alarm list text is affected.

To change the font:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on the Options menu item and then click on Fonts.

ComfortVIEW displays the Font dialog box. Refer to Figure
5-4.

3. In the Font box, select the font to use.

The text in the Sample box changes to reflect the font you
select.

4. In the Font Style box, select any style options to use (for
example, bold or italic).

5. In the Size box, select the point size to use:  the larger the
point size, the larger the characters appear on your screen.

6. Click on OK.

All alarm list text displays in the new font.

Note: To make the font change permanent, click on the Options
menu item and then click on Save settings on exit. A
checkmark (✓ ) appears before the command to indicate that
it is enabled. The text will appear in the new font, style, and
point size the next time you display the alarm list.

Changing the Font



337

Figure 5-4
Font Dialog Box

8

8

Font:

Font

Sample

Font Style: Size:

Geneva
MS Sans Serif
MS Sans Serif
MS Sans Serif
MS Sans Serif

Regular

Regular
10
12
14
18

AaBbYyZz

Geneva
OK

Cancel

While the alarm list is displayed, it is not dynamic. New alarms that
occur while you are viewing the alarm list will not be included in the
list. They will, however, be annunciated.

To include new alarm messages in the alarm list:

Click on the Update Alarm List icon in the toolbar, or click
on the Functions menu item and then click on Refresh.

The Alarm List window refreshes and any new alarm messages
display at the bottom of the list.

Note: Any sorts that may have previously been selected will no
longer be in effect. Any alarms that may have previously
been selected will no longer be highlighted.

Updating the
Alarm List
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You can sort the presentation of the alarm list:

• alphabetically by area, zone, element, or point name
• by alarm/alert level from zero down to six followed by return to

normals.
• chronologically by time/date (beginning with those alarms that

occurred earliest.)

You can use sorts in combination with each other. The last sort
chosen will have precedence. For example, if you select Area,
Alarm level, then Time/Date, ComfortVIEW sorts the file first
according to time/date, then by alarm level, and then alphabetically
by area name.

To sort the alarm list:

1. Display the alarm list. If necessary, follow the instructions
listed under Viewing the Alarm List.

2. Click on the Options menu item and then click on Sort.

ComfortVIEW displays the sorts list. The sorts that are
currently active are indicated with a checkmark.

3. Click on one or more of the following menu items: Default,
Time/Date, Area, Zone, Element, Point, or Alarm Level.

Note: Clicking on an active sort de-selects it.

Clicking on Default removes all sorts currently in
effect and sorts alarms by time and date of reception
beginning with those alarms received earliest.

The alarm list updates and re-displays, sorted accordingly.
An indication of the currently-selected sorts displays in the
status bar, which displays on the third line of the alarm list
window.

Figure 5-5 shows an alarm list sorted by time and date.

Sorting the
Alarm List
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Figure 5-5
Alarm List Sorted
by Time and Date
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Some of ComfortVIEW alarms operations require you to select
alarm/alert/return to normal messages. For example, you must
specify which alarms you wish to print or delete. You can select
one, more than one, or all alarm messages.

To select one or more alarm messages:

1. Display the alarm list.

For instructions, turn to Viewing the Alarm List.

2. Click on the alarm message or messages you wish to select.

When you select an alarm message, its background becomes
highlighted with the highlight color that you have selected in
your Windows control panel. This indicates that a message is
“selected.”   Clicking on a “selected”  alarm message un-
highlights the background and “de-selects”  the message.

Note: When in the alarm list, you can select multiple alarms
using the standard Windows Ctrl-Click or Shift-Click
technique.

To select all alarm messages:

1. Display the alarm list. If necessary, follow the instructions
listed under Viewing the Alarm List.

2. Click on the toolbar’s Select All icon, or click on Functions
then click on Select all.

The background of all alarm messages becomes highlighted
with the highlight color that you have selected in your Win-
dows control panel. This indicates that a message is “se-
lected.”   Clicking on a “selected”  alarm message un-high-
lights the background and “de-selects”  the message.

Selecting
Alarms

Selecting One or More
Messages

Selecting All
Messages
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Acknowledging
Alarms

You can acknowledge receipt of alarm messages. You can acknowl-
edge one, multiple, or all alarm messages. Once you’ve acknowl-
edged an alarm message, ComfortVIEW adds your user name and a
time and date stamp to the selected alarm message.

Note: You may also acknowledge alarms by following the
instructions listed under Viewing New and Unacknowl-
edged Alarms and then clicking on the Alarm Window’s
Alarm Acknowledge icon.

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on the Alarm Acknowledge icon that appears in the
alarm-specific toolbar below the alarm message you wish to
acknowledge.

Note: You may also acknowledge a single alarm message
by selecting the alarm that you wish to acknowledge
(Refer to Selecting Alarms) and clicking on the
Functions menu item and then clicking on Acknowl-
edge, or by clicking on the Alarm Acknowledge
icon in the toolbar.

The alarm list re-displays, and your user name and the time
and date of acknowledgement display along with the ac-
knowledged alarm.

Refer to Figure 5-6 below.

Fan does not turn on when commanded, all affected air handler controls are either disabled or slowed to minimum conditions.

Alarms in System: 7 Alarms in viewing buffer: 7

United Mutual Insurance - Utility Floor AHU 0,2 Alarm - 2 at 9:30 25-Aug-1994: Supply Fan Status Off commanded state is On.

Alarm Manager

Sorted by: Default

File Edit Configure Functions Options Help

Filters in effect

John Jacobs 10:52 16-Sept-1994

Figure 5-6
Acknowledging a
Single Alarm

Acknowledging
One Alarm
Message
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Acknowledging
More Than One
or All Alarm
Messages

Figure 5-7
Alarm List with
Acknowledged Alarms

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Select the alarms that you wish to acknowledge by following
the instructions listed under Selecting Alarms.

3. Click on the Alarm Acknowledge icon that appears in the
alarm list toolbar in the second line of the screen or click on
the Functions menu item and then click on Acknowledge.

The alarm list re-displays, and your name and the time and
date of acknowledgement display along with the acknowl-
edged alarm. See Figure 5-7 below.
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You have the option to enter an operator’s note for each alarm. This
note can be viewed, printed along with the standard alarm message,
or copied to the Windows clipboard.

Alarms that currently have an operator’s note attached to them
appear with a toolbar icon as shown at left.

Alarms that do not have an operator’s note appear with a plain
yellow note icon as shown at left.

1. Display the alarm list. If necessary, follow the instructions
listed under Viewing the Alarm List.

2. Click on the Note icon that appears in the alarm-specific
toolbar below the alarm message.

ComfortVIEW displays the Operator Note dialog box, which
allows you to view, modify, delete, or add a note.

Note: You may also display the Operator Note dialog box
by clicking on Functions and then clicking on Note.

3. Click in the Note text box and make any desired additions or
changes. You can enter up to 500 alphanumeric characters.

Refer to Figure 5-8 and Table 5-8 for instructions on using
this box.

4. After you have completed any changes, click on OK. This
closes the Operator Note dialog box and saves the new note
text.

1. Select the alarms to which to attach a note. If necessary,
follow the instructions found under Selecting Alarms.

2. Click on the Functions menu item and then click on Note.

ComfortVIEW displays the Operator Note dialog box.

To Attach the
Same Note to
Multiple Alarms

To View, Modify,
or Attach a Note
to One Alarm

Attaching an
Operator’s Note
to an Alarm
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Figure 5-8
Operator Note Dialog Box

Operator Note

OK Cancel Help...

Note:

Edits the operator note text

3. Click in the Note text box and enter your text. You can enter
up to 500 characters.

Note: If any of the selected alarms currently has a note
attached to it, ComfortVIEW appends this new note
to the existing note text. You can enter up to 500
characters per note.

Refer to Figure 5-8 and Table 5-8 for instructions on using
this box.

4. After you have entered the note text, click on OK. This closes
the Operator Note dialog box and saves the new note text.
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Click on To

The Note text box enter, modify, or delete operator note
text. You may enter up to 500 charac-
ters. If you have selected multiple
alarms, this text appends to any
existing note text.

Help display help information.

OK close the dialog box and save the
settings.

Cancel exit the dialog box and restore the
previous settings. Any changes
made are not saved.

Table 5-8
Operator Note
Dialog Box
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ComfortVIEW alarm suppression feature gives you the capability to
disable the audible and visual alarm indication for selected re-
occurring alarms. This feature can be useful for “nuisance-type”
alarms for which you do not want re-indication upon each subse-
quent receipt.

Note: You can only suppress acknowledged alarms.

When ComfortVIEW initially receives an alarm, it stores the alarm
in the alarm list, produces an audible signal and, depending on the
alarm indication option you select, produces an accompanying
visual signal. If you enabled alarm suppression, and ComfortVIEW
receives this same alarm again, audible (and visual, if selected)
indication does not occur. ComfortVIEW displays the number of
subsequent receipts of the alarm that has been suppressed in the
Suppressed field, which appears in the alarm-specific toolbar below
the alarm message.

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Acknowledge the alarm that you wish to suppress (if not
already acknowledged).

3. Click on the Suppression icon in the alarm-specific toolbar
below the  alarm whose re-occurrences you wish to suppress.
ComfortVIEW displays the Alarm Suppression dialog box.

Note: If the icon appears dimmed, the alarm has not been
acknowledged. You must first acknowledge the
alarm before you can suppress it. Refer to Acknowl-
edging Alarms.

4. Click on Allow to disable alarm suppression, or click on
Suppress to enable alarm suppression.

5. Indicate the suppression duration (in hours) and click on OK.

Refer to Figure 5-9 and Table 5-9 that follow for further
instructions on using this dialog box.

Suppressing
Alarms

To Enable or Disable
Alarm Suppression
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Follow the steps below to update the alarm list and include sup-
pressed alarms:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on the Functions menu item and then click on View
Suppressed.

The alarm list updates to include all suppressed alarms and
any new alarms that may have been received while you were
viewing the list. The suppressed alarms do not contain a
Suppression icon in their alarm-specific toolbar.

To View Suppressed
Alarms

Closes this dialog box and saves settings

Alarm Suppression

OK Cancel Help...

hour

Allow

Suppress 1

Figure 5-9
Alarm Suppression
Dialog Box
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Table 5-9
Alarm Suppression
Dialog Box

Click on To

Suppress prohibit visual, audible, and alarm list
indication for subsequent receipts of
selected alarm.

The Hours text box specify the number of hours (1 to 168)
for suppression of selected alarm.
When you display this dialog box
again, this field displays the number
of suppression hours remaining.

Allow allow visual, audible, and alarm list
indication for selected alarm. This
cancels alarm suppresssion.

Help display help information.

OK close the dialog box and save the
settings.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.
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You can delete all or selected alarms from the alarm list to remove
any unnecessary alarms. For example, you should remove an alarm
that was generated during preventive maintenance that may reflect a
false condition. You can only remove acknowledged alarms.

Note: You can also delete alarms using the Cut command, which
appears under the Edit menu item. This command differs
from the Edit Menu’s Delete command, in that it copies
alarms to the Windows clipboard before deleting them.
This could be useful, for example, if you wish to use
alarms in a report that you are creating using another
Windows application.

To delete an alarm:

1. Display the alarm list. If necessary, follow the instructions
listed under Viewing the Alarm List.

2. Select the alarm message or messages you wish to delete by
clicking on them. The background of a selected message is
highlighted. This indicates that a message is “selected.”  For
additional information, refer to the Selecting Alarms section
of this chapter.

3. Click on the Edit menu item and then click on Delete.

Note: You may also perform this command by clicking on
the Delete icon in the toolbar.

ComfortVIEW displays a dialog box asking for confirmation
before actually deleting any messages.

4. Click on Yes to cause the removal to take place, or click on
No to prevent the removal from taking place.

Deleting
Alarms
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You can print selected or all alarm messages. ComfortVIEW can
automatically print alarms on occurrence, or on operator request.
You can also specify which alarm message components
ComfortVIEW prints (standard alarm message, custom message,
acknowledgement, operator note).

1. Click on the File menu item and then click on Page Setup.

ComfortVIEW displays the Page Setup dialog box.

2. Click on the items you wish to include with printed alarm
messages, and then click on OK. Refer to Figure 5-10 and
Table 5-10 for instructions on using this box.

The specified alarm components print when you print se-
lected or all alarm messages.

Note: ComfortVIEW uses the alarm components specified in the
Page Setup dialog box when it copies alarms to the Win-
dows clipboard using the Edit menu item’s Cut and Copy
commands.

Printing the
Alarm List

To Select Which
Alarm Message
Components
to Print

Figure 5-10
Page Setup
Dialog Box

Printer setup...

Page Setup

Select items to print...

OK Cancel Help...

Selects printers and additional options

Alarm message

X

Custom message

X

Acknowledgement

X

Operator note
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Table 5-10
Page Setup
Dialog Box

Click on To

Alarm message print the standard alarm message.

Custom message print the custom message along with
the standard alarm message and any
other selected items.

Acknowledgement print the acknowledgement message
along with the standard alarm message
and any other selected items.

Operator note print the operator note along with the
standard alarm message and any other
selected items.

Printer setup display another dialog box where you
specify the number of copies and print
quality. Click on this dialog box’s
Setup button to specify the printer,
paper size, and page orientation.

Help display help information.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on the alarm message or messages you wish to print.
The background of the selected message highlights to indicate
that it is “selected.”  For additional information on selecting
alarm messages, refer to Selecting Alarms.

To Print
Selected
Alarm
Messages
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3. Click on the File menu item and then click on Print.

Note: You may also print the selected alarms by clicking
on the toolbar’s Print icon.

ComfortVIEW displays a dialog box asking for confirmation
before printing.

4. Click on Yes to print the messages, or click on No to prevent
printing from taking place.

ComfortVIEW prints the selected alarm messages. The alarm
message components to be included (alarm message, custom mes-
sage, acknowledgement, operator note) are those that you specify
using the File menu’s Page Setup command.

1. Display the alarm list. If necessary, follow the instructions
listed under Viewing the Alarm List.

2. Click on the File menu item and then click on Print.

Note: You may also print all alarms by clicking on the
toolbar’s Print icon.

ComfortVIEW displays a dialog box asking for confirmation
before printing.

3. Click on Yes to print the messages, or click on No to prevent
printing from taking place.

ComfortVIEW prints all alarm messages. The alarm message
components to be included (alarm message, custom message,
acknowledgement, operator note) are those that you specify using
the File menu’s Page Setup command.

You can set up ComfortVIEW to print alarm messages on occur-
rence. You do this using ComfortVIEW's Setup function. Refer to
the Setup chapter of this manual for instructions.

To Automatically
Print Alarms on
Occurrence

To Print All Alarm
Messages
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You can add a custom alarm message to the ComfortVIEW custom
alarm message list and set the criteria for attaching it to incoming
alarms. Custom alarm messages can provide additional information,
geared to a specific alarm, that ComfortVIEW displays or prints
along with a standard alarm message.

You can also use the custom alarm message interface such that
ComfortVIEW will override a specific alarm's default audible
indication and instead play a user-specified .wav sound file on
reception of specific alarms.

You set criteria (Area, Zone, Element, Point, and Precedence) for
attaching custom messages to incoming alarms. ComfortVIEW
compares incoming alarms to your specified criteria and establishes
alarm-custom message links using the following rules:

ComfortVIEW begins by identifying criteria that might qualify the
message for attachment. One possibility that will qualify a custom
message for attachment to an alarm is an exact match between your
user-defined criteria and the incoming alarm. Other possibilities
involve any wildcards that you use to specify criteria. An incoming
alarm must satisfy each of the six user-defined criteria before the
custom message can qualify for attachment to the incoming alarm. If
ComfortVIEW does not find any set of criteria that qualify for
attachment, then the alarm will not have a custom message attached.

For example, you may have one generic custom message that is
configured for attachment to every air handler alarm, and another
custom message that is configured for attachment to air handler fan
status alarms specifically. To ensure that the fan status custom
message gets attached to the air handler fan status alarms, you
should assign a higher precedence to the fan status custom message
than to the generic air handler custom message.  You would assign
the fan status custom message a precedence of Very High, and the
air handler message a precedence of Medium. If more than one
custom message qualifies for attachment, ComfortVIEW uses the
one with the highest user-specified precedence.

Assigning Custom
Messages to
Incoming Alarms

Rules for Custom
Message Attachment
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Adding, Modifying, or
Deleting a Custom
Message

Follow the steps below to add, modify, or delete a custom message:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on Configure then click on Custom messages.

ComfortVIEW displays the Assign Custom Alarm Messages
dialog box. This dialog box allows you to add, modify, or
delete a custom alarm message. It also enables you to identify
the criteria for those incoming alarms to which you want the
custom alarm message attached.

The existing messages appear in the box below Select a
Custom Alarm Message. As you scroll down the list and
highlight each message, you can see its associated Area,
Zone, Element, Level, Point, and Precedence on the bottom of
the window.

3. Do one of the following, depending on whether you want to
add, modify, or delete a message:

• Click on Add to add a new custom alarm message to the
list of messages, or

• Select a message and then click on Modify to change the
message or its associated incoming alarm criteria, or

• Select a message and then click on Delete to delete it.

4. Refer to Figure 5-11 and Table 5-11 for further instructions
on using the fields in this dialog box. Use the Tab or Enter
key to move between fields.

5. Once you have made your changes click on OK. This perma-
nently saves the change and closes the Assign Custom Alarm
Messages dialog box.
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Figure 5-11
Assign Custom Alarm
Messages Dialog Box



356

Click on To

Add add a new custom alarm message to
the list of existing messages that are
displayed in the Select a Custom
Alarm Message box. Type the mes-
sage in the Add Custom Message text
box. Up to 128 characters are allowed.
To add a message that will play an
audible .wav file on alarm reception,
enter the text CWPLAY: followed
immediately by the name of the sound
file. For example, CWPLAY:Fanalm.
To add a message that can be re-
played at a later time, enter the text
CWWAVE: followed by the sound file
name. The CWPLAY and CWWAVE
codes can be hidden from the dis-
played custom message text by pre-
ceding the codes with the characters ||,
(which are also known as pipe charac-
ters). You can add both CWPLAY
and CWWAVE files to a single
message. Remember that the sound
file must reside in the
MEDIA\WAVES directory in the
\CWORKS, \CVIEW, or other direc-
tory in which you installed
ComfortVIEW on your server ma-
chine.

Note:  Sound files must not have a file
name in excess of 8 characters.

A ComfortVIEW alarm .wav file will
not interrupt the playing of another
non-ComfortVIEW .wav file.

Then specify the Area, Zone, Element,
Point, Level, and Precedence of
incoming alarms to assign to this new
message. Each field is described
below. Use the Tab or Enter key to
move between fields.

       (continued)

Table 5-11

Assign Custom

Alarm Messages

Dialog Box
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Table  5-11
Assign Custom
Alarm Messages
Dialog Box
(continued)

Click on To

Note: If you leave a field blank,
ComfortVIEW automatically fills
this field with the % (wildcard). Refer
to Table 5-12 for a list and explana-
tion of allowed wildcards.

Click on Save to display the new
message in the list of alarm messages.
You must click on OK to exit this
dialog box and and save the new
message.

Modify modify an existing custom message or
its associated incoming alarm criteria.
You must select the message you wish
to modify before clicking on Modify.

Delete delete an existing custom message.
You must select the message you wish
to delete before clicking on Delete.
ComfortVIEW does not remove the
message until you click on OK.

 . . . display the Speedy Data Entry dialog
box where you can quickly and easily
select the area, element, table, and
point whose alarms you wish to attach
to the specified custom message. This
dialog box is described in the Speedy
Data Entry section of this manual's
Carrier Network Manager chapter.

Area enter the up to 48 character name of
the area whose alarms you wish to
attach to the specified custom mes-
sage.

Note: You can specify the Area,
Zone, Element, Point, or Level criteria
using wildcards. Refer to Table 5-12
that follows for a list and explanation
of allowed wildcards.
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Table 5-11
Assign Custom
Alarm Messages
Dialog Box
(continued)

Click on To

Zone enter the up to 48 character name of
the zone whose alarms you wish to
attach to the specified custom mes-
sage. This criterion is applicable only
to CCN system manager-type products
(for example TSM, HSM, PSM, FSM,
CSM).

Element enter the up to 8 character element
name of the CCN system element
whose alarms you wish to attach to the
specified custom message. This name
can be found in the Carrier Network
Manager's controller list (Ex: AHU).

Point enter the up to 8 character name of the
point whose alarms you wish to attach
to the specified custom message.

Level enter the level of alarms you wish to
attach to this custom message. Click-
ing on the down arrow gives you these
choices:  Alarm, Alert, Return to
Normal, Any. Click on the desired
level, or on Any to select all levels.

the Precedence
drop-down list assign a priority level to this

custom message.

Note: You could potentially have
more than one custom message that
meets the criteria for attachment to an
alarm. ComfortVIEW will look at
the precedence level and assign the
message with the higher precedence
level to the alarm. In general, you
should give a high precedence to
custom alarm messages that have very
specific incoming alarm criteria. Give
a lower precedence to custom alarm
messages that have more general
criteria.

       (continued)
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Click on To

Save save the new or modified custom
message and its attachment criteria in
the custom message list. The save will
not apply until you click on OK.

OK close the dialog box and save the
settings.

Cancel close the dialog box and restore
previous settings.

Wildcard
Symbol Meaning

_ takes the place of any single character.

Example:  Specifying TEMP_ for the
point name means that any incoming
alarm's point name that has five
characters, where the first four are the
letters T E M P, will be acceptable as
a match for the point name.

Acceptable matches for this example:
TEMP1 or TEMPS.

% takes the place of one or more
characters.

Example:  Specifying TEMP% for the
point name means that any incoming
alarm message’s point name that has
T E M P as its first four letters will be
acceptable as a match for the point
name.

Acceptable matches for this example:
TEMP1, TEMP99, or TEMP534.

Table 5-11
Assign Custom
Alarm Messages
Dialog Box
(continued)

Table 5-12
Wildcards
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This section provides information on:

• the definition of a WorkSPACE.

• how to determine if an alarm has a WorkSPACE.

• how to assign a WorkSPACE to an existing alarm.

A WorkSPACE is a group of windows containing graphics and trend
plots of CCN data. You use the ComfortVIEW WorkSPACE Man-
ager application to create and view WorkSPACEs. For example, you
could set up a WorkSPACE to include a temperature trend, and a
graphic of the associated chilled water system. You can then display
these windows simultaneously.

As part of  the ComfortVIEW Alarm Manager application, you set
up links between alarms and WorkSPACEs. This gives you the
ability to jump from the Alarm List window to the WorkSPACE
Manager application and view the graphic, or trend plot that pertains
to the selected alarm.

You will know if an alarm has an associated WorkSPACE by look-
ing at the WorkSPACE icon that appears in the alarm-specific
toolbar below the alarm message. If the icon does not appear to be
activated (is not a blue color), a WorkSPACE has not been assigned
to this alarm. To assign a WorkSPACE to an alarm, refer to the
Assigning a WorkSPACE to an Existing Alarm section that follows.

Displaying
an Existing

Alarm’s
WorkSPACE

Determining if an
Alarm Has an
Associated WorkSPACE

What is a
WorkSPACE?
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Follow the steps below to display an existing alarm’s associated
WorkSPACE.

Note: You may also display an alarm’s WorkSPACE by follow-
ing the Flashing Icon Alarm Viewing instructions, which
can be found in the Viewing New and Unacknowledged
Alarms section of this chapter. Then click on the alarm
window’s WorkSPACE icon.

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on the blue WorkSPACE icon that appears in the alarm-
specific toolbar below the alarm message.

ComfortVIEW will invoke the WorkSPACE Manager appli-
cation and display the WorkSPACE that has been assigned to
this alarm.

Follow the steps below to assign a WorkSPACE to an existing
alarm:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Select the alarm message or messages to which you wish to
attach a WorkSPACE. If you need additional information,
refer to the Selecting Alarms section of this chapter.

3. Click on the Functions menu item and then click on Attach
WorkSPACE.

Note: You may also perform this command by clicking on
the non-blue WorkSPACE icon that appears in the
alarm-specific toolbar below the alarm message.

Displaying
WorkSPACEs

Assigning a
WorkSPACE to an
Existing Alarm
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ComfortVIEW displays the Attach WorkSPACE Dialog Box,
which allows you to select a pre-configured WorkSPACE and
assign it to the selected existing alarm(s). Refer to Figure 5-
13 and Table 5-13 for further instructions on using this dialog
box.

Note: You are assigning a WorkSPACE to this specific,
existing alarm. This WorkSPACE-alarm assignment is
not valid for any subsequent occurrences of this alarm.

Figure 5-13
Attach WorkSPACE
Dialog Box

Attach Workspace

OK Cancel Help...

Select a Workspace:

Identifies a work space to be attached to selected alarms
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Click on To

A WorkSPACE in the list select it.

Help display help information.

OK close the dialog box and attach the
selected WorkSPACE to the selected
alarm.

Cancel exit the dialog box and restore the
previous settings. Any changes made are
not saved.

Follow the steps below to change an alarm’s WorkSPACE assign-
ment:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Select the alarm message or messages whose WorkSPACE link
you wish to modify by clicking on the appropriate messages.
The background of the selected messages is highlighted. This
indicates that a message is “selected.”  If you need additional
information on selecting alarms, refer to the Selecting Alarms
section of this chapter.

3. Click on the Functions menu item and then click on Attach
WorkSPACE.

ComfortVIEW displays the Attach WorkSPACE Dialog Box,
which allows you to assign a WorkSPACE to this alarm. Select
a WorkSPACE from the list of pre-configured WorkSPACEs,
and click on OK.

Note: You are assigning a WorkSPACE to this specific
existing alarm. This WorkSPACE-alarm assignment is
not valid for any subsequent occurrences of this alarm.
Refer to Figure 5-13 and Table 5-13 for further in-
structions on using this dialog box.

Table 5-13
Attach WorkSPACE
Dialog Box

Modifying an Existing
Alarm’s WorkSPACE
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A WorkSPACE is a group of windows containing graphics and
trend plots of CCN data. You use the ComfortVIEW WorkSPACE
Manager application to create and view WorkSPACEs. For ex-
ample, you could set up a WorkSPACE to include a plot of tempera-
ture, and a graphic of the associated chilled water system. You could
then display these windows simultaneously.

As part of  the ComfortVIEW Alarm Manager application, you set
up links between alarms and WorkSPACEs. This gives you the
ability to jump from the Alarm List window to the WorkSPACE
Manager and view the graphic or trend plot that is pertinent to the
selected alarm.

You set the criteria (Area, Zone, Element, Point, and Precedence)
for attaching WorkSPACEs to incoming alarms. ComfortVIEW
compares incoming alarms to your specified criteria and establishes
alarm-WorkSPACE links using the following rules:

ComfortVIEW begins by identifying any criteria that might qualify
the WorkSPACE for attachment. One possibility that will qualify a
WorkSPACE for attachment to an alarm is an exact match between
your user-defined criteria and the incoming alarm. Other possibili-
ties involve any wildcards that you use to specify criteria. If
ComfortVIEW does not find any set of user-defined criteria that
qualify for attachment, then the alarm will not have a WorkSPACE
attached.
For example, you may have one generic WorkSpace that is config-

Assigning
WorkSPACES to
Incoming Alarms

What is a WorkSPACE?

Rules for WorkSPACE
Assignment



365

ured for attachment to every air handler alarm, and another
WorkSPACE that is configured for attachment to air handler fan
status alarms specifically. To ensure that the fan status WorkSPACE
gets attached to air handler fans status alarms, you should assign a
higher precedence to the fan status WorkSPACE than to the generic
air handler WorkSPACE. You would assign the fan status
WorkSPACE a precedence of Very High, and the air handler
WorkSPACE a precedence of Medium. If more than one
WorkSPACE qualifies for attachment, ComfortVIEW uses the one
with the highest user-specified precedence.

Follow these steps to assign a WorkSPACE to an incoming alarm or
to modify an existing WorkSPACE-incoming alarm assignment:

1. Display the alarm list. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on Configure and then click on WorkSPACEs.

ComfortVIEW displays the Assign WorkSPACEs dialog box.
This dialog box gives you the capability to select a
WorkSPACE. It also enables you to identify the criteria for
those incoming alarms to which you want the WorkSPACE
attached.

The names of all currently-assigned WorkSPACEs appear in
the box below Select a WorkSPACE. As you scroll down the
list and highlight each WorkSPACE, you can see its associ-
ated Area, Zone, Element, Level, Point, and Precedence on
the bottom of the window.

3. Do one of the following, depending on whether you want to
add, modify, or delete a WorkSPACE:

• Click on Add  to establish a new WorkSPACE-incoming
alarm assignment, or

• Select a WorkSPACE and then click on Modify to change
a WorkSPACE or its associated incoming alarm criteria,
or

• Select a WorkSPACE and then click on Delete to remove
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it from the list and to delete the existing WorkSPACE-
alarm assignment.

4. Refer to Figure 5-14 and Table 5-14 that follow for further
instructions on using the fields in this dialog box. Use the Tab
or Enter key to move between fields.

5. Once you have made your changes, click on OK. This closes
the Assign WorkSPACEs dialog box.

Figure 5-14
Assign WorkSPACEs
Dialog Box

Assign WorkSPACEs

Select a WorkSPACE:

Save Cancel

OK Cancel Help...Now... Modify... Delete

Precedence:Area:

Zone:

Element:

Point:

Level:

%

%

%

%

Any
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Click on To

Add establish a new WorkSPACE-incom-
ing alarm assignment. The Add
WorkSPACE Assignment line dis-
plays the names of existing
WorkSPACEs. Use the down arrow to
display the list of all WorkSPACEs.

Then specify the Area, Zone, Element,
Point, Level, and Precedence of
incoming alarms to attach to this
WorkSPACE. Each field is described
below. Use the Tab or Enter key to
move between fields.

Note:    If you leave a field blank,
ComfortVIEW  automatically  fills
this field with the _ (wildcard). Refer
to Table 5-15 that follows for a list
and explanation of allowed wildcards.

Click on Save to display the newly-
assigned WorkSPACE in the list of
WorkSPACEs on the top of the
window. You must click on OK to exit
this dialog box and and save the new
WorkSPACE-incoming alarm assign-
ment.

Modify identify a new WorkSPACE to be
assigned to the displayed incoming
alarm criteria, or to modify the dis-
played incoming alarm criteria. You
must select the WorkSPACE you wish
to modify before clicking on Modify.

(continued)

Table 5-14
Assign WorkSPACEs
Dialog Box



368

Click on To

Delete delete an existing WorkSPACE-
incoming alarm assignment. You must
select the WorkSPACE you wish to
delete before clicking on Delete.
ComfortVIEW does not remove the
WorkSPACE until you click on OK.

Area enter the up to 48 character name of
the area whose alarms you wish to
attach to the specified WorkSPACE.

Note:  You can specify the Area,
Zone, Element, Point, or Level criteria
using wildcards. Refer to Table 5-15
that follows for a list and explanation
of allowed wildcards.

Zone enter the 8 character name of the zone
whose alarms you wish to attach to the
specified WorkSPACE. This criterion
is applicable only to CCN system
manager-type products (for example
TSM, HSM, PSM.)

Element enter the up to 8 character element
name of the CCN system element
whose alarms you wish to attach to the
specified WorkSPACE.

Point enter the 8 character name of points
whose alarms you wish to attach to the
specified WorkSPACE.

(continued)

Table 5-14
Assign WorkSPACEs
Dialog Box
(continued)
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Table 5-14
Assign WorkSPACEs
Dialog Box
(continued)

Click on To

Level enter the level of alarms you wish to
attach to this WorkSPACE. Clicking
on the Down arrow gives you these
choices:  Alarm, Alert, Return to
Normal, Any. Click on the desired
level, or  click on Any to select all
levels.

the Precedence assign a priority level to this
drop-down list WorkSPACE. You could potentially

have more than one WorkSPACE that
meets the criteria for attachment to an
alarm.

Note: ComfortVIEW will look at
the precedence level and assign the
WorkSPACE with the higher prece-
dence level to the alarm. In general,
you should give a high precedence to
WorkSPACEs that have very specific
incoming alarm criteria. Give lower
precedence to WorkSPACEs that have
more general criteria.

Save save the new or modified
WorkSPACE and its attachment
criteria in the WorkSPACE list. The
save will not apply until you click on
OK.

Cancel close the dialog box and restore
previous settings.

OK close the dialog box and save the
settings.
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Wildcard
Symbol Meaning

_ (underscore) takes the place of any single character.

Example:  Specifying TEMP_ for the
point name means that any incoming
alarm’s point name that has five
characters, where the first four are the
letters T E M P, will be acceptable as
a match for the point name.

Acceptable matches for this example:
TEMP1 or TEMPS.

% takes the place of one or more charac-
ters.

Example:  Specifying TEMP% for the
point name means that any incoming
alarm message’s point name that has
T E M P as its first four letters will be
acceptable as a match for the point
name.

Acceptable matches for this example:
TEMP1, TEMP99, or TEMP534.

Table 5-15
Wildcards
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Selecting
Alarm List

Display Colors

Follow the steps below to select the color of alarm, alert, return to
normal, custom alarm, and acknowledgement messages:

1. Display the Alarm List. If necessary, refer to the instructions
listed under Viewing the Alarm List.

2. Click on Options and then click on Colors.

ComfortVIEW displays the Alarm Colors dialog box. Refer to
Figure 5-16 and Table 5-16 for instructions on using this box.

3. Click on the button preceding the type of message whose color
you wish to change (Alarm Messages, Alert Messages, Return
to Normal Messages, Custom Alarm Messages, or
Acknowledgements).

Figure 5-16
Alarm Colors
Dialog Box

Acknowledgements

Custom Alarm messages

Return to Normal messages

Alarm messages

Alert messages

Alarm Colors

Select text...

Selects color for display of selected text

OK Cancel Help...Defaults

Color...
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4. Do one of the following depending on whether you want to
use default colors or select another color scheme:

• Click on Colors if you wish to use another color scheme.
ComfortVIEW displays the Color dialog box. Refer to
Table 5-17 that follows for further instructions on using
this dialog box.

• Click on Defaults to use the default colors:  royal blue for
alarm/alert/return to normal text, black for custom mes-
sage text, and red for acknowledgement text.

5. After you have chosen the desired colors for your alarm
message display, click on OK. This closes the Color dialog
box and selects the specified colors.

Click on To

Colors display the Color dialog box and
select the color for the selected text.
You can select one of the standard
colors or you may create a custom
color. Refer to Table 5-17 for instruc-
tions on using this box.

Default select the default colors —
royal blue for alarm/alert/return to
normal text, black for custom message
text, and red for acknowledgement
text.

Help display help information.

OK close the dialog box and select the
specified colors.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Table 5-16
Alarm Colors
Dialog Box
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Table 5-17
Color Dialog Box Click on To

Basic Color select a standard color for the selected
text.

Custom Color select one of the previously-defined
custom colors.

Define Custom Colors refine the selected basic or custom
color. The Color dialog box expands
to include a color refiner box. Click
on the basic or custom color that you
wish to refine. Use the cursor that is
inside the color refiner box and the
vertical luminosity bar to change the
color. You may also type values in the
boxes. The right side of the Color/
Solid box displays the new text color.
Note that the Solid colors are the only
ones that apply. For more information
on defining custom colors, refer to
your Windows user’s guide. Click on
Add to Custom Colors to add the new
color to the custom colors palette.

OK close the dialog box and select the
specified colors.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.
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File Menu

Alarm Menu
Commands

Table 5-18
File Menu

This section describes each of the commands that appear in the
alarm menus.

The following table describes each of the commands in the Alarm
Manager's File menu.

Command Use this command to

Export copy selected alarms to a file. You can
copy this file to another direc-
tory, sub-directory, or drive. One use
for this function would be to export
ComfortVIEW alarm data for use with
another software product, such as a
word processor or spreadsheet pro-
gram.

Note:  You must specify which alarm
message components (alarm message,
acknowledgement message, custom
message, operator note) to export. Use
the File menu’s Page Setup command
to select these components.

Dialog Box Options:

File Name:  Type a name for the
export file.

Save File As Type:  Click on the
down arrow and select the file
type from the drop down list.

Directories:  Click on the directory
path where you want the file saved.

(continued)
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Command Use this command to

Dialog Box Options: (continued)

Drives:  Click on the down arrow and
select the drive where you want the
file saved from the drop down list.

Network:  Click on this button to save
the file to another computer  on the
local area network. ComfortVIEW
displays the Connect Network Drive
dialog box.

OK:  Closes the dialog box and saves
changes made.

Cancel:  Exits the dialog box and
restores the previous settings.

Print print selected alarm messages.

Print All print all alarm messages.

Page Setup select which alarm message compo-
nents to print, copy, or export (alarm
message, acknowledgement message,
custom message, operator note).

Exit exit the Alarm Manager application.

Table 5-18
File Menu
(continued)
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The following table describes each of the commands in the Alarm
Manager's Edit menu.

Command Use this command to

Cut delete selected alarms or text and store
it on the Windows clipboard. Use this
function to rapidly copy alarm text to
another software application (such as a
word processing program). When
editing text in a text box or field, you
can only perform this command using
the Ctrl X key combination.

Note:   You must specify which alarm
message components (alarm message,
acknowledgement message, custom
message, operator note) to cut using
the File menu’s Page Setup command.

Copy copy selected alarms or text and store
them on the Windows clipboard. Use
this function to rapidly copy alarm text
to another software application (such
as a word processing program). When
editing text in a text box or field, you
can only perform this command using
the Ctrl C key combination.

Note:  You must specify which alarm
message components (alarm message,
acknowledgement message, custom
message, operator note) to copy using
the File menu’s Page Setup command.

Delete delete selected alarms or text. When
editing text in a text box or field, you
can only perform this command using
the Delete (or Backspace) key.

Export to clipboard copy selected alarms to the Windows
clipboard. Alarms copied using this
command will differ from alarms

                                            (continued)

Edit Menu

Table 5-19
Edit Menu
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Command Use this command to

copied using the Copy command, in
that these alarms, when pasted into
another application, will be preceded
by the CCN number, and will display
in a tab-separated internal alarm
record format.

The following table describes each of the commands in the Alarm
Manager's Configure menu.

Command Use this command to

Custom Messages add or modify a custom alarm mes-
sage and identify the criteria for
attachment to alarms.

WorkSPACEs attach a WorkSPACE to an incoming
alarm or modify an existing
WorkSPACE-incoming alarm assign-
ment.

The following table describes each of the commands in the Alarm
Manager's Functions menu.

Command Use this command to

Acknowledge acknowledge receipt of selected
alarms. Once you’ve acknowledged
an alarm message, ComfortVIEW
adds your user name and a time and
date stamp to the selected alarm
message.

Refresh include new alarms that may have
occurred while you were viewing the
alarm list.

(continued)

Table 5-19
Edit Menu
(continued)

Configure Menu

Table 5-20
Configure Menu

Functions Menu

Table 5-21
Functions Menu
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Command Use this command to

Select All select all alarm messages in the alarm
list. You must select alarms that you
wish to acknowledge, delete, or print.
The background of the selected
messages will be highlighted. Per-
forming this command again will de-
select all messages and remove the
highlighting.

Attach WorkSPACE assign a WorkSPACE to selected
alarms. The alarm-specific toolbar
that is displayed below each alarm in
the Alarm List contains a
WorkSPACE icon. If an alarm’s
WorkSPACE icon does not appear to
be activated (is not a blue color), a
WorkSPACE has not been assigned to
this alarm. Click on the non-blue
WorkSPACE icon or use the Options
Menu’s Attach WorkSPACE com-
mand to display the Attach
WorkSPACE Dialog Box, which
allows you to assign a WorkSPACE to
this alarm. Note that you are assigning
a WorkSPACE to the selected existing
alarm(s). This WorkSPACE-alarm
assignment is not valid for any subse-
quent occurrences of this alarm.

View Suppressed update the alarm list and include
suppressed alarms. The suppressed
alarms do not contain a Suppression
icon in their alarm-specific toolbar.

(continued)

Table 5-21
Functions Menu
(continued)
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Table 5-21
Functions Menu
(continued)

Command Use this command to

Note display or add an operator note to the
selected alarm(s). If you are attaching
a note to a group of alarms, the note
will be appended to existing notes.
Alarms that currently have an
operator’s note attached to them
appear with a toolbar icon resembling
a “scribbled”  note. Alarms that do not
have an operator’s note, appear with a
plain yellow note icon.

The following table describes each of the commands in the Alarm
Manager's Options menu.

Command Use this command to

Font change the font that ComfortVIEW
uses to display alarm list text. When
you change the font, all alarm list text
is affected.

Colors select the display colors for the alarm/
alert/return-to-normal, custom mes-
sage, and acknowledgement message
text.

Toolbar hide or display the alarm list toolbar
that appears in the second line of the
alarm window.

       (continued)

Options Menu

Table 5-22
Options Menu
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Table 5-22
Options Menu
(continued)

Command Use this command to

Status bar hide or display the status bar that
appears in the third line of the alarm
window. The status bar displays the
following information:  the total
number of alarms that have been
received, the number of alarms that
the currently-logged on operator is
seeing, the alarm filters that are
currently in effect, an indication of
how the alarm list is currently sorted.

Sort sort the presentation of the alarm list.
You can sort the presentation of the
alarm list alphabetically by area, zone,
element, or point name, by alarm level
from zero to seven, or chronologically
by time/date. You can use combina-
tion sorts. The last sort chosen will
have precedence. For example, if you
select Area, Alarm level, and then
Time/Date, ComfortVIEW will sort
the file first according to time/date,
then by alarm level, and then alpha-
betically by area name. Selecting
Default removes all sorts currently in
effect and sorts alarms by time and
date of reception beginning with those
alarms received earliest.

Save settings on exit save any changes you make using
commands on the Options menu. For
example, if you change the font and
then exit the Alarm Manager, the text
appears in the new font the next time
you start the Alarm Manager. This
command also saves the size and
position of all Alarm Manager win-
dows.
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The following table describes each of the commands in the Alarm
Manager's Window menu.

Command Use this command to

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
components, and copyright.

Window Menu

Table 5-23
Window Menu
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Alarm Manager
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This chapter provides information on ComfortVIEW Setup applica-
tion.

For information on... Turn to page

launching the Setup application 385

adding, modifying, and deleting internal gateways 386

adding, modifying, deleting ComfortVIEW operators:
• adding a new or modifying an existing operator 389
• deleting an operator 390
• defining system access levels 392
• setting up operator profiles 398
• setting up your own operator profile 398
• assigning access levels to operators 401
• specifying operator alarm indication preferences 405
• setting up your own alarm indication preferences 406

specifying alarm indication preferences for logged
out computers 407

specifying alarm printers 417

defining ComfortVIEW local
area network workstations 419

defining ComfortVIEW alarm printers 422

defining FID and Comfort Controller
custom engineering units 425

specifying the following global system parameters:
• metric or customary US units (fixed setting

specified during ComfortVIEW
software installation) 428

• time of day at which to retrieve accumulated
report data from your CCN options 428

• period of time to retain accumulated report
data in your ComfortVIEW database 428

• number of times to re-try report data retrieval
should a failure occur 428

• system event activity tracking 429
• alarm purge filename and threshold 429

exporting an entire CCN's database 433

importing an entire CCN's database 437

setup menu command summary 443

Setup
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The following terms are used throughout this chapter.

Client — A computer on a local area network running
ComfortVIEW communication and user interface software, or
ComfortVIEW user interface software only.

Server — A computer on a local area network running
ComfortVIEW communication, user interface, service, and database
software.

You use ComfortVIEW Setup application to add or define the
following:

• ComfortVIEW operators

• ComfortVIEW local area network workstation names

• Alarm printer names and port locations

• Global parameters:

• Metric or customary US units (fixed setting chosen at instal-
lation)

• Time of day at which to retrieve accumulated report data
from your CCN options

• Period of time to retain accumulated report data in your
ComfortVIEW database

• Number of times to re-try report data retrieval should a
failure occur.

• Enable/disable of system activity event logging.

• Enable/disable automatic ComfortVIEW login in
conjunction with Windows NT login.

• Enable/disable of automatic alarm deletion, including purge
filename and threshold.

You can also use the Setup application to export or import an entire
CCN's database.
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To launch the Setup application:

Double click on the Setup icon.

ComfortVIEW displays the Setup window shown in
Figure 6-1. The top line of the window contains the setup menu.
Refer to Setup Menu Command Summary at the end of this chapter
for a description of each menu item and command.

Launching
the Setup

Application

Figure 6-1
Setup Window
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In addition to using a CCN Autodial Gateway, you can also connect
to a remote CCN using an internal gateway, which is a modem that
is internal or external to your ComfortVIEW workstation.

Note that ComfortVIEW only supports one internal modem. Mul-
tiple modems can be supported, however, if they are connected to
external communication ports.

Prior to initially using an internal gateway, you must specify the
modem's communication port and telephone number.

Follow the instructions below to add a new, or to modify or delete
an existing internal gateway.

1. Click on the Setup menu item and then click on Gateway
ports.

ComfortVIEW displays the Gateway Ports dialog box. Refer
to Table and Figure 6-1a. The names of any communication
ports that have been previously designated for use by an
internal gateway are displayed.

2. In the Gateway Ports dialog box, click on one of the follow-
ing, depending on whether you wish to configure a new port,
modify an existing port's telephone number, or delete an
existing port:

• To delete a port's modem designation, click on a port in
the Select Gateway port list, and then on Delete

At the confirmation message, click on Yes to complete
the deletion or on No to cancel.

• To modify a currently-configured port's telephone num-
ber, click on a port in the Select gateway list, and then on
Modify.

The New Gateway Port dialog box will be displayed.
Refer to Figure and Table 6-1b.

In the New Gateway Port dialog box, modify the tele-
phone number, as desired.

• To configure a new port for use with a modem, click on
New.

The New Gateway Port dialog box will be displayed.
Refer to Figure and Table 6-1b.

Adding,
Modifying,
Deleting Internal
Gateways
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In the New Gateway Port dialog box, click on the Gate-
way port drop down list to select the port to configure,
and under Phone Number, enter the internal modem's
telephone number.

Note: The internal modem telephone number is used in
alarm processing. If you wish to receive alarms
from a remote CCN when you are connected to it,
you must enter this number.

3. Click on OK to exit the Gateway Ports dialog box and save
the settings or on Cancel to exit the dialog box and restore
previous settings.

Figure 6-1a
Gateway Ports
Dialog Box

Click on To

New configure a new port for use with a
modem.

The New Gateway Port dialog box
will be displayed. Refer to Figure and
Table 6-3.

A port in the Select
Gateway port list select an existing communication port

for modification or deletion.

Delete delete the selected port's modem
designation.

       (continued)

Table 6-1a
Gateway Ports
Dialog Box
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Click on To

Modify modify the telephone number of the
selected port.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-1a
Gateway Ports
Dialog Box
(continued)

Figure 6-1b
New Gateway Port
Dialog Box

Click on To

the Gateway port drop
down list select the communication port to

configure.

Phone number enter or modify the internal modem's
telephone number.

Note: The internal modem telephone
number is used in alarm
processing. If you wish to
receive alarms from a remote
CCN when you are connected
to it, you must enter this
number.

       (continued)

Table 6-1b
New Gateway Port
Dialog Box
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Click on To

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

ComfortVIEW can support up to 100 different operators.

To quickly and easily add a new ComfortVIEW operator, click on
the Operator Profile toolbar wizard shown at left. The wizard guides
you through the following setup functions:

• Setting up the operator profile (operator and login name, pass-
word, and alarm indication preference)

• Defining system access levels and assigning access levels to the
operator

• Specifying alarm indication preferences.

To modify an existing ComfortVIEW operator, follow the instruc-
tions below.

Click on the Administration menu item and then click on
Operators.

Note: You may also perform this command by clicking on
the Modify Operator Profiles icon in the toolbar.

ComfortVIEW displays the Operator Configuration dialog
box. The names of all existing ComfortVIEW operators
display under Select an Operator.

Refer to Figure 6-2 and Table 6-2 for further instructions on
using the Operator Configuration box.

Table 6-1b
New Gateway Port
Dialog Box
(continued)

Adding,
Modifying,

Deleting
Operators

To Add a New
Operator

To Modify an Existing
Operator
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1. In the Operator Configuration dialog box, use the mouse or
the up or down arrow to select the operator to modify in the
Select an Operator box.

2. Click on Profile to modify the operator’s login name, operator
name, password, start-up application, or alarm indication
preferences. For step by step instructions, refer to Setting Up
Operator Profiles, which appears later in this Setup chapter.

3. Click on Access Level to modify the set of operator’s privi-
leges for each of the areas in your CCN. For step by step
instructions, refer to Assigning Access Levels to Operators,
which appears later in this Setup chapter.

4. Click on OK.

1. In the Operator Configuration dialog box, use the mouse or
the up or down arrow to select the operator to delete.

2. Click on the Delete button.

3. Follow Steps 1 and 2 for each operator that you wish to delete.

4. Click on OK.

To Delete an Existing
Operator

Select an Operator

Operator Configuration

OK Cancel Help...

Profile...

Access levels...

New...

Delete

Arthur Doyle

Selects an operator for modification or deletion

Beth Ames
System Administrator

Figure 6-2
Operator Configuration
Dialog Box
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Table 6-2
Operator Configuration
Dialog Box

Click on To

Select an Operator: list select an operator to modify or delete.

Profile display the Operator Profile dialog
box. This box gives you the capability
to modify the selected operator’s login
name, operator name, password, start-
up application, or alarm indication
preferences.

Access levels display the Operator Access dialog
box. This box gives you the capability
to modify the selected operator’s
assigned privilege (access) levels.

New display the Operator Profile dialog
box. This box gives you the capability
to add an operator to the system.

Delete remove the selected operator from the
system. ComfortVIEW displays a
dialog box asking for confirmation
before deleting the selected operator.
Click on Yes to delete the operator, or
click on No to prevent the deletion
from taking place.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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ComfortVIEW provides you with the capability to define and create
customized access levels. You can create an access level and specify
the ComfortVIEW operations allowed for that level. You then
assign access levels to ComfortVIEW operators on an area by area
basis.

For example, you can create an access level that has viewing privi-
leges only. An operator that is assigned this access level will be able
to view controller data but not change controller configuration in the
specified areas.

For information on assigning levels to operators, refer to Assigning
Access Levels to Operators.

Perform the following to create, modify, or delete an existing access
level:

Click on the Administration menu item and then click on
Access Levels.

ComfortVIEW displays the Customized Access Control
dialog box. The names of all currently-configured access
levels display under Select an Access Level:. As you select an
access level, the names of the operations that this access level
allows display in the lower left box. The lower right box
displays the operations that this access level does not allow.
You move functions between the left and right boxes to
define or modify an access level.

Defining System
Access Levels
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Figure 6-3
Customized Access
Control Dialog Box

Customized Access Control

Allowed functions:

Alarm Indication
Alarm Viewing

Access Level name:

Alarm Viewing

Available functions:

Alarm Acknowledgement
Alarm Management
Control Element Administration
Control Element Configuration
Custom Programming
Force/Auto Points
Setpoint Configuration
Time Schedule Configuration
View Data DIsplays
View/Print Reports

<<Add

Remove>>

Save Cancel

Selects an Access Level for modification or deletion

Select an Access Level:

All Operations
Setpoint Changes
Control Override Ability
Viewing Only

OK Help...Cancel

New...

Modify...

Delete
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Click on To

Select an Access Level: list select an access level to modify or
delete.

New create a new access level.
Type the name of the new access level
in the Access Level name box, select
the function(s) from the Available
functions list, and click on <<Add.

Modify modify the selected access level.
Select the function(s) you wish to add
from the Available functions list, and
click on <<Add. To remove a selected
function from the Allowed functions
list, click on Remove>>.

Delete delete the currently-highlighted access
level.

Save save the new or modified access level.
Note that the save will not apply until
you click on OK.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Add add selected Available functions: to
the Allowed functions: list.

Remove move selected Allowed functions: to
the Available functions: list.

Table 6-3
Access Level Functions
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1. Click on New to create a new access level.

2. Type the name of the new access level in the Access Level
Name box.

3. Select the functions to which this access level will be allowed
from the Available functions list, and click on <<Add.

Note: Refer to Table 6-4 for a list of functions and their
corresponding ComfortVIEW operations.

The selected functions will display in the Allowed functions
list.

4. If you wish to remove a function from the Allowed functions
list, select the function and click on Remove>>.

5. When the Allowed functions list contains the desired func-
tions for this access level, click on Save.

6. Click on OK to close the dialog box and save the new access
level.

1. Select the access level from the list displayed under Select an
Access Level:.

2. Do one of the following, depending on whether you want to
modify or delete an access level:

• To modify an access level’s associated functions, click on
Modify and then follow Steps 3 to 6 under To Create a
New Access Level.

• To delete an access level, click on Delete.

ComfortVIEW displays a dialog box asking for confirma-
tion before deleting the selected access level. Click on Yes
to delete the access level or click on No to prevent the
deletion from taking place.

To Create a New
Access Level

To Modify or Delete an
Existing Access Level
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Function Allows You

Alarm Acknowledgment Based on area assignments and alarm
filters, to:
• acknowledge an alarm.
• attach an operator note to an alarm.

Alarm Management Based on area assignments and alarm
filters, to:
• delete selected alarms.
• suppress nuisance alarms.

Alarm Viewing Based on area assignments and alarm
filters, to:
• view and hear the alarm indicator.
• view the pop-up dialog box contain-

ing a description of the most severe
unacknowledged alarm.

• view the alarm list.
• update the alarm list to include the

latest alarms.
• sort the alarm list.
• view operator notes.
• print selected alarms.
• attach a WorkSPACE to an alarm.
• export selected alarms.

Note:  In order to receive alarms, you
must also set up your individual alarm
indication preferences and filters. For
instructions, refer to Setting Up
Operator Profiles and Specifying
Operator Alarm Indication Prefer-
ences, which appear later in this
Carrier Network Manager chapter.

Control Element Based on area assignments, to perform
Administration the following administration and setup

procedures:
• add, upload/download, configure, or

delete a controller to/from
ComfortVIEW database.

• import and export controllers.
       (continued)

Table 6-4
Access Level Functions
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Function Allows You

Control Element • perform off-line configuration.
Administration • upload/download controller
(continued) configuration.

• initiate a CCN directory poll.
• initiate CCN diagnostics.

Custom Programming Based on area assignments, to:
• use the custom programming envi-

ronment.

Force/Auto Points* Based on area assignments, to:
• override (force) a controller’s auto-

matic control on any available point.
• remove overrides (forces) on any

available point and return the point
to the controller’s automatic control.

Setpoint Configuration* Based on area assignments, to:
• modify all setpoints for assigned

buildings.

Time Schedule
Configuration* Based on area assignments, to:

• modify all time schedules for as-
signed buildings.

View Data Displays Based on area assignments, to:
• view tabular displays of system

element data.
• view a set of predetermined system

views.
• create a WorkSPACE of system

views — add, modify, delete
WorkSPACE(s).

• connect and disconnect to permitted
remote CCNs.

* The View Data function will automatically be included when you
select this function.

Table 6-4
Access Level Functions
(continued)
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You must specify a login name, operator name, password, start-up
application, access level, and alarm indication preferences for every
ComfortVIEW operator.

Follow the steps below to create or modify any operator’s profile:

1. Display the Operator Configuration dialog box by clicking on
the Administration menu item followed by clicking on Opera-
tors.

2. Click on New to add a new operator to the system, or

Click on Profile to modify the selected operator’s profile
information.

ComfortVIEW displays the Operator Profile dialog box.

3. Refer to Figure 6-5 and Table 6-5 for instructions on using
the Operator Profile dialog box.

After entering all  information, click on OK.

If you are adding a new operator, the Operator Access dialog
box now displays. Refer to Assigning Access Levels to
Operators  for instructions on using this box.

If you are modifying an existing operator’s profile, the Opera-
tor Configuration dialog box re-displays.

To create or modify your own operator profile:

1. Click on the Administration menu item.

2. Click on Your profile.

Note: You may also perform this command by clicking on
the Modify Your Operator Profile icon in the
toolbar.

Setting Up
Operator Profiles

Setting Up Your Own
Operator Profile
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Click on To

the Login name text box type your operator login name (up to
eight characters).

the Operator name text box type your full operator name (up to 48
characters).

the Password text box type your login password (up to 16
characters). Note that this text is case
sensitive. For example, if you type the
characters here in all upper case
letters, you must always login with all
upper case letters.

Start-up application select the ComfortVIEW application
that automatically launches on login.

(continued)

Figure 6-5
Operator Profile Dialog
Box

Table 6-5
Operator Profile Dialog
Box
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Click on To

Alarm indication set up your visual and audible alarm
indication preferences. ComfortVIEW
displays the Alarm Indication Prefer-
ences dialog box. For instructions on
using this box, refer to Specifying
Operator Alarm Indication Prefer-
ences, which appears later in this
Setup chapter.

Quiet-time logout desired enable or disable this feature, which
monitors the PC for an operator-
specified period of inactivity and then
automatically logs out the current
ComfortVIEW operator.

Quiet time enter the number of minutes of inac-
tivity that must pass prior to automatic
ComfortVIEW logout. One minute
prior to the execution of auto logout, a
dialog box, which is accompanied by
a "beep," will be displayed warning of
the pending logout. A countdown
timer is included. Any unsaved data
will be lost and outstanding remote
CCN and RAS connections will be
dropped prior to the logout.

OK close the dialog box and save changes
made. If you are adding a new opera-
tor, ComfortVIEW then displays the
Operator Access dialog box. Select
the access levels for this operator. For
instructions on using this box, refer to
Assigning Access Levels to Opera-
tors, which appears later in this Setup
chapter.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-5
Operator Profile Dialog
Box
(continued)
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You must assign access or privilege levels to every ComfortVIEW
operator. You can assign access levels to operators on an area by
area basis. For example, if you have two access levels named Con-
trol Element Configuration and Passive Monitor (each with different
access privileges), you could give an operator Control Element
Configuration access for one area in your CCN, and Passive Moni-
tor access for another area.

For information on creating access levels, refer to Defining System
Access Levels (which appears earlier in this chapter).

Follow the steps below to assign an operator’s access levels.

Note: If you are adding a new operator to the system, the Opera-
tor Access dialog box automatically displays after you
click on the Operator Profile dialog box’s OK button. Skip
to Step 3 below.

1. Display the Operator Configuration dialog box by clicking on
the Administration menu item followed by clicking on Opera-
tors.

2. Click on Access levels to modify the selected operator’s
access levels.

ComfortVIEW displays the Operator Access dialog box.

3. Refer to Figure 6-6 and Table 6-6 for instructions on using
this dialog box.

4. Click to enable or disable the following privileges: System
setup, Report setup, Report Generation, and Workspace
setup. Refer to Table 6-6 for a description of specific opera-
tions associated with these privileges.

5. Select the operator’s default access level from the drop down
list box. The operator will by default be assigned this access
level for all areas with the exception of those areas listed in
the Exceptions list.

6. In the Exceptions Areas list, select the areas for which you wish
to assign an access level that is different from the default access
level.

Assigning Access
Levels to
Operators
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As you select an area, the area’s currently assigned access
level displays in the Exception: list at the bottom of the dialog
box. If you wish to change an area’s access level, select the
new access level from the Exception: drop down list.

7. Once you have made your access level assignments, click on
OK. This closes the dialog box and saves your settings.

Figure 6-6
Operator Access Dialog
Box
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Click on To

Select operator’s default
Access Level: select the privilege level that the operator

will have for all areas in your CCN with
the exception of those areas listed in this
dialog box under Exceptions. Clicking on
the down arrow displays all existing
access levels. Select an access level from
this list.

Global Privileges:

System setup enable/disable system setup privileges.
These privileges include access to the
following operations:

• operator configuration and preferences.
For example, adding, modifying, and
deleting operators —name and pass-
word assignments, quiet time for auto
logoff, access level creation, modifica-
tion, and deletion, alarm annunciation
and viewing criteria including setting
up alarm filters.

• alarm administration.
For example, creating custom alarm
messages, specifying alarm printing
criteria, WorkSPACE/alarm condi-
tion relationships.

• ComfortVIEW Setup application.
For example, alarm printer-location
and options, LAN computer names,
global report data retrieval settings.

• CCN administration.
For example, adding, modifying, and
deleting CCNs, areas, including
setting PC address and baud rate,
alarm acknowledgment capability.

         (continued)

Table 6-6
Operator Access Dialog
Box
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Click on To

Report setup enable/disable report setup privileges.
These privileges include access to the
following operations:

• creating report definitions.

• install optional and custom reports.

• configure reports that have custom
groupings of data — consumable,
runtime, history.

Report generation perform the following operations:

• generate, view, and print any report
—standard, optional, or custom.

WorkSPACE setup enable/disable WorkSPACE setup
privileges. These privileges allow you
to create and modify WorkSPACEs
ViewSPACES, and trends.

Global functions enable/disable access to the following
Global Function Manager operations:

• configure timed forces, central time
schedules, point transfers, and holiday
tables.

the Exceptions Areas list select each area that you wish to
assign a different access level than the
default access level that is specified in
the Select operator’s default Access
Level box. As you select an area, the
area’s currently-assigned access level
displays in the Exception: list at the
bottom of the dialog box.

Initially, all areas are assigned to the
default access level. If you wish to
change the access level, select the new
access level for this area from the
Exception: drop down list.

 (continued)

Table 6-6
Operator Access Dialog
Box
(continued)
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Click on To

Clear Exceptions re-set all Exception Areas to the
default access level.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

You can configure the method by which ComfortVIEW notifies an
operator of the existence of unacknowledged alarms, alerts, return to
normals, or user-specified critical alarm conditions. ComfortVIEW
can notify an operator in one of the following manners:

• A "beep" sounds or a user-specified sound file plays with no
visual indication

• A flashing icon displays on top of any window that you are
currently viewing

• A pop-up window displays on top of any window that you are
currently viewing.

ComfortVIEW also gives you the capability to:

• set up alarm filters that specify families of alarms to be pre-
sented to each ComfortVIEW operator.

• specify which alarms are to be treated as critical alarms.

• enable or disable full-screen critical alarm indication.

• customize your audible alarm indication "beep" tones.

• specify a sound file (.wav format) to play on receipt of an alarm,
alert, return to normal, or critical alarm.

Note: The sound file must not have a file name in excess of 8
characters.

Table 6-6

Operator Access Dialog

Box

(continued)

Specifying

Operator Alarm

Indication

Preferences
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Follow the steps below to set up or modify operator alarm indication
preferences:

1. Display the Operator Configuration dialog box by clicking on
the Administration menu item followed by clicking on Opera-
tors.

2. Select the operator whose preferences you wish to access.

3. Click on Profile.

4. Click on Alarm indication.

ComfortVIEW displays the Alarm Indication Preferences
dialog box.

5. Specify visual and audible alarm indication preferences, or
click on Defaults to select the pre-programmed default op-
tions.

Refer to Figure 6-7 and Table 6-7 for instructions on using
this dialog box.

6. Once you have specified alarm indication preferences, click
on OK. This closes the dialog box and saves the settings.

Note: ComfortVIEW includes a new feature that gives you the
ability to override this audible indication and play a
specified .wav file on the occurrence of specific alarms
from specific system elements and points. For more
information on this feature, refer to Assigning Custom
Messages to Incoming Alarms in the Alarm Manager
chapter of this manual.

To create or modify your own current alarm indication preferences:

1. Click on the Administration menu item.

2. Click on Your profile.

Note: You may also perform this command by clicking on
the Modify Your Operator Profile icon in the
toolbar. You cannot, however, modify alarm filters
when you are modifying from Your Profile.

Specifying Your Own
Alarm Indication
Preferences
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If you have system setup privilege, you can use the Administration
menu’s Logout state command to specify alarm indication prefer-
ences for all logged out ComfortVIEW workstations. Whenever any
ComfortVIEW operator logs out, the logged out ComfortVIEW
workstation will indicate (annunciate) alarms as specified here.
When an operator logs back in, alarm indication will be guided by
the operator’s personal alarm preferences that are specified using the
Administration menu’s Operators command.

1. Display the Alarm Indication Preferences dialog box by
clicking on the Administration menu item followed by click-
ing on Logout state.

2. Refer to Figure 6-7 and Table 6-7 for instructions on using
this dialog box.

Figure 6-7
Alarm Indication
Preferences  Dialog Box

Specifying Alarm
Indication Preferences
for Logged Out
ComfortVIEW
Workstations
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Click on To

Critical alarm threshold specify the level of critical alarms.
Alarm levels range from 0 to 6 with
Level 0 alarms being more severe than
Level 6 alarms. If ComfortVIEW
recieves an alarm with a level that is
less than or equal to the value entered
here, ComfortVIEW displays a full-
screen pop-up window on top of any
window that you are currently view-
ing. In addition to specifying this
alarm level, you must also click on
Enable visual critical alarm indica-
tion.

Filters specify the alarms to be presented to
this operator. The Alarm Filters dialog
box is displayed. Use this box to
specify the families (area, element,
and level) of alarms that this operator
will receive. For more information on
this dialog box, refer to the Alarm
Filters Dialog Box figure and table
below.

None, Flashing icon,
or Pop-up window indicate your preference for visual

alarm indication.

If you click on:
• None — ComfortVIEW produces

no visual indication of the existence
of alarms/alerts.

• Flashing icon — ComfortVIEW
displays a flashing alarm icon on top
of any window.

                   (continued)

Table 6-7
Alarm Indication
Preferences Dialog Box
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Click on To

None, Flashing icon,
or Pop-up window (cont.) • Pop-up window — a small pop-up

window displays on top of any
window that you are currently
viewing. For more information on
alarm indication, refer to Viewing
New and Unacknowledged Alarms
in the Alarms chapter of this
manual.

Enable visual critical
alarm indication activate/de-activate full-screen pop-up

window visual indication of critical
alarms. You must also specify critical
alarm levels by selecting a value from
the Critical alarm threshold pull-down
list.

Note:   Visual critical alarm pop-up
windows will not display if there is
currently an unacknowledged pop-up
alarm window.

Enable audible indication activate/de-activate audible alarm/alert
indication. Then click on Audible
alarm, Audible alert, or Audible
return to normal to specify each alarm
type's "beep" tone or sound file. The
Audio Configuration dialog box will
be displayed.  Refer to Figure 6-10
and Table 6-10 for instructions on
using this box.

Enable audible critical
alarm indication activate/de-activate the specific

audible indication for critical alarms.
Then click on Audible critical alarm
to specify the "beep" tone or sound
file for critical alarms.  If you de-
activate this feature, ComfortVIEW
will generate the tone specified for

       (continued)

Table 6-7
Alarm Indication
Preferences Dialog Box
(continued)
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Click on To

alarms on receipt of a critical alarm.
The Audio Configuration dialog box
will be displayed.  Refer to Figure 6-
10 and Table 6-10 for instructions on
using this box.

Defaults select the following default alarm
indication preferences:

• critical alarm threshold — 0
• visual indication — flashing icon
• visual critical alarm indication —

disabled
• audible alarm indication — enabled
• customized audible indication for —

alarms
• audible critical alarm indication —

disabled

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-7
Alarm Indication
Preferences Dialog Box
(continued)
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Click on To

Filter select an alarm filter number from the
drop down list.  There are 25 unique
filters that you can set up and assign
to a single operator. These filters are
for this operator only. Use the down
arrow key to scroll through the list of
filters. If a filter is already configured,
its associated area, element, and level
display in the respective text boxes.

       (continued)

Figure 6-8
Alarm Filters Dialog Box

Table 6-8
Alarm Filters Dialog Box

Alarm Filters

Level:

Area:

OK Cancel Help...

Any

Element:

%

Reset

Filter:

Enable this filter

X

Alarm filter 0Alarm filter 0
Alarm filter 1
Alarm filter 2
Alarm filter 3
Alarm filter 4
Alarm filter 5
Alarm filter 6

% ...
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Table 6-8
Alarm Filters Dialog Box
(continued)

Click on To

ComfortVIEW compares incoming alarms
to your specified criteria and
establishes which alarms are routed to
which operators using the following rules:

ComfortVIEW begins by identifying
criteria that might qualify the alarm for
routing. One possibility that will qualify is
an exact match between your user-defined
criteria and the incoming alarm. Other
possibilities involve any wildcards that
you use to specify criteria. An incoming
alarm must satisfy each of the three user-
defined criteria before the incoming alarm
will be routed to any operator. Refer to
Table 6-9 for a list and explanation of
allowed wildcards.

Area text box enter an up to 48 character name of the
area whose alarms you wish this operator
to receive.

Note:   This name must match the area
name exactly as it appears in the System
Overview window (including case).

Enter the % wildcard to receive alarms
from all areas.

display the Speedy Data Entry dialog box
where you can quickly and easily select
the area, element, category, table, and
point whose alarms you wish to present to
this operator. This dialog box is described
in the Speedy Data Entry section of this
manual's Carrier Network Manager chap-
ter.

Element text box enter an up to eight character element
name of the CCN system element whose
alarms you wish this operator to receive.

              (continued)

. . .
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Click on To

Note:   This name must match the system
element name exactly as it appears in the
Controller List window (including case).

Enter the % wildcard to receive alarms from
all system elements.

Level enter the level of alarms you wish this
operator to receive. Clicking on the Down
arrow gives you these choices:  Alarm,
Alert, Return to Normal, Any. Click on the
desired level, or on Any to select all levels.
If multiple levels are required (but not
Any), create duplicate filters each with its
own level.

Note:  You can specify the Area or Element
criteria using wildcards within the text of
the area or element name. Refer to Table 6-
9 for a list and explanation of allowed
wildcards.

Enable this filter activate the selected alarm filter number.
The operator will now receive alarms
matching the filter’s associated area, ele-
ment, and level.

Reset clear all alarm filters.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the previous
settings. Any changes made are not saved.

Help display help information.

Table 6-8
Alarm Filters Dialog Box
(continued)
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Wildcard Meaning
Symbol

_ (underscore) takes the place of any single character.

Example:  Specifying United Mutual
Insurance - Building #_ for the area name
means that any incoming alarms from
controllers in an area where the first 36
characters are United Mutual Insurance -
Building #, will be acceptable as a match
for the area name.

Acceptable matches for this example
might be:

• United Mutual Insurance - Building #1
• United Mutual Insurance - Building #2
• United Mutual Insurance - Building #A
• United Mutual Insurance - Building #B

% takes the place of one or more characters.

Example:  Specifying United Mutual
Insurance% for the area name means that
any incoming alarms from controllers in
an area that has United Mutual Insurance
as the first 23 characters will be acceptable
as a match for the area name.

Acceptable matches for this example
might be:

• United Mutual Insurance - Building #1
• United Mutual Insurance - Chillers
• United Mutual Insurance - Physical
Plant
• United Mutual Insurance - Air Handlers

Note: Entering % without any accompa-
nying characters in the Area or Element
text box allows you to receive alarms from
all areas or system elements.

Table 6-9
Wildcards
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Figure 6-10
Audio Configuration
Dialog Box

Table 6-10
Audio Configuration
Dialog Box

Click on To

Internal speaker use the PC's internal speaker to pro-
duce an audible indication of the
specified alarm type. To configure an
exact tone, use the Start frequency,
Pulse duration, Number of pulses,
Delta frequency, Oscillation, and Test
edit boxes.

Note:   For ComfortWORS for Win-
dows 9x clients, audible indication is
determined differently. If the 9x
computer contains a sound card, you
must specify a sound Name for the
Default Beep in the Control Panel's
Sounds Properties dialog box in order
to receive any audible alarm indica-
tion. If there is no sound card, the
alarm tone will default to the standard
system beep tone.

       (continued)
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Click on To

Start frequency set the audible alarm "beep" tone’s
starting frequency (37 to 32000 Hz)

Pulse duration set the length of each pulse
(0 to 1000 ms)

Number of pulses set the audible alarm tone’s total
number of pulses (0 to 10)

Delta frequency set the increment to be applied to each
pulse (-2000 to 2000)

Oscillation enable/disable an oscillation effect

Test produce a sample tone based on
current parameters

Defaults select the internal speaker tone default
parameters specified below:

Start frequency: 1000 Hz
Pulse duration: 20 ms
Number of pulses: 2
Delta frequency: 0 Hz
Oscillation: disabled

Sound card use the PC's sound card to play the
specified .wav file as an audible
indication of the selected alarm type.

WAV filename enter the filename of the .wav sound
file to be played on the occurrence of
the selected alarm type. This file must
be located in the \MEDIA\WAVES
directory in the \CVIEW,  \CWORKS,
or other directory in which you in-
stalled ComfortVIEW on your server
machine. You can also click on the

       button and select a filename.

Note:  The sound file must not have a
file name in excess of 8 characters.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-10

Audio Configuration

Dialog Box

(continued)

. . .
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Specifying Alarm
Printers

ComfortVIEW gives you the capability to define families of alarms
that will be automatically printed to specific ComfortVIEW printers.
You define alarm families by setting up alarm filters that specify the
Area, Element, and Level for incoming alarms. You then assign
alarm filters to specific printers. The alarms will print on occurrence
to the specified printer(s).

ComfortVIEW compares incoming alarms to your specified criteria
and establishes which alarms get routed to which printers using the
following rules:  ComfortVIEW begins by identifying criteria that
might qualify the alarm for routing. One possibility that will qualify
is an exact match between your user-defined criteria and the incom-
ing alarm. Other possibilities involve any wildcards that you use to
specify criteria. An incoming alarm must satisfy each of the three
user-defined criteria before the incoming alarm will be routed to any
printer. Refer to Table 6-9  for a list and explanation of allowed
wildcards.

Follow the steps below to set up alarm filters and assign filters to
printers:

1. Click on the Administration menu item and then click on
Alarm printers.

ComfortVIEW displays the Alarm Printers dialog box. The
names of all ComfortVIEW printers, the computer name, and
printer port that controls the printer display under Select a
printer. You add printers to this list using ComfortVIEW
Setup application.

2. Select a printer from the Select a Printer: box, and then click
on Filters.

ComfortVIEW displays the Alarms Filters dialog box.

3. You must now select an alarm filter number from the Filter
drop down list. There are 25 unique filters that you can set up
and assign to a single printer. Select this field and then use
the down arrow key to scroll through the list of existing
filters.

If a filter is already configured, its associated area, element,
and level criteria display in the respective text boxes.
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4. To modify an existing or enter a new Area click on the  . . .
button that is located to right of the Area box.

ComfortVIEW displays the Speedy Data Entry dialog box.

5. In the Speedy Data Entry dialog box, select the Area and
system element whose alarms you wish this printer to receive.

If desired, you can filter alarms from specific categories,
tables, and points by selecting from the corresponding drop
down lists.

6. Select the level of alarms you wish this printer to receive
from the Level drop down list. Clicking on the Down arrow
gives you these choices:  Alarm, Alert, Return to Normal, *.
Click on the desired level, or on * to select all levels.

Note: You can specify the Area, Element, or Level criteria
using wildcards. Refer to Table 6-9 for a list and
explanation of allowed wildcards.

7. Click on Enable this filter to assign the selected filter’s
alarms to the selected printer.

8. Click on OK to close the dialog box and save changes made
or

Click on Cancel to exit the dialog box and restore the previ-
ous settings.

Note: Clicking on Reset clears all alarm filters.
You must specify new alarm filters for this printer to
receive alarms.

Figure 6-11
Alarm Printers Dialog Box

OK Cancel Help...

Alarm Printer 1

Alarm Printers

Select a printer:

SERVER - LPT1

Filters...

Alarm Printer 2
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Defining
ComfortVIEW
Local Area
Network
Workstations

When you connect ComfortVIEW workstations via a local area
network (LAN), you must enter all server and client computer names
in the Setup Workstations dialog box. ComfortVIEW uses these
computer names to link clients and servers and to send data between
ComfortVIEW workstations on the LAN.

Note: To allow a remote ComfortVIEW workstation to dial into a
ComfortVIEW server, you must enter the remote
ComfortVIEW computer name in the server’s Setup Work-
stations dialog box.

Follow the steps below to add or delete LAN workstations:

1. Display the Setup window. If necessary, refer to Launching the
Setup Application.

2. Click on the Setup menu item and then click on Workstations.

ComfortVIEW displays the Setup Workstations dialog box
shown in Figure 6-12. This dialog box displays the names of
all ComfortVIEW workstations.

1. Click on New.

The New Workstation dialog box will be presented. Refer to
Figure 6-13.

2. Enter the computer name of the ComfortVIEW workstation,
and then click on OK.

Note: This is the computer name that was specified during
Windows installation. This name is displayed in the
title of the Program Manager window between the
text Program Manager - and the \. The computer
name must not contain blanks.

The Setup Workstations dialog box re-displays. The new
computer name appears in the Workstations list in alphabetical
order.

3. Repeat Steps 1 and 2 until you have entered the names of all
ComfortVIEW LAN workstations in the Setup Workstations
dialog box.

Note: If you change any computer name using Windows,
you must add the new name in this dialog box before
you delete the old name in Windows.

To Add a New
Workstation
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1. In the Workstations list, click on a computer name.

2. Click on Delete.

ComfortVIEW deletes the selected workstation and re-
displays the Setup Workstations dialog box.

Figure 6-12
Setup Workstations
Dialog Box

Setup Workstations

Server

Workstations:

Client 1
Client 2
Client 3
Client 4

New...

Delete

Help...CancelOK

Click on To

a computer name in the
Workstations list select a workstation to delete.

New to add a new workstation to the
Workstations list. ComfortVIEW
displays the New Workstation dialog
box. For instructions on completing
this dialog box, refer to Figure 6-13
and Table 6-13.

Note:   The Setup Workstations dialog
box is typically used when
ComfortVIEW workstations are
operating on a local area network or as
a dial-in connection.

Delete delete the selected workstation from
the Workstations list.

       (continued)

Table 6-12
Setup Workstations
Dialog Box

To Delete an Existing
Workstation
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Click on To

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-12
Setup Workstations
Dialog Box
(continued)

New Workstation

OK Cancel Help...

Workstation Name:

Workstation

Edits workstation name

Figure 6-13
New Workstation
Dialog Box

Table 6-13
New Workstation
Dialog Box

Click on To

Workstation name: text box enter the new computer name.

Note: This is the computer name that
was specified during Windows instal-
lation. This name appears as the
Computer Name in the Control Panel's
Network dialog box under the Identifi-
cation tab. (For Win 2000, select
Network and Dial-up Connections,
Advanced menu items, Network
Identification, followed by the Net-
work Identification tab.) The com-
puter name must not contain blanks.

K close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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Defining
ComfortVIEW
Alarm Printer
Names and Port
Locations

ComfortVIEW gives you the capability to define families of alarms that
will be routed to specific printers. You define the families using the
Carrier Network Manager application.

Follow the steps below to specify ComfortVIEW alarm printers. These
are the printer names that will appear in the Alarm Printers dialog box
that displays when you click on the Carrier Network Manager’s Adminis-
tration menu item and the Alarm Printers command.

1. Display the Setup window. If necessary, refer to Launching the
Setup Application.

2. Click on the Setup menu item and then click on Alarm Printers.

ComfortVIEW displays the Setup Alarm Printers dialog box
shown in Figure 6-14. This dialog box displays the names of all
alarm printers.

1. Click on New.

The New Printer dialog box will be presented. Refer to Figure 6-15.

2. Enter a name for the alarm printer.

3. Click on the Port: drop down list and select the computer and port
to which the printer is connected. If your ComfortVIEW worksta-
tions are connected via a local area network (LAN), the Port list
will include all active ports on your Windows NT network. If you
are not on a LAN, the list will include all active ports on your
computer.

4. Click on OK to save the data, or on Cancel to exit without saving
changes.

The Setup Printers dialog box re-displays. The new printer name
appears in the Printers list in alphabetical order.

5. Repeat Steps 1 to 4 until the Setup Printers dialog box includes the
names of all ComfortVIEW alarm printers.

You now must use the Alarm Printers command in the Setup
application’s Administration Menu to assign alarms to specific
ComfortVIEW printers.

To Add a New Printer
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1. In the Printers list, click on a printer name.

2. Click on Delete.

ComfortVIEW deletes the selected printer and re-displays the
Setup Printers dialog box.

Click on To

New to add a new printer to the Printers list.
ComfortVIEW displays the New Printers
dialog box. For instructions on completing
this dialog box, refer to Figure 6-15 and
Table 6-15.

Delete delete the selected printer from the Printers
list.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the previous
settings. Any changes made are not saved.

Help display help information.

To Delete an Existing
Printer

Figure 6-14
Setup Printers
Dialog Box

Table 6-14
Setup Printers
Dialog Box

Setup Alarm Printers

OK Cancel Help...

Control
Room

Printers:

ALARMPRINTER: SERVER - LPT1 New...

Delete
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Figure 6-15
New Printer Dialog Box

New Printer

OK Cancel Help...

Printer Name:

Laserjet

Port:

SERVER - LPT1

Table 6-15
New Printer Dialog Box Click on To

Printer name text box enter the new printer name.

Port drop down list select the computer and port to which
the printer is connected.

 OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.
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Follow the steps below to define custom analog and discrete engi-
neering units. These units will display along with points in FIDs and
Comfort Controllers.

1. Display the Setup window. If necessary, refer to Launching
the Setup Application.

2. Click on the Setup menu item and then click on Custom units.

ComfortVIEW displays the Custom Units/Discrete States
dialog box. Refer to Table 6-16 and Figure 6-16.

3. Follow the Defining Discrete States and the Defining Analog
States instructions below. Then click on OK to exit the dialog
box and save your changes.

To assign the custom engineering units to FID points, enter the
number that corresponds to the desired engineering unit in the
Display Units decision that appears in the FID's service configura-
tion table. For an explanation of this decision, refer to the UT203
FID Overview and Configuration Manual.

To assign custom engineering units to Comfort Controller points,
select the desired engineering unit from the sensor type/units/state
drop down list that appears in the Carrier Network Manager's
Object Definition dialog box. Note that when using the Building
Supervisor, the Network Service Tool, or another interface device to
view Comfort Controller points that have been assigned custom
units, the units will appear blank.

In the left discrete states column, enter the state that signifies an
open contact. In the right discrete states column, enter the state that
signifies a closed contact.

Note: For DI devices, it is assumed that the FID's Sensed
Discrete Logic Type decision is set to Standard
Logic. For DO devices, this assumes that the Output
Signal decision is set to Straight Logic.

In the Analog units text box, enter the name for the analog unit.

Defining Custom
Engineering Units

Defining Analog Units

Defining Discrete States
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Click on To

the Analog units text box enter the name for the analog unit.

the Discrete states left column enter the state that signifies an
open contact.

the Discrete states right column enter the state that signifies a
closed contact.

OK close the dialog box and save
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes
made are not saved.

Help display help information.

Table 6-16
Custom Units/Discrete
States Dialog Box
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Figure 6-17
Custom Units/Discrete
States Dialog Box

Custom Units/Discrete States

OK Cancel Help...

Analog units:

Edits custom analog units

Discrete states (0,1):
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Follow the steps below to specify the following global system
parameters:

• Metric or customary US units (fixed setting chosen at installa-
tion)

• Time of day at which to automatically retrieve accumulated
report data from your CCN options

• Period of time to retain accumulated report data in your
ComfortVIEW database

• Number of times to re-try report data retrieval should a failure
occur.

• Disable/enable of automatic alarm deletion, including purge
filename and threshold.

• Disable/enable of system activity event logging, length of time
to retain system activity events in your ComfortVIEW database,
and automatic ComfortVIEW log in option.

Note: Changes to the automatic data retrieval time, report data
retention period, and number of retries parameters will
take effect at the top of the hour.

1. Display the Setup window. If necessary, refer to Launching
the Setup Application.

2. Click on the Setup menu item and then click on Globals.

ComfortVIEW displays the Setup Globals dialog box shown
in Figure 6-18.

3. Under the Data retrieval tab, in the Time at which to retrieve
data: box, enter the hour of day for automatic data retrieval of
report data.

ComfortVIEW Report Panel application will automatically
retrieve report data from your CCN options at ten minutes
past the hour specified. You may also click on the up or down
arrow to increment or decrement the displayed hour. For
additional information on automatic data retrieval, refer to the
Report Panel chapter of this manual.

4. In the Number of data retrieval retries box, enter the number
of times to re-try automatic report data retrieval. Should a
failure occur that interferes with timed data retrieval,
ComfortVIEW will re-try data retrieval every minute for the

Specifying Global
System
Parameters
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number of times specified. You may also click on the up or
down arrow to increment or decrement the displayed value.

5. In the Data Retention Period text box, enter the number of
days that ComfortVIEW will retain retrieved report data in its
database. You can generate reports using the retained data
until the end of this retention period. At the end of the reten-
tion period, the data will be automatically deleted. Only
retrieved report data (for example, consumable, runtime, and
history data) is subject to this purging. Tab-separated report
files that are saved to the database as a result of a report
generation process are not affected.

Note: Valid entries range from 0 to 99 days. Entering 0
causes the report data to be retained as long as
ComfortVIEW has disk space to store it. You are
cautioned against doing this, as it could eventually
fill up the ComfortVIEW database.

6. Click on the System activity tab to access the system activity
logging and automatic ComfortVIEW login options. Refer to
Table 6-18 for additional information on these options.

7. Click on the Alarm purge tab to access the automatic alarm
archiving options. Refer to Table 6-18 for additional informa-
tion on these options

Figure 6-18
Setup Globals Dialog Box
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Click on To

Data Retrieval Tab:
the Time at which to
retrieve data box enter the hour of day for automatic

retrieval of report data and, optionally,
automatic alarm purging.
ComfortVIEW Report Panel applica-
tion will automatically retrieve report
data from your CCN options at ten
minutes past the hour specified. You
may also click on the up or down
arrow to increment or decrement the
displayed time. For additional infor-
mation on automatic data retrieval,
refer to the Report Panel chapter of
this manual.

the Number of data
retrieval retries data box enter the number of times to re-try

automatic report data retrieval should
a failure occur. You may also click on
the up or down arrow to increment or
decrement the displayed value. Valid
entries range from 0 to 5.

the data retention
period data box enter the number of days that you wish

to retain accumulated report data in
your ComfortVIEW database. At the
end of the retention period, the data
will be automatically deleted. You can
generate reports using the retained
data until the end of this retention
period. Only retrieved report data (for
example, consumable, runtime, and
history) is subject to this purging. Tab-
separated report files that are saved to
the database as a result of a report
generation process are not affected.

        (continued)

Table 6-18
Setup Globals Dialog Box
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Table 6-18
Setup Globals Dialog Box
(continued)

Click on To

System Activity tab:
Log system activity specify whether system activity events
events will be tracked for use in the System

Activity Report. System activity
events include things such as logins
and logouts, alarm deletions, and
alarm acknowledgements. Refer to
Appendix A of this manual for a
complete list of all system activity
events.

Event retention period specify the number of days that
system activity report data will be
retained in your ComfortVIEW
database. At the end of the retention
period, the data will be automatically
deleted. You can generate System
Activity reports using the retained
data files until the end of this retention
period.

Automatic login specify whether you want automatic
ComfortVIEW login as part of Win-
dows login, thus eliminating the need
for two logins. Enabling this option
and setting your Operator Profile
dialog box's Login name to match
(including case sensitivity) your
Windows local username (that you
can access in the Windows User
Manager) will allow you to be auto-
matically logged into ComfortVIEW
whenever you log into Windows on
the current workstation. Note that the
ComfortVIEW password is not used
when this option is selected.

                   (continued)
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Click on To

Alarm Purge tab:
Enable alarm purge enable or disable the automatic alarm

archiving and deletion option.

Alarm purge filename specify the filename to which the
purged alarms will be appended.

Threshold at which purge enter the alarm purge limit. At the
occurs designated data retrieval time, if the

number of alarms is greater than or
equal to this value, ComfortVIEW
purges the oldest n alarms from the
database, where n is calculated based
on the current number of alarms minus
the value entered in the Number of
alarms to leave in database decision.
The alarms are converted into standard
ASCII format and appended to the
specified filename.

Number of alarms to be indicate the number of alarms to
left in database remain in the database after purge

completion.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 6-18
Setup Globals Dialog Box
(continued)
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ComfortVIEW gives you the capability to back up an entire CCN's
database to another directory, sub-directory, or drive. You should
make it a practice to periodically back up your CCN database in the
event that a malfunction should occur with your hard disk. Because
it allows you to copy a CCN database from one PC to another, this
function could also be helpful to Carrier service personnel for in-
office preparation of a ComfortVIEW field database.

CCN export copies the selected CCN's entire database to the speci-
fied drive. This drive can be the ComfortVIEW floppy diskette
drive, another ComfortVIEW hard drive partition, or another com-
puter on the local area network. The information that will be copied
includes:

• the CCN name and number

• the area name(s)

• all controllers and all associated configuration

• WorkSPACEs that contain points from the specified CCN (and
the associated ViewSPACEs and trends — including graphic
backgrounds and databoxes from the specified CCN)

Note: WorkSPACEs that contain links to these WorkSPACEs,
as well as WorkSPACEs that are linked to by these
WorkSPACEs, will also be included.

• Report definitions that contain points from the specified CCN

• All System Activity report definitions.

This CCN database information can be copied back, or imported to
ComfortVIEW at any time, using the File menu's Import command.
For additional information, refer to Importing CCNs, which appears
later in this Setup chapter.

Follow the instructions below to export a CCN from the
ComfortVIEW hard disk:

1. Display the Setup window. If necessary, refer to Launching
the Setup Application.

2. Click on the File menu item and then click on Export CCN.

The Export CCN Selection dialog box will be displayed.
Refer to Figure 6-19.

Note: You may also perform this command by clicking on
the Export CCN icon in the toolbar.

Exporting CCNs
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3. Click on the CCN that you wish to export, and then click on
OK.

The Export Target Selection dialog box will be displayed.

4. In the Export Target Selection dialog box, select the directory
and drive where you want the file saved. Refer to Table 6-20
for more information on using the Export Target Selection
dialog box.

5. Click on OK to export the CCN to the specified file name and
location.

ComfortVIEW displays a dialog box asking for confirmation
before copying the selected CCN. Click on Yes to complete
the export, or click on No to prevent the export from taking
place.

ComfortVIEW will save the exported files to the specified
directory using the following file naming convention:
00000xxx, where xxx is the CCN number.

A function status box is displayed during the copy process. If
you are exporting to diskette, ComfortVIEW will prompt you
to insert another diskette, if necessary. The message Function
completed successfully displays on completion.

Note: The ComfortVIEW export procedure will terminate
if any single file to be exported is larger in size than
the diskette to which you are exporting. For ex-
ample, if you are exporting to a 720 kb diskette, and
a graphic file is 1 Mb in size, the export procedure
will terminate.
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Export CCN Selection

Select CCN to export:

United Mutual Insurance CCN1
United Mutual Insurance CCN2

Selects CCN to export

Help...CancelOK

Figure 6-19
Export CCN Selection
Dialog Box

Click on To

a CCN select a CCN to export.

OK close the dialog box and save the
selection. The Export Target Selection
dialog box will be displayed. For
more information on using this dialog
box, refer to the Export Target Selec-
tion Dialog Box figure and table
below.

Cancel exit the dialog box without saving the
selection.

Help display help information.

Table 6-19
Export CCN Selection
Dialog Box



436

d:\cworks\apps

Export Target Selection

Select directory for export files:

Help...CancelOK

Selects directory in which to store export data files

d:\

cworks

apps

d:

Figure 6-20
Export Target Selection
Dialog Box

Click on To

the drive drop down list select the drive where you want the
files saved.

a directory to select a directory where you want
the files saved.

OK close the dialog box and save the
selection.

Cancel exit the dialog box without saving the
selection.

Help display help information.

Table 6-20
Export Target Selection
Dialog Box
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You can use the File menu's Import CCN command to copy previ-
ously-exported CCN database files to ComfortVIEW. This function
would typically be used by a Carrier representative during off-line
preparation of a ComfortVIEW database.

CCN database files that were previously exported using the File
menu's Export CCN command, will be copied to the ComfortVIEW
database.

Follow the instructions below to import previously exported CCN
database files to a ComfortVIEW hard disk:

1. Display the Setup window. If necessary, refer to Launching
the Setup Application.

2. Click on the File menu item and then click on Import CCN.

Note: You may also perform this command by clicking on
the Import CCN icon in the toolbar.

The Import Source Selection dialog box will be displayed.
Refer to Figure 6-21.

3. In the Import Source Selection dialog box, select the drive
and directory that contains the CCN that you wish to import,
and then click on OK.

ComfortVIEW displays the Imported CCN Definition dialog
box. This dialog box functions the same as the New CCN
Definition dialog box that displays when you are adding a
new CCN.

4. Enter the name and number of the CCN being imported. CCN
names may consist of up to 48 characters. If necessary, refer
to Figure 6-22 and Table 6-22 for instructions on using the
CCN Definition dialog box.

Note: You must enter a unique CCN name and number. If
the new CCN name or number is already used in the
target ComfortVIEW database, a notification mes-
sage will be displayed and the CCN Definition
dialog box will be re-displayed.

5. Make any other modifications, and then click on OK to close
the Imported CCN Definition dialog box and start the import.

A confirmation dialog box will be displayed asking if you
wish to import the specified CCN.

Importing CCNs
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6. Click on Yes to start the import or on No to close the dialog
box without importing.

A function status box will display during the import process.
ComfortVIEW will copy all previously-exported CCN data-
base files from the specified drive and directory to the new
CCN name and number. In the new CCN, ComfortVIEW will
precede the imported area names with the new CCN name.

Note: If, during the import, ComfortVIEW finds that the
name of a database item being imported already
exists in the target ComfortVIEW database, the New
Name dialog box will be displayed. You can either
enter a new name for the imported item,  overwrite
the original item with the one being imported, or
skip the importing of this item. If necessary, refer to
Figure 6-23 and Table 6-23 for instructions on using
the New Name dialog box.

The message Function completed successfully  displays on
completion.

7. You should now launch the Carrier Network Manager appli-
cation and set up the access parameters for the new CCN. See
Modifying CCNs in the Adding/Modifying CCNs section of
this manual's Carrier Network Manager chapter. The im-
ported CCN and address will default to Database Only and
System Element 239. You can modify these values as re-
quired.
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Figure 6-21
Import Source Selection
Dialog Box

Click on To

the drive drop down list select the drive where the exported
files are currently stored.

a directory select the CCN files to import.

OK close the dialog box and save the
selection. The Imported CCN Defini-
tion dialog box is displayed. Refer to
Table 6-22 and Figure 6-22 for in-
structions on using this dialog box.

Cancel exit the dialog box without saving the
selection.

Help display help information.

a:\

Import Source Selection

Select directory containing exported CCN:

Help...CancelOK

Selects directory from which to import CCN data files

a:\

ccn_exp

00000001

a:

Table 6-21
Import Source Selection
Dialog Box
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Used CCN numbers:

Imported CCN Definition

CCN name:

OK Cancel Help...

100

CCN number:

1 Access ...

Table 6-22
Imported CCN Definition
Dialog Box

Figure 6-22
Imported CCN Definition
Dialog Box

Click on To

CCN name edit box enter the new CCN name. Up to 48
characters are allowed. You must
assign the new CCN a name that is
different from those that are currently
used in the target ComfortVIEW
database.

CCN number edit box modify the displayed CCN number.
You must assign the new CCN a
number that is different from those
that are currently used in the target
ComfortVIEW database. This number
is used internally by various
ComfortVIEW applications to identify
CCNs. Used CCN numbers can be
viewed by clicking on the down arrow
in the Used CCN numbers drop down
list.

       (continued)
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Click on To

Note:   If you are importing a remote
CCN that will be accessed by
Autodial Gateway, this number must
match the Customer Number config-
ured at the remote Autodial Gateway.

Used CCN numbers view the highest number already in
use in the target database. Click on the
down arrow to view a complete list of
all used CCN numbers.

OK close the dialog box and save the
selection.

Cancel exit the dialog box without saving the
selection.

Help display help information.

Table 6-22
Imported CCN Definition
Dialog Box
(continued)

Figure 6-23
New Name Dialog Box

New Name

Cancel Help...

A ViewSPACE of the given name already exists;
Enter a new name, or press Overwrite to replace.

Original name:

ViewSPACE Controller Comfort

New name:

ViewSPACE Controller Comfort

Overwrite Overwrite all

OKSkip



442

Click on To

New name edit box modify the name of the database item
that is being imported.

Note:   If desired, you can leave this
name as is and overwrite the original
like-named target database item by
clicking on Overwrite or Overwrite
all.

Overwrite replace the original like-named target
database item with the one being
imported.

Overwrite all replace all original like-named target
database items with the ones being
imported. For example, clicking on
Overwrite all during the importing of
ViewSPACEs, will replace all original
like-named ViewSPACEs with those
being imported.

Skip continue the CCN import without
importing this database item.

OK close the dialog box and save the
selection. ComfortVIEW will then
verify that the new name is unique.

Abort abort the entire import process.

Help display help information.

Table 6-23
New Name Dialog Box
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This section describes each of the commands that appear in the
Setup window menus.

The following table describes each of the commands that appear in
the File menu.

Command Use this command to

Export CCN export an entire CCN's database.

Import CCN import an entire CCN's database.

Print print a report of ComfortVIEW Setup
options.

Print Setup select a printer and printing options.

The Print dialog box displays. To
change the printer from the one
displayed, click on the drop down list.
Click on Properties to access Page
Setup, orientation, and size options.

Exit exit the Setup application.

Setup Menu
Command
Summary

File Menu

Table 6-24
File Menu
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The following table describes each of the commands that appear in
the Setup menu.

Command Use this command to

Globals specify the following global system
parameters:

• Metric or customary US display
units

• Time of day at which to retrieve
accumulated report data from
your CCN options

• Period of time to retain accumulated
report data in your ComfortVIEW
database

• Number of times to re-try report
data retrieval should a failure occur

• Enable/disable system activity event
logging.

• Enable/disable automatic
ComfortVIEW login in
conjunction with Windows NT
login.

• Enable/disable automatic alarm
deletion, including purge
filename and threshold.

The Setup Globals dialog box dis-
plays.

Workstations add or delete LAN workstations. The
Setup Workstations dialog box dis-
plays. If your ComfortVIEW setup
contains workstations communicating
on a LAN, you must specify the
computer name of every LAN work-
station. Clicking on New displays the
New Workstation dialog box and
allows you to add a new workstation to
the Workstations list. Enter the work-
station name as it appears in the
Computer Name in the Network dialog

        (continued)

Setup Menu

Table 6-25
Setup Menu
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Command Use this command to

box's Identification tab. This dialog
box is located in the Windows NT
Control Panel. Clicking on an existing
workstation and then clicking on
Delete deletes a workstation from the
Workstations list.

Note:   This command is not available
on stand-alone ComfortVIEW
systems.

Alarm printers specify the name and port assignment
of all ComfortVIEW alarm printers.
The Setup Printers dialog box dis-
plays. Clicking on New displays the
New Printers dialog box and allows
you to add a new printer to the Print-
ers list. Clicking on an existing printer
and then clicking on Delete deletes a
printer from the Printers list. You now
must use the Alarm Printers command
in the Carrier Network Manager
Administration menu to assign alarms
to specific ComfortVIEW printers.

Gateway ports add a new or modify or delete an
existing internal Gateway. The Gate-
way Ports dialog box displays. The
names of any communication ports
that have been previously designated
for use by an internal Gateway are
displayed. In the Gateway Ports dialog
box, you can click on New to config-
ure a new port for use with a modem,
Modify to change the selected cur-
rently-configured port's telephone
number, or on Delete to delete the
selected port's modem designation.

Custom units set up custom analog and discrete
units that will be displayed with points
in FIDs and Comfort Controllers.

Table 6-25
Setup Menu
(continued)
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Command Use this command to

Add equipment help upgrade your Carrier equipment help
files to the latest versions.

Remote status display or hide the remote connection
status window. This window displays
the names of all remote CCNs to
which a connection is currently
established (including RAS connec-
tions). You can set the windows to
always appear on top of all other
windows by right clicking on the title
bar and selecting Always on top.

The following table describes each of the commands in the
Administration menu.

Command Use this command to

Access levels create customized access levels. You
can create an access level and specify
the ComfortVIEW operations allowed
for that level. ComfortVIEW displays
the Customized Access Control dialog
box. You then assign access levels to
operators on an area by area basis.

Operators add, modify, or delete a
ComfortVIEW operator.
ComfortVIEW displays the Operator
Configuration dialog box. The names
of all existing ComfortVIEW opera-
tors display under Select an Operator.
When adding a new or modifying  an
existing operator you must enter the
operator’s profile information, assign
the operator’s access privileges, and
specify the operator’s alarm indication
preferences and alarm filters.

Alarm printers route alarms to specified
ComfortVIEW printers.
                                           (continued)

Administration Menu

Table 6-26
Administration Menu

Table 6-25
Setup Menu
(continued)
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Table 6-26
Administration Menu
(continued)

Command Use this command to

ComfortVIEW displays the Alarm
Printers dialog box. The names of all
ComfortVIEW printers display under
Select a printer:. The computer name
and printer port that controls that
printer are also displayed. Printers are
assigned using ComfortVIEW Setup
application.

Logout state set up the alarm indication preferences
for all logged out ComfortVIEW
workstations. Whenever any
ComfortVIEW operator logs out, the
logged out ComfortVIEW
workstation will indicate (annunciate)
alarms as specified here. When an
operator logs back in, alarm indication
will be guided by the operator’s
personal alarm preferences that are
specified using the Administration
menu’s Operators command.

Your profile modify your login name, password,
start-up application, automatic log-off,
or alarm indication preferences.

The following table describes each of the commands that appear in
the Help  menu.

Command Use this command to

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
applications, and copyright.

Help Menu

Table 6-27
Help Menu
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Report Panel



Alarm Manager
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This chapter provides instructions on ComfortVIEW's Report Panel
application.

For instructions on... Turn to page

accessing the Report Panel application 451

producing a report — an overview 453

creating a report definition:
• displaying the report definition list 454
• creating, copying, or modifying a report definition 457
• deleting an existing report definition 479
• printing a report definition 480
• changing the report definition list font 480

generating a report:
• required conditions for manual and automatic

report generation 481
• manual report generation 483
• automatic report generation 484
• report data status 484
• using the report viewer 485
• print preview and report viewer commands 487, 490

editing report data 494

managing your report files 497

using the Report Panel to initiate a
third party report application 499

a summary of all report panel commands 501

a summary of all report definition list commands 503

sample ComfortVIEW reports 510

producing optional ComfortVIEW reports 539

Report
Panel
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The following terms are used throughout this Report Panel chapter.

Consumable Report — A ComfortVIEW report that lists usage
information, taken at fifteen-minute intervals (for example, kilowatt
hours of electricity or gallons of fuel). The Data Collection Option
Module collects the consumable data, which is typically measured
by devices such as wattmeters and flow sensors. ComfortVIEW
gives you the capability to create daily, monthly, and yearly con-
sumable reports.

Runtime Report — A ComfortVIEW report that lists the number
of minutes each hour that a discrete system element point is in the
on state. The Data Collection Option Module collects runtime data.
ComfortVIEW gives you the capability to create daily, monthly, and
yearly runtime reports.

History Report — A ComfortVIEW report that lists value or status
information taken at user-specified time intervals. The Data Collec-
tion Option Module collects history data.

Report Definition — The specifications for a report. The first step
in creating a ComfortVIEW report is to create a report definition. In
the report definition, you specify parameters such as the report name
and description, report type, the points on which to report, and the
range of dates from which to compile data. ComfortVIEW main-
tains a list of all report definitions in its database.

Area — A logical grouping of system elements within a CCN. For
example, an area could be a building, a floor, a wing, or a chiller
plant.

Data Retrieval — The act of uploading data from the Data Collec-
tion Option module to the ComfortVIEW database.

Report Generation — The act of compiling the report data that
data retrieval has uploaded from the Data Collection Option module
to the ComfortVIEW database.

Terminology
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ComfortVIEW Report Panel function gives you the capability to
generate reports from data that the Data Collection Option Module
collects from the network.

The types of reports currently available to you include consumable,
runtime, and history. Samples of these report types appear at the end
of this chapter. Refer to Table 7-1 below for a description of each
report type. Additional report types may become available. As new
report types are installed, their icons automatically display in the
report panel window. Refer to Appendix A — Additional
ComfortVIEW Reports for more information.

Report Type Contents

Consumable Usage information for devices measur-
ing consumables (for example, flow
sensors and wattmeters) from one or
all Data Collection Options on one or
more networks (including remote
CCNs). You can create daily, monthly,
or yearly consumable reports.

Runtime Equipment runtime (on-time) informa-
tion for discrete system element points
from one or all Data Collection Op-
tions on one or more networks. You
can create daily, monthly, or yearly
runtime reports.

History Timed or event-triggered history
(point value) information collected
periodically over time from one or all
Data Collection Options on one or
more networks.

A consumable, runtime, or history report can contain information on
up to 48 points.

Accessing the
Report Panel

Table 7-1
Reports
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To launch the Report Panel application:

Double click on the Report Panel icon.

ComfortVIEW displays the Report Panel window shown in Figure
7-2.

This window contains icons for each report type. Clicking on an
icon displays the report definition list. The top line of the window
contains the report panel menu bar. Refer to Report Panel Menu
Command Summary at the end of this Report Panel chapter for a
description of each menu item and command.

If desired, you can add an icon to this window. The icon could
initiate the execution of a custom report that you have created using
a third party spreadsheet program. For instructions, refer to the
Using the Report Panel To Initiate a Third Party Report Application
section of this chapter.

Figure 7-2
Report Panel Window

Report Panel

Reports Options Help

Consumable History Run Time

This chapter provides ComfortVIEW operating instructions for
creating report definitions and generating reports. For information
on how to configure the Data Collection Module for use with the
ComfortVIEW Report Panel application, refer to the Data Collec-
tion Option Overview and Configuration Manual. For information
on configuring other modules for use with ComfortVIEW optional
reports, refer to the respective module's overview and configuration
manual.

Other Required
Documentation
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The report creation process is summarized below. For more detailed
report creation instructions, refer to the Creating, Copying, or Modi-
fying a Report Definition and Generating a Report sections of this
chapter.

To produce a ComfortVIEW report you must perform the following
tasks:

1. Define the specifications for the report. You do this by creat-
ing a report definition where you enter specifications such as
the report name and description, report type (daily, monthly,
yearly), automatic data retrieval and report generation prefer-
ences, and the points on which to report.

ComfortVIEW maintains a list of all report definitions in its
database. You can view, modify, or delete a report definition,
or re-generate a report from an existing definition at any time.
You can also copy a report definition for use as a starting
point in creating another report definition.

2. Manually generate the report, or, if you select automatic report
generation, the report automatically generates at a time that you
specify using the ComfortVIEW Setup application. When
ComfortVIEW generates a report, it retrieves data from the
network (or uses data that was already retrieved) and creates a
temporary tab-separated report file. If desired, you can save the
tab-delineated report file permanently on disk for use with third
party spreadsheet applications. You can also opt to print the
report file.

Report definitions define the specifications for your reports. Report
specifications include information such as the report name and
description, report type (daily, monthly, yearly), automatic data
retrieval and report generation preferences, and the points on which
to report.

Producing a
Report — An
Overview
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Follow the steps below to display a list of all existing report defini-
tions.

1. Display the report panel. If necessary, refer to the instructions
listed under Accessing the Report Panel.

2. Click on the Reports menu item and then click on the report
type (Consumable, History, Runtime, or System Activity).

Note: You may also perform this command by double
clicking on the Report Panel’s Consumable, History,
Runtime, or System Activity icon.

ComfortVIEW displays a Report Definition List window similar to
the one displayed in Figure 7-3. This window lists the up to 8
character report name and up to 48 character description of all
existing report definitions for the type of report selected (consum-
able, runtime, history, and system activity). Some of the report
definitions may be preceded by a red icon. These are reports that
have been specified to be automatically generated. Refer to the
explanation of the Report Definition Dialog Box that appears later
in this chapter for additional information on this option.

The top line of the window contains the menu bar. Refer to Report
Definition List Menu Command Summary at the end of this chapter
for a description of each menu item and command.

The second line of the window contains the toolbar. Refer to Report
Panel Definition List Window Toolbar below for information on
using each toolbar button.

The third line of the window contains the status bar. This line
displays the name and description of the currently highlighted report
definition.

Note: If desired, you can remove the status bar from the Report
Definition List window by clicking on the Options menu
item followed by clicking on Status bar. To return the
status bar to the window, perform these two commands
again.

You may also change the window’s font and point size by
clicking on the Options menu item followed by clicking
on Font. For further instructions, refer to the Changing the
Font section of this chapter.

Displaying the
Report Definition
List
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The second line of the Report Definition List window contains the
toolbar. If you use a mouse, the toolbar gives you instant access to
the most frequently used Report Panel commands. By simply
clicking the mouse button, you can perform operations such as
generating reports, copying and deleting report definitions, and
printing report definitions.

Note: If desired, you can remove the toolbar from the Report
Definition List window by clicking on the Options menu
item followed by clicking on Toolbar. To return the
toolbar to the window, perform these two commands
again.

Figure 7-3
Sample Report Definition
List Window

Report Definition List
Window Toolbar

Consumable Reports

Consumable Reports

Consumable Reports

File Options HelpEdit

METERS: Miscellaneous Meters

METERSMO:  Miscellaneous Meters

METERSYR:  Miscellaneous Meters

Prints selected report definitions
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The following table describes the buttons that appear on the Report
Definition List window toolbar.

Click on To

import report data.

generate a report using the selected
report definition.

re-generate a report using the selected
report definition with a new range of
dates.

print the selected report definition.

create a new report definition.

copy a selected definition.

modify a selected report definition.

 delete a selected definition.

update the screen with the latest report
definitions.

display help information.

Table 7-3
Report Definition List
Window Toolbar
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Creating,
Copying, or
Modifying a
Report Definition

To Create a New
Report Definition

1. Display the report definition list. If necessary, refer to Displaying
the Report Definition List.

2. Click on the File menu item and then click on New.

ComfortVIEW displays a Report Definition dialog box similar to
the ones shown in Figure 7-4 and Appendix A. You use this
dialog box to enter the specifications for a report.

Note: You may also perform this command by clicking on the
Add New report icon in the tool bar.

3. To produce a consumable, runtime, or history report, you must
enter the specifications shown below. For a list of specifications
for other optional ComfortVIEW reports, refer to Appendix A.

• Report Name and Description
• Report Type (None, Daily, Monthly, Yearly)
• Manual Generation or Automatic Retrieval Options
• Report Dates
• Data Points on Which To Report
• Format

Refer to Figure 7-4 and Table 7-4 and to Appendix A for instruc-
tions on using the Report Definition dialog box.

4. Click on OK to exit the dialog box and save changes, or

click on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the report definition list.

Figures 7-8 to 7-10 display different Report Definition dialog box
configurations with explanations of the reports that will be pro-
duced by each.
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To Copy an Existing
Report Definition

To Modify an Existing
Report Definition

Follow the instructions below to create a new report definition by copying
a selected definition.

1. Display the report definition list. If necessary, refer to Displaying
the Report Definition List.

2. Click on the report definition you wish to copy.

3. Click on the Edit menu item and then click on Copy.

ComfortVIEW copies the selected report definition and displays the
copied Report Definition dialog box.

4. Enter the new Report Name, and, if desired, make any other modifi-
cations.

Refer to Table 7-4 and Appendix A for instructions on using the
Report Definition dialog box. Figures 7-8 to 7-10 display different
Report Definition dialog box configurations with explanations of
the reports that will be produced by each.

5. Click on OK to exit the dialog box and save changes, or

click on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the report definition list.

1. Display the report definition list. If necessary, refer to Displaying
the Report Definition List.

2. Double click on the report definition to modify.

Note: You may also perform this command by clicking on a
report in the report definition list followed by clicking on
the Edit menu item and then clicking on Modify.

ComfortVIEW displays a Report Definition dialog box similar to
the one shown in Figure 7-4 and Appendix A.

3. Modify the specifications as desired.

4. Click on OK to exit the dialog box and save changes, or

click on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the report definition list.
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Figure 7-4
Report Definition Dialog
Box

Click on To

the Report Name text box enter an up to 8 character name for the
report. This name identifies the report
in the report definition list.

the Report Description
text box enter an up to 48 character description

for the report. This name appears
along with the 8 character report name
in the report definition list. It is also
the report title that prints on the top
line of the report.

(continued)

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports

Enable automatic data retrieval

History

Report Definition

Report Name:

OK Cancel Help...

X

None

Format...

Defaults

HP LaserJet III

ZONE TEMP

Report Description:

Zone Temp Tracking

Report

Save tab-separated data file

Print to

XEnable automatic report generation

Send report directly to CWREPORT

Retrieve History data

Manual Generation Options

00:00 10/23/96

Data from:

Range of times/dates

Report Dates

23:59 10/24/96

Data through:

Save dates as relative

X

X

Automatic Retrieval Options

Closes this dialog box and saves settings

Data Points...

Data retrieval period...
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Click on To

Report
None specify that you do not wish to generate

reports every time you automatically re-
trieve module data.

Daily create a daily report. You can create daily
reports for yesterday, today, or for a speci-
fied range of dates.

Monthly create a monthly report for the dates speci-
fied under Range of data.

Yearly create a yearly report for the dates specified
under Range of data.

History create a history report.

Report Dates:
Yesterday create a daily report using yesterday’s data.

Today create a daily report using today’s data. The
report will contain today’s data starting from
midnight to the current time.

Range of times/dates: create a report using data from a range
Data from: of times and dates. Click on the button to the
Data through: right of the Data from: and Data through:

dates to display the Data Range dialog box.
Enter the data start and end times and dates.
Refer to Figure 7-5 and Table 7-5 for in-
structions on using the Data Range dialog
box.

When defining a report based on a single
day’s data, enter the corresponding date in
both the Data from: and Data to: text boxes.
Note:   If, in a runtime report definition, you
enter a whole hour Data through time (for
example, 3:00), ComfortVIEW will subtract
1 minute and display the resulting time (in
this case, 02:59). This also occurs in con-
sumable report definitions, except that it will
occur for both whole hour and 15 minute
Data through times (for example, 02:15).

                 (continued)

Table 7-4
Report Definition Dialog
Box  — Consumable,
Runtime, and History
Reports (continued)
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Click on To

Save dates as relative automatically adjust the Data from
and Data through dates relative to the
current date. For example, you create
a report definition on 8/10/94. You
specify the Data from: and Data
through: dates to be 8/3/94 and 8/10/
94. On 8/18/94, you generate another
report from this existing definition.
ComfortVIEW will automatically
adjust these dates relative to 8/18/94
date. Data from: will automatically
update to 8/11/94 and Data through:
will update to 8/18/94.

Automatic Retrieval Options:
Enable automatic
data retrieval automatically, at ten minutes past the

hour you specify using the
ComfortVIEW Setup application,
retrieve the specified report data from
the Data Collection Option module
and store it in the ComfortVIEW
database. The data will be retained in
the database for the period you specify
using the Setup application.

Note:   The Data Collection Option
Module only stores up to two days-
worth of runtime and consumable
data. Failure to retrieve module data
will cause the data to be lost. Thus,
even if you do not wish to generate a
report at this time, and have specified
this by clicking on None, you still
must retrieve module data.

(continued)

Table 7-4
Report Definition Dialog
Box  — Consumable,
Runtime, and History
Reports (continued)
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Click on To

Enable automatic
report generation automatically, after data retrieval,

generate the specified report using the
data that has been automatically
retrieved from the modules and stored
in the ComfortVIEW database. This
option is typically used in conjunction
with the Enable automatic data re-
trieval option.

Save tab-separated
data file save the actual report that is created as

part of the report generation process.
ComfortVIEW will save the report to
the CWORKS\REPORTS\report type
directory path (where report type  is
replaced by the type of report being
generated:  CONSUME, HISTORY,
RUNTIME, etc.). ComfortVIEW uses
the following report file naming
convention:  Rptname.xxx  (where
Rptname is replaced by the eight
character name you enter in the
Report Name text box, and xxx is the
report number ranging from 001 to
999. Note that this number is
incremented each time you re-gener-
ate this report.)

You would only select this option if,
at some later time, you intend to read
the report into a third party spread-
sheet application.

       (continued)

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports (continued)
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Click on To

the Print to: drop
down list select a printer on which to automati-

cally print the report. When several
printers exist in your system, this
option gives you the capability to
specify a different printer for each
report.

Data Retrieval Period display the Data Retrieval Period
(in History Report dialog box. Here you specify
Definition only) a time interval, in hours, weeks, or

months to automatically retrieve
history data  from the Data
Collection Option Module. Refer to
Figure and Table 7-5a for instructions
on using this dialog box. Data retrieval
will commence at 10 minutes past the
hour you specify in the Setup applica-
tion and will occur at this interval. The
Data Collection Option Module only
stores up to 192 pieces of data for
history reports. Thus, depending on the
sampling period that is configured in
the module, the data could be lost if
ComfortVIEW does not retrieve it
often enough.

The following table gives you some
guidelines for sampling periods (inter-
vals) and the maximum collection
period after which data could be lost:

        (continued)

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports (continued)
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Click on To

Data Retention Option Module Do not set
Period (continued) Sampling Period    ComfortVIEW

Collection
Period to more
than

1 minute 3 hours
2 minutes 6 hours
4 minutes 12 hours
6 minutes 18 hours
8 minutes and up 24 hours

Manual Generation Options:

Retrieve yesterday’s retrieve yesterday’s data from the Data
data Collection Option Module and manually

create a daily, monthly, or yearly report
based on this data. This option will only
be available if you select a report date
of yesterday or a range of data that
includes yesterday.

Retrieve today’s data retrieve today’s data from the Data
Collection Option Module and manually
create a daily, monthly, or yearly report
based on this data. This option will only
be illuminated if you select a report date
of Today or a Range of data that in-
cludes today. ComfortVIEW will
retrieve data from the module ranging in
time from midnight to the current time.

Retrieve history data retrieve history data from the Data
(in History Report Collection Option. Module and
Definition only)  manually create a history report based

on this data. ComfortVIEW will retrieve
data from the module ranging from the
time of last collection to the current
time.

          (continued)

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports (continued)
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Click on To

Send report directly
to CWREPORT
printer bypass the report viewer and print the

report without first displaying it. If you
do not enable this option,
ComfortVIEW will display the report
on-screen allowing you to view it
before printing it.

The report will print on the
CWREPORT printer that you create in
the Windows NT Print Manager.

Defaults select the defaults listed below:

History Defaults:
Report:   History
Automatic Retrieval Options:  Enable

automatic data retrieval, Enable
automatic report generation, Save
tab-separated data file, Collection
Period: 0 (Data will be retrieved at
hour specified in the ComfortVIEW
Setup application.)

Manual Generation Options:  Retrieve
history data

Report Dates:  Data from yesterday’s to
today’s date

Save Dates as Relative:  Enabled

         (continued)

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports (continued)
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Click on To

Defaults (continued) Consumable and Runtime Defaults:
Report:  Daily
Automatic Retrieval Options:  Enable

automatic data retrieval, Enable
automatic report generation, Save tab-
separated data file

Manual Generation Options:  Retrieve
today’s data

Report Dates:  Range of Data: Yesterday
through today

Save Dates as Relative:  Enabled

Data Tables select the tables to include in the report.
ComfortVIEW displays the Report Data
Tables dialog box. This box allows you to
select a CCN and display the names of all
Data Collection Option tables in the CCN.
You can then select the tables containing
the points you wish to include in the
report. You can include points from more
than one CCN whether they are local or
remote. Refer to Figure 7-6 and Table 7-6
for instructions on using this dialog box.

Format select the report format. ComfortVIEW
displays the Report Format dialog box.
Refer to Figure 7-7 and Table 7-7 for
instructions on using this dialog box.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the previ-
ous settings. Any changes made are not
saved.

Help display help information.

Table 7-4
Report Definition Dialog
Box — Consumable,
Runtime, and History
Reports (continued)
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Click on To

a day in the calendar modify the displayed day of
month.

the scroll bar’s down or up arrow modify the month and year.

OK close the dialog box and save
the settings.

Cancel close the dialog box and
restore the previous settings.

Help display help information.

Figure 7-5
Data Range Dialog Box

Table 7-5
Data Range Dialog Box

Date Range

OK Cancel Help...

October 1994

Su

1 2 3 4 5

6 7 8 9 10 11 12

19181716151413

20 21 22 23 24 25 26

3130292827

M Tu W Th F S

Selects the date, scroll bar selects the month

Set time and date

02:30 p
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Figure 7-5a
Data Retrieval Period
Dialog Box

Click on To

Daily retrieve history data from the Data
Collection Option module every day
at the hourly interval you specify
under Data retrieval interval. Retrieval
will begin at the hour you specify
using the Setup application.

Weekly retrieve history data from the Data
Collection Option module once a
week on the day you specify under
Retrieval day of week.

Monthly retrieve history data from the Data
Collection Option module once a
month on the day you specify under
Retrieval day of month.

       (continued)

Table 7-5a
Data Retrieval Period
Dialog Box

Closes this dialog box and saves settings

OK

Monday

Retrieval day of week:

Weekly

Retrieval period

Daily

Monthly

Help...Cancel

Data Retrieval Period
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OK close the dialog box and save the
settings.

Cancel close the dialog box and restore the
previous settings.

Help display help information.

Click on ToTable 7-5a
Data Retrieval Period
Dialog Box
(continued)

Figure  7-6
Report Data Tables
Dialog Box

Report Data Tables

CCN Selection:

United Mutual Insurance

Data Tables Selected:

Data Tables Available:

OK Cancel Help...

<< Add Remove >>

United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM02S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM03S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM04S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM05S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM06S: Data Collect Consumable

United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM01S: Data Collect Consumable

United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM07S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM08S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM09S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM10S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM11S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM12S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM13S: Data Collect Consumable
United Mutual Insurance::DATACXFR: Data Collect/Transfer - 0,82::CONSM14S: Data Collect Consumable
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Click on To

the CCN Selection:
drop down list select the CCN containing the tables

to include in the report.

the Data Tables
Available: list display the names of all available Data

Collection tables in the selected CCN.
Click on a table name and then click
on Add to include up to 48 of the
table’s associated points in the report.

the Data Tables
Selected: list display the tables currently selected to be

included in the report. Click on a table
name and then click on Remove to delete
the table’s associated points from the report.

<<Add add the tables selected in the Data
Tables Available: list to the report. The
selected table name will be transferred
from the Data Tables Available list to
the Data Tables Selected list.

Remove>> remove the tables selected in the Data
Tables Selected: list from the report.
The selected table name will be trans-
ferred from the Data Tables Selected
list to the Data Tables Available list.

OK close the dialog box and save the
settings.

Cancel close the dialog box and restore the
previous settings.

Help display help information.

Table 7-6
Report Data Tables
Dialog Box
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Figure 7-7
Report Format  Dialog
Box

Click on To

Area in Page Header include the area name in the report
header. You would typically only elect to
do this if all report points are in the same
area. If points are from different areas,
click on Legend to include each point’s
area name at the bottom of all pages.

Point description include each point’s 24 character point
description in the column headers. The
description will appear below the point
name.

Show units include each point’s units in the column
headers.

(continued)

Table 7-7
Report Format  Dialog
Box

Report Format

Include:

OK Cancel Help...

Includes the area in the page header

Area in page header

X

Point description

X

Show units

X

Header every page

X

Footer every page

X

Legend

X

Page Numbers

X

Points per Legend: 4
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Click on To

Legend include each point’s area name, in
legend format, at the bottom of all
pages.

Points per legend for future use.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Note that Header every page, Footer every page, and Page numbers
fields are enabled, but appear dimmed. ComfortVIEW will auto-
matically include these items on all pages of the report.

Table 7-7
Report Format  Dialog
Box
(continued)
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The report definition shown in Figure 7-8 will generate a history
report named ZONETEMP, which is used for zone temperature
tracking. In this example, it is assumed that today is October 24,
1996 and ComfortVIEW is configured to automatically and
periodically retrieve data from the network’s Data Collection
Option Module. This report definition will automatically gener-
ate the ZONETEMP history report once a day. This definition
will also create a report, on manual command, using the most
up-to-the-minute zone temperature data that it can retrieve from
the network.

Automatic Retrieval Options:  The zone temperature history data
will be automatically retrieved from the Data Collection Option
Module every two hours as was specified in the Data Retrieval
Period dialog box, which was accessed by clicking on the Data
retrieval period button. An actual report, based on the retrieved
data, will be automatically generated, once a day, and will be
printed to a printer named HP LaserJet III. The time of day that
the report will generate is 2:00 am. This information has been
specified using the ComfortVIEW Setup application.

Manual Generation Options:  When the report is generated on
command by a user, the latest up-to-the-minute data will be
retrieved from the Data Collection Option Module. This manu-
ally-generated report will be presented on the screen for user
viewing. Since the Range of Data has been configured to in-
clude all of yesterday’s as well as today’s data, the report will
include data from the previous day’s automatic retrieval activity.

Sample History Report
Explanation
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Figure 7-8
Sample History Report
Definition Dialog Box

Enable automatic data retrieval

History

Report Definition

Report Name:

OK Cancel Help...

X

None

Format...

Defaults

HP LaserJet III

ZONE TEMP

Report Description:

Zone Temp Tracking

Report

Save tab-separated data file

Print to

XEnable automatic report generation

Send report directly to CWREPOR

Retrieve History data

Manual Generation Options

00:00 10/23/96

Data from:

Range of times/dates

Report Dates

23:59 10/24/96

Data through:

Save dates as relative

X

X

Automatic Retrieval Options

Closes this dialog box and saves settings

Data Tables...

Data retrieval period...
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The report definition shown in Figure 7-9 will generate a con-
sumable report named METER1A, which is used for tracking
building energy usage. In this example, it is assumed that today
is October 24, 1996 and ComfortVIEW is configured to auto-
matically retrieve daily consumable data from the network’s
Data Collection Option Module. This report definition will
automatically generate the METER1A consumable report once a
day. This definition will also create a report, on manual com-
mand, using the most up-to-date consumable data that it can
retrieve from the network.

Automatic Retrieval Options:  The consumable data will be
automatically retrieved from the Data Collection Option Module.
An actual report, based on the retrieved data, will be automati-
cally generated, once a day, and will be printed to a printer
named HP LaserJet III. The time of day that the report will
generate is 2:00 am. This information has been specified using
the ComfortVIEW Setup application.

Manual Generation Options:  When the report is generated on
command by a user, the most up-to-date consumable data will be
retrieved from the Data Collection Option Module. This manu-
ally-generated report will be sent directly to the CWREPORT
printer. Since the Range of Data has been configured to include
all of yesterday’s as well as today’s data, the report will include
data from yesterday’s automatic retrieval activity.

Sample Consumable
Report Explanation
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Figure 7-9
Sample Consumable
Report Definition Dialog
Box

Daily

Monthly

Report Definiton

Report Name:

OK Cancel Help...

X

None

Format...

Data Tables...

Defaults

LaserJet III

METER1A

Report Description:

Building Meter Summary

Yearly

Report

Save tab-separated data file

Print to

XEnable automatic report generation

Send report directly to CWREPORT printer

Retrieve Yesterday's data

Manual Generation Options

Retrieve Today's data

00:00 10/22/96

Data from:

Today

Range of data

Yesterday

Report Dates

23:59 10/23/96

Data through:

Save dates as relative

X

X

X

Closes this dialog box and saves settings

Automatic Retrieval Options

Enable automatic data retrieval
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The report definition shown in Figure 7-10 will generate a
runtime report named SUPFANS, which is used for accumulat-
ing the run time of a building’s air handler supply fans. In this
example it is assumed that today is October 25, 1996 and
ComfortVIEW is configured to automatically retrieve daily data
from the network’s Data Collection Option Module in anticipa-
tion of creating a monthly report. This report definition will not
automatically generate a report every day. It will automatically
retrieve the data, however. The report definition permits the
manual generation of a monthly report based on the month’s
accumulated data.

Automatic Retrieval Options:  The runtime data will be auto-
matically retrieved from the Data Collection Option Module.
The retrieval time of day has been specified using the
ComfortVIEW Setup application.

Manual Generation Options:  When the report is generated on
command by a user, the included runtime data will include data
for the current month through yesterday. No data retrieval will
take place on the generation of the monthly report. This report
will be presented to the user by means of the report viewer. It
will not be sent directly to the CWREPORT printer.

Sample Runtime Report
Explanation



478

Figure 7-10
Sample Runtime Report
Definition Dialog Box

Daily

Monthly

Report Definiton

Report Name:

OK Cancel Help...

X

None

Format...

Data Tables...

Defaults

LaserJet III

SUPFANS

Report Description:

Supply Fan Runtimes

Yearly

Report

Save tab-separated data file

Print to

Enable automatic report generation

Send report directly to CWREPORT printer

Retrieve Yesterday's data

Manual Generation Options

Retrieve Today's data

00:00 10/24/96

Data from:

Today

Range of data

Yesterday

Report Dates

23:59 10/24/96

Data through:

Save dates as relative

X

Closes this dialog box and saves settings

Automatic Retrieval Options

Enable automatic data retrieval
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Follow the instructions below to delete a report definition from the
report definition list.

Deleting a report definition deletes the definition only. The report
definition deletion process does not delete any related report files
that you may have saved.

1. Display the report definition list. If necessary, refer to Dis-
playing the Report Definition List.

2. Click on the report definition you wish to delete.

Note: ComfortVIEW allows you to delete multiple report
definitions. Use the Windows-standard mouse or
keyboard techniques to select multiple definitions.

3. Click on the Edit menu item and then click on Delete.

Note: You may also perform this command by clicking on
Delete icon in the toolbar.

ComfortVIEW displays the following prompt:  Reconfigure
the data collection tables?

4. Click on Yes to free up any data collection tables that have
been assigned to this report, or on No to prevent table
deallocation from taking place.

You would typically select No if you wish to keep the tables
in a Data Collection Option for later use, or if the tables are
in a GPM or HPM and cannot be deallocated.

Note: ComfortVIEW will not deallocate any data collec-
tion tables that are being used by other report
definitions.

You will then be presented with a deletion confirmation
dialog box.

5. Click on Yes to complete the deletion or click on No to
prevent the deletion from taking place. If you have selected
multiple definitions and wish to delete all, click on Yes to All.

ComfortVIEW displays a function status box during the
deletion, and the report definition list re-displays when the
deletion is complete.

Deleting an
Existing

Report Definition
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Follow the steps below to print a selected report definition.

1. Display the report definition list. If necessary, refer to Dis-
playing the Report Definition List.

2. Click on the report definition you wish to print.

3. Click on the File menu item and then click on Print.

Note: You may also perform this command by clicking on
the Print icon.

ComfortVIEW opens the Windows Notepad application and dis-
plays the report definition information.

To print the Report Definition:

Click on Notepad’s File menu item and then click on Print.

To close the report:

Click on Notepad’s File menu item and then click on Exit.

You can change the report definition list font. When you change the
font, all report definition list text is affected.

To change the font:

1. Display the report definition list. If necessary, refer to Dis-
playing the Report Definition List.

2. Click on the Options menu item followed by clicking on Font.

ComfortVIEW displays the Font dialog box. Refer to Figure
7-11.

3. In the Font box, select the font you want to use.

The text in the Sample box changes to reflect the font you
select.

4. In the Font Style box, select any style options you want to use
(for example, bold or italic).

5. In the Size box, select the point size you want to use:  the
larger the point size, the larger the characters appears on your
screen.

6. Click on OK.

Printing a
Report

Definition

Changing the Font
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Note: To Make the New Report Definition List Font and Point
Size Permanent: Click on the Options menu item and then
click on Save settings on exit. A checkmark (✓ ) appears
before the command to indicate that it is enabled. The text
will appear in this new font and point size the next time
you start the Report Panel. This command also saves the
size and position of the report window.

Figure 7-11
Font Dialog Box

8

8

Font:

Font

Sample

Font Style: Size:

Geneva
MS Sans Serif
MS Sans Serif
MS Sans Serif
MS Sans Serif

Regular

Regular
10
12
14
18

AaBbYyZz

Geneva
OK

Cancel

This section explains the report generation process. It first discusses
the required conditions and then presents step by step automatic and
manual report generation instructions.

Before you can generate a report, the following conditions must
exist:

• A report definition, which contains the specifications for the
report, must exist in the report definition list. To verify, display
the report definition list. If necessary, refer to Displaying the
Report Definition List for instructions. If you must add a new or
modify an existing report definition, refer to the Creating,
Copying, or Modifying a Report Definition section of this
chapter.

Required Conditions
for Manual and
Automatic Report
Generation

Generating
a Report
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• To generate a consumable, runtime, or history report, a Data
Collection Module must exist on the Carrier Comfort Network.
The module also must have been added to the ComfortVIEW
database. For instructions on adding system elements to the
database, refer to the Adding/Modifying Controllers section of
this manual’s Carrier Network Manager chapter.

• For consumable, runtime, and history reports, a report table must
exist and must be configured in the Data Collection Option. (For
example, if the Data Collection Option is collecting runtime
data, you must configure the Data Collection Option’s
RUNTMxxS Table.) For instructions on configuring Data Col-
lection Option tables, refer to Displaying and Configuring CCN
Options in the Carrier Network Manager chapter of this manual.

• For consumable and runtime points in PICs or Comfort Control-
lers, an equipment part report table must also exist and be
configured in the PIC or Comfort Controller. (For example, if
the Data Collection Option is collecting runtime data from the
39N Air Handler PIC, you must also configure the 39N’s
Runtime Configuration Table.) If necessary, refer to the Modify-
ing Configuration Table Values or Configuring Comfort Con-
trollers section of the Carrier Network Manager chapter of this
manual.

• When generating reports for remote CCNs, ComfortVIEW will
automatically connect to the remote CCN to retrieve data. Your
Autodial Gateway must be capable of connecting to the remote
CCN when commanded by ComfortVIEW.

Note: This will only happen if your report definition calls for
the retrieval of data to create the report. If you plan to
use data that has already been been retrieved and stored
in the ComfortVIEW database, remote CCN connection
is not necessary.

• If you wish to print the report, you must create a  printer called
CWREPORT in the Windows NT Print Manager. Manually-
generated reports will print to this printer. Automatically-
generated reports will print to the printer you select in the
Report Definition dialog box.



483

Follow the steps below to produce a report on request.

1. Verify that the Required Conditions for Manual and Automatic
Report Generation exist.

2. Display the report definition list. If necessary, refer to Display-
ing the Report Definition List.

3. Click on the report definition from which you wish to create a
report.

Note: If desired, you can review the report specifications by
double clicking on the report definition. The Report
Definition dialog box will display. Modify specifica-
tions as desired. Click on OK to save the modifications,
or click on Cancel to exit without saving changes.

Be aware that changes made to the Report Dates options will
affect any automatic generation. Remember to return the Report
Dates to their original settings.

4. Click on the File menu item and then click on Generate.

ComfortVIEW displays a confirmation dialog box asking if you
wish to generate the report.

5. Click on Yes to generate the report or click on No to prevent
report generation. If you have selected multiple reports and wish
to generate all, click on Yes to All.

A function status box is displayed during the report generation.

If, in the Report Definition dialog box, you enabled the Send
report directly to CWREPORT printer option, the report prints
on the CWREPORT printer created in the Windows NT Print
Manager, and the report definition list re-displays on completion.
Refer to the end of this chapter for sample ComfortVIEW re-
ports.

If you did not enable the Send report directly to CWREPORT
printer option, ComfortVIEW initiates the report viewer and
displays the report on-screen. For instructions on the Report
Panel’s report viewer function, refer to the Using the Report
Viewer section of this chapter.

To Manually Generate
a Report



484

You can also use the File menu's Regenerate command (or click on
the Regenerate icon in the toolbar) to manually reproduce a selected
report based on a range of dates that is different than those specified
in the report definition.

Follow the steps below to automatically produce a report at a user-
specified time.

1. Verify that the Required Conditions for Manual and Auto-
matic Report Generation exist.

2. Display the report definition list. If necessary, refer to Dis-
playing the Report Definition List.

3. Configure your report definition to automatically retrieve data
and automatically generate a report. For instructions, refer to
Modifying an Existing Report Definition in the Creating,
Copying, or Modifying a Report Definition section of this
chapter.

4. The report will automatically generate and print at the time
specified in the ComfortVIEW Setup application. If you wish
to view or modify this time, refer to this manual’s Setup
chapter for instructions. The report will print on the printer
specified in the Report Definition dialog box’s Print to drop
down list. This list appears under Automatic Retrieval Op-
tions.

If bad data is encountered when a daily time-based report (i.e.,
History, Runtime, or Consumable) is being generated,
ComfortVIEW will indicate the reason for the bad data on the report
in the status column to the right of the data. Bad data may be en-
countered for the following reasons:

• no data was available from the controller

• there was a communication failure within the CCN

• there was a hardware failure at the controller

 Manual Report

Regeneration

To Automatically
Generate a Report

Report Data Status
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• the data collection option was configured improperly

• there was a mismatch of information between the ComfortVIEW
database and the Data Collection Option.

When bad data is encountered in a daily time-based report, it is
discarded and ComfortVIEW provides an interpolated value for that
time instead. The interpolated value is calculated using the average
of the good data readings preceding and succeeding the bad data.
Interpolated values are inserted if up to two consecutive data read-
ings are bad. If bad data exists for more than two data readings, no
interpolation is performed, and the data is included in the report.

The report viewer function gives you the capability to:

• view, print, and save a report on disk.

• display another previously-generated report file.

The report viewer is automatically invoked as part of manual report
generation. You can also, however, manually initiate the report
viewer by clicking on the report definition list's File menu item and
then clicking on Report Viewer.

Note: In Windows 9x client, it is recommended that you do not
open more than one instance of the Report Viewer application. This
is in order to conserve system resources.

When it is invoked by manual report generation, the report viewer
function consists of a Report Viewer window with a Print Preview
mode. The Print Preview mode is activated automatically when you
manually generate a report and disable the Report Definition dialog
box’s Send report directly to CWREPORT printer option. When you
exit the Print Preview mode, the Report Viewer window is dis-
played.

When you manually generate a report, the report viewer displays the
report in front of you in a Print Preview mode. This gives you the
opportunity to view the report before you print it. A sample Print
Preview window is displayed in Figure 7-12.

Using the Report
Viewer

Print Preview Mode
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Figure 7-12
Sample Print Preview
Window

ComfortWorks Report Viewer - FANS.001

Zoom OutZoom In CloseTwo PagePrev PageNext PagePrint...

Miscellaneous Meters
Daily Runtime Report for October 24, 1994

United Mutual Insurance Complex

1 2 3 4 5 6 7
AH1 AH1 Chiller Chiller Chiller Misc. Misc.

Supply Fan Return Fan Compressor 1 Compressor 2 Compressor 3 Lighting Lighting
Status Status Zone 1 Zone 2

Time Minutes Minutes Minutes Minutes Minutes Minutes Minutes

10/28/94 1 0 0 0 0 0 0 0
2 0 27 27 0 0 60 60
3 60 60 60 0 0 60 60
4 60 60 60 60 30 60 60
5 45 60 60 60 45 -2 60 60<=
6 60 60 60 60 60 60 60
7 60 60 45 60 60 60 60
8 60 60 60 60 60 60 60
9 45 60 60 60 60 60 60

10 60 60 60 60 60 60 60

18 45 45 60 60 0 0 60
19 45 45 45 45 0 0 45
20 45 45 45 45 0 0 45
21 45 45 45 45 0 0 45
22 45 45 45 45 0 0 45
23 0 0 0 0 0 0 0
24 0 0 0 0 0 0 0

Totals: 613 612 664 520 490 460 360
Hours: 10.2 10.2 11.1 6.8 7.0 13.7 14.3

0= No Data Available. -1 = Communication Failure. -2 = Hardware Error. -3 = Configuration Error. -4 = Discrete Startup. -5 = Database Mismatch

Legend 1 - United Mutual Insurance - Main Office 5 - United Mutual Insurance - Main Office
2 - United Mutual Insurance - Main Office 6 - United Mutual Insurance - Main Office
3 - United Mutual Insurance - Main Office 7 - United Mutual Insurance - Main Office
4 - United Mutual Insurance - Main Office

11/1/94
13:14

Area Name
Report Titile w/ Date of Data
Report Description

Unit

Time/Date
Report Generated

Page 1

Point Description

Point  Name
Legend Index #

Highest
Value Marker

Legend

Status

ComfortVIEW
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Click on To

Print print the report. The Print dialog box
displays. To print selected report
pages, click on Pages and enter the
page numbers. To change the dis-
played print quality, make your
selection from the drop down list.
Enter the desired number of copies in
Copies:. Then, click on OK.

Note:  To change the report’s orienta-
tion (the default is landscape), click on
the Print dialog box’s Properties
button, and, in the Print Properties
dialog box, select Portrait.

By default, the report will print on the
CWREPORT printer that you have
created in the Windows Print Man-
ager. To print on another printer, click
on the Name drop down list and select
the desired printer.

After printing the report,
ComfortVIEW displays the Report
Viewer window. Refer to Report
Viewer Window following this table
for an explanation of this window.

Next Page if you have a multi-page report,
view the next page.

Prev Page if you have a multi-page report,
view the previous page.

Two Page display pages side by side.

(continued)

Table 7-12
Print Preview Window
Buttons
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Table 7-12
Print Preview Window
Buttons
(continued)

Click on To

Zoom In magnify and view the report at a closer
range.

Zoom Out return the report to its original size.

Close exit the report without printing.
ComfortVIEW now displays the Report
Viewer window.

Note: Unlike other windows, you cannot close this window by
clicking on its control menu box.

A sample Report Viewer window is displayed in Figure 7-13. The top
line of the Report Viewer window displays ComfortVIEW Report
Viewer followed by the report file name. The second line of the
window contains the menu bar. Report Viewer menu commands are
summarized in Table 7-13.

From the Report Viewer window, you can:

• display another report file that had been previously generated and
saved on disk.

Note: Automatically-generated report files are saved if you
select the Save tab-separated data file option in the
Report Definition dialog box. Manually-generated
report files are saved using the Report Viewer
window’s File Save as command.

• save the currently-displayed report file on disk. You would
typically save a report file if you intend to view it at a later time
or if you wish to read the file into a third party spreadsheet appli-
cation.

• re-display the Print Preview Window and view the report.

• print the currently-displayed report.

Report Viewer Window
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Figure 7-13
Sample Report Viewer
Window

Report File Name (Active)

ComfortVIEW Report Viewer - FANS.001

File Options

For Help, press F1

Help
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File Menu
Commands Use this command to

Open display another report file.

Note:  This report file must have been
previously generated and saved to disk.

The File Open dialog box displays.
Select the file you wish to display or
type the file name in the File Name
box. You can also select a different
drive by making your selection from
the Drives drop down list. You can
select a report file that is resident on
another network computer by clicking
on the Network button. ComfortVIEW
saves automatically-generated reports
to the \REPORTS\report type directory
path (where report type  is replaced by
the type of report being generated:
CONSUME, HISTORY, RUNTIME,
etc.). This directory path will be
located in \CWORKS, \CVIEW, or
other directory in which you installed
ComfortVIEW. ComfortVIEW uses
the following report file naming con-
vention:  Rptname.xxx  (where
Rptname is replaced by the 8 character
name you enter in the Report Name
text box, and xxx is the report number
ranging from 001 to 999. Note that this
number is incremented each time you
re-generate this report.)

(continued)

Table 7-13
Report Viewer Menu
Commands
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File Menu
Commands Use this command to

Save As save the currently-displayed report
file. The name of the currently-
displayed report appears in the top
line of the window following
ComfortVIEW Report Viewer -.

The File Save As dialog box displays.
To save the file with a name different
from the one displayed in the File
Name box, type the name for the file.
You may also select a different drive
and a different directory or folder. For
your convenience, a \REPORTS
directory is supplied on your disk.
This directory will be located in the
\CWORKS, \CVIEW, or other direc-
tory in which you installed
ComfortVIEW. To save the file on
another network computer, click on
the Network button.

Print print the currently displayed report
file. The name of the currently-
displayed report appears in the top
line of the window following
ComfortVIEW Report Viewer -.

The Print dialog box displays. To
print selected report pages, click on
Pages and enter the page numbers. To
change the displayed print quality,
make your selection from the drop
down list. Enter the desired number of
copies in  Copies:, and, if desired,
click on Collate Copies. Click on OK.

       (continued)

Table 7-13
Report Viewer Menu
Commands
(continued)
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Table 7-13
Report Viewer Menu
Commands
(continued)

File Menu
Commands Use this command to

Print (continued) Note:   If you wish to change the
report’s orientation (the default is
landscape), click on the Print dialog
box’s Properties button, and, in the
Print Properties dialog box, select
Portrait.

By default, the report will print on the
CWREPORT printer created in the
Windows NT Print Manager. If you
wish to print on another printer, click
on the Name drop down list and select
a printer.

Print Preview return to the Print Preview Window
and view the report.

Print Setup override the CWREPORT printer
assignment. By default, manually-
generated reports print on this printer,
which is created in the Windows NT
Print Manager. Selecting this
command allows you to override the
CWREPORT printer assignment.

The Print Setup dialog box displays. If
you wish to change the printer from
the one displayed, select from the drop
down lists. Click on Portrait or
Landscape to select the report’s
orientation. If you wish to select
another network printer, click on the
Network button, and, in the Connect to
Printer dialog box, select a printer.

(continued)
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File Menu
Commands Use this command to

Exit exit the Report Viewer Window. The
Report Definition list re-displays.

Options Menu
Commands Use this command to

Toolbar hide or display the toolbar that appears
in the second line of report panel
windows.

Status bar hide or display the status bar that
appears along the bottom of the
Report Viewer Window.

Help Menu
Commands Use this command to

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information, and copyright.

Table 7-13
Report Viewer Menu
Commands
(continued)
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Editing Report
Data

ComfortVIEW gives you the ability to modify the consumable and
runtime and tenant billing data that it retrieves from the Data Collec-
tion and Tenant Billing Options and stores in its database.

Specifically, if there are missing or erroneous daily values in your
monthly data, you can insert the missing or modify the existing daily
values by following the instructions below. ComfortVIEW then
automatically updates your monthly and yearly totals accordingly.

To edit your report data:

• Use the Windows Notepad application to create a text file con-
taining the new or modified daily values. For instructions, refer
below to To Create the Text File.

• Display the report definition list and use the File menu’s Import
data command to import the Notepad text file into the
ComfortVIEW database. If you are modifying existing daily
totals, the text file data will overwrite the existing values. If you
are inserting missing daily totals, the text file data will be inserted
into the monthly data. The monthly and yearly data will automati-
cally update accordingly. For instructions on importing the
Notepad text file, refer below to To Import the Data into the
Consumable. Runtime, or Tenant Billing Data File.

1. Use the Windows Notepad application to create a file with the
new or modified data.

Note: You must type each line of data in the format shown
below. Separate each piece of data with a Tab.

For Consumable and Runtime Data:
Year [Tab] Month [Tab] Day [Tab] Numeric Value [Tab] Index #

where:
Year = the 4 digit year (Ex: 1999); Month = 1-12; Day = 1-31;
Numeric Value = the daily value
Index # = 0 (Consumable) 1-8 (Runtime Index #)

For Tenant Billing Data:
Year [Tab] Month [Tab] Day [Tab] Hour [Tab] Minute [Tab] Zone#
[Tab] Name [Tab] Duration

where:
Year = the 4 digit year (Ex: 1999); Month = 1-12; Day = 1-31;
Hour = 1-24;  Minute = 1-60; Zone# = the tenant billing zone;
Name = the zone name; Duration = time in minutes

To Create the Text File
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2. Save the Notepad text file in the directory
\CVIEW\REPORTS using the .RPT file extension.
Example Notepad text file containing consumable data:
EXAMPLE.RPT

1994 9 1 21113.2567 0

Explanation:
When this text file is imported, the existing daily consumable
total usage value for 9/1/94 will be overwritten with the value
21113.2567. If there currently is no usage value for this date,
this value will be inserted into the monthly data. It will then
be added to the 9/94 monthly total. The 94 yearly total also
will be adjusted accordingly.

1. Display the report definition list. If necessary, refer to Dis-
playing the Report Definition List.

2. Click on the File menu item and then click on Import data.

ComfortVIEW displays the Data Table Selection dialog box.
This dialog box lists all consumable and runtime tables in
each CCN. Refer to Figure 7-14 and Table 7-14 for instruc-
tions on using this dialog box.

3. Select a CCN from the Select CCN drop down list.

4. In the Select data table list, select the option table containing
the point whose monthly data you intend to modify and click
on OK.

The Open File dialog box displays.

5. Select the Notepad text file you wish to import or type the
text file name in the File Name box. You can also select a
different drive by making your selection from the Drives drop
down list. You can select a text file that may be resident on
another network computer by clicking on the Network button.

6. Click on OK.

The dialog box closes, the data imports into the selected
consumable or runtime file, and the report definition list re-
displays.

To Import the Data into
the Consumable,
Runtime, or Tenant
Billing Data File
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Figure 7-14
Data Table Selection
Dialog Box

Data Table Selection

OK Cancel Help...

Select CNN:

United Mutual Insurance

CONSM03S: Data Collect Consumable

Select Data Table:

CONSM04S: Data Collect Consumable
CONSM05S: Data Collect Consumable
CONSM06S: Data Collect Consumable
CONSM07S: Data Collect Consumable
CONSM08S: Data Collect Consumable
CONSM09S: Data Collect Consumable
CONSM13S: Data Collect Consumable
CONSM11S: Data Collect Consumable

Selects a report data table as the import target

Click on To

A CCN in the Select CCN
drop down list select the CCN containing the table to

modify.

A table in the Select Data
Table list select the table containing the point

whose monthly data you intend to
modify.

(continued)

Table 7-14
Data Table Selection
Dialog Box
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Table 7-14
Data Table Selection
Dialog Box
(continued)

Click on To

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

This section describes the files that are used and created by the
ComfortVIEW Report Panel application. It also includes informa-
tion on steps to take to manage the report files in your
ComfortVIEW database.

The Report Panel application uses or creates the following files:

• The actual report files

These are the files that ComfortVIEW produces as a result of
generating a report. Depending on how you set up the report
definition, you can save automatically generated reports in your
ComfortVIEW database. ComfortVIEW will save the report to
the CVIEW\REPORTS\report type directory path (where report
type  is replaced by the type of report being generated:  CON-
SUME, HISTORY, RUNTIME, etc.).

You can also save manually generated reports. Manually gener-
ated reports can be saved to a directory of your choice. But, for
your convenience, the following reports directory has been set
up for you:  CVIEW\REPORTS.

ComfortVIEW uses the following report file naming convention:
Rptname.xxx  (where Rptname is replaced by the 8 character
name you enter in the Report Name text box, and xxx is the
report number ranging from 001 to 999. Note that this number is
incremented each time you re-generate this report.)

Managing Your
Report Files
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To Manage These Report Files:

It is your responsibility to periodically delete or copy report files to a
diskette. This is particularly important if you have configured your
ComfortVIEW system to automatically generate reports and save them
in your database. This action will lead to a steady decrease in available
ComfortVIEW disk space.

• The report data that ComfortVIEW retrieves from the CCN option
modules, stores in the ComfortVIEW database, and uses to formulate
reports.

To Manage This Data:

It is your responsibility to specify the number of days that
ComfortVIEW will retain retrieved report data in its database. At the
end of this retention period, which you specify using ComfortVIEW
Setup application, ComfortVIEW automatically deletes the data.

Only retrieved consumable, runtime, and history report data is subject
to this purging. You can generate reports using the retained data until
the end of this retention period.

Retention period valid entries range from 0 to 99 days. Entering 0
causes the data to be retained as long as ComfortVIEW has disk space
to store it. You are cautioned against doing this, as it could eventually
consume all disk space.

• The Notepad text files that you create and import to the ComfortVIEW
database in the event that you have missing or incorrect daily report
values.

These text files modify the report data that ComfortVIEW retrieves
from the CCN option modules. (These data files are described in the
bulleted item above.)

You must type data into the Notepad text file using the format shown
in the Editing Report Data section of this chapter, and save the text file
in the directory \CVIEW\REPORTS using the .RPT file extension.

To Manage These Data Files:

You can delete these files once the Import is complete.
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You can include your own custom report in the Report Panel. You
do this by adding an icon to the Report Panel window. The icon
could be used, for example, to launch a third party spreadsheet
application that you could use to manipulate your report data.

Follow the steps below to add a report to ComfortVIEW Report
Panel:

1. Display the report panel. If necessary, refer to the instructions
listed under Accessing the Report Panel.

2. Click on the Options menu item and then click on New.

ComfortVIEW displays the New Report Profile dialog box.

3. In the Report name box, enter a descriptive report or applica-
tion name. This name will display beneath the icon in the
Report Panel window.

4. In the Menu entry box, enter a descriptive report or applica-
tion name. This name will display in the command list when
you click on the Report Panel window’s Report menu item.

Note: To allow a user to invoke this command using a
shortcut key, place an & character before the letter
that you wish to be the shortcut key.

5. In the Icon file box, enter the directory path and file name of
the icon that you wish to represent this report in the Report
Panel window, or

click on the box to the right of the text box to search your
directories for the proper icon file.

6. Enter any help text that you want presented in the Report
Panel when the user selects your report application.

7. In the Executable box, enter the name of the executable file
ComfortVIEW will invoke to start your report application, or

click on the box to the right of the text box to search your
directories for the proper executable file.

If necessary, refer to Figure 7-15 and Table 7-15 for a summary of
all New Report Profile dialog box options.

Using the Report
Panel To Initiate a
Third Party Report
Application
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Figure 7-15
New Report Profile Dialog
Box

New Report Profile

Report name:

OK Cancel Help...

Menu entry:

Icon File:

...

Help Text:

Executable

...

Click on To

the Report Name text box enter a name for the report or applica-
tion. This name will display beneath
the icon in the Report Panel window.

the Menu entry text box enter a command name for the report.
This name will display in the com-
mand list when you click on the
Report Panel window’s Report menu
item.

Note: To allow a user to invoke this
command using a shortcut key, place
an & character before the letter that
will be the shortcut key.

       (continued)

Table 7-15
New Report Profile Dialog
Box
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Click on To

the Icon text box enter the directory path and file name
of the report icon that you wish to
add to the Report Panel window. You
may also click on the box to the right
of the text box to search your directo-
ries for the proper icon file.

the Help text box enter any help text that you want
presented in the Report Panel when
the user selects your report applica-
tion.

the Executable box enter the name of the executable file
ComfortVIEW will invoke to start
your report application. You may
also click on the box to the right of
the text box to search your directories
for the proper executable file.

OK close the dialog box and save
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

This section describes each of the commands that appear in the
Report Panel window menus. Refer to Figure 7-2 in the Accessing
the Report Panel section of this chapter to view a copy of the
Report Panel Window.

The table below describes each of the commands that appear in the
Report Panel’s Reports menu. Consumable, history, and runtime
commands will always display in this Report menu. Additional
report names will appear in the menu as you install other optional
ComfortVIEW report types.

Table 7-15
New Report Profile Dialog
Box
(continued)

Report Panel
Menu Command
Summary

Reports Menu
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Click on To

Consumable display the consumable report defini-
tion list.

History display the history report definition
list.

Runtime display the runtime report definition
list.

Exit exit the report panel application.

The table below describes each of the commands that appear in the
Report Panel’s Options menu.

Click on To

New add a custom report to the report
panel. If desired, you can create your
own custom report and icon and add it
to the report panel. This icon could be
used, for example, to launch a third
party spreadsheet application that you
could use to manipulate your report
data. The New Report Profile dialog
box displays.

This command will also be used to
add new ComfortVIEW report types
as they become available.

Modify modify the selected report profile.
You must click on the report type icon
prior to using this command. The
profile dialog box displays. Make any
desired changes. Click on OK to close
the dialog box and save changes
made, or on Cancel to exit the box
and restore previous settings.

         (continued)

Table 7-16
Reports Menu

Options Menu

Table 7-17
Options Menu
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Click on To

Delete delete the selected report profile. You
must click on the report type icon
prior to using this command.
ComfortVIEW deletes the selected
report icon and profile, and its accom-
panying report definition list.

The table below describes each of the commands that appear in the
Report Panel’s Help menu.

Click on To

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information, and copyright.

This section describes each of the commands that appear in the
report definition list menu. Refer to Figure 7-3 in the Displaying the
Report Definition List section of this chapter to view a sample
report definition list.

The table below describes each of the commands that appear in the
report definition list’s File menu.

Click on To

New create a new report definition and
define the specifications for your
report. This is the first step in the

       (continued)

Table 7-17
Options Menu
(continued)

Help Menu

Table 7-18
Help Menu

Report Definition
List Menu
Command
Summary

File Menu

Table 7-19
File Menu
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Click on To

report creation process. Report specifications
include information such as the report name
and description, report type (daily, monthly,
yearly), automatic data retrieval and report
generation preferences, and the points on
which to report. The Report Definition
dialog box displays. Refer to Report Defini-
tion Dialog Box in the Creating, Copying, or
Modifying a Report Definition section of
this chapter for instructions on using this
dialog box. Click on OK to close the dialog
box and save information entered, or click
on Cancel to exit the dialog box without
saving.

Import data modify retrieved consumable or runtime
monthly data by importing a Notepad text
file containing the new data.

Generate produce (generate) the selected report. A
confirmation dialog box displays. Click on
Yes to generate the report or on No to pre-
vent report generation. A function status box
displays during the report generation. If you
enabled the Report Definition dialog box’s
Send report directly to CWREPORT printer
option, the report will print. If you did not
enable this option, ComfortVIEW initiates
the report viewer and allows you to view the
report before printing. Refer to the Generat-
ing a Report and Using the Report Viewer
sections of this chapter for additional report
viewer and generation information.

Regenerate manually generate a selected report based on
a new range of data dates. ComfortVIEW
will display the Regenerate Start Date and
Regenerate End Date dialog boxes where

      (continued)

Table 7-19
File Menu
(continued)
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Click on To

you must enter report data start and end
dates and times. If necessary, refer to Data
Range Dialog Box, which appears in the
Creating, Copying, or Modifying a Report
Definition section of this chapter, for
instructions on using these dialog boxes.
ComfortVIEW will generate the report
using the new report data.

Print print the selected report definition.
ComfortVIEW opens the Notepad applica-
tion and displays the report definition. Click
on the File menu item and then click on
Print. Click on File and Exit to close the
report.

Print setup configure report print specifications such as
print resolution and orientation.

If desired, you can also use this command
to override the ComfortVIEW printer
assignment.

Manually-generated reports for which you
enable the Send report directly to
CWREPORT printer option will print on
the CWREPORT printer that you create in
the Windows NT Print Manager. Use this
command to override the printer assign-
ment.

Report viewer manually initiate the report viewer function.
ComfortVIEW displays the File Open
dialog box. Refer to the explanation of the
Open command in Table 7-13 for instruc-
tions on using this dialog box.

Note: In Windows 9x client, it is recom-
mended that you do not open more than one
instance of the Report Viewer application.
This is to conserve system resources.

Exit exit the report definition list.

Table 7-19
File Menu
(continued)
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The table below describes each of the commands that appear in the
report definition list’s Edit menu.

Click on To

Copy create a copy of a selected report
definition. ComfortVIEW copies the
selected report definition and displays
the copied Report Definition dialog
box. Type the new Report Name, and,
if desired, make any other modifica-
tions. Click on OK to close the dialog
box and save changes made, or click on
Cancel to exit the dialog box without
saving changes.

Delete delete a selected report definition. At
the Reconfigure the data collection
tables? prompt, click on Yes to
deallocate (or free up) any data collec-
tion tables or on No to prevent table
deallocation from taking place. You
would typically select No if you wish to
keep the tables in a Data Collection
Option for later use, or if the tables are
in a GPM or HPM and cannot be
deallocated. You will then be presented
with a deletion confirmation dialog
box. Clicking on Yes completes the
report definition deletion, or on No
cancels the report deletion. Note that if
you have specified table deallocation,
but the tables are being used by other
report definitions, they will not be
deallocated.

Modify modify the selected report definition.
The Report Definition dialog box
displays. Make any desired modifica-
tions. Click on OK to close the dialog
box and save changes made, or click on
Cancel to exit the dialog box without
saving changes.

Edit Menu

Table 7-20
Edit Menu
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The table below describes each of the commands that appear in the
report definition list’s Options menu.

Click on To

Font change the font that ComfortVIEW uses
to display report definition list text.

Dialog Box Options:

Font:  Select the font to use.

Font Style:  Select any style options
(for example, bold or italic)

Size:  Select the point size. The larger
the point size, the larger the characters
appear on your screen.

Sample:  The text in this box changes
to reflect the font, font style, and size
you select.

OK:  Closes the dialog box and save
changes made.

Cancel:  Exits the dialog box and
restores the previous settings.

       (continued)

Options Menu

Table 7-21
Options Menu
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Click on To

Toolbar hide or display the toolbar that ap-
pears in the second line of report
panel windows.

Status bar hide or display the status bar that
appears in the third line of report
panel windows. This status bar dis-
plays the name and description of the
currently highlighted report definition.

Refresh update the report definition list with
the most recent report definitions that
have been created and saved in the
ComfortVIEW database.

Save settings on exit save any changes you make by using
commands on the Options menu. For
example, if you change the font and
then exit the report definition list, the
text appears in the new font the next
time you enter the report list. This
command also saves the size and
position of report windows.

The table below describes each of the commands that appear in the
report definition list’s Help menu.

Click on To

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
components, and copyright.

Table 7-21
Options Menu
(continued)

Help Menu

Table 7-22
Help Menu
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This section contains sample ComfortVIEW reports.

The following reports are included:

• Consumable Daily Report
• Consumable Monthly Report
• Consumable Yearly Report

• Runtime Daily Report
• Runtime Monthly Report
• Runtime Yearly Report

• History Report

Sample reports for additional ComfortVIEW reports can be found in
Appendix A.

Sample Reports
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This chapter provides information on ComfortVIEW's Global Func-
tion Manager application.

For instructions on... Turn to page

launching the Global Function Manager application 517

configuring a ComfortVIEW server to automatically
force and auto user-specified groups of points 517

transmitting data from point to point or broadcasting
point data onto the CCN Bus 522

creating global occupancy schedules 527

configuring global holidays 527

a summary of all Global Function Manager commands 534

To launch the Global Function Manager application:

Double click on the Global Function Manager icon.

ComfortVIEW displays the Global Function Manager window. The
top line of the window contains the Global Function Manager menu.
Refer to Global Function Manager Menu Command Summary at the
end of this chapter for a description of each menu item and com-
mand.

You can configure a ComfortVIEW server to automatically force
and auto one or more user-specified points, based on user-specified
time parameters.

Follow the steps below to set up, modify, or delete a timed force:

1. Click on the Functions menu item and then click on Timed
Force.

The Timed Force Groups dialog box is displayed. Refer to
Figure and Table 8-1. This dialog box contains the names of
all currently-configured force groups.  As you select a force
group, the group's force and auto time, force precedence,
enable/disable status, and the names of all points that are
currently assigned to the group display under Force group

Global
Function
Manager

Timed Force

Launching the
Global

Function
Manager
Application
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information and in the Force points: list in the lower section
of the dialog box.

2. In the Timed Force Groups dialog box, you can do the fol-
lowing:

• Click on New to define a new force group (up to 300
force groups can exist), or click on an existing force
group and then click on Modify to modify it. The Timed
Force Points dialog box will be displayed. Use this dialog
box to add and delete points from the group (up to 60
points per group), and to specify force precedence, and
force and auto time. Double click on the Value cell to
specify a new or modify the existing force value. Refer to
Figure and Table 8-2 for instructions on using this dialog
box.

• Click on an existing force group, and then click on Delete
to delete it. In the confirmation dialog box, click on Yes
to delete the group or on No to close the dialog box
without group deletion.

3. Click on OK to close the Timed Force Groups dialog box and
save your settings or on Cancel to close the dialog box
without saving settings.

At the specified time, ComfortVIEW will force the points identified
for each group. Successes and failures will be logged in the System
Activity log using an operator name of ComfortVIEW and an event
of either Timed force or Timed force with auto, depending on
whether an auto time was configured for the point, and whether the
point being forced supports the force with auto feature. Alarms will
be generated for failures. Those points for which an auto time is
configured that do not support the force with auto feature, will
receive a standard force and ComfortVIEW will issue the auto
command at the appropriate time. If the ComfortVIEW server is
turned off before the scheduled auto time, the auto will not be
performed. ComfortVIEW will not perform forces or autos on
points whose force or auto time occurred while ComfortVIEW was
not running.
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Figure 8-1
Timed Force Groups
Dialog Box

Click on To

the name of a group in the
Force groups: list select a group to modify or delete.

New create a new force group. The Timed
Force Points dialog box is displayed.
Refer to Table and Figure 8-2 for
instructions on using this dialog box.

Modify modify the selected force group. The
Timed Force Points dialog box is
displayed. Refer to Table and Figure
8-2.

Note: Double clicking on an existing
group in the Force Groups: list also
will display this dialog box.

       (continued)

Table 8-1
Timed Force Groups
Dialog Box
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Click on To

Delete delete the selected force group. At the
confirmation dialog box, click on Yes
to delete the group or on No to close
the dialog box without completing the
deletion.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-1
Timed Force Groups
Dialog Box
(continued)

Figure 8-2
Timed Force Points
Dialog Box
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Click on To

the Group name: text box enter a name for this group of timed
force points.

Enabled enable or disable the functionality of
this timed force group.

Force time: and Auto time:

enter the force start or end date and
time. These times will apply to all
points in this force group. The Force
Time and Date dialog box will be
displayed. Enter the force start or end
time and date. If necessary, you can
refer to Figure and Table 7-5 in this
manual's Report Panel chapter for
instructions on using the Force Time
and Date dialog box.

delete the currently-displayed force or
auto time and date.

Force using:
Local precedence
Remote precedence set the force level to either a local or

remote ComfortVIEW force. Remote
forces have a higher precedence than
local. The word Supervisor (for local
ComfortVIEW forces) or Remote
Monitor (for remote ComfortVIEW
forces) appears in the points status
column to indicate the type of
ComfortVIEW force that is in effect.

New add a point to this timed force group.
The Point Selection dialog box will be
displayed. Select the point from the
area, element, category, table, and
point drop down lists. If necessary,

       (continued)

Table 8-2
Timed Force Points
Dialog Box
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Click on To

Refer to Table and Figure 4-13 in this
manual's WorkSPACE Manager
chapter for instructions on using the
Point Selection dialog box.

Delete delete the selected point from this
timed force group.

the Value cell (double click) to specify the force value for the
selected point. The Force dialog box
will be displayed. Enter the desired
override value. If necessary, refer to
Table and Figure 2-23 in this manual's
Carrier Network Manager chapter for
instructions on using the Force dialog
box.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

You can configure ComfortVIEW to transmit point data from one
CCN system element to another, or to broadcast data from one CCN
system element onto the CCN Bus. You can create up to 99 different
point transfer instances.

Follow the steps below to set up, modify, or delete a point transfer
or broadcast:

1. Click on the Functions menu item and then click on Point
Transfer.

The Point Transfer dialog box is displayed. This dialog box displays
a list of up to 99 point transfer/broadcast instances. A Modify button
will be displayed next to those point transfers that are currently

Table 8-2
Timed Force Points
Dialog Box
(continued)

Point Transfer/
Broadcast
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configured. A New button will be displayed next to the
unconfigured transfer instances. As you scroll through the list, each
transfer's associated point transfer information, including error
reporting for unprocessed transfers/broadcasts, will be displayed in
the lower section of the dialog box.

2. In the Point Transfer dialog box, you can do the following:

• Click on New to define a new or on Modify to modify an
existing point transfer/broadcast. The Modify Point
Transfer dialog box will be displayed. Use this dialog
box to specify or modify your point transfer/broadcast
information. Refer to Figure and Table 8-4.

• Click on Delete to delete an existing point transfer/
broadcast.

3. Click on OK to close the Point Transfer dialog box and save
your settings or on Cancel to close the dialog box without
savings settings.

At start-up, ComfortVIEW will issue all enabled transfers/broad-
casts, then schedule subsequent transfers/broadcasts based on the
configured frequency. Any new or modified point transfers/broad-
casts will execute immediately, then scheduled according to the
indicated frequency. Errors will be reported in the Point Transfer
dialog box.
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Figure 8-3
Point Transfer
Dialog Box

Click on To

New configure a new point transfer or
broadcast instance. The Modify Point
Transfer dialog box is displayed.
Refer to Table and Figure 8-4 for
instructions on using this dialog box.

Modify modify a point transfer or broadcast.
The Modify Point Transfer dialog box
is displayed. Refer to Table and
Figure 8-4.

Note: Double clicking on any point
transfer instance also will display this
dialog box.

OK close the dialog box and save the
changes made.

       (continued)

Table 8-3
Point Transfer
Dialog Box



525

Click on To

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-3
Point Transfer
Dialog Box
(continued)

Figure 8-4
Modify Point Transfer
Dialog Box

Click on To

Enabled enable or disable the functionality of
this transfer or broadcast.

Read from select the point to transfer or broad-
cast. The Point Selection dialog box
will be displayed. Select the point
from the area, element, category,

       (continued)

Table 8-4
Modify Point Transfer
Dialog Box
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Click on To

table, and point drop down lists. If
necessary, refer to Table and Figure 4-
13 in this manual's WorkSPACE
Manager chapter for instructions on
using the Point Selection dialog box.

Transfer specify this instance to be a point
transfer.

Write to select the point to which you wish to
transfer. The Point Select dialog box
will be displayed.

Force level
drop down list select the force level for point trans-

fers. You must select a force with a
higher level (which will appear above
this one in the drop down list.) Broad-
casts will automatically use a Control
force level.

Broadcast specify this instance to be a broadcast.

Name specify the point name that will
receive the broadcasted data.
ComfortVIEW will broadcast the
specified Read from point value to all
local CCN system elements contain-
ing this point name.

Frequency specify the time interval at which the
broadcasts/transfers of data will
execute. Point transfer allowable
entries:  1-240. Broadcast allowable
entries:  15-240.

OK close the dialog box and save the
changes made.
Note: Changes will not take effect
until you exit the previous (Point
Transfer) dialog box.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-4
Modify Point Transfer
Dialog Box
(continued)
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A ComfortVIEW server that has been configured to be a time
broadcaster (using the Enable Time Broadcast decision in the
Carrier Network Manager's Standard CCN Settings dialog box) will
send holiday status, along with the time, date, and day-of-week,
when broadcasting to all locally-connected CCNs. The holidays
which will be sent are read from the group of holidays that you
specify here by selecting the Functions menu's Holiday tables
command.

Selecting this command displays the Holidays dialog box. Use this
dialog box to select each holiday by clicking on a day in the calen-
dar. Select the month and year using the scroll bar.

For a list of all currently-configured holidays, select the File menu's
Print command.

The Global Function Manager gives you the ability to create master
occupancy (time) schedules and to link these schedules to up to 100
existing occupancy schedules in specified CCN system elements on
any locally-connected CCN. If desired, you can also create an
override schedule that will supersede the master schedule on a
specified day. Once a day (or when you manually select Download),
ComfortVIEW will download the master and any associated over-
ride time schedules to the specified system elements, override the
existing controller time schedules, and then update the local
ComfortVIEW database to match the newly-changed controller
databases. This function would be helpful in those situations, for
example, where there are a large number of CCN controllers in a
facility to allow you to quickly change all occupancy schedules at
once.

Follow the steps below to create a global occupancy schedule.

1. Click on the Functions menu item and then click on Central
Time Schedule.

The Central Time Schedules dialog box is displayed. Refer to
Figure and Table 8-5. This directory-tree structured dialog
box displays the names of all currently-existent master occu-
pancy schedules. Double-clicking on the name of a master
schedule displays the categories Links and Overrides.

Holiday Broadcast

Central Time
Schedules
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Double-click on either one of these categories to display the
names of the associated link and override schedules.

2. In the Central Time Schedules dialog box, you can do the
following:

• Define a new master time schedule by clicking on the
header Central time schedules and then clicking on New.
The Master Time Schedule dialog box will be displayed.
Refer to Figure and Table 8-6. Click to enable/disable
days of the week, and enter the Occupied From and To
times in the corresponding edit boxes. The bar graph will
update to display the occupied times.

• Create a new controller time schedule link or a new
override schedule by clicking on the name of an existing
master schedule and then clicking on New. The Link/
Override dialog box will be displayed. Refer to Figure
and Table 8-7. Select either Link or Override.

You could also create a new link or override by expand-
ing the directory tree, clicking on Links or Overrides, and
then clicking on New.

• Modify an existing master, link, or override schedule by
clicking on the name of the master, link, or override
schedule and then clicking on Modify. If you are modify-
ing a link, the Select Table dialog box will be displayed.
If you are modifying a master or override schedule, the
Master Time Schedule or Override Schedule dialog box
will be displayed. Refer to Figure and Table 8-6.

• Download a master schedule to all associated links and
override schedules, if appropriate, by clicking on the
name of the central schedule and then clicking on Down-
load.

• Delete an existing master, override, or linked schedule by
clicking on the schedule, override, or link name and then
clicking on Delete. In the confirmation dialog box, click
on Yes to delete the schedule, or on No to close the dialog
box without completing the deletion.

3. Click on OK to close the Central Time Schedules dialog box
and save your settings, or on Cancel to close the dialog box
without saving settings.
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Daily, at 3:00 am, ComfortVIEW will download each master sched-
ule to its set of linked schedules on the bus. It will also update the
corresponding linked schedules in the ComfortVIEW database. On a
given day, if an override schedule exists, the override schedule will
be used instead of the master.

Figure 8-5
Central Time Schedules
Dialog Box

Click on To

the header Central
time schedules and then
click on New add a new master time schedule. The

Master Time Schedule dialog box will
be displayed. Refer to Figure and
Table 8-6 for instructions on using
this dialog box.

an existing master schedule
name and then click on
New create a link to an existing controller

time schedule or a new override
schedule. The Link/Override dialog
box will be displayed. Refer to Figure
and Table 8-7 for instructions on
using this dialog box.

Note:   You can also create a new link
or override by expanding the directory
tree, clicking on Links or Overrides
and then clicking on New.

       (continued)

Table 8-5
Central Time Schedules
Dialog Box
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Click on To

an existing central, link,
or override schedule name
and then click on Modify modify an existing master, link, or

override schedule. Either the Select
Table, Master Time Schedule, or
Override Schedule dialog box will be
displayed. Refer to Figure and Table
8-6 for instructions on using the
Master Time or Override Schedule
dialog box. For instructions on using
the Select Table dialog box, refer to
Figure and Table 4-13 in this manual's
WorkSPACE Manager chapter.

an existing master schedule
name and then click on
Download send the master schedule or an over-

ride to the specified (linked) control-
lers. The download will overwrite the
specified controller time schedules,
and then update the local
ComfortVIEW database to match the
newly-changed controller databases.

an existing master schedule,
override schedule,
or link and then click on
Delete delete the selected link or schedule.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-5
Central Time Schedules
Dialog Box
(continued)
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Figure 8-6
Master or Override Time
Schedule Dialog Box

Click on To

the Description text box specify a name for this master sched-
ule. This name will be displayed in the
Central Time Schedules dialog box.

Enabled enable or disable the functionality of
this master schedule.

a Day of Week enable or disable a day of week for
this occupancy period.

Occupied
From specify the hour and minute, in mili-

tary format, at which this occupied
period begins.

Note:  You can also select this time by
left clicking on the desired time in the
Hours time bar.

To specify the hour and minute, in mili-
tary format, at which this occupied
period ends. The bar graph will update
to display the occupied times.

Note:  You can also select this time by
right clicking on the desired time in
the Hours time bar.

       (continued)

Table 8-6
Master or Override Time
Schedule Dialog Box
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Click on To

Override date select the month and date that the
(in Override Schedule only) override schedule will take prece-

dence over the master schedule. The
Override Date dialog box will be
displayed. Select the month and year
using the scroll bar. Select the date by
clicking on a day in the calendar.

Reset erase all current occupancy selections.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-6
Master Time Schedule
Dialog Box
(continued)

Figure 8-7
Link/Override Dialog Box

Click on To

Create link specify the controller occupancy
schedule that will be overridden by
this central schedule. The Select Table
dialog box will be displayed. If neces-
sary, you can refer to Figure and
Table 4-13 in this manual's
WorkSPACE Manager chapter for
instructions on using this dialog box.

Note: Up to a maximum of 100
different occupancy tables can
be linked to one central
schedule.

       (continued)

Table 8-7
Link/Override Dialog Box
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Click on To

Create override create a time schedule that will over-
ride this central schedule on a speci-
fied day. The Override Schedule
dialog box will be displayed. This
dialog box is the same as the Master
Time Schedule dialog box (shown in
Figure and Table x-x), with the only
difference being that the Override
Schedule dialog box contains an
Override date button. Clicking on this
button will display the Override Date
dialog box, where you enter the date
on which this schedule will override
the central schedule. Note that the
range of valid dates extends from
today's date to one year in the future.
This date will automatically apply for
consequent years.

Note: Up to a maximum of 366
overrides can be created for
one central schedule.

OK close the dialog box and save the
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table 8-7
Link/Override Dialog Box
(continued)
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The following table describes each of the commands that appear in
the Global Function Manager menus.

The following table describes each of the commands that appear in
the File menu.

Command Use this command to

Print print a report of timed force groups,
central time schedules, point transfers,
or holidays.

The Print dialog box displays. Select
the type of report to print.

Print Setup select a printer and printing options.
The Print dialog box displays. To
change the printer from the one dis-
played, click on the drop down list.
Click on Properties to access Page
Setup, orientation, and size options.

Exit exit the Global Function Manager
application.

The following table describes each of the commands that are in the
Functions menu

Command Use this command to

Timed Force automatically force and auto groups
of-specified points, based on user-
specified time parameters.

The Timed Force Groups dialog box
displays.

        (continued)

Global Function
Manager Menu
Command
Summary

File Menu

Table 8-8
File Menu

Functions Menu

Table 8-9
Functions Menu
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Command Use this command to

Central Time Schedule create global occupancy schedules.
The Central Time Schedules dialog
box displays. From this dialog box,
you can display, modify, or delete
existing, or create new master, linked,
and override occupancy schedules.

Point Transfer transmit point data from  one CCN
system element to another, or to
broadcast data from system element
onto the CCN Bus.

The Point Transfer dialog box dis-
plays. This dialog box displays a list
of up to 99 point transfer/broadcast
instances. From this dialog box you
can modify or delete an existing or
create a new point transfer/broadcast.

Holiday Tables specify the global holidays. If your
ComfortVIEW server is configured to
be a time broadcaster, it determines
the holiday status that will be broad-
cast to all locally-connected CCNs
along with time, date, and day-of-
week according to the holidays that
are specified here.

The Holidays dialog box is displayed.

Table 8-9
Functions Menu
(continued)
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The following table describes each of the commands in the Help
menu.

Command Use this command to

Contents display the help table of contents.

Search search for a help topic by typing a
keyword.

About display program information, version
information on all ComfortVIEW
components, and copyright.

Help Menu

Table 8-10
Help Menu



BEST++



Alarm Manager
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The ComfortVIEW BEST++ application gives you access to
Carrier's Building Environmental Systems Translator (BEST++)
custom programming language. This easy-to-use programming
language gives you the ability to write programs to supplement or
enhance the standard control algorithms that are resident in Carrier's
Comfort Controllers.

Instructions on operating the ComfortVIEW BEST++ application
are included in Appendix D of the BEST++ Programmer's Refer-
ence Manual (808-893). This manual can be ordered from Carrier
Literature Distribution.

ComfortVIEW
BEST++
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Consumable, runtime, and history reports are described in this
manual's Report Panel chapter. Other report types that are available
to you are described in Table A-1 below.

Report Type Contents

 System Activity ComfortVIEW "system-type" events;
refer to Table A-4 for a list of the
events that can be reported.

Alarm Summary Selected alarm information

Time Schedule Controller-by-controller occupancy
schedules and associated points

Tenant Billing Timed overrides and resulting charges

To produce any of these reports, you need to first create a report
definition, and then generate the report. The remainder of this
appendix describes how to create report definitions for each of the
above report types; see the Report Panel chapter for instructions on
generating reports.

Follow these steps to create a report definition for a System Activity
report:

1. Launch the Report Panel application by double-clicking on
the Report Panel icon (shown at left).

2. Double-click on the System Activity icon (shown at left). You
will see a list of the existing System Activity report definitions.

3. Click on the File menu item, then click on New. You can also
click on the Add New Report tool bar icon (shown at left).

ComfortVIEW displays a Report Definition dialog box,
shown in Figure A-2.

3. Use the Report Definition dialog box to enter the following:

• Report Name and Description
• Manual Generation or Automatic Retrieval Options
• Report Dates

Refer to Figure A-2 and Table A-2 for instructions on using
the Report Definition dialog box.

Table A-1
Additional Reports

Appendix A
— Additional
ComfortVIEW
Reports

Defining a System
Activity Report
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4. Click on the Events button to choose which types of system
events to include in the report. Refer to Selecting Events for
the Report, which appears later in this chapter, for informa-
tion on how to do this.

5. Click on the Format button to see a dialog box with various
report formatting options. These are described under Format-
ting a Report, which appears later in this chapter.

6. Click on OK to exit the Report Definition dialog box and save
changes, or click on Cancel to exit the dialog box without
saving changes.

ComfortVIEW re-displays the System Activity Report Defini-
tion list.

The Report Definition dialog box works much the same way for
System Activity, Alarm Summary, Time Schedule, and Tenant
Billing reports. Table A-2 can be used as a reference for each; any
differences are noted in the table. The Tenant Billing Report Defini-
tion, though, does include some additional settings that are described
in Defining A Tenant Billing Report later in this chapter.

Report Definition

Report Name:

SYSTACT

Report Description:

System Activity Report

Automatic Generation Options
Enable automatic report generation

HP LaserJet III

Save tab-separated data file

Print to

X

X

Send report directly to CWREPORT

Manual Generation Options

Format...

Events...

Defaults

00:00  Nov 02, 1997

Events from:

Report Dates

23:59  Nov 09, 1997

Events through:

Save dates as relative

X

Range of times/dates

Yesterday

Today

OK Cancel Help...

Closes this dialog box and saves settings

. . .

. . .

Report Definition
Dialog Box

Figure A-2
Report Definition Dialog
Box for System Activity
Reports
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Click on To

the Report Name text box enter an up to 8 character name for the
report. This name identifies the report
in the report definition list.

the Report Description
text box enter an up to 48 character description

for the report. This name appears with
the report name in the report defini-
tion list. It is also the report title that
prints on the top line of the report.

Report Dates:
Yesterday use yesterday’s event data in the report.

Today create a report using today’s event
data. The report will contain today’s
data starting from midnight to the
current time.

Range of data create a report using data from a range
   Events from: of dates. Enter the date or click on the
   Events through: button to the right of the Events from:

and  Events through: dates to display
the Data Range dialog box. Refer to
Figure 7-5 and Table 7-5 in the Report
Panel chapter for instructions on using
the Data Range dialog box.

When defining a report based on a
single day's data, enter the corre-
sponding date in both the Events
from: and Events through: text boxes.

For Alarm Summary reports, the field
names are Alarms from and Alarms
through, but the functions are exactly
the same.

       (continued)

Table A-2
Report Definition
Dialog Box
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Click on To

Save dates as relative automatically adjust the Events from:
and Events through: dates relative to
the current date. For example, you
create a report definition on 8/10/97.
You specify the Events from: and
Events through: dates to be 8/3/97 and
8/10/97. On 8/18/97, you generate
another report from this existing
definition. ComfortVIEW will auto-
matically adjust these dates relative to
8/18/97.

Automatic Generation Options:

Enable automatic
report generation automatically, after data retrieval,

generate the specified report using the
data that is stored in the
ComfortVIEW database.

Save tab-separated
data file save the actual report that is created as

part of the  report generation process.
ComfortVIEW will save the report to
the CWORKS\REPORTS\report type
directory path (where report type  is
replaced by the type of report being
generated:  CONSUME, HISTORY,
RUNTIME, SYSTACT, etc.).
ComfortVIEW uses the following
report file naming convention:
Rptname.xxx  (where Rptname is
replaced by the eight character name
you enter in the Report Name text
box, and xxx is the report number
ranging from 001 to 999. Note that

       (continued)

Table A-2
Report Definition
Dialog Box (continued)
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Click on To

this number is incremented each time
you re-generate this report.)

You would only select this option if,
at some later time, you intend to use
the report in a word processing or
spreadsheet application.

the Print to: drop
down list select a printer on which to automati-

cally print the report. When several
printers exist in your system, this
option gives you the capability to
specify a different printer for each
report.

Manual Generation Options:

Send report directly
to CWREPORT
printer bypass the report viewer and print the

report without first displaying it. If
you do not enable this option,
ComfortVIEW will display the report
on-screen allowing you to view it
before printing it.

The report will print on the
CWREPORT printer that you create
in the Windows NT Print Manager.

Defaults select the following defaults:

  •  Enable automatic report generation
  •  Save tab-separated data file
  •  Save Dates as Relative
  •  Report Dates:  Data from 00:00
      yesterday to 23:59 today

       (continued)

Table A-2
Report Definition
Dialog Box (continued)
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Click on To

Events select the system activity events on
(System Activity only) which to report. ComfortVIEW

displays the Report Event Groups
dialog box, which lists the events that
will be included in the report, and
allows you to add and remove events.
See Figure A-3 and Table A-3 for
instructions on using this dialog box.

Filters select the CCN elements whose
(Alarm Summary only) alarms will be included in the report.

When you click this button, you will
see the Alarm Filters dialog box,
which lists the elements that will be
included in the report, and lets you
add and removeup to 48 elements.
Double clicking on an item moves it
from one list to the other.

CCN elements select the CCN elements whose
(Time Schedule only) schedules will be included in the

report. When you click this button,
you will see the CCN Elements dialog
box. This dialog box lists the elements
that will be included in the report, and
lets you add and remove up to 48
elements. Double clicking on an item
moves it from one list to the other.

Data tables select the tenants who will be included
(Tenant Billing only) in the report. When you click this

button, you will see the Data Tables
dialog box, which lets you add and
remove up to 48 tenants from the
report.

(continued)

Table A-2
Report Definition
Dialog Box (continued)
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Click on To

Format select the report format and sort order
in which report data will be presented.
ComfortVIEW displays the Report
Format dialog box. See Figure A-5
and Table A-5 for instructions on
using this dialog box.

The Report Format feature does not
apply to Time Schedule and Tenant
Billing reports.

OK close the dialog box and save changes
made.

Cancel exit the dialog box and restore the
previous settings. Any changes made
are not saved.

Help display help information.

Table A-2
Report Definition
Dialog Box (continued)
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ComfortVIEW lets you select which types of system events to
include in the report. When you click on the Events button in the
Report Definition dialog box, you will see the Report Event Groups
dialog box shown in Figure A-3.  The box on the right side list all
the different event groups which are not included in the report; the
box on the left lists all the event groups that are included. Table A-3
describes how to use the different controls in the dialog box to build
a list of event groups to include.

Alarm Summary, Time Schedule, and Tenant Billing reports all use
similar dialog boxes to select elements for their reports. The main
difference is that the labels within the box are different, reflecting
the different types of data each report includes. The Alarm Sum-
mary report uses the Alarm Filters dialog box; the Time Schedule
report uses the CCN Elements dialog box; and the Tenant Billing
report uses the Data Tables dialog box. Despite the different names,
they all function in basically the same way.

Following this section, see Table A-4 for a reference of the specific
events which are a part of each System Activity event group, and the
target outcomes for each group that will be included in the report.

Selecting Events
for the Report

Event groups in report:

Date/time of event

Report Event Groups

Select event groups to remove from the report

<< Add

Remove >>

Event groups not in report:

Alarms
Setup
Reports
WorkSPACEs
Remote
Operators
CCNs/Areas
CCN Elements
Option Tables
Time Schedules
Setpoint Tables
Configuration

OK Cancel Help...

Figure A-3
Report Event Groups
Dialog Box
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Click on To

an item in the Event groups
in report: list select an event group to re-

move from the report. Table
A-4 lists the specific events
associated with each event
group.

Remove remove a selected event group
from the report.

Note:  You can also remove an
item by double clicking on it.

an item in the Event groups
not in report: list select an event group to add

back to the Event groups in
report: list.

Add add a selected event group to
the report.

Note:  You can also add an
item by double clicking on it.

Select Area (Time Schedule
and Alarm Summary only) select the CCN area of the

desired element.

Select CCN (Tenant Billing only) select the CCN of the desired
tenants.

OK close the dialog box and save
changes made.

Cancel exit the dialog box and restore
the previous settings. Any
changes made are not saved.

Help display help information.

Table A-3
Report Event Groups
Dialog Box
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The table below lists the different event groups and the specific events
associated with each group. The target column lists the outcome of the
event. The target information is that which appears in the system
activity report. For example, the target of an access level addition (in
event group operators) would be the new access level name.

Group Associated Events Target

Logins Logins and logouts, n/a
Quiet time logouts

Alarms Alarm acknowledgements,
deletions, and suppressions # acknowledged,

deleted, or
suppressed

Setup Modify global setup parameters n/a

Add and delete workstation workstation
name

Add and delete alarm printers printer name

Modify custom units n/a

Reports Report definition additions,
modifications, and deletions rpt name and

description

Manual and automatic report
generations rpt name and

description

Report data imports CCN name,
table name and
description

WorkSPACEs WorkSPACE/ViewSPACE/Trend
additions, modifications, and
deletions name

Remote Manual and automatic connects to
and disconnects from remote CCNs CCN name

  (continued)

Table A-4
Event Groups and
Associated Events



549

Group Associated Events Target

Operators Access level additions,
modifications, and deletions access level
name
Operator profile additions,
modifications, and deletions operator profile
name

CCNs/Areas CCN additions, modifications,
and deletions CCN name

Area additions, modifications,
and deletions area name

NDS update polls and cold calls CCN name

Time/date broadcasts CCN name

CCN Elements CCN system element additions,
modifications, and deletions;
CCN system element moves;
CCN system element uploads
and downloads; CCN system
element verifications;
CCN element set time/date area name,

element name,
description,
address

Option Tables Consumable, runtime, history
table additions, modifications,
and deletions area name,

element name,
description,
address,
table name and
description

Time Schedules Time schedule uploads,
downloads, and modifications See option

tables

                                                       (continued)

Table A-4
Event Groups and
Associated Events
(continued)
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Group Associated Events Target

Setpoint Tables Setpoint table uploads,
downloads, and modifications See option

tables

Configuration Configuration table uploads,
downloads, and modifications See option

tables

FIDs FID point additions,
modifications, and deletions area name,

element name,
description,
address,
point name and
description

Comfort
Controllers Comfort Controller object

additions, modifications,
and deletions area name,

element name,
description,
address,
table name and
description,

Forces Point forces and autos;
Submaster point forces See FIDs

(plus value)

Table A-4
Event Groups and
Associated Events
(continued)
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ComfortVIEW gives you several options for customizing the ap-
pearance of your report. You can:

• sort the report in different ways
• include only system events which are coded as successes or

failures.

Use the Report Format dialog box (Figure A-5) to set these different
options. You can reach the Report Format dialog box by clicking on
the Format button in the Report Definition dialog box, as described
in Table A-2.

The Report Format dialog box is used by both the System Activity
and Alarm Summary reports; the only difference is that the Alarm
Summary report gives you a different list of options to include.

Table A-5 describes the options available in the Report Format
dialog box.

Sort order:

<< Add

Remove >>

Date/time of event
Event group
Operator name

Target

Available sort keys:

OK Cancel Help...

Include ...

Include only successes
Include only failures
Include both

Header every page
Page numbers

X

X

Report Format

Selects sort keys to remove

Formatting a Report

Figure A-5
Report Format
Dialog Box
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Click on To

the Sort order: list select a sort key. The report's data
will be sorted in the order that you
specify here. The precedence of
each sort is determined by its
position in the list. Once a key is
selected, use the up or down arrow
to reposition it.

the Available sort keys: list select a sort key to apply to the
report data. Click on Add to move
the sort to the Sort order list.
Figure A-5 shows the sort keys for
a System Activity report.

Add move the selected sort key from
the Available list to the Sort order
list. ComfortVIEW will now apply
this sort to the report data.

Remove remove the selected sort. The sort
key will move from the Sort order
list back to the Available list.

the up arrow increase the precedence of a
selected sort. The sort key will
move up in the Sort order list.

the down arrow decrease the precedence of a
selected sort. The sort key will
move down in the Sort order list.

Include
(System Activity only)

     Include only successes include only successfully-
completely events in the report.

    Include only failures include only failed events in the
report.

     Include both include both successes and failures
in the report.

       (continued)

Table A-5
Report Format
Dialog Box
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Click on To

Select components to include
(Alarm Summary only)

     Alarm message Include the message component of
the alarm.

     Custom message Include the custom message
component (if any) of the alarm.

     Acknowledgement For each alarm in the report,
include the acknowledgement
message.

     Operator note For each alarm in the report,
include the operator note, if any.

Select levels to include
(Alarm Summary only)

     Alarm Include alarms in the report.

     Alert Include alerts in the report.

     Return to normal Include return-to-normal messages
in the report.

OK close the dialog box and save
changes made.

Cancel exit the dialog box and restore the
previous settings. Any changes
made are not saved.

Help display help information.

Note that the Header every page and Page numbers fields are en-
abled, but appear dimmed. ComfortVIEW will automatically in-
clude this information on all pages of the system activity report.

On the following page is a sample System Activity Report.

Table A-5
Report Format
Dialog Box
(continued)

Sample Report
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To create a report definition for an Alarm Summary report, follow
these steps:

1. Launch the Report Panel application by double-clicking on
the Report Panel icon (shown at left).

2. Double-click on the Alarm Summary icon (shown at left).
You will see a list of all the existing Alarm Summary report
definitions.

3. Click on the File menu item, then click on New. You can also
click on the Add New Report icon on the tool bar (shown at
left).

ComfortVIEW displays a Report Definition dialog box
similar to the one shown in Figure A-6.

4. Use the Report Definition dialog box to enter the following:

• Report Name and Description
• Manual Generation or Automatic Retrieval Options
• Report Dates

Defining an
Alarm
Summary
Report

Figure A-6
Report Definition
Dialog Box for
Alarm Summary
Reports
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Refer to Table A-2 for instructions on using the Report
Definition dialog box.

5. Click on the Filters button to displhe Alarm Filters dialog box
where you can select the CCN elements whose alarms will be
included in the report. Double clicking on an item moves it
from one list to the other.

6. Click on the Format button to set the following report format
options:

• Sort the report in different ways
• Select which types of alarms to include in the report
• Include all of the alarm message or just certain compo-

nents.

Table A-5 in the Formatting a Report section earlier in this
chapter describes the Report Format dialog box in detail.

7. Click on OK to exit the dialog box and save changes, or click
on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the Alarm Summary Report
Definition list.

The facing page shows a sample Alarm Summary report.Sample Report
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11/05/97 Alarm Sumary Report Page1
08:43 Alarm Summary Report For November 4, 1997

=====================================================================================
ProgCentral - area RCSI 0,52 Alarm - 6 at 0:00 4-Nov-1997: Comm Failure on Element 8

ProgCentral - area RCSI 0,52 Alarm - 6 at 0:00 4-Nov-1997: Comm Failure on Element 24

ProgCentral - area RCSI 0,52 Alarm - 6 at 8:00 4-Nov-1997: Comm Failure on Element 8

ProgCentral - area RCSI 0,52 Alarm - 6 at 8:00 4-Nov-1997: Comm Failure on Element 24

ProgCentral - area RCSI 0,52 Alarm - 6 at 8:00 4-Nov-1997: Comm Failure on Element 24

ProgCentral - area RCSI 0,52 Alarm - 6 at 8:00 4-Nov-1997: Comm Failure on Element 112

ProgCentral - area RCSI 0,52 Alarm - 6 at 9:00 4-Nov-1997: Comm Failure on Element 24

ProgCentral - area RCSI 0,52 Alarm - 6 at 9:00 4-Nov-1997: Comm Failure on Element 112

ProgCentral - area RCSI 0,52 Alarm - 6 at 10:00 4-Nov-1997: Comm Failure on Element 24

ProgCentral - area RCSI 0,52 Alarm - 6 at 10:00 4-Nov-1997: Comm Failure on Element 112

ProgCentral - area AHU 0,90 Alarm - 2 at 10:20 4-Nov-1997: Space Temperature -10.0 dF outside limit of 45.0 dF.

ProgCentral - area AHU 0,90 Return to normal at 10:21 4-Nov-1997: Space Temperature.
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Defining a Time
Schedule Report

Figure A-7
Report Definition
Dialog Box for
Time Schedule
Reports

Time Schedule reports let you see occupancy schedules and associ-
ated points on a controller-by-controller basis. To create a report
definition for a Time Schedule report, follow these steps:

1. Launch the Report Panel application by double-clicking on
the Report Panel icon (shown at left).

2. Double-click on the Time Schedule icon (shown at left). You
will see a list of all the existing Time Schedule report defini-
tions.

3. Click on the File menu item, then click on New. You can also
click on the Add New Report icon on the tool bar (shown at
left).

ComfortVIEW displays a Report Definition dialog box
similar to the one shown in Figure A-7.

4. Use the Report Definition dialog box to enter the following:

• Report Name and Description
• Manual Generation or Automatic Retrieval Options

Refer to Table A-2 for instructions on using the Report
Definition dialog box.
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5. Click on the CCN Elements button to display the CCN Ele-
ments dialog box where you can select the CCN elements
whose schedules will be included in the report. Double
clicking on an item moves it from one list to the other.

6. Click on OK to exit the dialog box and save changes, or click
on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the Time Schedule Report Defini-
tion list.

The following page shows a sample Time Schedule report.Sample Report
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The Tenant Billing report lets you create reports showing the timed
override and resulting charges for each tenant you have defined as
part of your CCN. The timed override is the amount of time a tenant
has exceeded their scheduled occupancy hours. In order to create
Tenant Billing Reports, your CCN must include a Tenant Billing
Module. This is an optional piece of hardware which resides on the
CCN and collects the data needed for the report.

To create a Tenant Billing report definition, follow these steps:

1. Launch the Report Panel application by double-clicking on
the Report Panel icon (shown at left).

2. Double-click on the Tenant Billing icon (shown at left). You
will see a list of all the existing Tenant Billing report defini-
tions.

3. Click on the File menu item, then click on New. You can also
click on the Add New Report icon on the tool bar (shown at
left).

Defining a Tenant
Billing Report

Figure A-8
Report Definition Dialog
Box for Tenant Billing
Reports
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ComfortVIEW displays a Report Definition dialog box
similar to the one shown in Figure A-8.

4. Use the Report Definition dialog box to enter the following:

• Report Name and Description
• Report Type
• Manual Generation or Automatic Retrieval Options
• Report Dates

Refer to Table A-2 for instructions on using the Report
Definition dialog box. Table A-9 describes additional report
definition features not described in Table A-2.

5. Click on the Data Tables button to display the Report Data
Tables dialog box where you can select the data tables that
will be included in the report. Generally, each customer's data
is stored in its own data table, so the Data Tables button lets
you select which customers to include in the report. Double
clicking on an item moves it from one list to the other.

6. Click on OK to exit the dialog box and save changes, or click
on Cancel to exit the dialog box without saving changes.

ComfortVIEW re-displays the Alarm Summary Report
Definition list.

To learn more about defining tenants and tenant billing, see the Tenant
Billing Option Overview and Configuration Manual (808-730).
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Click on To

Report
None deactivate the report definition.

Summary create a summary report, which shows
for each tenant the total override time
and total charges for each day.

Activity include for each tenant the summary
described above, plus an activity log
which shows each override instance
with zone name, override start time,
and requested time.

Automatic Generation Options:

Enable automatic
data retrieval automatically retrieves the tenant

billing data that is stored in the Tenant
Billing CIO Module. Otherwise, the
report will use the data that is stored
in the ComfortVIEW database.

Manual Generation Options:

Retrieve last
month's data include the previous month's billing

data in the report.

Retrieve this
month's data include the current month's billing

data in the report.

On the following pages are sample Tenant Billing Reports—a
Summary report, and an Activity report.

Table A-9
Additional Report
Definition Items for
Tenant Billing Reports

Sample Reports
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01/29/99
11:58 Tenant  Billing Report for January 1, 1999 to January 31, 1999                                   Page 1

General Insurance Incorporated
New York,  New York

Summary Report

Timed
Override
Duration Rate Cost

Day (hh:mm) ($/hour) ($0.00)
======== ======== ============ ============

January-1999 1 2:40 1.00 2.67
2 1:49 1.00 1.82
7 0:35 1.00 0.58
8 1:05 1.00 1.08

10 0:55 1.00 0.92
11 2:00 1.00 2.00
14 1:05 1.00 1.08
15 1:00 1.00 1.00
19 0:30 1.00 0.50
21 0:40 1.00 0.67

_________ _________
12:19 12.32

N  =  No data;  I  =  Oncomplete data;   M  =  Database mismatch;   C  =  Communication failure
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Activity Report
Timed Override

Start Requested Total
Time Duration Duration

Day Zone (hh:mm) (hh:mm) (hh:mm)
======== ======== ===================================

January-1998 5 ZONE1 9:00 1:10 1:10

January-1998 9 ZONE1 22:00 0:40 0:40

January-1998 21 ZONE3 12:00 0:13 0:13

January-1998 22 ZONE3 12:00 0:14 0:14

January-1998 23 ZONE1 12:00 0:36 0:36

January-1998 24 ZONE1 12:00 0:20 0:20
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Appendix B —
CWACCESS.DLL

ComfortVIEW includes a dynamic-link library (DLL) which allows
third-party programs to access CCN system elements, central time
schedules, and occupancy and setpoint schedules. It also lets those
programs use Carrier's Autodial Gateway and Telink products to
connect to remote CCNs. This new DLL, CWACCESS.DLL, is
installed in the \CVIEW\Apps directory at the same time
ComfortVIEW is installed. The DLL is designed so that applications
which use it can work independently of ComfortVIEW. You do not
need to be logged in to ComfortVIEW to use the DLL, nor does
ComfortVIEW need to be installed on the machine from which you
are accessing the DLL's functions. ComfortVIEW must however, be
installed and running on a ComfortVIEW server computer that is
located on the same network as the computer from which you are
accessing this DLL.

The DLL provides the following functions:

CW_InitLib
CW_GetErrorBuffer
CW_CloseLib
CW_OpenOccupancyTable
CW_CloseOccupancyTable
CW_ReadPeriod
CW_WritePeriod
CW_OpenSetPointTable
CW_CloseSetPointTable
CW_ReadSetPoint
CW_WriteSetPoint
CW_ConnectToRemoteCCN
CW_DisconnectFromRemoteCCN

The following sections describe each of these functions, including
return values and parameters, C++ prototypes from the DLL, and
sample Visual Basic declarations and function calls.

Note that for those functions which return string values to their
parameters, the parameter variable must be initialized with some
value (not just declared or dimensioned) before the function is
called. You must use the CW_InitLib function to establish the
connection to the ComfortVIEW server before using any of the
other functions. For all functions (except for CW_CloseLib and
CW_GetErrorBuffer), the result should be checked for an error; use
the CW_GetErrorBuffer function to display the actual error.

Overview
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int CW_InitLib(char *Server)

This function initializes the connection to the ComfortVIEW server.
This connection must be established before any tables or setpoints
can be read or written to.

Parameters–
Server The name of the ComfortVIEW Server

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_InitLib Lib
“CWACCESS.DLL”  (ByVal Server As String) As Integer

Example–
Server = “ \\ProgCentral2”
Result = CW_InitLib(Server)

int CW_GetErrorBuffer(char *ErrBuf)

This function retrieves any error messages that are produced by any
CWACCESS function. It will retrieve up to 255 characters from the
Error Queue, and will also retrieve multiple error messages.

Parameters–
ErrBuf A string of up to 255 characters which stores an

error message

Return Value–
The value 0 indicates that there are still error messages in the
error buffer; a positive value indicates there are no more
error messages.

CW_InitLib()

CW_GetErrorBuffer()
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Sample Declaration–
Public Declare Function CW_GetErrorBuffer Lib
“CWACCESS.DLL”  (ByVal ErrBuf As String) As Integer

Example–
ErrBuf = String(255, 0)
ErrResult = CW_GetErrorBuffer(ErrBuf)
While ErrResult = 0

MsgBox “Error Detected = “  & ErrBuf
ErrResult = CW_GetErrorBuffer(ErrBuf)

Wend

In the above example, CW_GetErrorBuffer is called in a While loop
to ensure that all error messages will be displayed.

void CW_CloseLib()

This function terminates the connection to the ComfortVIEW
server.

Parameters–
None

Return Value–
None

Sample Declaration–
Public Declare Sub CW_CloseLib Lib “CWACCESS.DLL”  ()

Example–
Call CW_CloseLib

CW_CloseLib()
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int CW_OpenOccupancyTable(unsigned long CCNNumber, un-
signed short Bus, unsigned short Controller, unsigned short
OccupancyTableNumber, char * OccupancyTableName, unsigned
short *TableID)

This function opens the time schedule for the controller which is
specified by the function’s arguments. The table to be opened can be
specified by either its name or number. If the value of Occupancy-
TableNumber = 0, the function will use the string stored in
OccupancyTableName to identify the desired table. If Occupancy-
TableNumber contains a valid table number, it will open the table
and return its name in OccupancyTableName. When a table has
been successfully opened, a system-generated integer is returned to
TableId. This number is then used by the CW_CloseOccupancy-
Table, CW_WritePeriod and CW_ReadPeriod functions to identify
the appropriate table.

This function can also be used to open the Central Time Schedule.
To open the Central Time Schedule, use the following arguments:
CCNNumber, Bus, and Controller must be 0, and the Occupancy-
TableName must be a name of the Central Time Schedule.

Parameters–
CCNNumber The CCN number of the controller

whose occupancy table you want
to open

Bus The number of the CCN bus the
controller is on

Controller The ID number of the controller
OccupancyTableNumber  The controller’s occupancy table

number
OccupancyTableName The controller’s occupancy table

name
TableId Returns the table id of the opened

table

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

CW_OpenOccupancyTable()
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Sample Declaration–
Public Declare Function CW_OpenOccupancyTable Lib
“CWACCESS.DLL”  (ByVal CCNNumber As Long,
ByVal Bus As Integer, ByVal Controller As Integer, ByVal
OccupancyTableNumber As Integer, ByVal
OccupancyTableName As String, TableId As Integer) As
Integer

Example–
CCNNumber = 1
Bus = 0
Controller = 10
OccupancyTableNumber = 1
OccupancyTableName = String(255, 0)
TableId = 0
Result = CW_OpenOccupancyTable(CCNNumber, Bus,
Controller, OccupancyTableNumber,
OccupancyTableName, TableId)

int CW_CloseOccupancyTable (unsigned short TableId, int
Saveflag)

This function closes the occupancy table specified by TableId. You
can can also set SaveFlag to save any changes made to the table
with the CW_WritePeriod function. The results of the function
CW_WritePeriod will not be stored in the database until the
CW_CloseOccupancyTable function is called with a non-zero value
for Saveflag.

If the CW_CloseOccupancyTable function fails, it may fail at
different stages of completion. The function GetErrorBuffer will
display the extent of the error. If the error indicates that a table is
successfully downloaded into the ComfortVIEW database but not
downloaded into the controller, the table will not be downloaded
into the controller at a later time automatically by ComfortVIEW.

CW_CloseOccupancyTable()
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Parameters–
TableId This is the TableId obtained from the

CW_OpenOccupancyTable Function.
Saveflag If this flag is set to a non-zero value the table will

be saved to the database and downloaded to the
controller. If it is set to zero any changes will not
be saved

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_CloseOccupancyTable Lib
“CWACCESS.DLL”  (ByVal TableId As Integer, ByVal
Saveflag As Integer) As Integer

Eaxmple–
Saveflag = 1
Result = CW_CloseOccupancyTable(TableId, Saveflag)

int CW_ReadPeriod (unsigned short TableId, unsigned short
PeriodNumber, unsigned short *DOWFlags, unsigned short
*OccupiedStartHour, unsigned short *OccupiedStartMinute, un-
signed short *OccupiedEndHour, unsigned short
*OccupiedEndMinute)

This function reads an Occupancy Period based upon the TableId
and the PeriodNumber. The period is specified as the days of the
week, and a start and end time. The table to be read must have been
opened with the CW_OpenOccupancyTable function prior to calling
this function. When the table is opened, the CW_OpenOccupancy-
Table function returns the TableId value which is used by the
CW_ReadPeriod function to identify the proper table.

CW_ReadPeriod()
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Parameters–
TableId This value is supplied by the

CW_OpenOccupancyTable function
PeriodNumber The period number to read
DOWFlags Returns a packed byte representing

the days of the week and holidays in
the following manner: MTWTFSSH

OccupiedStartHour Returns the start hour of period 0–24
OccupiedStartMinute Returns the start Minute of period

0–59
OccupiedEndHour Returns the end hour of period 0–24
OccupiedEndMinute Returns the end Minute of period

0–59

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_ReadPeriod Lib
“CWACCESS.DLL”  (ByVal TableId As Integer, ByVal
PeriodNumber As Integer, DOWFlags As Integer,
OccupiedStartHour As Integer, OccupiedStartMinute As
Integer, OccupiedEndHour As Integer, OccupiedEndMinute
As Integer) As Integer

Example–
PeriodNumber = 1
DOWFlags = 0
OccupiedStartHour = 0
OccupiedStartMinute = 0
OccupiedEndHour = 0
OccupiedEndMinute = 0
Result = CW_ReadPeriod(TableId, PeriodNumber,
DOWFlags, OccupiedStartHour, OccupiedStartMinute,
OccupiedEndHour, OccupiedEndMinute)
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The DOWFlags are stored as a packed byte. The sample code below
shows a way to translate the data to a more usable form.
CheckDay0–CheckDay8 are eight variables which correspond to the
MTWTFSSH of the DOWFlags; 1 indicates that the day is in the
period, 0 indicates that it is not.

DOWMask(8) As Integer
DOWMask(0) = 128
DOWMask(1) = 64
DOWMask(2) = 32
DOWMask(3) = 16
DOWMask(4) = 8
DOWMask(5) = 4
DOWMask(6) = 2
DOWMask(7) = 1

For key = 0 To 7
DayLoop = “CheckDay”  & key
If (DOWFlags And DOWMask(key)) Then

Me(DayLoop) = 1
Else

Me(DayLoop) = 0
End If

Next key

The Me(DayLoop) expression is used to access the variable name,
which is stored as a string in DayLoop and is a member of the
current Microsoft Access Form. This could also be accomplished in
Visual Basic by storing the values in an array.

int CW_WritePeriod(unsigned short TableId, unsigned short
PeriodNumber, unsigned short DOWFlags, unsigned short
OccupiedStartHour, unsigned short OccupiedStartMinute, unsigned
short OccupiedEndHour, unsigned short OccupiedEndMinute)

This function writes a period specification to the table specified in
TableId. The table to be written to must have been opened with the
CW_OpenOccupancyTable function prior to calling this function.
When the table is opened with this function, it returns the TableId

CW_WritePeriod()
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value which is used by the CW_WritePeriod function to identify the
proper table.

Note that the new period is not saved to the database until the table
is closed with the CW_CloseOccupancyTable function and a non-
zero SaveFlag. However, if you read this table before it is closed,
you will receive the new data.

Parameters–
TableId This value is supplied by the

CW_OpenOccupancyTable function
PeriodNumber The period number to read
DOWFlags Returns a packed byte representing

the days of the week and holidays in
the following manner: MTWTFSSH

OccupiedStartHour Returns the start hour of period 0–24
OccupiedStartMinute Returns the start Minute of period

0–59
OccupiedEndHour Returns the end hour of period 0–24
OccupiedEndMinute Returns the end Minute of period

0–59

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_WritePeriod Lib
“CWACCESS.DLL”  (ByVal TableId As Integer, ByVal
PeriodNumber As Integer, ByVal DOWFlags As Integer,
ByVal OccupiedStartHour As Integer, ByVal
OccupiedStartMinute As Integer, ByVal OccupiedEndHour
As Integer, ByVal OccupiedEndMinute As Integer) As
Integer
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Example–
TableId = TableId
PeriodNumber = 1
OccupiedStartHour = 5
OccupiedStartMinute = 30
OccupiedEndHour = 18
OccupiedEndMinute = 15
Result = CW_WritePeriod(TableId, PeriodNumber,
DOWFlags, OccupiedStartHour,
OccupiedStartMinute, OccupiedEndHour,
OccupiedEndMinute)

The DOWFlags are stored as a packed byte. The sample code below
shows a way to translate the data to a more usable form.
CheckDay0–CheckDay8 are eight variables which correspond to the
MTWTFSSH of the DOWFlags; 1 indicates that the day is in the
period, 0 indicates that it is not.

DOWMask(8) As Integer
DOWMask(0) = 128
DOWMask(1) = 64
DOWMask(2) = 32
DOWMask(3) = 16
DOWMask(4) = 8
DOWMask(5) = 4
DOWMask(6) = 2
DOWMask(7) = 1

DOWFlags = 0
For key = 0 To 7

DayLoop = “CheckDay”  & key
If (Me(DayLoop) <> 0) Then

DOWFlags = DOWFlags Or DOWMask(key)
End If

Next key
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int CW_OpenSetPointTable (unsigned long CCNNumber, unsigned
short Bus, unsigned short Controller, char * SetPointTableName,
unsigned short *SetPointTableId, unsigned short *SetPointCount)

This function opens the setpoint table which is identified by the
function’s arguments: CCN number, bus number, controller element
number, and table name. When a setpoint table has been success-
fully opened, a system-generated integer is returned to SetPoint-
TableId. This number is then used by the CW_CloseSetPointTable,
CW_WriteSetPoint and CW_ReadSetPoint functions to identify the
appropriate table.

Parameters–
CCNNumber The CCN number of the controller

whose setpoint table you want to
open

Bus The number of the CCN bus the
controller is on

Controller The ID number of the controller
SetPointTableName The controller’s setpoint table name
SetPointTableId Returns the table id of the opened

table
SetpointCount Returns the number of points in the

setpoint table

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_OpenSetPointTable Lib
“CWACCESS.DLL”  (ByVal CCNNumber As Long, ByVal
Bus As Integer, ByVal Controller As Integer, ByVal
SetPointTableName As String, SetPointTableId As Integer,
SetPointCount As Integer) As Integer

CW_OpenSetPointTable()
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Example–
CCNNumber = 1
Bus = 0
Controller = 10
SetPointTableName = String(255, 0)
SetPointTableName = “SS01”
SetPointTableId = 0
SetPointCount = 0
Result = CW_OpenSetPointTable(CCNNumber, Bus,
Controller, SetPointTableName, SetPointTableId,
SetPointCount)

int CW_CloseSetPointTable (unsigned short SetPointTableId, int
Saveflag)

This function closes the setpoint table specified by SetPointTableId.
You can can also set SaveFlag to save any changes made to the table
with the CW_WriteSetPoint function. The results of the function
CW_WriteSetPoint will not be stored in the database until the
CW_CloseSetPointTable function is called with a non-zero value
for Saveflag.

If the CW_CloseSetPointTable function fails, it may fail at different
stages of completion. The function GetErrorBuffer will display the
extent of the error. If the error indicates that a table is successfully
downloaded into the ComfortVIEW database but not downloaded
into the controller, the table will not be downloaded into the control-
ler at a later time automatically by ComfortVIEW.

Parameters–
SetPointTableId This is the SetPointTableId obtained from

the CW_OpenSetPointTable Function.
Saveflag If this flag is set to a non-zero value the

table will be saved to the database and
downloaded to the controller. If it is set to
zero any changes will not be saved

CW_CloseSetPointTable()
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Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_CloseSetPointTable Lib
“CWACCESS.DLL”  (ByVal SetPointTableId As Integer,
ByVal Saveflag As Integer) As Integer

Example–
Saveflag = 1
Result = CW_CloseSetPointTable(SetPointTableId,
Saveflag)

int CW_ReadSetPoint(unsigned short SetPointTableId, unsigned
short PointNumber, char *Description, char *Name, double *Value,
char *Units, double *HighLimit, double *LowLimit, char *Notes)

This function reads the setpoint information for the setpoint speci-
fied by the function’s arguments.

Parameters –
SetPointTableId This is the SetPointTableId returned by

CW_OpenSetPointTable.
Point Number The number of the point to read.
Description This string returns the description.
Name This string returns the point’s name.
Value Returns the value of the point.
Units This string returns the units of the point’s

value and limits.
HighLimit Returns the maximum value the point can

hold.
LowLimit Returns the minimum value the point can

hold.
Notes This string returns the point’s notes.

CW_ReadSetPoint()
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Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_ReadSetPoint Lib
“CWACCESS.DLL”  (ByVal SetPointTableId As Integer,
ByVal PointNumber As Integer, ByVal Description As
String, ByVal Name As String, Value As Double, ByVal
Units As String, HighLimit As Double, LowLimit As
Double, ByVal Notes As String) As Integer

Example–
PointNumber = 1
Name = String(15, 0)
Units = String(10,0)
Value = 0
HighLimit = 0
LowLimit = 0
Description = String(255,0)
Notes = String(255,0)
Result = CW_ReadSetPoint(SetPointTableId, PointNumber,
Description, Name, Value, Units, HighLimit, LowLimit,
Notes)

int CW_WriteSetPoint(unsigned short SetPointTableId, unsigned
short PointNumber, char *Description, double Value)

This function writes a value to the table and setpoint specified by
the function's arguments. This information is not saved to the data-
base until the table is closed by CW_CloseSetPointTable function
with a non-zero SaveFlag; however, if you read this table before it is
closed, you will receive the new data. Value is the only field that
can be changed in a setpoint table. If the value of PointNumber = 0,
the function will use the string stored in Description to identify the
desired point.

CW_WriteSetPoint()



581

Parameters–
SetPointTableId This is the SetPointTableId returned by

the CW_OpenSetPointTable function
PointNumber The number of the point to write to.
Description The description of the point to write to.

If PointNumber < > 0, this parameter can
be left blank.

Value The value to set the point to.

Return Value–
The function returns 0 if there is no error; any other value
indicates an error. (See the description of CW_GetError-
Buffer() for more information on CWACCESS errors.)

Sample Declaration–
Public Declare Function CW_WriteSetPoint Lib
“CWACCESS.DLL”  (ByVal SetPointTableId As Integer,
ByVal PointNumber As Integer, ByVal Description As
String, ByVal Value As Double) As Integer

Example–
PointNumber = 1
Value = 100.4
Description = String(255,0)
Result = CW_WriteSetPoint(SetPointTableId, PointNumber,
Description, Value)

int CW_ConnectToRemoteCCN(char *RemoteCCNName)

This function establishes a connection to a remote CCN.

Parameters–
RemoteCCNName The name of the remote CCN to connect

to

Return Value–
The function returns 0 if the connection was established
successfully; any other value indicates an error. (See the
description of CW_GetErrorBuffer() for more information
on CWACCESS errors.)

CW_ConnectToRemoteCCN()
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Sample Declaration–
Public Declare Function CW_ConnectToRemoteCCN Lib
“CWACCESS.DLL”  (ByVal CCNName As String) As
Integer

Example-
Rname = "RemoteSite"
Result = CW_ConnectToRemoteCCN(Rname)

int CW_DisconnectFromRemoteCCN(char *RemoteCCNName)

This function terminates the connection to a remote CCN.

Parameters-
RemoteCCNName The name of the remote CCN to

disconnect from.

Return Value-
The function returns 0 if the connection was terminated
successfully; any other value indicates an error. (See the
description of CW_GetErrorBuffer() for more information
on CWACCESS errors.)

Sample Declaration-
Public Declare Function CW_DisconnectFromRemoteCCN
Lib "CWACCESS.DLL" (ByVal CCNName As String) As
Integer

Example-
Rname = "RemoteSite"
Result = CW_DisconnectFromRemoteCCN(Rname)

CW_DisconnectFromRemoteCCN()
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Index

A
Access Levels

assigning to operators 401
creating 395
defining 392
deleting 395
functions 394
modifying 395

Accessing
Alarms 328
Carrier Network Manager 32
Global Function Manager 517
Report Panel 451
Setup 385
WorkSPACE Manager 216

Acknowledging
alarms 341

Adding
access levels 395
alarm printer 422
areas 54
Consumable Tables 123
controllers 60
custom alarm messages 354
data box 275
History Tables 124
LAN Workstation 419
link area 275
new CCN 39
operators 386, 389
option tables 120
port locations 422
remote sites 209
report definition 457
Runtime Tables 123
system elements 60
trends 279
ViewSPACEs 245

Adjusting
columns 76

Alarm
accessing 328
acknowledging 341
assigning a WorkSPACE 361
attaching a WorkSPACE 360
attaching custom messages 353
attaching operator note 343
audio configuration 353, 415
beeping 326
critical 327, 408, 409
definition 324
deleting 349
disabling 346
enabling 346
Export command 374
export to clipboard com-

mand 376
filters 408, 411, 413
flashing icon 326, 328

icons 332
icons, pop-up window 329
indication 325
indication preferences 327
levels 335
linking messages to other applica-

tions 178
menu commands 374
message, contents 334
message, example 333
message format 333
modifying alarm WorkSPACE 363
pop-up window 326, 328, 329
pop-up window, example 328
printing automatically 352
purging 432
selecting 340
specifying indication prefer-

ences 405
specifying printers 417
specifying your own indication

preference 406, 407
suppressing 346
toolbar, explanation 331
viewing new and unacknowl-

edged 328
viewing suppressed 347
wildcards 370

Alarm Acknowledger 51
Alarm History Tables

displaying 81
Alarm List

color 371
example 330
font 336
printing 350
sorting 338
status bar 335
updating 337
viewing 330

Alert
definition 324

Analog States
defining 425

Animated Data Box
definition 214

Animated Graphic
specifications 299

Archiving
trend data to file 232

Area(s)
adding 54
definition 54
deleting 57
displaying a list 33
displaying a list, short-cut 34
modifying name 55

Assigning
WorkSPACEs to alarms 361

Attaching
alarm operator note 343
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custom alarm messages 353
operator note 343
WorkSPACEs to incoming

alarms 364
Audio Configuration

alarms 353, 415
Autodial Gateways

assigning operations 47, 166
connecting to remote CCNs 169

Autoing
Maintenance Tables 94, 517
points 94, 517
status display or maintenance

table values 517
Status Display Tables 94, 517

Automatic Retrieval Options
report definition 461, 542, 563

B
Basic Bus Scan 82, 84, 89
Beeping sound

alarm indication 326
BEST++

accessing 537
configuration and maintenance

tables 161
Bookmark

definition 214
jumping to WorkSPACEs 224
placing 224
removing 224
run mode 224

Broadcasting
point data 522
time of day, date, day of week,

holiday status 118, 527
Bus Scan 82

C
Carrier Network Manager

accessing 32
commands 179
Font Command 193
Gateways Commands 192
launching 32
NDS - Update Poll Command 191
overview 32
Print Setup Command 180
toolbar 36

CCN Options
alternate method for adding/

modifying tables 120
deleting tables 127
displaying 125
displaying/configuring 120
modifying 125
modifying table descriptions 126

CCN(s)
accessing database only 44
accessing local workstations 45
accessing remote workstations 45
adding 39
adding direct local connec-

tion 40
adding modem connection 41
adding remote-gateway 41
deleting 56
displaying the list 33
exporting 433
importing 437
modifying access parameter 49
modifying name 49
modifying number 49
number, purpose 43

Cell
copying/pasting data 103
definition 74, 80

Central Time Schedules
creating 527

Client
definition 201

Cloning
WorkSPACEs 246, 261, 283, 301

Colors
alarm list 371

Columns
adjusting 76
hiding 76
showing 76

Comfort Controller Reference
Jumps 81

ComfortVIEW
command menu conventions 22
help 25
logging out 10
related documentation 6
window elements 18

ComfortVIEW Database
off-line preparation 63
uploading to 63

ComfortVIEW database
adding a controller 60

Commands
Alarm Menu 374
Carrier Network Manager 179
keyboard selection 23
menu convention 22
mouse selection 23
Report Definition List 503
Report Panel 501
Setup Menu 443
WorkSPACE Manager 301

Configuration Data
downloading from ComfortVIEW to

controllers 115
exporting 163
uploading from controllers to

ComfortVIEW 116

verifying 114
Configuration Tables

copying 63
displaying 78, 81
displaying Setpoint and Occu-

pancy graphically 80, 198, 320
displaying UT203 FID 80
example 79
format 80
importing from 63
modifying decision descrip-

tions 103, 106
modifying values 97
multiple instances of data 80
types 79, 161
use 78, 81
viewing 78, 81

Configuring
CCN Options 120
Comfort Controllers 132
UT203 FIDs 128, 132

Connecting
remote CCNs 169, 290
remote server workstation 205

Consumable Report
contents 451
Daily, sample 510
defaults 466
explanation 475
Monthly, sample 511
required conditions for 482
Yearly, sample 512

Consumable Tables
configuring in CCN Options 120
configuring in Comfort Control-

lers 146
Controller Configuration Data

exporting 163
Controller Database Report 171

printing 172
Controller List

displaying 34
modifying table names/descrip-

tions 104
sorting 59

Controller List Report
printing 172

Controller List Window
displaying 58
example 58, 71

Controllers
adding 60
definition 30, 58
deleting 69
modifying description 66
modifying name 66
modifying sort key 66

Copying
configuration data by drag and

drop 108, 110
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configuration data with Copy
command 109, 111

configuration table values 103
configuration tables 63
individual tables 110
Maintenance Table Values 96
report definition 458
Status Display Table Values 96

Copying and Moving Controller
Configuration Data 107

Creating
access levels 395
report definition 457
report text files 494
tabular ViewSPACE dis-

plays 277, 318
trends 279
ViewSPACEs 245, 255, 256
WorkSPACEs 245

Critical Alarm
enabling visual indication of 409
indication 327

Critical Alarm Threshold 408
Custom Alarm Messages

assigning to incoming alarms 353
Custom Engineering Units

analog states 425
defining 425
discrete states 425

Customizing
point displays 75

CWREPORT printer option. 485

D
Data Box

adding 275
animated, definition 214
cascading 318
definition 214
deleting 274
modifying 263
modifying location 273
modifying parameters 273
modifying size 273
viewing description 235
viewing point name and descrip-

tion 235
Data Box Frame

guidelines for creation 298
Data Point

parameters/values 235
report definition 466, 470
selection 267
submaster 238

Data Range
report defini-

tion 460, 467, 468, 469, 541
Data Retention Period 428

Data Retrieval
retries 428
specifying time 428

Data Status
Report Panel 484

Date
modifying/sending 118

Day of Week
modifying/sending 118

DDE
required conditions 77, 175
sharing ComfortVIEW data with

other applica-
tions 77, 175, 241, 244

Decision Descriptions
green coloring 98
modifying 103, 106

Dedicating
Autodial Gateways 166

Defaults
Consumable/Runtime Reports 466
History Report 465

Defining
alarm printer names/port loca-

tions 422
analog states 425
custom engineering units 425
discrete states 425
LAN workstation 419
System Access Levels 392

Delete a ViewSPACE 278
Deleting

access levels 395
alarm printers 423
alarms 349
areas 57
CCNs 56
controllers 69
custom alarm messages 354
data box 274
LAN Workstations 420
link area 274
operators 390
option tables 127
port locations 423
remote sites 212
report definition 479
trend 288
WorkSPACEs 253

Deleting/Removing ViewSPACEs 278
Descriptions

modifying 104
modifying in option tables 126

Design Mode
definition 214
printing trend window 295
printing ViewSPACE 295

Detailed Bus Scan 82, 84, 90
Device Config Report 171
Dialog Box

explanation 24
sample 6

Disconnecting
remote CCN 170, 292
remote server workstation 208

Displaying
Configuration Tables 78, 81
Controller List Window 58
maintenance tables 70
option configuration tables 125
point IDs 77
point range, Y-axis 229
report definition list 454
status bar 454
status display tables 70
trend, run mode 226, 283
trend value 229
trends 225
UT203 FID configuration tables 80
ViewSPACE 233
WorkSPACEs 361
WorkSPACEs associated with

alarms 360
Downloading

configuration data from
ComfortVIEW to controller 115

to the Comfort Controller 158
Drag and Drop 98

copying configuration
data 108, 110

example 99
Drop Down List

WorkSPACE Manager 221
Dynamic Data Exchange

ComfortVIEW data 77, 175
required conditions 77, 175

E
Editing

report data 494
Exit the Tabular Display and Re-Size

Databoxes 278
Exporting

a CCN's database 433
command, Alarm Manager 374
Controller Configuration Data 163

Exporting to Clipboard
command, Alarm Manager 376

F
Fast User Switching 7
FIDs

configuring 128, 132
uploading 117

Filters
alarm 408, 411, 413

Font
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alarms, changing 336
Carrier Network Manager 193
changing in the Carrier Network

Manager 38
report definition, changing 480
Report Definition List 507

Force
clearing (autoing) 94, 517
definition 30
Maintenance Tables 92, 517
messages 75
notes 95
Status Display Tables 92, 517

Forcing
automatically 517
status display or maintenance

table values 92, 517
WorkSPACE values 241, 243

Frame Family 269
Function

definition 30

G
Gateways

assigning operations 166
Carrier Network Manager 192
connecting to remote CCNs 169

Generating
reports 481
reports, automatically 484
reports, manually 483, 484

Generation Options
report definition 464

Global Function Manager
accessing 517
commands 534
launching 517

Global Parameters
setup 430
specifying 428

Graphic Background
creating 256
specifications 255

Green Shading
on configuration decisions 98

H
Help

usage 25
Hiding

columns 76
History Report

contents 451
defaults 465
explanation 473
required conditions for 482
sample 516

History Tables

adding 124
configuring in CCN Options 120

Holiday Status
modifying/sending 118
specifying 527

I
Icons

alarm 332
alarm indicator window 329
Carrier Network Manager tool-

bar 36
flashing alarm 326, 328
Report Definition List 456
Report Panel 452
System Overview Window 35

Importing
a CCN's database 437
configuration tables 63
data to Consumable or Runtime

data files 495

J
Jumping

bookmarked WorkSPACE 224
from Comfort Controller status

display tables 70
from configuration

tables 81, 155, 156
from status display and mainte-

nance tables 70
from trends 231

K
Keyboard

functions 15
selecting commands 23
usage 14

L
LAN Workstation

adding 419
defining 419
deleting 420
setup 420, 421

Launching
areas, short-cut 34
Carrier Network Manager 32
CNM, short-cut 34
Report Panel 452
Setup 385
WorkSPACE Manager 217

Link Area
adding 275
deleting 274

modifying 270, 275
showing all 316

List Entry 153
to configure Comfort Control-

lers 153
Locking

a ViewSPACE 260
Logging In

automatic 431
Windows 6

Logging Out
ComfortVIEW 10
Windows NT 7

M
Magenta Shading

on point names 70, 81, 153, 156
Maintenance Tables

autoing 94
displaying 70
example 73
format 74
linking data to other PC applica-

tions 78, 81
messages 74
modifying (forcing) values 92
modifying point descriptions 96
viewing 70

Managing
report files 497

Manual Generation Options
report definition 464

Master and Override Time Schedules
creating 527

Menu
conventions 22

Menu Bar
WorkSPACE Manager 219

Menu Summary
Alarms 374
Carrier Network Manager 179
Report Definition List 503
Report Panel 501
Setup 443
WorkSPACE Manager 301

Messages
access denied 206
alarm, contents 334
alarm, example 333
alarm, format 333
alarm precedence 358
custom alarm 353
force 75
Maintenance Tables 74
Status Display Table 74

Mode
design, definition 214
design, printing trend window 295
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design, printing ViewSPACE 295
design vs. run 216
run, displaying trend 283
run, displaying ViewSPACE 233
run, jump to bookmarked

WorkSPACE 224
run, printing trend win-

dow 294, 306
run, printing ViewSPACE 294, 306
run, trend 226

Modem
compatibility 203
phone number pause 209
verifying 205

Modifying
access levels 395
alarm WorkSPACE 363
analog configuration values 97
analog points 92
area names 55
CCNs 49
configuration table values 97
controller description 66
controller name 66
controller sort key 66
custom alarm messages 354
data box 263
data box: parameters, location,

size 273
data point parameters 235
data point values 235
date 118
day of week 118
decision descriptions 103
descriptions, configuration table

decisions 103
discrete configuration table

values 97
discrete points 92
holiday status 118
link area 270, 275
Loadshed and Occupancy

Tables 104, 106
Maintenance Table values 92
operators 389
option configuration tables 125
option table descriptions 126
options tables 120
point descriptions, Maintenance

Tables 96
point descriptions, Status Display

Tables 96
remote sites 209
report definition 458
Status Display Tables 92
table names/descriptions 104
time 118
trends 279
ViewSPACE name 272

ViewSPACEs 272
WorkSPACEs 251

Mouse
selecting commands 23
terminology 13
usage 13

Moving
controllers between areas 112
split bar 59

N
Name

modifying controller descrip-
tion 66

NDS - Poll Command
Carrier Network Manager 191

NDS Diagnostics
enabling 51
specifying high priority system

elements 62, 68

O
Objects

definition 31, 215
Occupancy Tables

creating master and override 527
displaying in a graphical for-

mat 80, 199, 320
Opening

existing WorkSPACE 217
Operator Note

attaching 343
viewing 343

Operator Profiles
setting up 398

Operators
adding 386, 389
assigning access levels 401
deleting 386, 389
modifying 386, 389
specifying alarm indication

preferences 405
Options

alternate method for adding and
modifying tables 120

deleting tables 127
displaying 125
displaying and configuring 120
modifying 125
modifying table descriptions 126

Override and Master Time Schedules
creating 527

Overview
creating a new ViewSPACE 255
Report Panel 453
Report Viewer 488
WorkSPACE Manager 219

P
Pasting

cell data 96
configuration values 103
data into protected cells 97
incompatible data 97
individual tables 110
Maintenance Table Values 96
Status Display Table Values 96

Placing
bookmark, WorkSPACE 224

Point
definition 31

Point Data
broadcasting onto the CCN

Bus 522
linking to other applica-

tions 175, 176
transferring from one system

element to another 522
Point Descriptions

modifying Maintenance Tables 96
modifying Status Display Tables 96

Point Displays
customizing 75

Point IDs
displaying 77

Point Name
viewing 235

Point Range
Y-axis 229

Poke 92
poke 178
Polling

a CCN bus 82
Port Location

adding 422
deleting 423

Precedence
custom alarm message 358
WorkSPACE 369

Print Preview
printing from 487

Print Preview Mode 485
Print Setup

Carrier Network Manager 180
Printer

adding alarm 422
alarm setup 423
defining alarm printer names/port

locations 422
deleting 423
specifying alarm 417

Printing
Alarm List 350
alarms automatically 352
Carrier Network Manager

Data 171
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Controller Database Report 172
Controller List Report 172
report definition 480
System Overview 171
Table Window Report 171
trend definition report 295
trend window, run mode 294, 306
ViewSPACE report 295
ViewSPACE, run mode 294, 306
WorkSPACE Report 295

Privilege Levels
assigning 401
defining 392

Profiles
specifying operator 398

R
Reference Jumps

from Comfort Controller configura-
tion tables 80, 156

from Comfort Controller status
display tables 70

from trends 231
Reference Jumps from Comfort

Controller Status Dis 70
Remote Access

modem verification 205
required conditions for source

workstation 202
Remote CCNs

connecting/disconnect-
ing 169, 170, 290

Remote Server Workstation
access denied message 206
adding sites 209
connecting 205
deleting sites 212
disconnecting 208
modifying sites 209
phone number pause 209

Remote Site Manager 201
Removing

bookmark, WorkSPACE 224
status bar 454
trend 288, 306
ViewSPACE 279, 306

Report
printing trend definition 295
printing ViewSPACE 295
printing WorkSPACE 295

Report Data
creating text files 494
editing 494
importing to Consumable or

Runtime data files 495
number of days retained 429

Report Dates 460, 541
Report Definition

adding 457
copying 458
creating 457
modifying 458

Report Definition List
automatic retrieval op-

tions 461, 542
commands 503
Consumable Report defaults 466
data points 466, 470
data range 467, 468, 469
deleting 479
displaying 454
font, changing 480
Font Command 507
history defaults 465
icons 456
manual generation options 464
printing 480
range of data 460, 541
report dates 460, 541
report format 471
Runtime Report defaults 466
toolbar 455

Report Files
managing 497

Report Format
report definition 471

Report Panel
accessing 451
commands 501
Consumable Daily, sample 510
Consumable Monthly, sample 511
Consumable Report 451
Consumable Yearly, sample 512
data status 484
generating reports 481
generating reports automati-

cally 484
generating reports manu-

ally 483, 484
generating, required condi-

tions 481
History Report 451
History, sample 516
icons 452
initiating third party report applica-

tions 499
launching 452
new report profile 499, 500, 501
other required documenta-

tion 452
producing, overview 453
report types 451
Runtime Daily, sample 513
Runtime Monthly, sample 514
Runtime Report 451
Runtime Yearly, sample 515
Sample Reports 509
System Activity Report 539

Report Viewer

menu commands 490
overview 488

Reports
Carrier Network Manager 171
Controller Database 171
Device Config 171

Required Conditions
dynamic data exchange 77, 175
remote connection 202
report generation 481

Retrieval Options
report definition 461, 542, 563

Retry
data retrieval 428
number allowed 428

Run Mode
displaying trend 283
displaying VIewSPACE 233
jumping to bookmarked

WorkSPACE 224
printing trend window 294, 306
printing ViewSPACE 294, 306
trend 226

Runtime Report
contents 451
Daily, sample 513
defaults 466
example 477
Monthly, sample 514
required conditions for 482
Yearly, sample 515

Runtime Tables
configuring in CCN Options 120
configuring in Comfort Control-

lers 146

S
Samples

Consumable Daily 510
Consumable Monthly 511
Consumable Yearly 512
dialog box 6
History 516
illustration 5
instructions 4
Runtime Daily 513
Runtime Monthly 514
Runtime Yearly 515

Saving
trend data to file 232
trends 282
ViewSPACEs 271, 276
WorkSPACEs 249

Selecting
alarms 340

Server
definition 201

Setpoint Tables
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displaying in a graphical for-
mat 80, 198, 320

Setup
accessing 385
commands 443
global parameters 430
launching 385
overview 385

Shadow Controller 51, 86
Sharing

ViewSPACE data (DDE) 241, 244
Showing

columns 76
Sort Key(s)

modifying controller 66
numbers 62, 67
purpose 62, 67

Sort key(s) 59
definition 31

Sorting
alarms 338
controller list 59

Specifications
animated graphic 299

Specifying
global parameters 428

Speedy Data Entry
availability indication

use of in configuring Comfort
Controllers 153

use of in configuring other control-
lers 101

Split bar
moving 59

Standards
manual 3

Starting
trends 230

Status
report data 484

Status Bar
alarm list 335
Carrier Network Manager 33
displaying/removing 454
WorkSPACE Manager 229

Status Display Tables
autoing 94
displaying 70
example 72
format 74
messages 74
modifying (forcing) values 92
modifying point descriptions 96
viewing 70

Status Messages
Maintenance Tables 74
Status Display Tables 74

Stopping
trends 229

Submaster

data point 238
Suppressing

alarms 346
System Access Levels

defining 392
System Activity Report

contents 539
defaults 543
enabling tracking 431
event retention period 431

System Elements
adding 60

System Overview Report
printing 171

System Overview Window
displaying 32
example 34
icons 35

System Summary 82, 90
System Table

definition 31

T
Table Jumps

from configuration tables 80, 155
from status display and mainte-

nance tables 70
from trends 231
from ViewSPACEs 236

Table Names
modifying 104

Table Window Report
printing 171

Tables
deleting in CCN Options 127
modifying in CCN Options 126

Text
changing font in Carrier Network

Manager 38
Third Party Report Application

usage with Report Panel 499
Time

modifying/sending 118
Time Schedules

creating master and override 527
Timed Force 517
Toolbar

alarm 331
Carrier Network Manager 36
removing from System Overview

Window 36
Report Definition List 455
WorkSPACE Manager 221

Trend
adding 279
archiving/saving data to file 232
deleting/removing 288, 306
displaying run mode 283
displaying value 229

displaying/using 225
modifying 279
printing window, design

mode 295
printing window, run

mode 294, 306
range 287
run mode 226
saving 282
saving data to file 232
starting 230
stop 229
table and reference jumps

from 231

U
Update Poll

command 191
Updating

alarm list 337
Uploading

configuration data to
ComfortVIEW 116

Using
trends 225

Using the Report Viewer 485
UT203 FIDs

configuring 128, 132
uploading 117

V
Verifying

controller configuration vs.
ComfortVIEW database 114

modem 205
print results 114

Viewing
alarm list 330
Configuration Tables 78, 81
data box, point name and

description 235
data point parameters 235
data point values 235
maintenance tables 70
operator note 343
status display tables 70
suppressed alarms 347

ViewSPACE
adding 245
creating overview 255
definition 216
displaying 233
displaying data boxes in a cas-

caded format 318
general operation 234
locking 260, 318
modifying 272
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printing design mode 295
printing run mode 294
printing, run mode 306
re-arranging in a tabular display

format 277, 318
removing 279
saving 271, 276
sharing data (DDE) 241, 244
showing all link areas 316
table and reference jumps

from 236

W
Wildcards

alarm, custom messages 359
alarm WorkSPACE 370

Window
elements 18

Windows
logging in 6

Windows NT
logging out 7

Wizards
alarm 78, 233, 243
operator profile 389
report 78, 233, 244
trend 233, 244

Worksheet
keys 76
moving around in 76
short-cuts 76

WorkSPACE
assigning to alarms 361
associated with alarms 360
attaching to incoming alarm 364
cloning 246, 261, 283, 301
creating 245
definition 324
deleting 253
displaying 361
modifying 251
opening existing 217
precedence 369
saving 249

WorkSPACE Manager
accessing 216
bookmark usage 224
Commands 301
drop down list 221
forcing values 241, 243
launching 217
menu bar 219
overview 219
status bar 229
toolbar 221

Workstations
adding 419
deleting 420
setup 420, 421
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and mail.

Your comments regarding this manual will help us improve future
editions.   Please comment on the usefulness and readability of this
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